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Leggere attentamente questo manuale
prima di utilizzare 'unita, e conservarlo per
riferimenti futuri.

AVVERTENZA

Per ridurre il rischio di
incendi o scosse elettriche,
non esporre questo
apparato alla pioggia o
all’'umidita.

Per evitare scosse
elettriche, non aprire
I’involucro. Perl’assistenza
rivolgersi unicamente a
personale qualificato.

AVVERTENZA

Un’eccessiva pressione sonora da auricolari
e cuffie pud causare la perdita dell’'udito.
Per usare questo prodotto in maniera sicura,
evitare I'ascolto prolungato a livelli eccessivi
di pressione sonora.

Per i clienti in Europa

Questo prodotto recante il marchio CE &
conforme sia alla direttiva sulla compatibilita
elettromagnetica (EMC) emesse dalla
Commissione della Comunita Europea.

La conformita a queste direttive implica la

conformita alle seguenti normative europee:

* EN55103-1 : Interferenza
elettromagnetica (Emissione)

* EN55103-2 : Sensibilita ai disturbi
elettromagnetici (Immunita)

Questo prodotto & destinato all'uso nei

seguenti ambienti elettromagnetici: E1

(residenziali), E2 (commerciali e industriali

leggeri), E3 (esterni urbani) e E4 (ambienti

EMC controllati, ad esempio studi televisivi).

Il fabbricante di questo prodotto & la Sony
Corporation, 1-7-1 Konan, Minato-ku,
Tokyo, 108-0075 Giappone.

La rappresentanza autorizzata per EMC e la
sicurezza dei prodotti € la Sony Deutschland
GmbH, Hedelfinger Strasse 61, 70327

Stoccarda, Germania. Per qualsiasi
questione riguardante I'assistenza o la
garanzia, si prega di rivolgersi agli indirizzi
riportati nei documenti sull’assistenza o sulla
garanzia a parte.
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Premessa

Prima dell’uso

Dopo aver acquistato il camcorder con memoria
allo stato solido PMW-500, prima di metterlo in
funzione, & necessario impostare I’area di
utilizzo.

(Se non viene eseguita questa impostazione, il
camcorder non funziona).

Per ulteriori informazioni su queste impostazioni,
vedere “Impostazione dell’area di utilizzo”
(pagina 38).

Prima di collegare/rimuovere i componenti opzionali o
gli accessori al/dal PMW-500 (qui denominato “il
camcorder”), assicurarsi di spegnere il camcorder.

. =

Indicazioni modalita in
questo manuale

Alcune funzioni e informazioni sono disponibili
solo quando questo camcorder ¢ in una modalita
operativa specifica. Nel presente manuale tali
modalita sono indicate dai contrassegni seguenti.
Quando appaiono questi contrassegni, le funzioni
o informazioni associate sono disponibili solo in
quella modalita.

Modalita HD: quando OPERATION >Format
>HD/SD nel menu di impostazione € impostato

su [HD].

Modalita UDF: quando OPERATION >Format
>File System nel menu di impostazione &

impostato su [UDF].

FAT

Modalita FAT: quando OPERATION >Format
>File System nel menu di impostazione &
impostato su [FAT].

Modalita FAT-HD: quando OPERATION
>Format >File System nel menu di impostazione
¢ impostato su [FAT] e OPERATION >Format
>HD/SD nel menu di impostazione ¢ impostato
su [HD].

Modalita FAT-SD: quando OPERATION
>Format >File System nel menu di impostazione
¢ impostato su [FAT] e OPERATION >Format
>HD/SD nel menu di impostazione ¢ impostato
su [SD].

Premessa / Indicazioni modalita in questo manuale

9
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Capitol01

Caratteristiche

CCD a 2/;” full HD “PowerHAD FX”

 Sensori di immagini progressive IT (Interline
Transfer) 2/3” con 207 milioni di pixel, per
risoluzione full HD (1920 x 1080)

* I CCD “PowerHAD FX” presentano un segnale
che elabora ASIC con convertitori a 14 bit A/D
Queste nuove tecnologie di sensori di immagini
permettono di catturare immagini di alta
qualita, con sensibilita F11 (59.94i) e F12 (501)
e un rapporto SN di 59 dB. D

1) Con la soppressione di rumore attiva (il valore “off” &
54 dB) La soppressione di rumore si serve della
tecnologia di elaborazione del segnale Sony per
sopprimere il rumore nelle regioni ad alta frequenza.

Schede di memoria SxS come supporto
di registrazione

Grazie all’utilizzo delle schede di memoria SxS,
il camcorder garantisce funzionalita non lineari
come I’accesso casuale immediato e il
funzionamento basato su file.

E possibile scegliere il file system FAT o UDF
per i supporti di registrazione.

Leggero, a basso consumo energetico

Le caratteristiche del progetto quali il segnale
video ICs e la registrazione su scheda di memoria
SxS permettono un funzionamento senza
ventilazione e un consumo energetico di 27 W o
meno. La leggerezza del camcorder (3,4 kg) e il
baricentro basso permettono di trasportare il
camcorder su una spalla e allo stesso tempo
assicurano una stabilita eccezionale.

Caratteristiche

Registrazione HD tramite codec “MPEG-
2 Long GOP” e registrazione SD in
formato MPEG IMX50/DVCAM

Il camcorder ¢ in grado di registrare immagini HD
1920 x 1080, 1440 x 1080, e 1280 x 720 tramite
il codec di compressione “MPEG-2 Long GOP”.
Per la registrazione in modalita FAT, consente di
scegliere il bit rate da utilizzare: a 35 Mbps (in
modalita HQ) o 25 Mbps (in modalita SP).
Per la registrazione in modalitd UDF, consente di
scegliere il bit rate da utilizzare: a 35 Mbps (in
modalita HQ) o 50 Mbps (in modalita HD422).
Grazie all’efficace formato di compressione, il
camcorder consente di registrare immagini HD di
alta qualita per un tempo di registrazione
prolungato, pari a circa 60 minuti a 50 Mbps
(modalita HD422) o a circa 90 minuti a 35 Mbps
(modalita HQ) in un’unica scheda di memoria
SxS da 32 GB (quando la modalita di
registrazione & UDF).
E inoltre in grado di registrare e riprodurre due
formati SD: MPEG IMX 50 Mbps e DVCAM 25
Mbps. D
1) E necessaria la chiave di registrazione e riproduzione

SD CBK-MDO1.

Per ulteriori informazioni, contattare un

rappresentante Sony

Supporto multi formato

Il camcorder supporta un formato di registrazione
interlacciato (1080/59.94i o 1080/50i), un
formato di registrazione progressivo (1080/
29.97P, 1080/23.98P, 720/59.94P, 720/29.97P,
720/23.98P, o 1080/25P, 720/50P, 720/25P),
offrendo la flessibilita necessaria per la
registrazione HD su scala mondiale.

Supporta anche la registrazione e la riproduzione
di segnali SD (sia NTSC che PAL). Il camcorder
vanta una funzionalita di registrazione e
riproduzione opzionale dei segnali in formato
IMX/DVCAM, e puo inviare segnali HD
convertiti a SD.



Numerose funzioni per un rendimento
migliore nelle diverse circostanze di
ripresa

* Funzione Picture Cache

« Filtri ottici ND e filtri elettrici CC

¢ Gamma iper

* Funzione Slow shutter

* Funzione Registrazione clip senza interruzioni

 Funzione di registrazione per fotogrammi

* Funzione a intervalli (registrazione ad
intervalli)

* Funzione di movimento lento e rapido

* Funzione Freeze mix

* Funzione Live & Play

» Funzione di estensione digitale D

* Funzione di ingrandimento della messa a fuoco

* Interruttori programmabili

¢ Monitor LCD a colori in alta risoluzione da 3,5”

* Controllo remoto

1) Quando I’ingresso CBK-HD02 SDI/COMPOSITE e
interfaccia a 50 pin opzionale ¢ installato

Registrazione dati su unita flash USB e
lettura dati da unita flash USB (modalita
UDF)

E possibile collegare le unita flash USB al
connettore di dispositivi esterni per registrare dati
proxy o per leggere metadata di pianificazione. E
anche possibile salvare le impostazioni del menu
di impostazione sulle unita flash USB e caricare
le impostazioni del menu dalle unita flash USB
sul camcorder.

Supporto LAN wireless

E possibile collegare questo camcorder ad un
computer con LAN wireless (connessione Wi-Fi)
collegando l'adattatore Wi-Fi opzionale CBK-
WAOLI al connettore di dispositivi esterni.

Una connessione Wi-Fi consente di trasferire
metadata di pianificazione da un computer a
questo camcorder e di trasferire clip ed altri file
da questo camcorder ad un computer. E anche
possibile utilizzare la funzione Live Logging per
trasferire dati proxy AV ad un computer durante
le riprese, per un logging del video in fase di
ripresa.

Presenta le caratteristiche uniche delle
serie XDCAM

Il camcorder presenta le caratteristiche di serie
XDCAM, compresa la visualizzazione di
miniature e la gestione dei metadata, e le migliora
introducendo un’interfaccia macchina-uomo
migliorata.

Supporta due tipi di mirino

A seconda dell’applicazione, si pu0 usare il
mirino serie HDVF opzionale o il mirino a colori
CBK-VFO01.

Configurazione di sistema del camcorder

Quando si installa I’ingresso CBK-HD02 SDI/
Composite opzionale e I’interfaccia a 50 pin, si
puo montare 1’adattatore per videocamera HD
CA-FB70 e connettere I'unita di controllo HD
CA-TX70 per configurare un sistema di ripresa e
registrazione.

Quando si installa I’ingresso CBK-HDO02, si pud
anche connettere 1I’adattatore HDCA-702 MPEG
TS al posto dell’adattatore per telecamera. Cio
permette di convertire questa uscita HDSDI del
camcorder in uno stream di trasporto MPEG HD.

Download del software

Quando I’unita viene utilizzata in collegamento
con un PC, scaricare driver, plug-in e software
applicativo (se del caso) dal sito web per i
prodotti business di Sony.

Indirizzo del sito web per i prodotti business di

Sony:
Stati Uniti http://pro.sony.com
Canada http://www.sonybiz.ca

America Latina http://sonypro-latin.com
Europa, Medio Oriente e Africa
http://www.pro.sony.eu

Giappone http://www.sonybsc.com
Asia e Pacifico  http://pro.sony-asia.com
Corea http://bp.sony.co.kr

Cina http://pro.sony.com.cn

Caratteristiche

eolwelouRd | ojouden
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Posizione e funzione dei
componenti e dei
comandi

Alimentazione

Connettore adattatore (vedere pagina 12)

Interruttore LIGHT

Consente di attivare e disattivare una luce video

collegata al connettore LIGHT (vedere

pagina 13).

AUTO: se I'interruttore POWER della luce video
¢ in posizione ON, la luce video viene accesa
automaticamente mentre il camcorder ¢ in
fase di registrazione.

MANUAL: ¢ possibile accendere o spegnere
manualmente la luce video dall’apposito
interruttore.

Quando il camcorder ¢ impostato per la registrazione in
modalita Picture Cache, non & possibile accendere la luce
prima di avviare la registrazione (o mentre i dati vengono
memorizzati nella memoria).

Interruttore POWER
Consente di accendere e spegnere 1’apparecchio.

Posizione e funzione dei componenti e dei comandi

Connettore DC IN (ingresso
alimentazione CC) (tipo XLR, 4 pin,
maschio)

Per mettere in funzione il camcorder da un

alimentatore CA, collegare un cavo di

alimentazione CC a questo terminale e poi

collegare il cavo al terminale in uscita CC del BC-

L70, BC-L160, o altro caricabatterie.

1 Connettore DC OUT 12 V (uscita

alimentazione CC) (4 pin, femmina)
Fornisce I’alimentazione a un sintonizzatore a
sintesi di frequenza WRR-860C/861/862 UHF
opzionale (massimo 0,5 A).

Non collegare nessun sintonizzatore che non sia a sintesi
di frequenza UHF.

Attacco collegamento batteria
Collegare un pacco batteria BP-L80S. In
alternativa, collegare un adattatore CA AC-
DN2B/DN10 per utilizzare il camcorder con
alimentazione CA.

Per ulteriori informazioni, vedere “Preparazione
dell’alimentazione” (pagina 34).

Per ulteriori informazioni, vedere “Come collegare
un sintonizzatore UHF portatile (per un sistema
microfono wireless UHF)” (pagina 44).

Per garantire la sicurezza dell’ utilizzatore e il corretto
funzionamento del camcorder, Sony consiglia di
utilizzare il pacco batteria BP-L80S.

Connettore adattatore

Consente il collegamento di un adattatore per
videocamera HD CA-FB70 o un adattatore
HDCA-702 MPEG TS. Per collegare un
adattatore, rimuovere il coperchio dal connettore
e installare I’ingresso CBK-HD02 SDI/
COMPOSITE opzionale e I’interfaccia a 50 pin.



Attacchi degli accessori

Attacco per la tracolla
Permette di montare la tracolla in dotazione
(vedere pagina 48).

Attacco per accessori
Permette di collegare un accessorio opzionale,
quale una luce video (vedere pagina 47).

Manopola di posizionamento anteriore-
posteriore del mirino

Per regolare la posizione del mirino in direzione

anteriore-posteriore, sganciare la leva e la

manopola LOCK. Dopo la regolazione, avvitare

nuovamente la leva e la manopola LOCK.

4] Regolatore di posizionamento sinistra-
destra del mirino

Allentare questo regolatore per regolare il

posizionamento sinistra-destra del mirino (vedere

pagina 36).

Attacco del mirino
Permette di collegare il mirino.

E Connettore VF (mirino) (26 pin,
rettangolare e 20 pin, rotondo)

11 connettore di interfaccia analogico (20 pin)

serve per il collegamento di un mirino serie

HDVF, mentre il connettore di interfaccia digitale

(26 pin) per il collegamento di un mirino HD

CBK-VFO01.

Utilizzare un cavo di connessione per il
collegamento del mirino al connettore
corrispondente.

Non collegare i mirini a entrambi i connettori allo stesso
tempo.

Tappo attacco obiettivo

Dopo aver bloccato I’obiettivo in posizione
utilizzando la leva di bloccaggio dell’obiettivo,
inserire la gomma sulla proiezione inferiore.
Questo fissa I’obiettivo, e previene che si smonti.

8] Manopola di posizionamento anteriore-
posteriore del mirino (manopola
LOCK)

Allentare questa manopola per regolare il

posizionamento anteriore-posteriore del mirino

(vedere pagina 36).

El Attacco per il supporto del microfono
opzionale

Permette di installare un supporto per il

microfono opzionale CAC-12 (vedere

pagina 43).

M Appoggio per le riprese a spalla
Sollevare la leva di montaggio dell’appoggio per
le riprese a spalla per regolare il posizionamento
anteriore-posteriore. Regolare la posizione per
una massima praticita di utilizzo a spalla(vedere
pagina 49).

Connettore LIGHT (luce video) (2 pin,
femmina)

E possibile collegare una luce video con un

consumo energetico massimo di 50 W, come ad

esempio, una luce Anton Bauer Ultralight 2 o

equivalente (vedere pagina 47).

Morsetto del cavo dell’obiettivo
Bloccare un cavo dell’obiettivo.

Connettore MIC IN (ingresso
microfono) (+48 V) (tipo XLR, 5 pin,
femmina)

Permette di connettere un microfono stereo a

questo connettore. L’alimentazione (+48 V)

viene fornita tramite questo connettore.

Posizione e funzione dei componenti e dei comandi
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Connettore LENS (12 pin)
Permette di connettere un cavo dell’obiettivo a
questo connettore.

Quando si collega o scollega il cavo obiettivo al
connettore, spegnere prima il camcorder.

Montaggio del treppiede
Se si utilizza il camcorder sul treppiede, montare
I’adattatore del treppiede (opzionale).

Attacco per ’obiettivo (attacco speciale
a baionetta)
Fissare 1’obiettivo.

Contattare un rappresentante Sony per ulteriori
informazioni sugli obiettivi disponibili.

Leva di bloccaggio dell’obiettivo

Dopo aver inserito I’obiettivo nell’apposito
supporto, ruotare il regolatore dell’ attacco
dell’obiettivo mediante questa leva in modo da
bloccarlo in posizione.

Dopo aver bloccato 1’ obiettivo, assicurarsi di
utilizzare la gomma dell’ attacco per evitare che si
stacchi.

Copriobiettivo

Rimuoverlo spingendo la leva di blocco
dell’obiettivo. Se non ¢ montato alcun obiettivo,
lasciare il tappo inserito onde evitare che la
polvere penetri all’interno.

Posizione e funzione dei componenti e dei comandi

Funzionamento e connettori

Parte anteriore

Pulsante REC START (avvio
registrazione)

Premere per avviare la registrazione. Premere di

nuovo per arrestare la registrazione. Il risultato di

tale operazione sara simile a quello del pulsante
REC dell’obiettivo.

Selettore SHUTTER

Impostare questo interruttore su ON per utilizzare
I’otturatore elettronico. Spostare su SELECT per
selezionare la velocita o la modalita

dell’ otturatore. Quando si utilizza questo
interruttore, la nuova impostazione appare sullo
schermo del mirino per 3 secondi circa.

Per ulteriori informazioni, vedere “Impostazione
dell’otturatore elettronico” (pagina 56).

Selettore FILTER

Su questo camcorder sono disponibili quattro
filtri ND.

Quando si utilizza questo selettore, la nuova
impostazione appare sullo schermo del mirino per
3 secondi circa.

Impostazione del  Filtro ND

selettore FILTER

1 CLEAR

2 l/4 ND (attenua la luce di
circa ]/4)




Impostazione del  Filtro ND

selettore FILTER

3 1/16 ND (attenua la luce di
circa !/ 16)

4 U4 ND (attenua la luce di
circa ]/64)

[A Comando MIC (microfono) LEVEL
Permette di regolare il livello d’ingresso dei
canali audio 1, 2, 3 e 4 (vedere pagina 60).

Lato destro (accanto al davanti)

Si pud modificare I’'impostazione del menu
MAINTENANCE in modo da memorizzare
diverse impostazioni di bilanciamento del bianco
per varie posizioni del selettore FILTER. Cio
consente di ottenere il bilanciamento del bianco
ottimale per le attuali condizioni di ripresa in base
alla selezione del filtro.

Per ulteriori informazioni, vedere “Regolazione del
bilanciamento del bianco” (pagina 54).

1 Manopola MENU

Consente di modificare la selezione della voce o
un’impostazione all’interno del menu(vedere
pagina 114).

Interruttore AUTO W/B BAL
(regolazione automatica del
bilanciamento del bianco/nero)

Consente di attivare le funzioni di regolazione

automatica del bilanciamento del bianco/nero.

WHITE: consente di regolare automaticamente
il bilanciamento del bianco. Se I’interruttore
WHITE BAL (vedere pagina 17) &
impostato su A o B, I'impostazione del
bilanciamento del bianco viene salvata nella
memoria corrispondente. Se ’interruttore
WHITE BAL si trova impostato su PRST,
I’impostazione automatica del bilanciamento
del bianco non funziona.

BLACK: consente di regolare automaticamente
I’impostazione del nero e del bilanciamento
del nero.

E possibile utilizzare Iinterruttore AUTO W/B

BAL anche quando la funzione ATW (Auto

Tracing White Balance) ¢ in funzione.

Se si sposta nuovamente 1’interruttore sulla parte

WHITE durante la regolazione automatica del

bianco, la regolazione viene annullata e

I’impostazione del bilanciamento del bianco

torna all’impostazione iniziale.

Se si sposta nuovamente 1’interruttore sulla parte

BLACK durante la regolazione automatica del

nero, la regolazione viene annullata e

I’impostazione del bilanciamento del nero torna

all’impostazione iniziale.

.

Interruttori ASSIGN. (programmabili)
1/2/3

E possibile assegnare le funzioni desiderate a

questi interruttori in OPERATION >Assignable

SW nel menu di impostazione (vedere

pagina 171).

Off ¢ assegnato agli interruttori ASSIGN 1/2/3

come impostazione predefinita.

Gli interruttori ASSIGN.1/3 sono forniti con un

indicatore che indica se una funzione viene

assegnata all’interruttore (ON) o no (OFF).

Pulsante COLOR TEMP. (temperatura
del colore)

Premere per accendere il pulsante e modificare la

temperatura del colore (impostazione

predefinita). E possibile utilizzare questo

Posizione e funzione dei componenti e dei comandi
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pulsante come interruttore programmabile
(vedere pagina 171).

Manopola ALARM (regolazione del
volume dell’allarme)
Consente di controllare il volume del segnale di
avviso che viene trasmesso mediante
I’altoparlante incorporato o gli auricolari
opzionali. Quando si ruota la manopola verso la
posizione minima, non si avverte alcun suono.
Tuttavia, ses MAINTENANCE >Audio >Min
Alarm Volume nel menu di impostazione &
impostato su [Set], I’audio dell’allarme sara
udibile anche quando il volume & impostato al
minimo.

4] Manopola MONITOR (regolazione del
volume del monitor)

Consente di controllare il volume del segnale di

avviso che viene trasmesso mediante

I’altoparlante incorporato o gli auricolari.

Quando si ruota la manopola verso la posizione

minima, non si avverte alcun suono.

Interruttori MONITOR (selezione
monitor audio)

Combinando i due interruttori, & possibile

selezionare 1’audio desiderato dall’altoparlante

incorporato o dagli auricolari.

Posizione dell’interruttore parte inferiore:
CH-1/2

Posizione Uscita audio

dell’interruttore

parte superiore

CH-1/CH-3 Audio canale 1

MIX Audio mixato canali 1 e 2
(stereo) ¥

CH-2/CH-4 Audio canale 2

Posizione dell’interruttore parte inferiore:
CH-3/4

Posizione Uscita audio
dell’interruttore

parte superiore

CH-1/CH-3 Audio canale 3

Posizione e funzione dei componenti e dei comandi

Posizione Uscita audio

dell’interruttore

parte superiore

MIX Audio mixato canali 3 e 4
(stereo) ¥

CH-2/CH-4 Canale audio 4

a) Collegando delle cuffie stereo al connettore
EARPHONE, si avverte 1’audio in stereo. (Alla voce
MAINTENANCE >Audio nel menu di impostazione,
Headphone Out deve essere impostato su STEREO.)

[A Interruttore ASSIGN.
(programmabile) 0

E possibile assegnare la funzione desiderata a

questo interruttore in OPERATION >Assignable

SW nel menu di impostazione (vedere

pagina 172).

Off viene assegnato a questo interruttore se il

camcorder ¢ spedito dalla fabbrica.

Si tratta di un interruttore di tipo temporaneo. Ad

ogni pressione dell’interruttore si attiva o

disattiva la funzione assegnata all’interruttore.

Selettore GAIN

Consente di impostare il guadagno
dell’amplificatore video in modo che corrisponda
alle condizioni di illuminazione durante le
riprese. I valori del guadagno corrispondenti alle
impostazioni L, M e H possono essere selezionati
in OPERATION >Gain Switch nel menu di
impostazione (vedere pagina 127). (Le
impostazioni di fabbrica sono L=0 dB, M=6 dB, e
H=12dB.)

Una volta regolato questo interruttore, la nuova
impostazione appare sullo schermo del mirino per
3 secondi circa.

Bl Interruttore OUTPUT/DCC (segnale di
uscita/comando del contrasto dinamico)

Permette di selezionare 1’uscita del segnale video,

dal modulo camcorder compreso tra i seguenti.

BARS: viene emesso il segnale delle barre di

colore.

CAM: viene emesso il segnale video che si sta

riprendendo. Se questa opzione ¢ selezionata,
il selettore consente di attivare o disattivare
pce Y.

1) DCC (comando del contrasto dinamico): se
I’apertura del diaframma viene regolata in base al
soggetto e lo sfondo & molto luminoso, gli oggetti
dello sfondo risultano abbagliati.. La funzione DCC
consente di eliminare 1’alta intensita e di ripristinare la



maggior parte dei dettagli persi risultando

particolarmente efficace nei seguenti casi:

* Ripresa di persone all’ombra in un giorno assolato

 Ripresa di un soggetto in interno, con una finestra
alle spalle

* Scena con un alto livello di contrasto

E Interruttore WHITE BAL (memoria
del bilanciamento del bianco)

Consente di controllare la regolazione del

bilanciamento del bianco.

PRST: consente di regolare la temperatura del
colore sul valore predefinito (impostazione
predefinita: 3200K). Utilizzare questa
impostazione, se non si dispone del tempo
necessario per regolare il bilanciamento del
bianco.

A o B: consente di richiamare le impostazioni di
regolazione del bilanciamento del bianco gia
memorizzate su A o B. Premere I’interruttore
AUTO W/B BAL (vedere pagina 15) sul lato
WHITE per regolare automaticamente il
bilanciamento del bianco e salvare le
impostazioni di regolazione nella memoria A
oB.

B (ATW ])): se I’interruttore & impostato su B e
OPERATION >White Setting >White
Switch<B> ¢ impostato su [ATW] nel menu
di impostazione, viene attivata la funzione
ATW.

E possibile utilizzare I’interruttore AUTO
W/B BAL anche quando ATW ¢ attivato.

Una volta regolato questo interruttore, la nuova

impostazione appare sullo schermo del mirino per

3 secondi circa.

1) ATW (bilanciamento automatico del bianco): il
bilanciamento del bianco viene regolato
automaticamente in base alle variazioni delle
condizioni di illuminazione.

In alcune condizioni di illuminazione o in base
all’oggetto ripreso, la regolazione con I’ATW potrebbe
non fornire colori corretti.

Esempi:

* Quando un oggetto dal colore sostanzialmente
uniforme come il cielo, il mare, il suolo, I’erba o certi
tipi di fiore occupa la maggior parte dell'area del
fotogramma.

* Quando I’oggetto si trova sotto una fonte luminosa con
una temperatura del colore estremamente alta o
estremamente bassa.

Se I’esecuzione del bilanciamento automatico tramite
funzione ATW impiega un tempo eccessivamente lungo

o produce un effetto inadeguato, eseguire la funzione
AWB.

M Interruttore MENU ON/OFF

Per utilizzare questo interruttore, aprire il
coperchio.

Questo interruttore ¢ utilizzato per visualizzare il
menu sullo schermo del mirino o sullo schermo
del segnale di prova. Ogni volta che si sposta
I’interruttore verso il basso, la schermata del
menu viene attivata o disattivata.

La funzione di questo interruttore ¢ la stessa del
pulsante MENU nella sezione delle operazioni
della schermata delle miniature.

Questo interruttore dispone di varie funzioni, a

seconda della visualizzazione o meno di un menu.

Interruttore MENU CANCEL/PRST
(preset)/ ESCAPE

Per utilizzare I’interruttore MENU CANCEL/

PRST/ESCAPE, aprire il coperchio.

Non ¢ possibile disattivare la schermata del menu
chiudendo il coperchio.

Usare ’interruttore nel modo seguente quando il

menu non viene visualizzato.

CANCEL/PRST: ogni volta che I’interruttore &
spostato verso 1’alto, compare una finestra
per confermare le impostazioni del menu e lo
stato del camcorder compare sullo schermo
del mirino (vedere pagina 66). La finestra &
composta di cinque pagine, che cambiano
ogni volta che I'interruttore ¢ portato verso
I’alto. Ogni pagina & visualizzata per circa 10
secondi.

ESCAPE: per chiudere la pagina subito dopo la
visualizzazione, spingere I’ interruttore verso
il basso in posizione OFF.

Usare ’interruttore nel modo seguente quando il

menu viene visualizzato.

CANCEL/PRST: portando ’interruttore verso
I’alto dopo aver modificato un’impostazione
si visualizza il messaggio per confermare se
le impostazioni precedenti sono annullate.
Portando questo interruttore verso 1’alto si
annullano le impostazioni precedenti.
Portando I'interruttore verso 1’alto prima di
modificare un’impostazione o dopo aver

Posizione e funzione dei componenti e dei comandi
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annullato la modifica di un’impostazione nel
menu di impostazione si visualizza il
messaggio per confermare se le impostazioni
sono ripristinate al valore iniziale.

Portando di nuovo questo interruttore verso
I’alto si riportano le impostazioni precedenti
ai valori iniziali.

ESCAPE: utilizzare questo interruttore quando &
aperta la pagina del menu, che presenta una
struttura gerarchica. Ogni volta che
I’interruttore & portato in questa posizione, la
pagina ritorna al livello superiore della
struttura gerarchica.

Coperchio

Aprire il coperchio per utilizzare 1’ interruttore
MENU ON/OFF o I'interruttore MENU
CANCEL/PRST/ESCAPE.

Lato destro (accanto al retro)

{ ) L)
FREV PLAY/PAUSE | F FWD
O <« o1l O »p

Altoparlante incorporato

Posizione e funzione dei componenti e dei comandi

L’altoparlante puo essere utilizzato per

controllare I'audio E-E ! durante la registrazione

eil suono diriproduzione durante la riproduzione.

L’altoparlante emette inoltre dei segnali di

allarme per evidenziare le avvertenze di tipo

visivo (vedere pagina 193).

Se si collegano degli auricolari alla presa

EARPHONE, I’emissione dall’altoparlante viene

automaticamente disattivata.

1) E-E: abbreviazione di “Electric-to-Electric”. Nella
modalita E-E, i segnali video ed audio ricevuti dal
camcorder vengono poi emessi solamente dopo essere
passati attraverso circuiti elettrici interni. In questo
modo & possibile controllare i segnali di ingresso.

Monitor LCD

Visualizza la carica residua della batteria, spazio
residuo sui supporti, livelli audio, dati temporali,
ecc. (vedere pagina 25).

Consente inoltre di controllare le immagini della
telecamera e di riproduzione.

E possibile regolare la posizione e ’angolo del
monitor LCD.

Indicatore WARNING
Si illumina o lampeggia se si verifica
un’anomalia (vedere pagina 193).

B Spia ACCESS
Si illumina in blu quando si scrivono o si leggono
i dati dal supporto di registrazione.

Coperchio di protezione della sezione di
controllo audio

Aprire per accedere alla sezione di controllo

audio (vedere pagina 20).

A Coperchio di protezione della sezione
delle funzioni dello schermo delle
miniature

Aprire per accedere alla sezione di controllo delle

operazioni delle miniature (vedere pagina 20).



pulsante e indicatore F REV
(riavvolgimento rapido)

Esegue la riproduzione ad alta velocita in

direzione inversa. Ad ogni pressione del pulsante,

la velocita cambia nell’ordine x4 — x15 — x24.

L’indicatore lampeggia durante la riproduzione

all’indietro ad alta velocita.

Bl Pulsante e indicatore PLAY/PAUSE
Premere questo pulsante per riprodurre immagini
video sullo schermo del mirino o sul monitor
LCD. L’indicatore si illumina in fase di
riproduzione.

Durante la riproduzione, premendo nuovamente
questo pulsante, si interrompe la riproduzione e si
blocca 'immagine. A questo punto I’indicatore
lampeggia ad una velocita di un’illuminazione al
secondo.

La pressione del pulsante F REV o F FWD
durante la riproduzione o la pausa avvia la
riproduzione in avanti o all’indietro ad alta
velocita.

E] Pulsante ed indicatore F FWD
(avanzamento rapido)

Esegue la riproduzione ad alta velocita in avanti.

Ad ogni pressione del pulsante, la velocita cambia

nell’ordine x4 — x15 — x24. L’indicatore

lampeggia durante la riproduzione in avanti ad

alta velocita.

Pulsante PREV

Permette di saltare al primo fotogramma del clip
attuale.

Se si preme insieme al pulsante F REV, salta al
primo fotogramma del primo clip registrato sul
supporto di registrazione.

Se si preme il pulsante due volte in rapida
successione, il salto porta al primo fotogramma
del precedente (o al primo fotogramma del clip
attuale quando non ¢ presente alcun clip
precedente).

Pulsante STOP
Premere questo pulsante per interrompere la
riproduzione.

Pulsante NEXT

Salta al primo fotogramma del clip successivo.
Se si preme insieme al pulsante F FWD, salta al
primo fotogramma dell’ultimo clip registrato sul
supporto di registrazione.

Pulsante DISP SEL (selezione display)/

EXPAND (funzione di espansione)
Ogni volta che si preme questo pulsante, il
display del monitor LCD varia nel modo
seguente.

Indicazione display Significato

Video con Il monitor LCD visualizza
le stesse informazioni di

sovrapposte (CHAR) testo del mirino.

informazioni

Video senza Appare solo il video.

informazioni

sovrapposte (MONI)

Stato del display Appaiono indicazioni del
(STATUS) contatore, avvisi, livelli

audio ed informazioni
simili. Non appare alcuna
immagine video.

Se si preme questo pulsante durante la
visualizzazione delle miniature, la durata del clip
selezionato viene suddivisa in frazioni ed il primo
fotogramma di ciascun riquadro viene mostrato in
una ulteriore visualizzazione delle miniature
(funzione di espansione). Per un clip MP4
registrato in HD, la durata viene divisa in 12. Se
un clip SD registrato in AVI comprende file
multipli, le divisioni vengono visualizzate per i
file individuali.

Per i clip MP4, ad ogni pressione del pulsante, si
ripete la divisione. Tenere premuto il pulsante
SHIFT e premere questo pulsante per tornare
indietro nel processo di suddivisione.

Pulsante HOLD (visualizzazione hold)
Premendo questo pulsante si bloccano
istantaneamente i dati temporali visualizzati nel
monitor LCD. (Il generatore del codice temporale
continua a funzionare.) Premendo nuovamente
questo pulsante si disattiva la funzione.

Per ulteriori informazioni sulla visualizzazione del
contatore, vedere pagina 26.

Pulsante RESET/RETURN

Ripristina il valore mostrato nella visualizzazione
del contatore orario nel monitor LCD. A seconda
delle impostazioni dell’interruttore PRESET/
REGEN/CLOCK (vedere pagina 21) e
dell’interruttore F-RUN/SET/R-RUN (vedere
pagina 21), consente di ripristinare il display nel
modo seguente.

Posizione e funzione dei componenti e dei comandi
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Impostazioni degli Come Impostazione Retroilluminazione del monitor
interruttori ripristinare LCD

Interruttore DISPLAY: Contatore su H Alta (selezionare per visualizzare
COUNTER 0:00:00:00 il monitor LCD all’aperto durante
Interruttore DISPLAY: TC  Codice temporale il giorno)

Interruttore PRESET/ su 00:00:00:00 M LuminositatraHe L
REGEN/CLOCK: PRESET L Bassa (selezionare per visualizzare
Interruttore F-RUN/SET/ il monitor LCD all’interno o
R-RUN: SET all’esterno di notte)

Interruttore DISPLAY: Dati bit utente ¥ OFF Disattivato (il display & disattivo)
U-BIT su 00 00 00 00

Interruttore PRESET/ Sezione delle funzioni dello schermo delle

REGEN/CLOCK: PRESET
Interruttore F-RUN/SET/
R-RUN: SET

a) Bit codice temporale per ciascun fotogramma
registrato sul supporto, bit che possono essere
adoperati per registrare informazioni utili per I’utente,
quali numero di scena, luogo delle riprese, ecc.

Per ulteriori informazioni, vedere “Impostazione dei

dati temporali” (pagina 62).

Questo pulsante torna alla schermata precedente
quando viene premuto durante la visualizzazione
della schermata delle miniature, della schermata
di espansione delle miniature, o della schermata

delle miniature degli indicatori di identificazione.

Interruttore DISPLAY

Esso visualizza ciclicamente i dati visualizzati sul

display del contatore nel monitor LCD tramite la

sequenza COUNTER, TC e U-BIT (vedere

pagina 26).

COUNTER: visualizza la durata della
registrazione/riproduzione rimasta (ore,
minuti, secondi, fotogrammi).

TC: visualizza il codice temporale.

U-BIT: visualizzazione di dati bit utente.

Pulsante BRIGHT (luminosita)

Regola la luminosita della retroilluminazione del
monitor LCD.

Ad ogni pressione del pulsante si seleziona
I’impostazione successiva nell’ordine mostrato
nella tabella successiva.

Se si preme il pulsante con il monitor LCD
spento, la retroilluminazione LCD si attiva in
stato H.

Posizione e funzione dei componenti e dei comandi

miniature e sezione di controllo audio
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Kl Indicatore THUMBNAIL
Si illumina quando viene visualizzata la
schermata delle miniature.

Pulsante THUMBNAIL

Premere questo pulsante per visualizzare la
schermata delle miniature (vedere pagina 94) e
per svolgere un’operazione con le miniature.
Premere di nuovo per tornare alla visualizzazione
originale.

Pulsante SET (set) e pulsanti frecce
Utilizzare questi pulsanti per effettuare modifiche
acodice temporale e bit dell’utente per le funzioni
della schermata delle miniature (vedere

pagina 102).

Quando il menu & visualizzato, premere questo
pulsante per selezionare una voce o per
confermare la modifica delle impostazioni.

B Pulsante MENU

Ciascuna pressione di questo pulsante attiva e
disattiva la visualizzazione del menu di
impostazione.

La funzione di questo pulsante ¢ la stessa
dell’interruttore MENU ON/OFF.



H Interruttore F-RUN/SET/R-RUN
(funzionamento libero/impostazione/
funzionamento durante la
registrazione)

Seleziona la modalita operativa del generatore del

codice temporale interno. Tale modalita viene

impostata come illustrato di seguito, in base alla
posizione dell’interruttore.

F-RUN: il codice temporale continua ad avanzare
indipendentemente dal fatto che il camcorder
stia riprendendo o meno. Utilizzare questa
impostazione per sincronizzare il codice
temporale con un codice temporale esterno.

SET: impostare il codice temporale o i bit utente.

R-RUN: il codice temporale aumenta solo
durante la registrazione. Utilizzare questa
impostazione per mantenere sul supporto di
registrazione un codice temporale
consecutivo.

Per ulteriori informazioni, vedere “Impostazione del
codice temporale” (pagina 62) e “Impostazione dei
bit dell’utente” (pagina 63).

@ Manopole LEVEL CH1/CH2/CH3/
CH4 (livello di registrazione audio del
canale 1/2/3/4)

Regolare i livelli audio da registrare sui canali 1,

2, 3, e 4 quando gli interruttori AUDIO SELECT

CH1/CH2 e AUDIO SELECT CH 3-4 sono

impostati su MANUAL.

Interruttore AUDIO SELECT CH 3-4
(selezione del metodo di regolazione del
canale audio 3/4)

Consentono di selezionare il metodo di

regolazione del livello audio per i canali audio 3

e4.

AUTO: regolazione automatica

MANUAL: regolazione manuale

E Pulsante ESSENCE MARK

Premendo questo pulsante durante la

visualizzazione di una miniatura sullo schermo, &

possibile vedere la seguente visualizzazione delle

miniature dei fotogrammi con indicatore di

identificazione del clip selezionato, a seconda

della voce selezionata in un elenco presente sullo

schermo.

All: visualizzazione di tutti i fotogrammi indicati
con indicatori di identificazione.

Rec Start (in modalita UDF): visualizzazione
dei fotogrammi indicati con le tracce Rec

Start e dei primi fotogrammi dei clip (quando
i primi fotogrammi non sono indicati con le
tracce Rec Start).
Shot Mark1: visualizzazione dei fotogrammi
indicati con lo Shot Mark 1
Shot Mark2: visualizzazione dei fotogrammi
indicati con lo Shot Mark 2
E anche possibile selezionare Shot Mark 0 e Shot
Mark 3 - Shot Mark 9.
Se sono stati registrati dei clip usando metadata di
pianificazione che definivano i nomi per Shot
Mark 0 - Shot Mark 9, i nomi definiti sono
visualizzati nell'elenco al posto dei suddetti nomi
voce.
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El Pulsante SHIFT

Usarlo in combinazione con altri pulsanti.

M Interruttore PRESET/REGEN
(rigenerazione)/CLOCK

Seleziona il tipo di codice temporale da registrare.

PRESET: registra il codice temporale su un
supporto.

REGEN: registra il codice temporale in modo
continuo con il codice temporale esistente
registrato su un supporto. Il camcorder
funziona in modalita R-RUN,
indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN.

CLOCK: consente di registrare il codice
temporale sincronizzato con 1’orologio
interno. Il camcorder funziona in modalita F-
RUN, indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN.

Interruttori AUDIO SELECT CH1/
CH2 (selezione del metodo di
regolazione dei canali audio 1/2)

Consentono di selezionare il metodo di

regolazione del livello audio per i canali audio 1

e?2.

AUTO: regolazione automatica

MANUAL: regolazione manuale

Interruttori AUDIO IN CH1/CH2/
CH3/CH4 (selezione di ingresso dei
canali audio 1/2/3/4)

Consente di selezionare i segnali di ingresso

audio da registrare sui canali audio 1, 2,3 e 4.

FRONT: segnali di ingresso provenienti dal
microfono collegato al connettore MIC IN

Posizione e funzione dei componenti e dei comandi | 21
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REAR: segnali di ingresso audio provenienti da
un dispositivo audio collegato al connettore
AUDIO IN CH-1/CH-2

WIRELESS: segnali di ingresso audio dal
sintonizzatore portatile UHF se installato

Parte sinistra e sezione superiore

Interruttori ASSIGNABLE 4/5

E possibile assegnare le funzioni desiderate a
questi interruttori in OPERATION >Assignable
SW nel menu di impostazione (vedere

pagina 172).

Off & assegnato a questi interruttori se il
camcorder ¢ spedito dalla fabbrica.

Posizione e funzione dei componenti e dei comandi

Connettore PC

Si utilizza per mettere il camcorder in modalita di
connessione USB e di usarlo come dispositivo di
memorizzazione esterna per un computer.
Quando un computer senza slot ExpressCard
viene connesso al connettore, ciascuna scheda di
memoria inserita nel camcorder viene
riconosciuta come drive del computer.

Connettore di dispositivi esterni
Collegare un adattatore Wi-Fi opzionale CBK-
WAOI1 o un’unita flash USB.
Quando ¢ collegato un CBK-WAO01: ¢
disponibile la connessione LAN wireless.
Quando ¢ collegata un’unita flash USB: Sono
disponibili la registrazione, il salvataggio e il
caricamento dei seguenti dati.
* Registrazione di dati proxy (vedere
pagina 88)
* Caricamento di metadata di pianificazione
(vedere pagina 90)
« Salvataggio e caricamento dei dati di
impostazione (vedere pagina 176)

Usare questo connettore solo per connettere un CBK-
WAOLI o un'unita flash USB. Non connettere né usare un
hub USB o prodotti simili.

Per ulteriori informazioni su come usare I’CBK-
WAOI, consultare il Supplemento fornito con il CD-
ROM (contrassegnato con “Manuals for Solid-State
Memory Camcorder”).

ﬂ Slot schede di memoria SxS

Questi due slot (A e B) possono ricevere schede
di memoria SxS o altri supporti di registrazione
(vedere pagina 69).

Spie ACCESS

Indicare lo stato degli slot A e B (vedere

pagina 70). E possibile verificare se le spie sono
accese anche quando il coperchio dello slot &
chiuso.

A Pulsanti EJECT

Per rimuovere il supporto di registrazione dallo
slot, premere il pulsante EJECT per sbloccare,
quindi premere il pulsante nuovamente. Cio
permette che il supporto esca parzialmente dallo
slot (vedere pagina 70).



Coperchio dello slot
Far scivolare verso sinistra e verso destra per
aprire e chiudere.

E Pulsante SLOT SELECT (selezione
della scheda di memoria SxS)

Quando delle schede di memoria SxS sono

presenti in entrambi gli alloggiamenti A e B,

premere questo pulsante per selezionare la scheda

da usare(vedere pagina 71).

E] Connettore SDIIN (OPTION) (ingresso
SDI (opzionale)) (tipo BNC)

Quando si installano I’ingresso CBK-HDO02 SD1/

COMPOSITE opzionale e I’interfaccia a 50 pin,

il camcorder ¢ in grado di registrare segnali

HDSDI o SDSDI inviati a questo connettore.

Connettore GENLOCK IN (ingresso
segnale genlock) (tipo BNC)

Questo connettore invia un segnale di riferimento

quando il camcorder deve essere bloccato o

quando il codice temporale deve essere

sincronizzato con un dispositivo esterno.

I segnali di riferimento disponibili variano a

seconda della frequenza di sistema corrente come

mostrato nella tabella seguente.

Frequenza di Segnali di riferimento

sistema disponibili

1080/59.94i 1080/59.94i, 480/59.94i

1080/29.97P 1080/59.94i, 480/59.94i

1080/23.98P (invio  1080/23.98PsF, 480/59.94i

PsF)

1080/23.98P (invio  1080/59.94i, 480/59.94i

ridotto)

720/59.94P 1080/59.944, 720/59.94P,
480/59.941

720/29.97P 1080/59.94i, 720/59.94P,
480/59.94i

720/23.98P 1080/59.944, 720/59.94P,
480/59.941

480/59.94i 1080/59.94i, 480/59.94i

480/29.97P 1080/59.94i, 480/59.94i

10807501 1080/50i, 576/501

1080/25P 1080/50i, 576/501

720/50P 1080/50i, 720/50P, 576/50i

720/25P 1080/50i, 720/50P, 576/50i

576/50i 1080/50i, 576/501

576/25P 1080/50i, 576/501

(Genlock per il modulo della telecamera supporta
solo i segnali di sincronizzazione orizzontale)
Utilizzare MAINTENANCE >GENLOCK nel
menu di impostazione per regolare la fase H
genlock (fase del segnale di sincronizzazione
orizzontale).

Quando si installano I’ingresso CBK-HDO02 SDI/
COMPOSITE opzionale e I’interfaccia a 50 pin,
il camcorder ¢ in grado di registrare segnali video
compositi analogici inviati a questo connettore.

Connettore TC IN (ingresso codice
temporale) (tipo BNC)

Per applicare un blocco esterno al codice

temporale del camcorder, inserire il codice

temporale di riferimento.

Per ulteriori informazioni, vedere “Impostazione del

codice temporale” (pagina 62).

Connettore VIDEO OUT (tipo BNC)
Emette i segnali video per il monitoraggio. I
segnali di uscita selezionabili possono essere sia
compositi che HD-Y a seconda dell’impostazione
di OPERATION >Input/Output
>Output&i.LINK nel menu di impostazione.

Connettore TC OUT (uscita codice
temporale) (tipo BCN)

Per bloccare il codice temporale dell’apparecchio

secondo il codice temporale di questo camcorder,

collegarlo al connettore di ingresso del codice

temporale del videoregistratore esterno.

Posizione e funzione dei componenti e dei comandi
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Parte posteriore

LT

i um oo
o @] Hor—, @
1 2 AUDIO OUT

Indicatori (rossi) TALLY (contrassegno
posteriore)
Si illuminano durante la registrazione. Non si
illuminano se I'interruttore TALLY ¢ impostato
su OFF. Questi indicatori lampeggiano anche per
indicare le avvertenze (vedere pagina 18).
L’indicatore Tally sul pannello anteriore del
mirino, e I’indicatore REC nello schermo del
mirino si illuminano o lampeggiano allo stesso
modo.

Per ulteriori informazioni, vedere “Avvisi relativi al
funzionamento” (pagina 193).

Interruttore TALLY

Impostare su ON per attivare la funzione
dell’indicatore TALLY.

Presa EARPHONE (stereo, mini jack)
E possibile controllare I’audio E-E durante la
registrazione e 1’audio di riproduzione durante la
riproduzione. Se viene segnalato un allarme, &
possibile avvertire il segnale dagli auricolari.
Inserendo una presa auricolari nel jack, si

Posizione e funzione dei componenti e dei comandi

disattiva automaticamente 1’ altoparlante
incorporato.

Si puo selezionare monofonico o stereo in
MAINTENANCE >Audio nel menu di
impostazione.

B3 Selettori AUDIO IN

Selezionare la sorgente audio che si collega ai

connettori AUDIO IN CH-1/CH-2.

LINE: quando si connette un amplificatore stereo
o un’altra sorgente di segnale audio esterna

MIC: quando si collega un microfono che non
richiede un’alimentazione di 48 V

+48V: quando si collega un microfono che
richiede un’alimentazione di 48 V

Connettore HD/SD SDI OUT (tipo
BNC)

Emette un segnale HDSDI o SDSDI (audio

integrato). L’uscita dal connettore puo essere

abilitata o disabilitata tramite OPERATION

>Input/Output >SDI Output nel menu di

impostazione.

A Connettori AUDIO IN CH-1/CH-2
(canale audio 1 e ingresso canale 2) (tipo
XLR, 3 pin, femmina)

Si tratta di connettori d’ingresso audio per i canali

1 e 2 ai quali poter connettere un dispositivo

audio o un microfono.

Coperchio inferiore

Fornito per la protezione dei cavi collegati ai
connettori presenti sul pannello posteriore.
Allentando le viti che bloccano il coperchio
inferiore del camcorder, ¢ possibile regolare la
posizione del coperchio in base alle dimensioni e
alla forma delle spine del microfono o del cavo
audio.

Dopo aver regolato la posizione, stringere le viti
per bloccare il coperchio.

ﬂ Connettore AUDIO OUT (tipo XLR, 5§
pin, maschio)

Emette i segnali audio registrati sui canali audio 1

e 2 o canali audio 3 e 4. I segnali audio sono

selezionati dall’interruttore MONITOR.

El Connettore REMOTE (8 pin)
Serve a collegare 1’unita di controllo remoto in
modo da poter controllare a distanza il camcorder.



Prima di collegare/scollegare 1’unita di controllo remoto
al/dal camcorder, assicurarsi di spegnere I’interruttore
POWER.

Connettore i.LINK (HDV/DV) (6 pin,
compatibile con IEEE 1394, S400)

FAT

Quando la modalita di registrazione & FAT, per
inviare e ricevere stream HDV/DV, collegarlo al
dispositivo HDV/DV.

Monitor LCD

(PB__NDF_EXT LK”_HOL
TCG|PRPRPRRDPDPYRRIRID |
01:23:45:67

H MIN SEC FRM

108
[EH Wedia Near Full
129

edia
»Media B 1

Battery NN 2i6mN
100%

T,

Risoluzione

Indica la risoluzione del segnale video dell’uscita
HD.

Indicazione Risoluzione (orizzontale x

verticale)
1080 1080 linee (1920 x 1080)
720 720 linee (1280 x 720)

Formato di registrazione
Indica il formato di registrazione attuale o il
formato di registrazione del clip attualmente in
fase di riproduzione.
* Modalita UDF

HD422 50

HD420 HQ

IMX50

DVCAM

¢ Modalita FAT
HQ1920
HQ1440
HQ1280

SP1440
DVCAM

Modalita di registrazione
UDF: modalita UDF
FAT: modalita FAT

B Formato del file

MXF: quando la modalita di registrazione € UDF

MP4: quando la modalita di registrazione ¢ FAT-
HD

DV-AVI: quando la modalita di registrazione &
FAT-SD

Frequenza di sistema

Indica la frequenza di sistema del video al
momento riprodotto o registrato.

59.94i

29.97P

23.98P

50i

25pP

59.94P

50P

IA Display di stato

PB: viene visualizzato durante la riproduzione.

NDF: viene visualizzato quando ¢ selezionato il
modo non drop frame.

EXT-LK: appare quando il generatore di codici
temporali interno ¢ bloccato sull’ingresso di
un segnale esterno attraverso il connettore
TC IN (ingresso codice temporale).

HOLD: visualizzato quando la modalita
operativa del generatore di codici temporali
interno ¢ impostata su R-RUN e interrotta.

Formato audio

Indica il formato di registrazione audio o il
formato audio del clip attualmente in fase di
riproduzione.

Indicazione Stato

Modalitadi Formato di
registrazione registrazione
16bit FAT Qualsiasi formato
UDF « HD420 HQ
« DVCAM

¢ IMX (Audio
Length & impostato
su 16 bit)

Posizione e funzione dei componenti e dei comandi
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Indicazione Stato

Modalita di Formato di
registrazione registrazione
24bit UDF * HD422 50
¢ IMX (Audio
Length & impostato
su 24 bit)

Bl Indicazione dello stato di registrazione
Quando la voce Rec Status Indicator del menu
Operation ¢ impostata su [LCD] o [Both], durante
la registrazione vengono visualizzati indicatori

»>.

El Indicatori del livello audio
Indicano i livelli di registrazione o riproduzione
audio dei canalida 1 a 4.

Visualizzazione contatore temporale

Cambia i display del contatore, codice temporale

e bit dell’utente, a seconda della posizione

dell’interruttore DISPLAY.

Visualizza il tipo di dati attualmente mostrati nel

contatore orario, come segue.

TCG: codice temporale registrato

TCR: codice temporale di riproduzione

UBG: bit utente registrati

UBR: bit utente di riproduzione

CNT: contatore

CLK: visualizzazione orario (quando
I’interruttore PRESET/REGEN/CLOCK ¢
impostato su CLOCK)

Premendo il pulsante HOLD per mantenere il
valore del codice temporale, il codice temporale
viene visualizzato nel formato indicato di seguito.
Premendo nuovamente il pulsante HOLD per
disattivare 1’operazione, il codice temporale ¢
visualizzato nel formato normale.

00(/00L/00L/00

| tre punti indicano che il codice temporale
venga visualizzato in modalita hold.

Area indicatore di avviso

Vengono visualizzati quando si verificano
problemi con la registrazione o condensazione di
umidita.

Per ulteriori informazioni, vedere “Avvisi relativi al
funzionamento” a pagina 193.

E anche possibile visualizzare il nome del clip
successivo da registrare (vedere pagina 136).

Indicatore spazio residuo sui supporti
Mostra i segmenti che indicano lo spazio residuo
sui supporti negli slot.

Indicatore della carica residua della
batteria

Mostra i segmenti che indica la carica residua

della batteria.

Mirino HDVF-20A (opzionale)

7

B
HE H B REN

Presa
Collegarla al connettore VF (20 pin) del
camcorder.

Dispositivo di arresto
Previene che il mirino si sposti dal camcorder
quando si muove sui lati.

Indicatore Tally operatore telecamera
Si illumina quando il camcorder sta registrando.
Questo indicatore pud essere coperto se non
utilizzato.

Questo indicatore lampeggia anche per indicare
alcune avvertenze nello stesso modo
dell’indicatore tally e degli indicatori tally
(rosso)/registrazione nel mirino.

Posizione e funzione dei componenti e dei comandi



B Oculare

Indicatori e display di stato

Per ulteriori informazioni, vedere “Visualizzazione
dello stato sullo schermo del mirino” a pagina 28.

6] Regolatore diottrie
Permette la regolazione ottimale della messa a
fuoco.

Indicatore Tally

Si illumina quando il camcorder sta registrando.
Impostare I’interruttore TALLY su OFF se non in
uso. La luminosita puo anche essere regolata con
I’interruttore TALLY.

Questo indicatore lampeggia anche per indicare
alcune avvertenze nello stesso modo
dell’indicatore tally e degli indicatori tally
(rosso)/registrazione nel mirino.

El Comando PEAKING

Ruotando questo controllo in senso orario &
possibile regolare la nitidezza dell’immagine e
facilitare la messa a fuoco. Questo controllo non
ha effetti sui segnali di uscita del camcorder.

El Comando CONTRAST

Regola il contrasto dello schermo. Questo
controllo non ha effetti sui segnali di uscita del
camcorder.

Comando BRIGHT

Regola la luminosita dello schermo. Questo
controllo non ha effetti sui segnali di uscita del
camcorder.

Interruttore TALLY

Controlla I’indicatore tally posizionato sul lato

frontale del mirino.

HIGH: la luminosita dell’indicatore tally
impostata su “alta”.

OFF: I'indicatore tally non ¢ attivo.

LOW: la luminosita dell’indicatore tally &
impostata su “bassa”.

Interruttore ZEBRA (motivo zebra)

Controlla il motivo a zebra sullo schermo del

mirino come di seguito.

ON: un motivo a zebra compare sullo schermo.

OFF: il motivo a zebra scompare.

MOMENT: un motivo a zebra compare e resta
per circa cinque minuti.

Interruttore DISPLAY/ASPECT
Attiva e disattiva I’indice marker, e si muove tra
4:3 e 16:9 del rapporto di aspetto per lo schermo
del mirino.

DISPLAY: quando I’indice marker non ¢ attivo
con il camcorder, I’indice marker sullo
schermo del mirino si attiva e disattiva ogni
volta che si preme I’interruttore verso 1’alto
in questa posizione.

ASPECT: ad ogni pressione dell’interruttore in
questa posizione il display cambia aspetto.
(Effettuare modifiche alle impostazioni del
display tramite OPERATION >Marker
>Aspect Mask nel menu di impostazione
(vedere pagina 127)).

Cavo del mirino

Sostegno per microfono

Mirino CBK-VFO01 (opzionale)
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Presa

Collegarla al connettore VF (26 pin) del
camcorder.

Dispositivo di arresto
Previene che il mirino si sposti dal camcorder
quando si muove sui lati.

Posizione e funzione dei componenti e dei comandi
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Oculare

ﬂ Regolatore diottrie
Permette la regolazione ottimale della messa a
fuoco.

Oculare
E possibile sollevarlo quando richiesto dalla
situazione.

A Cilindro del mirino
E possibile sollevarlo o ruotarlo quando richiesto
dalla situazione.

Indicatore Tally

Si accende quando la registrazione viene avviata
attraverso la pressione del pulsante REC START
sul camcorder, il pulsante VTR sull’obiettivo, o il
pulsante VTR sull’unita di controllo remoto.
Quando si verifica un’anomalia, I’indicatore
Tally lampeggia per indicare un’avvertenza.

El Comando PEAKING

Ruotando questo controllo in senso orario &
possibile regolare la nitidezza dell’immagine e
facilitare la messa a fuoco. Questo controllo non
ha effetti sui segnali di uscita del camcorder.

El Comando CONTRAST

Regola il contrasto dello schermo. Questo
controllo non ha effetti sui segnali di uscita del
camcorder.

Comando BRIGHT

Regola la luminosita dello schermo. Questo
controllo non ha effetti sui segnali di uscita del
camcorder.

Interruttore TALLY

Controlla I’indicatore tally posizionato sul lato

frontale del mirino.

HIGH: la luminosita dell’indicatore tally ¢
impostata su “alta”.

OFF: I'indicatore tally non ¢ attivo.

LOW: la luminosita dell’indicatore tally ¢
impostata su “bassa”.

Interruttore ZEBRA (motivo zebra)
Controlla il motivo a zebra sullo schermo del
mirino come di seguito.

ON:: visualizzare un motivo zebrato.

OFF: non visualizzare un motivo zebrato.

Posizione e funzione dei componenti e dei comandi

Interruttore DISPLAY

Accende e spegne il display delle informazioni di
testo.

ON: visualizzare le informazioni testuali.

OFF: Non visualizzare le informazioni testuali.

Interruttore MIRROR

L’immagine visualizzata sullo schermo viene
capovolta orizzontalmente o verticalmente
quando il cilindro del mirino viene sollevato o
ruotato. Utilizzare I’interruttore per regolare la
visualizzazione delle immagini in tale situazione.
L/R: capovolgere I'immagine orizzontalmente.
OFF: non capovolgere I'immagine.

B/T: capovolgere I'immagine verticalmente.

Cavo del mirino

16| Sostegno per microfono

Visualizzazione dello stato sullo
schermo del mirino

Indicatori (HDVF-20A)

I seguenti indicatori sono organizzati sopra e
sotto lo schermo del HDVF-20A per mostrare lo
stato attuale e le regolazioni del camcorder.

TLLY/R EC
] o me—— ;3

 ——
—a

Cf I R e 5 |
VTR
SAVE a

Kl Indicatore TALLY (verde)

Si accende quando il camcorder ¢ nei seguenti

stati.

* Modalita Picture Cache attivata

* Segnale tally verde ricevuto (quando un
adattatore per telecamera ¢ installato su questo
camcorder e unita di estensione per telecamera
¢ collegata)



* Registrazione con MAINTENANCE >Camera
Config >HD/SDI Remote I/F nel menu di
impostazione impostato su [G-Tally]

Lampeggia quando il camcorder ¢ nei seguenti

stati.

« Impostato in modalita Interval Rec o in
modalita Frame Rec continua (1 lampeggio al
secondo)

¢ Registrazione in modalita Interval Rec o in
modalita Frame Rec continua (4 lampeggi al
secondo)

« Impostato in modalita di ripresa singola in
Frame Rec o registrazione in quella modalita (2
lampeggi al secondo)

Indicatore BATT (batteria)

Questo indicatore inizia a lampeggiare quando la
batteria connessa al camcorder € quasi esaurita e
resta acceso quando la batteria € completamente
scarica.

Per prevenire interruzioni durante il
funzionamento, sostituire la batteria non appena
I’indicatore inizia a lampeggiare.

1l livello della batteria al quale l'indicatore inizia a
lampeggiare puo essere impostato da
MAINTENANCE > Battery nel menu di
impostazione. Per ulteriori informazioni, vedere
vedere pagina 146.

Indicatori tally (rosso)/registrazione

Si illuminano quando il camcorder ¢ nei seguenti

stati.

* Registrazione con la voce del menu
MAINTENANCE >Camera Config >HD/SDI
Remote I/F impostata su [R-Tally]

 Segnale tally rosso ricevuto (quando un
adattatore per telecamera ¢ installato su questo
camcorder e unita di estensione per telecamera
¢ collegata)

Questi indicatori lampeggiano anche per indicare
alcune avvertenze nello stesso modo
dell’indicatore tally e dell’indicatore tally della
telecamera.

1 Schermo del mirino

Vedere “Schermo del mirino” (pagina 29).

Indicatore VIR SAVE
Non funziona su questo camcorder.

A Indicatore ! (di avviso)

Questo indicatore si accende quando si verifica
una delle seguenti condizioni con la voce
corrispondente impostata su [On] da
OPERATION >“!” LED nel menu di
impostazione.

* L’aumento non ¢ impostato su 0 dB.

« 1l selettore SHUTTER ¢ impostato su ON.

* Impostare I’interruttore WHITE BAL su PRST.

* ATW e disattivato.
« E utilizzata la carica dell’obiettivo.
* Il valore di riferimento della regolazione

automatica del colore non ¢ un valore standard.

« 1l selettore FILTER ¢ impostato su un valore
diverso da 1.

Schermo del mirino

Sullo schermo del mirino non viene visualizzata
solo I'immagine video, ma anche i caratteri ed i
messaggi recanti le impostazioni e lo stato di
funzionamento del camcorder, 1’indicatore del
centro, 1’indicatore dell’area di sicurezza, ecc.
Se non viene visualizzato lo schermo del menu e
I’interruttore DISPLAY & impostato su ON, le
voci che erano state impostate su ON con
OPERATION >Super Impose nel menu di
impostazione o con i relativi interruttori vengono
visualizzate nella parte superiore ed inferiore
dello schermo.

I messaggi di avvertenza vengono indicati per tre
secondi quando si svolgono operazioni di
modifica delle impostazioni del camcorder. I
messaggi di esecuzione della regolazione
vengono indicati durante la procedura di
regolazione. Una volta terminata la procedura di
regolazione, appaiono per tre secondi dei
messaggi che indicano il risultato delle
regolazioni.

Non solo queste indicazioni vengono visualizzate
sul mirino, un menu di impostazione abilita la
loro uscita come segnali video.

Di seguito vengono riportate tutte le voci che
possono venire visualizzate sullo schermo del
mirino.

Posizione e funzione dei componenti e dei comandi
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Lato superiore dello schermo del mirino
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Impostazioni di estensione

Indica I’'impostazione della funzione di

estensione digitale (quando ¢ installato I’ingresso

CBK-HDO02 SDI/COMPOSITE opzionale e

I’interfaccia a 50 pin) del camcorder e

I’impostazione dell’estensore dell’ obiettivo.

EX: I’estensore dell’obiettivo ¢ attivo.

08: il dispositivo di riduzione del camcorder &
attivo.

x2D: la funzione di estensione digitale del
camcorder ¢ attiva.

Ex2D: I’estensore dell’obiettivo e la funzione di
estensione digitale del camcorder sono
entrambi attivi.

E possibile attivare e disattivare la funzione di
estensione digitale del camcorder tramite un
interruttore programmabile cui & assegnato il
Digital Extender.

Quando si seleziona Slow & Quick Motion o si utilizza
la funzione Freeze mix non & possibile attivare la
funzione di estensione digitale.

Quando il camcorder si trova in modalita di
ingrandimento della messa a fuoco (Focus Mag),
I’attivazione della funzione di estensione digitale annulla
la modalita.

Posizione di zoom (quando I’obiettivo &
collegato)

Indica la posizione di zoom dell’obiettivo nella

gamma tra 0 e 99.

Posizione della messa a fuoco (quando
I’obiettivo di serie ¢ collegato)

Indica la posizione della messa a fuoco rispetto

alla distanza dal soggetto (in metri).

Posizione e funzione dei componenti e dei comandi

B Tally verde

Si accende quando il camcorder ¢ nei seguenti

stati.

* MAINTENANCE >Camera Config >HD-SDI
Remote I/F & impostato su [G-Tally] nel menu
di impostazione e un segnale di controllo della
registrazione viene emesso dal connettore HD/
SD SDI OUT.

¢ Quando si abilita la modalita Picture Cache

 Segnale tally verde ricevuto (quando un
adattatore per telecamera ¢ installato su questo
camcorder e unita di estensione per telecamera
¢ collegata)

Stato supporto
Visualizza il nome dello slot per i supporti
attualmente attivi (A o B).

A Modalita di registrazione speciale/stato
operativo

Indica la modalita di registrazione speciale/lo

stato operativo attuale nel modo seguente.

Indicazione Significato

OREC Registrazione in corso

STBY Quando la registrazione ¢ in pausa
nella modalita Clip Continuous Rec
o in standby in altre modalita

CONT Standby per la registrazione
successiva in modalita Clip
Continuous Rec

OCACHE Standby in modalita Picture Cache

@INT REC  Registrazione in corso in modalita

Interval Recording

@INT STBY Standby per la registrazione
successiva in modalita Interval

Recording

INT STBY  Standby in modalita Interval
Recording

@FRM REC Registrazione in corso in modalita
Frame Recording

OFRM Standby per la registrazione

STBY successiva in modalita Frame
Recording

FRM STBY Standby in modalita Frame
Recording

@S&Q REC  Registrazione in corso in modalita
Slow & Quick Motion

S&Q STBY  Standby in modalita Slow & Quick
Motion

CALL Chiamata di un dispositivo

(visualizzato collegato

in rosso)




Indicazione Significato
PREVIEW  Visualizzazione durante la
registrazione

Livello di ricezione del ricevitore
wireless

Quando un ricevitore wireless viene installato nel

camcorder, “W” compare nello stesso momento

degli indicatori di livello di ricezione a quattro
segmenti per ognuno dei canali (da 1 a 4) che
possono essere utilizzati dal sintonizzatore. Gli
indicatori sono come di seguito.

In una situazione normale: il numero dei
segmenti bianchi indica la potenza del livello
del segnale.

Muting (per un ricevitore analogico) o
aggravamento frequenza errori (per un
ricevitore digitale): il numero dei segmenti
grigi indica la potenza del livello del segnale.

Livello di ricezione sopra al picco: viene
visualizzato “P” al posto degli indicatori. D)

Batteria del sintonizzatore bassa: il numero del
canale e I’indicatore del canale flash
corrispondente. D

1) Quando si usa un DWR-S01D opzionale

B Capacita residua/tensione della batteria
Quanto segue viene visualizzato a seconda del
tipo di fonte di alimentazione.

Tipo di Cosa viene visualizzato
alimentazione

Batteria Icona della carica residua della
InfoLithium batteria e tempo di registrazione

residuo

Batteria Anton  Carica residua della batteria

Bauer (indicato in %)
Diversi dai Tensione in ingresso
suddetti.

El Ingresso esterno dell’alimentazione
Appare quando 1’alimentazione deriva da una
fonte di alimentazione esterna collegata al
connettore DC IN.

Temperatura colore

Visualizza la temperatura del colore calcolata a
partire dal guadagno di R e B, nella gamma da 1,5
K a 50,0 K (in intervalli di 0,1 K). I segni +/—
potrebbero essere visualizzati a seconda delle
impostazioni Offset White (vedere pagina 133).
No display: Offset White ¢ su OFF

+: il valore di Offset White & maggiore di 3200K.

—: il valore di Offset White ¢ inferiore a 3200K.

Numero di righe di sistema

Indica il numero di righe di sistema (1080/720/

576/480/486 V) del video attualmente in fase di

riproduzione o registrazione.

1) In modalita SD, quando I’'impostazione di
OPERATION >Format >Country ¢ diversa da [PAL
Area] nel menu di impostazione.

In modalita UDF: 486
In modalita FAT: 480

In modalita UDF ¢ visualizzata anche la
frequenza di sistema.

Formato video

Indica il formato video per la registrazione
(59.94i/29.97P/23.98P/50i/25P/59.94P/50P) o il
formato video del clip attualmente in fase di
riproduzione (vedere pagina 50).

E anche possibile visualizzare il rapporto del
formato video (16:9 o 4:3) quando si imposta il
formato di registrazione su IMX50 o DVCAM.

Indicazione della profondita di campo
(quando ’obiettivo di serie € collegato e
si usa il CBK-VF01)

Indicazione di errore/avvertenza
Una barra indica la profondita di campo. La
visualizzazione dell’unita di misura puo essere in
metri o in piedi, a seconda di quanto selezionato
in OPERATION >Display On/Off >Lens Info nel
menu di impostazione.
Un messaggio di errore o di avvertenza viene
visualizzato a seconda della situazione.
In questa sezione ¢ anche possibile visualizzare il
nome del clip successivo da registrare (vedere
pagina 136).

Indicazione modalita registrazione
speciale

1l seguente viene visualizzato quando il

camcorder si trova in modalita di registrazione

speciale.

* Frame Rec (modalita di registrazione per
fotogrammi)

* Interval Rec (modalita di registrazione a
intervalli)

¢ S&Q Motion (modalita rallentatore e
movimento rapido)

Posizione e funzione dei componenti e dei comandi
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Indicazione impostazione modalita di
registrazione speciale

Appare quando il camcorder si trova in una

speciale modalita di registrazione.

Lato inferiore dello schermo del mirino

(6| 7]
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Modalita di regolazione del diaframma
TLCS

Le icone seguenti vengono visualizzate per

indicare le modalita di controllo di livello video

sulla base del sistema di controllo del livello

totale (Total Level Control System/TLCS).

Icona Modalita di controllo TLCS
Modalita di retroilluminazione
Modalita standard

@ Modalita Spotlight

Modalita di regolazione della messa a
fuoco (quando I’obiettivo della messa a
fuoco automatica € collegato)

Indica la modalita di regolazione automatica della

messa a fuoco del camcorder.

* AF (modalita di messa a fuoco automatica)

* MF (modalita di messa a fuoco manuale)

¢ MF* (modalita di messa a fuoco automatica

quando la funzione MF Assist ¢ attiva)

¢ Full MF (modalita di messa a fuoco manuale

completa)

Regolazione di dispositivi esterni
“REC2” viene visualizzato quando
MAINTENANCE >Camera Config >HD-SDI
Remote I/F & impostato su [Chara] nel menu di
impostazione e un segnale di controllo della
registrazione viene emesso dal connettore HD/SD
SDI OUT.

Posizione e funzione dei componenti e dei comandi

1 Stato operativo del dispositivo collegato
via i.LINK

11 formato operativo (HDV o DV) e lo stato

operativo del dispositivo vengono indicati nel

modo seguente.

Indicazione Significato

ORECi[[i] Registrazione video HDV in corso

STBY i[[I] Standby per registrazioni HDV

OREC il Registrazione DV in corso

STBY il Standby per registrazioni DV

Indicazione di livello video

Viene visualizzata un’indicazione con un numero
di posizione del filtro ND quando il livello della
luce del soggetto & troppo alto o basso.

A Codice temporale

Messaggio di avvertenza
Indica il tempo di registrazione/riproduzione
trascorso, il codice temporale, i bit utente o altre
informazioni selezionate tramite I’interruttore
DISPLAY (vedere pagina 20).
Indica anche un messaggio di avvertenza quando
€ necessario prestare attenzione, come quando si
cerca di cambiare le impostazione.

Livello di luminosita (quando si usa il
CBK-VF01)

Indica il livello di luminosita medio (%) dell’area

di rilevamento.

E Fonte esterna di ingresso

Indica il tipo di segnale di ingresso esterno
(HDV) da registrare.

9] Registrazione di un ingresso esterno
Indica “EXT” quando si registra un ingresso
esterno.

M Filtro elettrico della temperatura del
colore

Compare quando la funzione CC 5600K &

impostata su ON.

Posizione del filtro

Indica il numero di posizione del filtro ND
attualmente selezionato. (vedere pagina 14).
Quando ELECTRICAL CC viene assegnato a un
interruttore programmabile, la posizione del filtro
elettrico (A/B/C/D) appare alla destra della



posizione del filtro ND (da 1 a 4), come mostrato
nella pagina anteriore.

Memoria relativa al bilanciamento del
bianco

Indica la memoria per la regolazione automatica

del bilanciamento del bianco attualmente

selezionata.

ATW: modalita ATW (bilanciamento automatico
del bianco)

W:A: modalita memoria A

W:B: modalita memoria B.

W:P: modalita predefinita

3200: quando I’interruttore a cui & stato assegnato
Color Temp SW 3200K ¢ attivo

4300: quando I’interruttore a cui & stato assegnato
Color Temp SW 4300K ¢ attivo

5600: quando I’interruttore a cui & stato assegnato
Color Temp SW 5600K ¢ attivo

6300: quando I’interruttore a cui & stato assegnato
Color Temp SW 6300K ¢ attivo

Valore di guadagno

Indica il valore di guadagno (in dB)
dell’amplificatore video, in base all’impostazione
del selettore GAIN.

Indicazione dello stato di registrazione
Quando la voce Rec Status Indicator del menu
Operation ¢ impostata su [Viewfinder] o [Both],
durante la registrazione vengono visualizzati
indicatori P

Otturatore
Indica la velocita o 1a modalita dell’otturatore.

Per ulteriori informazioni, vedere “Impostazione
dell’otturatore elettronico” (pagina 56).

Indicatori di livello audio
Indica i livelli audio dei canali 1 e 2.

Spazio residuo sui supporti

Il tempo di registrazione residuo disponibile nel
formato video corrente (velocita di trasmissione
bit di registrazione) viene calcolato in base allo
spazio rimanente in ciascun supporto e viene
indicato in unita di tempo (minuti). Se il supporto
¢ protetto da scrittura, viene visualizzata un’icona
con un lucchetto.

B Istogramma (quando si usa il CBK-
VF01)

Mostra la distribuzione dei pixel della luminanza

video (solo modalita HD).

[El Posizione del diaframma (quando
I’obiettivo ¢ collegato)
Indica la posizione del diaframma e
I’impostazione per la regolazione del
cambiamento del valore del diaframma (valore di
riferimento del diaframma dell’ obiettivo) (vedere
pagina 58).
L’impostazione per la regolazione del
cambiamento del valore del diaframma ¢ indicata
da un indicatore a quattro segmenti come
illustrato di seguito.

Valoredi  Indicatore

riferimento

+0.25 Il segmento in basso a sinistra
B jiventa grigio.

+0.5 B I due segmenti a sinistra
B Giventano grigi.

+0.75 B Idue segmenti a sinistra e
L quello in basso a destra

diventano grigi.

+1 HBE Tutti i segmenti diventano
L grigi.

-0.25 11 segmento in basso a sinistra
O diventa bianco.

-0.5 O  Idue segmenti a sinistra
O diventano bianchi.

-0.75 O  Iduesegmenti a sinistra e
oo quello in basso a destra

diventano bianchi.

-1 OO Tutti i segmenti diventano

oo

bianchi.

Posizione e funzione dei componenti e dei comandi
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Capitoloz

Preparazione
dell’alimentazione

Per ragioni di sicurezza, utilizzare

esclusivamente i seguenti pacchi batterie e

adattatori CA Sony.

» Pacco batterie al litio-ione BP-L80S

* Alimentazione CA tramite 1’adattatore CA AC-
DN2B/DN10

ATTENZIONE

Se una batteria non viene sostituita correttamente vi & il
rischio di esplosione.

Sostituire una batteria con una uguale o simile seguendo
le raccomandazioni del produttore.

Per lo smaltimento della batteria, attenersi alle norme in
vigore nel paese di utilizzo.

Uso di un pacco batteria

Con un pacco batteria BP-L80S il camcorder
potra essere utilizzato in modo continuato per 145
minuti circa.

AVVERTENZA

Le batterie non devono essere esposte a fonti di calore
eccessivo come luce solare diretta, fuoco, ecc.

La durata del pacco batteria dipende dalla frequenza del
suo utilizzo e dalla temperatura ambientale durante il
funzionamento.

Caricare il pacco batteria prima dell’uso,
utilizzando un caricabatterie adatto.

Per ulteriori informazioni sulla ricarica, consultare
il manuale operativo del caricabatterie.

Nota sull’'uso del pacco batteria

Potrebbe non essere possibile ricaricare
completamente un pacco batteria se questo &
caldo.

Preparazione dell’alimentazione

Come montare il pacco batteria

1 Iserireil pacco batteria nella parte
posteriore del camcorder, allineando la
linea laterale del pacco batteria con
quella corrispondente del camcorder.

@ BP-L80S
@ Allineare queste linee.

2 Fare scorrere il pacco batteria verso il
basso finché la relativa freccia “LOCK”
non si trova in corrispondenza della
linea presente sul camcorder.

© Freccia “LOCK”
@ Allineazione del camcorder

Se il pacco batteria non & collegato correttamente, il
terminale potrebbe danneggiarsi.



Come smontare il pacco batteria

Tenendo premuto il pulsante, sollevare il pacco
batteria.

Pulsante di sgancio

Non rimuovere il pacco batteria durante la
registrazione (mentre la spia ACCESS sul pannello a
destra ¢ accesa in blu e la spia ACCESS nello slot della
scheda € accesa in arancione). L’operazione potrebbe
corrompere i dati registrati sulla scheda.

Assicurarsi di spegnere il camcorder prima di sostituire
il pacco batteria.

Uso dell’alimentazione CA

Installare 1’adattatore AC-DN2B/DN10 sul
camcorder seguendo la stessa procedura utilizzata
per il pacco batteria, quindi collegarlo
all’alimentazione CA.

L’AC-DN2B/DNI10 ¢ in grado di fornire
un’alimentazione pari a 100 W.

Ad una presa CA J

Collegamento del mirino

ATTENZIONE

Quando il mirino ¢ collegato, non lasciare il camcorder
con I’oculare verso il sole. La luce solare diretta pud
entrare attraverso 1’oculare, andare sul mirino e causare
incendi.

Il mirino & fornito separatamente.
La procedura seguente ¢ un esempio di collegamento
del’HDVF-20A.

Per conoscere le procedure di collegamento di altri
mirini, consultare il manuale fornito con i singoli
mirini.

Collegamento del mirino
[ Nota |

Quando si collega il mirino, far attenzione ai seguenti
punti.

Assicurarsi di spegnere il camcorder prima di collegare
il connettore del mirino al connettore VF del
camcorder (20 pin). Se si effettua questo collegamento
quando il camcorder ¢ acceso, il mirino potrebbe non
funzionare correttamente.

Collegare il connettore del mirino con il connettore VF
del camcorder. Se il collegamento ¢ lento, potrebbe
esserci del rumore sul video o la luce tally potrebbe
non funzionare correttamente.

Per ulteriori informazioni sulla connessione del
mirino e camcorder, contattare un rivenditore Sony.

1 @ Svitare I’anello di posizionamento
sinistra-destra del mirino, ® collegare
il mirino alla base del mirino e ®
avvitare I’anello di posizionamento
sinistra-destra del mirino.

Collegamento del mirino
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Regolatore di posizionamento sinistra-
destra del mirino

Dispositivo di arresto

2 Collegare il connettore del mirino al
connettore VF (20 pin).

Connettore VF (20 pin)

Rimozione del mirino

Effettuare tutte queste operazioni seguendo la
procedura seguente di montaggio in ordine
inverso; inoltre, & necessaria un’altra operazione:
staccando il mirino dalla base, sollevare il tappo.

Regolazione della posizione del
mirino

Per regolare la posizione del mirino da sinistra a
destra, allentare la rotellina di posizionamento
sinistra-destra, mentre per regolare la posizione
da anteriore a posteriore, allentare la manopola di
posizionamento anteriore-posteriore.

Collegamento del mirino

Regolatore di posizionamento
sinistra-destra del mirino

Manopola di posizionamento
anteriore-posteriore del mirino

Utilizzare il braccio di rotazione
del mirino BKW-401

Montando il braccio di rotazione opzionale del
mirino BKW-401, & possibile ruotare il mirino
verso I’esterno in modo che la gamba destra
dell’utente non colpisca il mirino mentre si
trasporta il camcorder.

1 Svitare le leve di posizionamento
anteriore-posteriore del mirino e le
manopole di posizionamento anteriore-
posteriore del mirino, e poi tirare avanti
I’assemblaggio del mirino.

2 Utilizzare una chiave esagonale di
diametro 2,5 mm, scollegare
I’assemblaggio del mirino.



Bulloni conforo
esagonale

Assemblaggio del mirino

Collegare il BKW-401 con i bulloni
forniti.

Bulloni forniti con BKW-401

Regolare la posizione anteriore-
posteriore in modo che il braccio del
BKW-401 non tocchi la maniglia
quando viene sollevato.

Regolare la posizione in modo che
il braccio non tocchi 'impugnatura

Rimozione dell’oculare

Rimuovendo I’oculare si ha una vista piu chiara
dello schermo da lontano. E anche piti facile
spolverare lo schermo del mirino e lo specchio
staccando I’oculare.

1

Ruotare I’anello di blocco dell’oculare
completamente in senso antiorario per
allineare i segni rossi dell’anello di
blocco e la barra del mirino.

© Rotellina blocco
@ Indicatore della rotellina blocco
© Indicatore del cilindro del mirino

2 Scollegare I’oculare.

1

Indicatore dell’estremita del mirino

E possibile montare anche filtri di protezione
o adattatori macro da 52 mm di diametro,
normalmente disponibili in commercio.

Come montare nuovamente I’oculare

1

Allineare i segni rossi dell’anello di
blocco dell’oculare con la barra del
mirino.

Allineare il segno rosso all’estremita
dell’oculare con i segni rossi dell’anello
di blocco dell’oculare e la barra del
mirino. Poi inserire I’oculare nella
barra del mirino.

Ruotare la rotellina blocco oculare in
senso orario finché la freccia indicativa

Collegamento del mirino
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“LOCK” non ¢ puntata verso
P’indicatore del cilindro del mirino.

Se I’oculare & rovinato, sostituirlo con uno nuovo.

Per ulteriori informazioni sulla sostituzione
dell’oculare, contattare un rivenditore Sony.

Come regolare la messa a fuoco
del mirino e lo schermo

Come regolare la messa a fuoco del
mirino

Ruotare il regolatore delle diottrie finché
I’immagine del mirino non diventa piu nitida.

Regolatore diottrie

Come regolare lo schermo del mirino

Regolare la luminosita, il contrasto, e il
miglioramento dello schermo mirino con i
comandi mostrati di seguito.

1] Q (3]

PEAKING CONTRAST| BRIGHT

DISPLAY ZEBRA TALLY
= & . %
FFo FF
\ P MOMENT Low J

© Comando PEAKING
@® Comando CONTRAST
© Comando BRIGHT

Impostazione dell’area di utilizzo

Impostazione dell’area
di utilizzo

Utilizzo del camcorder per la prima volta

L’area di utilizzo non & preimpostata. Prima di
utilizzare il camcorder, € necessario impostare
questa voce. (Non & possibile adoperare il
camcorder senza aver impostato questa
funzione.)

Come impostare I’area di utilizzo

Interruttore POWER
Manopola MENU

1 Impostare ’interruttore POWER su
ON.
Sul mirino appare la schermata per
I’impostazione dell’area di utilizzo.

INITIAL SETTING




2 Premerela manopola MENU.
Vengono visualizzate le impostazioni per
aree di utilizzo selezionabili.

INITIAL SETTING
NTSC Area

NTSC(J) Area
PAL Area

3 Ruotare la manopola MENU per
selezionare I’area di utilizzo desiderata.

Impostazione Area di utilizzo

NTSC Area Area NTSC (per aree
diverse dal Giappone) ¥

NTSC(J) Area  Area NTSC (Giappone) ¥

PAL Area Area PAL®

a) L’emissione di segnale composito di questo
camcorder & un segnale NTSC con impostazione
del nero (7.5 IRE). La frequenza di sistema &
59.94i.

b) L’emissione di segnale composito di questo
camcorder & un segnale NTSC senza
impostazione del nero. La frequenza di sistema &
59.94i.

¢) L’emissione di segnale composito di questo
camcorder & un segnale PAL. La frequenza di
sistema & 50i.

4 Impostare le seguenti voci.
* Fuso orario
« Data/Ora

Vedere “Operazioni di base del menu di
impostazione” (pagina 114).

5 Ruotarela manopola MENU per
selezionare “Finish”, quindi premere la
manopola MENU.

Il camcorder & quindi pronto per 1’uso.

Impostazione di data/ora
dell’orologio interno

E possibile impostare o cambiare la data e 1’ora
dell’orologio interno. La data e 1’ora impostati si
riflettono sul codice temporale.

Per informazioni sulle operazioni del menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare MAINTENANCE >Clock
Set >Date/Time nel menu di
impostazione.

MAINTENANCE
s || Auto Shading »
APR »
Trigger Mode » [
»
»
»

24H
YYMMDD

Date Mode

a | Network Setting
Wi-Fi Setting
Mal| Clock Set

F i[| Language »

2 Premerela manopola MENU.
Appare la finestra di impostazione Date/
Time.

Date/Time
PIaRV03/01

11:57:24 AM SET

3 Ruotare la manopola MENU per
cambiare I’'impostazione desiderata,
quindi premere la manopola.

La selezione passa alla voce successiva sulla
destra.

4 Per continuare le impostazioni restanti,

ripetere il punto 3.

5 Assicurarsi che “SET” sia stato

selezionato, premere la manopola
MENU.

L’orologio interno ¢ regolato sulla data e
I’ora impostate nei punti 3 e 4.

Impostazione di data/ora dell’orologio interno
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Come annullare I'impostazione

Prima di eseguire il punto 5, spostare
I’interruttore MENU CANCEL/PRST/ESCAPE
su CANCEL/PRST.

Montaggio e regolazione dell’'obiettivo

Montaggio e regolazione
dell’obiettivo

Spegnere sempre il camcorder prima di montare o
rimuovere un obiettivo.

Per informazioni sull’uso dell’obiettivo, consultare
il relativo manuale operativo.

L’obiettivo & fornito separatamente.

1 Sollevare Ia leva di bloccaggio
dell’obiettivo e rimuovere il tappo
dell’obiettivo.

2 Allineare il piedino centrale presente
sull’obiettivo con ’incastro centrale
dell’obiettivo, quindi inserire I’obiettivo
nell’apposito attacco.

3 Tenendo I’obiettivo in posizione,
abbassare la leva di bloccaggio
dell’obiettivo.



Se I’obiettivo non & bloccato saldamente, potrebbe
staccarsi mentre il camcorder si trova in uso. Cio
potrebbe causare gravi danni. Accertarsi pertanto
che I’ obiettivo sia bloccato saldamente. Si consiglia
di collocare il gommino di bloccaggio per I’attacco
dell’obiettivo sulla leva di bloccaggio
dell’obbiettivo come indicato in precedenza.

4 Collegare il cavo dell’obiettivo al
connettore LENS.

5 Bloccare il cavo dell’obiettivo
utilizzando gli appositi morsetti.

Se @& stato montato un obiettivo di correzione
dell’aberrazione

La funzione di correzione dell’ aberrazione viene
attivata automaticamente. Avviare il camcorder
con un obiettivo di correzione dell’aberrazione
potrebbe richiedere pill tempo del normale a
causa del caricamento dei dati all’avvio.
Contattare un rappresentante Sony per
informazioni sugli obiettivi di correzione
dell’aberrazione.

Regolazione della lunghezza
focale

Se I’obiettivo non ¢ messo a fuoco correttamente
mentre si effettua lo zoom da teleobiettivo a
grandangolo, regolare la lunghezza focale (la
distanza dal piano della flangia di montaggio
dell’obiettivo al piano dell’immagine). Effettuare
laregolazione solo una volta dopo aver montato o
sostituito 1’obiettivo.

Quando si esegue la regolazione, usare come
soggetto un diagramma di regolazione della
lunghezza focale.

Se si utilizza un soggetto con contrasto insufficiente, si
sposta il camcorder o il soggetto durante la

regolazione, si puo verificare un errore di regolazione.

Posizionare il soggetto (diagramma di regolazione
della lunghezza focale della flangia) in modo che
appaia al centro dello schermo all’estremita del
teleobiettivo. Fare in modo che nessun oggetto
circostante (nessun oggetto pill vicino alla telecamera
rispetto al diagramma) entri nello schermo
all’estremita del grandangolo.

Come effettuare la regolazione

1 Impostare il diaframma su manuale.

2 Aprire il diaframma, posizionare il
diagramma di regolazione della
lunghezza focale ad una distanza di
circa 3 metri dal camcorder e
predisporre la luce per una uscita video
soddisfacente.

3 Allentare le viti di fissaggio sul
regolatore F.f o F.B (regolatore della
lunghezza focale).

4 Utilizzare lo zoom manuale o
motorizzato per impostare I’obiettivo
su teleobiettivo.

O Puntare il camcorder sul diagramma
ruotando il regolatore di messa a fuoco
ed effettuare la messa a fuoco.

6 Impostare il regolatore di zoom su
grandangolo.

7 Ruotareil regolatore F.f o F.B finché
non si mette a fuoco il diagramma,
senza toccare il regolatore.

8 Ripetere le fasi dalla 4 alla 7 finché il
diagramma viene messo a fuoco dal
grandangolo al teleobiettivo.

9 Serrare le viti di fissaggio del regolatore
F.foF.B.

Montaggio e regolazione dell’obiettivo
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Preparazione del
sistema di ingresso
audio

Come collegare un microfono al
connettore MIC IN

E possibile collegare il microfono stereo ECM-
680S opzionale alla sezione di applicazione del
microfono del mirino (opzionale).

La procedura seguente & un esempio di fissaggio
di un supporto per microfono al’ HDVF-20A.
Per conoscere le procedure di fissaggio di un

supporto per microfono ad altri mirini, consultare il
manuale fornito con i singoli mirini.

1 Allentare la vite ed aprire il morsetto
della sezione di applicazione del
microfono.

Morsetto della sezione di
applicazione del microfono

2 Inserire il microfono nella relativa
sezione di applicazione.

@ Avvolgere il distanziatore attorno al
microfono mentre si tolgono i fogli di
protezione da entrambi i lati del
distanziatore.

@ Inserire il microfono nella relativa
sezione di applicazione, facendo in
modo che il contrassegno “UP” si trovi
nella parte superiore.

(® Chiudere la sezione di applicazione del
microfono.

@ Serrare la vite.

Preparazione del sistema di ingresso audio

Per informazioni su come eseguire questa
operazione, consultare il manuale operativo del
microfono.

3 Inserire il cavo del microfono nel

connettore MIC IN, quindi impostare
P’interruttore AUDIO IN per il canale
su cui si desidera registrare I’audio da
questo microfono su FRONT.

4 Bloccare il cavo dell’obiettivo
utilizzando I’apposito morsetto.



Come connettere i microfoni ai
connettori AUDIO IN

E possibile collegare fino a due microfoni
monofonici ai connettori AUDIO IN CH-1/CH-2,
utilizzando una sezione di applicazione del
supporto per microfono opzionale CAC-12.
Questa ¢ la procedura per I’installazione di un
microfono condensatore electret, quale I’ECM-
674/678.

Per informazioni su come agganciare il CAC-12,
consultare il manuale operativo del CAC-12.

1 Agganciare il microfono del
condensatore elettrico.

@ Svitare la leva di blocco della pallina.

® Avvolgere il distanziatore (tipo a
foglio, in dotazione con il microfono)
attorno al microfono mentre si tolgono
i fogli di protezione da entrambi i lati
del distanziatore.

® Inserire il microfono nella relativa
sezione di applicazione, facendo in
modo che il contrassegno “UP” si trovi
nella parte superiore.

@® Chiudere la sezione di applicazione del
microfono.

® Serrare la vite.

(® Posizionare in modo che il microfono
non interferisca con il mirino e avvitare

la leva di blocco della pallina.

Microfono

Collegare il cavo del microfono al
connettore AUDIO IN CH-1 o CH-2.

juoizesedald g ojonde)n

Impostare gli interruttori come

descritto di seguito.

* Impostare i selettori AUDIO IN come
indicato di seguito, in base al tipo di
microfono utilizzato.

Alimentazione interna: MIC
Alimentazione esterna: +48V

* Impostare I’interruttore AUDIO IN CH1/
CH2 del canale a cui ¢ collegato il
microfono su REAR.

© Selettori AUDIO IN

@ Microfono monofonico

© Interruttori AUDIO IN CH1/CH2

O Al connettore AUDIO IN CH-1 0 CH-2

Attivare il livello di ingresso
corrispondente alla sensibilita del
microfono adoperato.

Attivare il livello di ingresso modificando
I’'impostazione di MAINTENANCE >Audio
>Rear MIC CH1/CH2 Ref nel menu di
impostazione (I’impostazione predefinita ¢ —60
dB). Per ulteriori informazioni, vedere

pagina 147.

Preparazione del sistema di ingresso audio | 43
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 Se il livello di ingresso del camcorder non si trova su
una impostazione corretta per la sensibilita del
microfono, i suoni alti potrebbero essere distorti,
influendo sul rapporto segnale/rumore.

« Per far si che i connettori AUDIO IN CH-1 e CH-2 del
camcorder forniscano un’alimentazione da 48 V
virtuale, sono presenti dei connettori XLR femmina (3
pin). Se il cavo del microfono ¢ dotato di un connettore
femmina, utilizzare un adattatore.

* Quando si scollega una sezione di applicazione del
microfono CAC-12 una volta connesso al camcorder,
far attenzione a non svitare le due viti che fermano il
CAC-12 (nel punto 1). Dopo aver scollegato il CAC-
12, assicurarsi di rimettere le vite al loro posto
originario.

Come collegare un sintonizzatore
UHF portatile (per un sistema
microfono wireless UHF)

Per utilizzare un sistema microfono wireless

UHF, spegnere il camcorder, quindi montare uno

dei seguenti sintonizzatori portatili UHF.

* Ricevitore wireless digitale DWR-S01D

« Sintonizzatore a sintesi di frequenza UHF
WRR-855S

« Sintonizzatore a sintesi di diversita UHF WRR-
860A/861/862

Per ulteriori informazioni relative a questo
apparecchio, consultare i relativi manuali operativi.

11 supporto di montaggio opzionale WRR (numero
articolo: A-8278-057-B) & necessario per I’installazione
del WRR-862.

Per ulteriori informazioni, contattare il proprio
rivenditore o un rappresentante Sony.

Come montare il DWR-S01D o WRR855S

1 Rimuovere le quattro viti di fissaggio
che mantengono il coperchio dello slot
dell’alloggiamento del sintonizzatore/
ricevitore portatile situato sul retro del
camcorder, per rimuovere il coperchio.

Preparazione del sistema di ingresso audio

5?; ‘

2 Inserire il DWR-SO1D 0 WRR-855S
nello slot dell’alloggiamento e avvitare
le quattro viti di fissaggio.

DWR-S01D o WRR-855S

3 Impostare il selettore AUDIO IN per il
canale al quale si desidera inviare il
segnale audio al WIRELESS (vedere
pagina 21).

Per collegare un WRR-862 (con un pacco
batteria BP-L80S)

1 Installare un adattatore per
sintonizzatore WRR (non in dotazione,
numero parte di ricambio: A-8278-057-
B) sulla parte posteriore del camcorder.

@ Utilizzare un cacciavite di tipo Phillips
per serrare le quattro viti poste nel
sintonizzatore, come mostrato di
seguito. Per tre di queste viti, inserire il
giravite nel foro corrispondente e
avvitare la vite.

Assicurarsi che le quattro viti siano completamente
avvitate.

® Allentare le viti di regolazione
dell’adattatore per sintonizzatore.



® Regolare la posizione dell’adattatore
per sintonizzatore del pacco batteria
BP-L80S da collegare, quindi stringere
le viti di regolazione per fissarlo.

(® Montare la piastra di supporto fornita
con il WRR-862.

Per il montaggio del sintonizzatore WRR
(numero articolo: A-8278-057-B), contattare un
rivenditore o rappresentante Sony.

BP-L80S
Viti di

regolazione Piastra di

fissaggio
(fornita con
WRR-862)

Collegare il pacco batteria.

Per informazioni su come collegare il pacco
batteria, vedere “Come montare il pacco
batteria” a pagina 34.

Installare il sintonizzatore sull’apposito
adattatore WRR.

WRR-862

Collegare il cavo di alimentazione del
sintonizzatore al connettore DC OUT
del camcorder ed il cavo di uscita audio
al connettore AUDIO IN CH-1 o CH-2.

Impostare gli interruttori come

descritto di seguito.

« Impostare il selettore AUDIO IN per il
canale al quale & collegato il cavo di uscita
audio su MIC.

* Impostare I’interruttore AUDIO IN CH1/

CH2/CH3/CH4 del canale a cui ¢ collegato

il cavo di uscita audio su REAR.

Se la funzione di rilevamento automatico
della connessione XLR ¢ attiva, il segnale
d’ingresso per la registrazione audio ¢
selezionato automaticamente, e quindi
I’impostazione non & necessaria.

© Interruttori AUDIO IN CH1/CH2

@ Al connettore DC OUT

© Al connettore AUDIO IN CH-1 o CH-2
O Selettori AUDIO IN

Collegamento di un apparecchio
audio con ingresso in linea

Collegare il connettore di uscita audio del
dispositivo audio che fornisce il segnale
d’ingresso linea al connettore AUDIO IN CH-1 o
CH-2.

Impostazioni dell’interruttore

Impostare il selettore AUDIO IN per il canale al
quale ¢ collegata la sorgente di segnale audio su
LINE.

Come selezionare gli ingressi audio da
registrare

* Con la funzione di rilevamento automatico della
connessione XLR disattivata (I’'impostazione di
default): un segnale deve essere selezionato per
la registrazione audio impostando I’interruttore
AUDIO IN CHI1 o CH2 su REAR a seconda di

quale connettore AUDIO IN CH-1 e CH-2 ¢
utilizzato per la connessione del dispositivo
audio esterno.

Preparazione del sistema di ingresso audio
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 Con il rilevamento automatico della
connessione XLR attivo, quando un cavo ¢
connesso al connettore AUDIO IN CH-1 o CH-
2, ’ingresso da quel connettore ¢ selezionato
automaticamente per la registrazione audio,
nonostante I’impostazione dell’interruttore
AUDIO IN CHI o CH2.

La funzione di rilevamento automatico della

connessione XLR pud essere attivata o disattivata

da MAINTENANCE >Audio >Rear XLR Auto

nel menu di impostazione.

© Interruttori AUDIO IN CH1/CH2

@ Al connettore AUDIO IN CH-1 o CH-2
© Apparecchiatura audio

O Selettori AUDIO IN

Montaggio del treppiede

Montaggio del treppiede

1 Collegare I’adattatore opzionale del
treppiede VCT-14/U14 al treppiede.

Adattatore per treppiede

Montaggio telecamera

2 Montare il camcorder all’adattatore del
treppiede.

Spostare il camcorder avanti lungo il solco
nell’unita adattatore finché non scatta.

Come rimuovere il camcorder
dall’adattatore del treppiede

Tenere premuto il pulsante rosso e tirare lalevain
direzione della freccia.



Pulsante rosso

Leva

La spina dell’adattatore del treppiede potrebbe rimanere
occupata anche dopo la rimozione del camcorder. Se cio
dovesse accadere, premere il pulsante rosso e spostare la
leva come mostrato qui sopra finché la spina non ritorni
in posizione. Se la spina resta occupata, non sara
possibile montare il camcorder sull’adattatore del
treppiede.

Connessione della luce
video

E possibile utilizzare Anton Bauer Ultralight 2 o
luce video equivalente per il camcorder
(alimentato da 12 V con consumo massimo di 50
W).

* Se si collega la luce video al connettore LIGHT
del camcorder e si imposta I’interruttore LIGHT
su AUTO, ¢ possibile accendere e spegnere
automaticamente la luce con 1’avvio e
I’interruzione della registrazione su questo
camcorder.

11 segnale di uscita del connettore LIGHT sul
camcorder ¢ comandato a 12 V anche se il
camcorder ¢ alimentato a 12 V o oltre (tramite il
connettore DC IN o il pacco batteria). La
luminosita o la temperatura del colore della luce
non variano in base all’aumento di tensione.

 Non utilizzare una luce video con un consumo di
corrente superiore a 50 W.

 La luminosita o la temperatura del colore della luce
cambiano quando la tensione fornita (tramite il
connettore DC IN o il pacco batteria) & inferiore a 12
V.

Come installare la luce video

Montare la luce video sull’attacco per accessori
dell’impugnatura del camcorder e collegare il
cavo della luce video al connettore LIGHT.

L’attacco per accessori sul camcorder ¢ di tipo

a foro svasato da l/4”. Se si desidera sostituirlo con un
attacco a scorrimento, usare il kit per attacco a piede fisso
fornito con I’unita. Per sapere come utilizzare il kit per
attacco a piede fisso, consultare “Uso di un’unita di disco
rigido” contenuto nel Supplemento fornito con il CD-
ROM (contrassegnato con “Manuals for Solid-State
Memory Camcorder”).

Connessione della luce video
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Uso della tracolla

Come rimuovere la tracolla

Come montare la tracolla

1 Montare un dispositivo di fissaggio
all’attacco per la tracolla.

Tirare la tracolla per bloccare il fissaggio.

uoizeledald g ojouden

2 Sistemare altro dispositivo di fissaggio
all’attacco per la tracolla sul lato
opposto dell’impugnatura come nel
punto 1.

48 | Uso della tracolla

Per sganciare premere qui e tirare in
direzione mostrata dalla freccia.




Regolazione della base
di appoggio per le
riprese a spalla

E possibile far scorrere la base di appoggio in
avanti o indietro fino a 40 mm. In questo modo si
otterra il bilanciamento ottimale per effettuare le
riprese con il camcorder a spalla.

Appoggio per le riprese a spalla

1 Sollevarelaleva al centro dell’appoggio
per le riprese a spalla per sbloccarla.

2 Fare scorrere la base di appoggio in
avanti o indietro fino ad individuare la
posizione desiderata.

3 Abbassare la leva per bloccare la base
di appoggio per le riprese a spalla nella
posizione selezionata.

Regolazione della base di appoggio per le riprese a spalla
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wwe B Regolazioni ed impostazioni

Per informazioni sulle operazioni del menu, vedere “Operazioni di base del menu di impostazione”
(pagina 114).

Impostazione del formato video

E possibile selezionare i seguenti formati di registrazione per creare diverse combinazioni di risoluzione
video e frequenza di sistema.

In modalita UDF

iuoizelsodwi ps juoizejofey ¢ ojonden

Impostazioni del menu OPERATION >Format Formato video (formato di Dimensione
HD/SD HD System Rec Format Frequenza di sistema a) registrazione/frequenza di fotogramma
Line sistema)
HD 1080 HD422 59.94i HD422 1920/59.941 1920x1080
50 50i HD422 1920/50i
29.97P HD422 1920/29.97P
25P HD422 1920/25P
23.98P HD422 1920/23.98P
HD420 59.94i HQ 1440/59.94i 1440%x1080
HQ 50i HQ 1440/50i
29.97P HQ 1440/29.97P
25P HQ 1440/25P
23.98P HQ 1440/23.98P
720 HD422 59.94P HD422 1280/59.94P 1280%x720
50 50P HD422 1280/50P
29.97P HD422 1280/29.97P
25P HD422 1280/25P
23.98P HD422 1280/23.98P
HD420 59.94P HQ 1280/59.94P
HQ 50P HQ 1280/50P
23.98PP HQ 1280/23.98P
SD — IMX50 9 59.94i IMX50/59.94i 720x486
501 IMX50/50i 720x576
29.97p9 IMX50/29.97P 720x486
25p® IMX50/25P 720x576
DVCAM Y 59.94i DVCAM/59.94i 720x480
501 DVCAM/50i 720x576
29.97P 9 DVCAM/29.97P 720x480
25p D DVCAM/25P 720x576

50 | Impostazione del formato video



a) 59.94i/29.97P/59.94P/23.98P: quando OPERATION >Format >Country nel menu di impostazione & impostato su
[NTSC Area] o [NTSC(J) Area]
50i/25P/50P: quando OPERATION >Format >Country nel menu di impostazione & impostato su [PAL Area]

b) Viene registrato in 59.94i dopo una riduzione 2-3

¢) Quando il CBK-MDO1 opzionale ¢ installato

d) Convertito a PsF e registrato

In modalita FAT

FAT
Impostazioni del menu OPERATION >Format Formato video (formato di Dimensione
HD/SD HD System Rec Format Frequenza di sistema a) registrazione/frequenza di fotogramma
Line sistema)
HD 1080 HQ 1920 59.94i HQ 1920/59.94i 1920%x1080
50i HQ 1920/50i
29.97p HQ 1920/29.97P
25P HQ 1920/25P
23.98P HQ 1920/23.98P
HQ 1440 59.94i HQ 1440/59.94i 1440%x1080
501 HQ 1440/50i
29.97P HQ 1440/29.97P
25P HQ 1440/25P
23.98P HQ 1440/23.98P
SP 1440 59.94i SP 1440/59.94i
501 SP 1440/50i
23.98PP SP 1440/23.98P
720 HQ 1280 59.94P HQ 1280/59.94P 1280%x720
50P HQ 1280/50P
29.97p HQ 1280/29.97P
25P HQ 1280/25P
23.98P HQ 1280/23.98P
SD — DVCAM © 59.94i DVCAM/59.94i 720x480
501 DVCAM/50i 720x576
29.97P 9 DVCAM/29.97P 720x480
25p D DVCAM/25P 720x576

a) 59.94i/29.97P/59.94P/23.98P: quando OPERATION >Format >Country nel menu di impostazione & impostato su
[NTSC Area] o [NTSC(J) Area]
50i/25P/50P: quando OPERATION >Format >Country nel menu di impostazione ¢ impostato su [PAL Area]

b) Viene registrato in 59.94i dopo una riduzione 2-3

¢) Quando il CBK-MDO1 opzionale ¢ installato

d) Convertito a PsF e registrato

Impostazione del formato video
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Selezione della modalita di
registrazione

Selezionare la modalita di registrazione tra UDF
e FAT.

1

2

w

4

Selezionare OPERATION >Format
>File System nel menu di impostazione
(vedere pagina 118).

OPERATION
Us| D [ =]
cu
[ | Format Media
Pal | Input/Output

HD/SD : FAT
HD System Line : 1080

Mal{LCD
Fil{Rec Function

»
»
Thi\Superimpose  » [|System Frequency : 59.94i
»
»

Rec Format HQ 1920

Girare la manopola MENU per
selezionare [UDF] o [FAT], quindi
premere la manopola.

Appare un messaggio di conferma.

Selezionare [Execute] per eseguire, o
selezionare [Cancel] per annullare,
quindi premere la manopola MENU.

Spegnere e riaccendere il camcorder.

Modifica del formato video

Consultare la tabella soprastante e modificare le
impostazioni delle voci interessate.

1

2

Selezionare OPERATION >Format nel
menu di impostazione (vedere
pagina 118).

OPERATION
(] p=] » ]
cul T File System UDF
@ | Format Media

Pal Input/Output HD System Line 1080

Mal| LCD
F i} Rec Function

Rec Format HQ 1920

»
»
Thf|Super impose  » [|System Frequency 59.94i
»
»

Girare la manopola MENU per
selezionare una voce da modificare,
quindi premere la manopola.

Impostazione del formato video

Girare la manopola MENU modificare
I’impostazione, quindi premere la
manopola.

Appare un messaggio di conferma.

Selezionare [Execute] per eseguire, o
selezionare [Cancel] per annullare,
quindi premere la manopola MENU.

Una volta modificata I’'impostazione di
HD/SD o Country, spegnere e
riaccendere il camcorder.



Regolazione del
bilanciamento del nero
e del hianco

Per ottenere il livello ottimale di qualita delle
immagini utilizzando questo camcorder, ¢
necessario effettuare la regolazione del
bilanciamento del nero e del bianco.

I valori relativi alle regolazioni del bilanciamento
del nero e del bianco impostati automaticamente
dal camcorder e le varie impostazioni vengono
salvati nella memoria del camcorder e mantenuti
anche se 1’apparecchio viene spento.

Regolazione del bilanciamento del nero

Il bilanciamento del nero deve essere regolato nei

casi elencati di seguito.

« Se il camcorder viene utilizzato per la prima
volta

« Se il camcorder non viene utilizzato per un
periodo di tempo prolungato

* Se il camcorder viene utilizzato in luoghi
caratterizzati da una forte escursione termica

* Se i valori del selettore GAIN (L/M/H/Turbo)
sono stati modificati utilizzando OPERATION
>Gain Switch nel menu di impostazione.

In genere, non & necessario regolare il

bilanciamento del nero nel caso in cui si utilizzi il

camcorder dopo averlo spento.

Regolazione del bilanciamento del
bianco

Regolare sempre il bilanciamento del bianco
quando cambiano le condizioni luminose.

Regolazione del hilanciamento
del nero

In modalita di bilanciamento automatico del nero,
le regolazioni vengono eseguite nell’ ordine
seguente: impostazione del nero e bilanciamento
del nero. La regolazione manuale del
bilanciamento del nero puo essere selezionata dal
menu d’impostazione.

La regolazione manuale del bilanciamento del
nero ¢ disabilitata nei seguenti casi.

* Durante la registrazione

* Nelle modalita di registrazione speciale (Picture
Cache Rec, Interval Rec, Frame Rec, Slow &
Quick)

* Se la modalita otturatore ¢ SLS

1 Impostare ’interruttore OUTPUT/
DCC su CAM.

2 Spostare I’interruttore AUTO W/B
BAL su BLACK, quindi rilasciarlo.
Il messaggio “Executing...” appare durante
I’esecuzione, e si trasforma in “Done”
quando le regolazioni terminano. I valori di
regolazione vengono salvati nella memoria
automaticamente.

Durante la regolazione del bilanciamento del nero, il
diaframma si chiude automaticamente.

Durante la regolazione del bilanciamento del nero, il
circuito di selezione del guadagno viene attivato
automaticamente, producendo uno sfarfallio sullo
schermo del mirino. Cio non indica, tuttavia, un
malfunzionamento.

La trasmissione di dati dal connettore i.LINK si blocca
temporaneamente se si esegue la regolazione del
bilanciamento del nero durante la trasmissione i. LINK.
La trasmissione dal connettore riprende quando
termina la regolazione del bilanciamento del nero.

Se non é possibile effettuare la
regolazione automatica del
hilanciamento del nero

Se non ¢ possibile completare correttamente la
regolazione del bilanciamento del nero, sullo
schermo del mirino viene visualizzato un
messaggio di errore per circa 3 secondi.

Di seguito sono elencati possibili messaggi.

Regolazione del bilanciamento del nero e del bianco
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Messaggio di  Significato

errore

NG: Iris Not 11 diaframma dell’ obiettivo non

Closed si & chiuso; € impossibile la
regolazione.

NG: Timeout ~ Non ¢ stato possibile completare
la regolazione entro il numero
standard di tentativi.

NG: Out of La differenza tra il valore di

Range riferimento e quello attuale

supera I'intervallo. E impossibile
la regolazione.

Se viene visualizzato uno dei messaggi di errore
precedenti, eseguire di nuovo la regolazione del
bilanciamento del nero.

Se il messaggio di errore compare di nuovo, &
necessario eseguire un controllo interno.

Per informazioni relative al controllo interno,
consultare il Manuale per la manutenzione.

Se il cavo dell’obiettivo non & connesso correttamente al
connettore LENS, non & possibile regolare il diaframma
dell’ obiettivo. Se cid dovesse accadere, il bilanciamento
del bianco non sara corretto.

Regolazione del hilanciamento
del bianco

1 Impostare gli interruttori e i selettori
come mostrato in basso.

« Interruttore GAIN: L (impostare un valore
del guadagno il pil piccolo possibile)

¢ Interruttore OUTPUT/DCC: CAM

+ Interruttore WHITE BAL: Ao B "

1)1 valori di regolazione vengono salvati nella
memoria B solo quando OPERATION >White
Setting >White Switch<B> nel menu di
impostazione ¢ impostato su [Memory].

2 Impostare il selettore FILTER per
adattarlo alle condizioni di luce come di
seguito.

3 In condizioni di illuminazione identiche
a quelle del soggetto da riprendere,
posizionare un foglio bianco di prova,
quindi zumare in avanti su di esso.

In alternativa, ¢ possibile utilizzare un
oggetto bianco qualsiasi, ad esempio un
panno o una parete.

L’area di bianco minima ¢ la seguente.

Un rettangolo al centro dello schermo.
La lunghezza dei lati € pari al 70% della
lunghezza e della larghezza dello schermo.

|
v

Assicurarsi che all’interno del rettangolo non siano
presenti punti luminosi.

4 Regolare il diaframma dell’obiettivo.

Obiettivo regolato manualmente: regola il
diaframma all’impostazione
appropriata.

Obiettivo con diaframma automatico:
regolal’interruttore automatico/manuale
sull’obiettivo su automatico.

5 Spostare I’interruttore AUTO W/B
BAL su WHITE, quindi rilasciarlo.
Il messaggio “Executing...” appare durante
I’esecuzione, e diventa “OK: (color
temperature of subject)’quando termina la
regolazione.
I valori di regolazione vengono salvati
automaticamente nella memoria selezionata
al punto 1 (A o B).

Se il camcorder dispone di un obiettivo zoom con
diaframma automatico, & possibile che il diaframma
produca un fenomeno di instabilita D Per evitare
tale problema, regolare la manopola del guadagno
del diaframma (contrassegnata con IG, IS o S)
sull’obiettivo.

Per ulteriori informazioni, consultare il
manuale operativo dell’obiettivo.

1) Instabilita: fenomeno di illuminazione ed
oscuramento ripetuti dell’immagine prodotto
dalla risposta ripetuta al comando del diaframma
automatico.

Se non e possihile effettuare la regolazione
automatica del bilanciamento del bianco

Se non ¢ possibile completare correttamente la
regolazione del bilanciamento del bianco, sullo
schermo del mirino viene visualizzato un
messaggio di errore per circa 3 secondi.

Regolazione del bilanciamento del nero e del bianco



Di seguito sono elencati possibili messaggi.

Messaggio di
errore

Significato

NG: Low Light Il livello video del bianco &
eccessivamente basso. Aprire il
diaframma dell’ obiettivo o

aumentare il guadagno.

NG: Timeout Non ¢ stato possibile
completare la regolazione entro

il numero standard di tentativi.

11 livello video del bianco ¢
eccessivamente alto. Ridurre
I’apertura del diaframma
dell’obiettivo o sostituire il filtro
ND.

NG: High Light

Se viene visualizzato uno dei messaggi di errore
precedenti, eseguire di nuovo la regolazione del
bilanciamento del bianco. Se il messaggio di
errore compare di nuovo, & necessario eseguire un
controllo interno.

Per informazioni relative al controllo interno,
consultare il Manuale per la manutenzione.

Se non si dispone del tempo necessario
per regolare il bilanciamento del bianco

Impostare I’interruttore WHITE BAL su PRST.
In tal modo sara possibile impostare
automaticamente il bilanciamento del bianco su
5600K (valore predefinito) premendo il pulsante
COLOR TEMP.

La temperatura del colore sulla quale ¢ impostato
il bilanciamento del bianco quando viene
premuto il pulsante COLOR TEMP. puo essere
selezionata tra 3200K, 4300K, 5600K, e 6300K
su OPERATION >Assignable SW nel menu di
impostazione. E anche possibile assegnare
temperature del colore agli interruttori ASSIGN.
1/3 o interruttori ASSIGNABLE 4/5.

Come modificare la temperatura del
colore quando si cambia il filtro ND

E possibile assegnare filtri CC (correzione colore)
elettrici ai filtri ND (vedere pagina 14), al fine di
cambiare automaticamente la temperatura del
colore quando si cambia il filtro ND.

1 Impostare MAINTENANCE >White
Filter >ND Filter C.Temp nel menu di

impostazione (vedere pagina 156) su On.

2 Per assegnare un filtro CC elettrico alla
posizione 1 del selettore FILTER,
selezionare [ND FLT C.Temp<1>]. Per
assegnarlo alle posizioni da 2 a 4,
selezionare [ND FLT C.Temp<2-4>].

3 Ruotare la manopola MENU per
selezionare la temperatura colore
desiderata.

Quando si ruota la manopola MENU, la
temperatura colore cambia nella maniera
seguente: 3200K «— 4300K «— 5600K «—
6300K.

4 Ripetere i punti 2 e 3 se necessario.

Per passare da un filtro CC elettrico
all’altro con un interruttore
programmabile

E possibile assegnare la funzione di passaggio da
un filtro CC elettrico all’altro a un interruttore
programmabile. Cio consente di passare alle
diverse temperature colore (3200K/4300K/
5600K/6300K) assegnate a fino a quattro
posizioni (da A a D), a ogni pressione
dell’interruttore programmabile.

A prescindere dalle assegnazioni degli interruttori
programmabili, & anche possibile passare tra le
temperature colore assegnate alle singole
posizioni per mezzo dell’unita di controllo
remoto RM-B150/B170/B750.

1 Selezionare MAINTENANCE >White
Filter nel menu di impostazione (vedere
pagina 156).

2 Selezionare la posizione a cui assegnare
un filtro CC, selezionando una delle
voci comprese tra [Electrical CC<A>] e
[Electrical CC <D>], quindi ruotare la
manopola MENU per selezionare la
temperatura colore desiderata.

Quando si ruota la manopola MENU, la
temperatura colore cambia nella maniera
seguente: 3200K «— 4300K «— 5600K «—
6300K.

Come non impostare alcuna temperatura
colore

Selezionare “-----”” dopo aver selezionato
Electrical CC <C> o <D>.

Regolazione del bilanciamento del nero e del bianco
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Quando si preme I’interruttore
programmabile, I’impostazione di quella
posizione non sara visualizzata. Ad esempio,

se si imposta “-----" per una posizione, verra
eseguito il passaggio tra le tre posizioni
restanti.

3 Ripetere il punto 2 come richiesto.

Assegnare la funzione di passaggio del
filtro elettrico CC (ELECTRICAL CC)
a un interruttore programmabile
(vedere pagina 174).

Impostazione
dell’otturatore
elettronico

Modalita otturatore

Di seguito vengono descritti le modalita di
otturazione utilizzabili con I’otturatore
elettronico e le velocita elencate di seguito.

Memoria relativa al bilanciamento del
bhianco

I valori memorizzati vengono mantenuti fino alla
regolazione successiva del bilanciamento del
bianco anche se il camcorder viene spento.

Il camcorder ha due memorie di bilanciamento
del bianco, A e B. E possibile salvare
automaticamente i valori di ciascun filtro ND
nella memoria che corrisponde all’impostazione
dell’interruttore WHITE BAL (A o B). Il
camcorder ha in dotazione quattro filtri ND, i
quali permettono di salvare un totale di otto valori
di regolazione (4 x 2). Tuttavia, nei seguenti casi
il contenuto delle memorie non & associato alle
impostazioni dei filtri ND.

¢ Quando il numero di memorie assegnate ad A e
B ¢ limitato ad una impostando OPERATION
>White Setting >Filter White Memory nel
menu di impostazione su Off.

Quando la funzione di passaggio tra i filtri CC
elettrici € stata assegnata a un interruttore

programmabile, o € stato collegato a un’unita di
controllo remoto. (In questi casi, il contenuto
della memoria relativa al bilanciamento del
bianco & collegato alle posizioni dei filtri CC
elettrici (da A a D).)

Inoltre, se OPERATION >White Setting >White
Switch<B> nel menu di impostazione € impostato
su [ATW (Auto Tracing White Balance)], e
I’interruttore WHITE BAL & impostato su B, la
funzione ATW viene attivata per regolare
automaticamente il bilanciamento del bianco
dell’immagine che si sta riprendendo per variare
le condizioni di luminosita.

Impostazione dell’otturatore elettronico

Modalita standard

Selezionare questa modalita per la ripresa di
soggetti in rapido movimento con riduzione al
minimo del fenomeno delle immagini sfocate.

E possibile impostare la velocita dell’ otturatore in
una o due modalita otturatore: Modalita Speed, in
cui la velocita viene regolata in secondi, e
modalita Angle, in cui la velocita € impostata in
gradi.

Modalita Speed

Frequenza  Velocita dell’otturatore (unita:

di sistema secondi)

59.94i V6o, 7100, V1200 1250 2500 500,
59.94P 10000 Y2000

501

50P

29.97p 0™, 50 V6o, 100, V120 V125,

I
/250- /500> /1000- /2000

T T T T T T
25P l/saa)sl 150, Yo, T00- V120, 1255
1250, /500> /1000> /2000

23.98p 32, ag ™, V5o ™. g, ogs 100s

17
/120, 11250 250: /500 11000> /2000

a) Questa velocita non ¢ disponibile quando il camcorder
¢ in modalita Slow & Quick Motion e quando
OPERATION >Rec Function >Frame Rate nel menu
di impostazione & impostato su un valore superiore
alla frequenza di sistema.

Modalita Angle
180°, 90°, 45°, 22,5°, e 11,25°

Modalita ECS (Extended Clear Scan)

Selezionare questa modalita per ottenere
immagini prive di bande di disturbo orizzontali
durante la ripresa di soggetti quali lo schermo di
un monitor.




Come viene mostrato nelle seguenti tabelle, la
gamma di velocita di otturazione possibili
variano in base all’attivazione o disattivazione
della funzione Slow & Quick Motion (S&Q).

System lines: 1080

Frequenza di Velocita dell’otturatore (unita:
sistema Hz)

S&Q: Off S&Q: On
59.94i Da 60,00 a 3800 —
50i Da 50,00 a 3500 —
29.97P Da 29,99 a4100 Da 32,01 a4100
23.98P Da 23,99 a 3700 Da 32,02 a 3700
25P Da 25,00 a 3900 Da 32,03 a 3900

System lines: 720

Frequenza di  Velocita dell’otturatore (unita:
sistema Hz)

S&Q: Off S&Q: On
59.94P Da 60,07 a4100 Da 32,01 a 4100
50P Da 50,03 a 3900 Da 32,03 a 3900
29.97P Da 29,99 24100 Da 32,01 a4100
23.98P Da 23,99 a 3700 Da 32,02 a 3700
25P Da 25,00 a 3900 Da 32,03 a 3900

Modalita SLS (slow speed shutter)

Selezionare questa modalita per riprendere i
soggetti in condizioni di scarsa illuminazione.

Impostazione Numero di
OPERATION >Format fotogrammi

>HD System Line nel accumulati

menu di impostazione

1080 2,3,4,5,6,7,8,16
720 2,4,6,8,16

La modalita SLS non puo essere utilizzata quando il
formato video & SP 1440/23.98P o quando il
camcorder ¢ in modalita Slow & Quick Motion.

Non ¢ possibile usare il modo SLS quando
OPERATION >Input/Output >i.Link I/O & impostato
su [Enable] nel menu di impostazione.

Non ¢ possibile emettere il segnale delle barre di
colore, attivare o disattivare la modalita SLS o
cambiare il numero di fotogrammi accumulati quando
il numero di fotogrammi accumulati & impostato su 16.

Selezione della modalita
dell’otturatore e della velocita
dell’otturatore

* Se viene utilizzato il diaframma automatico, questo si
apre gradualmente con I’aumentare della velocita
dell’ otturatore, riducendo in tal modo la profondita di
campo.

* La velocita selezionabile dell’otturatore varia a
seconda della frequenza di sistema corrente.

Come passare dalla modalita Speed alla
modalita Angle

1 Selezionare OPERATION >Shutter
Select >Shutter Select nel menu di
impostazione (vedere pagina 133).

2 Girarela manopola MENU per
selezionare Second o Degree, quindi
premere la manopola.

Come impostare la modalita
dell’otturatore e della velocita
dell’otturatore in modalita standard

Una volta selezionata la velocita dell’ otturatore,
I’impostazione viene mantenuta anche se il
camcorder viene spento.

1 Spostare il selettore SHUTTER da ON
a SELECT.
Viene visualizzata per circa 3 secondi
I’indicazione dell’impostazione attuale
dell’otturatore.

2 Prima che I’indicazione
dell’impostazione dell’otturatore
scompaia, spostare il selettore
SHUTTER su SELECT e ripetere la
procedura finché non compare la
modalita o velocita desiderata.

Quando sono visualizzate tutte le modalita e
velocita, la schermata cambiera nel seguente
ordine.

Impostazione dell’otturatore elettronico
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Modalita Speed (con frequenza di sistema
di 59.94i)
1

t1/60-’1/100-’ eeee =1/1000~1/2000
Modalita ECS

A seconda dell’impostazione del frame rate (vedere
pagina 85), alcune velocita dell’otturatore non sono
disponibili nella modalita Slow & Quick Motion. Tali
velocita sono sostituite dalla velocita dell’ otturatore pitt
lenta possibile.

Esempio: Se si esegue una ripresa in Slow & Quick
Motion quando la frequenza di fotogrammi ¢ impostata
su 60 e il formato video su HQ1280/29.97P

La velocita dell’ otturatore ¢ indicata come di seguito.

Quando la modalita Slow & Quick Motion non ¢ attiva
1/40—1/50—1/60—1/100—-...

Quando la modalita Slow & Quick Motion ¢ attiva
1/60—1/60—1/60—1/100—-...

Come impostare la velocita
dell’otturatore in modalita ECS

1 Impostare la modalita di velocita
dell’otturatore su ECS (consultare la
voce precedente).

2 Ruotare la manopola MENU per
selezionare la frequenza o il numero di
fotogrammi desiderato.

Come impostare la velocita
dell’otturatore in modalita SLS

1 Impostare OPERATION >Shutter
>Slow Shutter nel menu di
impostazione su [On] (vedere
pagina 133).

2 Selezionare il numero desiderato di
fotogrammi accumulati tramite
OPERATION >Shutter >SLS Frames
nel menu di impostazione.

Come modificare il valore di
riferimento per la regolazione
automatica del diaframma

11 valore di riferimento per la regolazione del
diaframma automatico puo essere modificato per
consentire una corretta ripresa di soggetti
retroilluminati o per evitare zone di massima luce
che potrebbero danneggiare le riprese. Il valore di
riferimento per il diaframma dell’ obiettivo puo
essere regolato secondo i seguenti valori,
rispettando il valore standard.
* Da 0,25 a 1 (aumentando di incrementi di 0,25):
da circa 0,25 a | interrompe ulteriore apertura
¢ Da-0,25 a -1 (diminuendo di incrementi di
0,25): da circa 0,25 a 1 interrompe ulteriore
chiusura
Inoltre, & possibile impostare 1’area di
rilevamento della luce.

Come modificare il valore di riferimento

1 Impostare OPERATION >Auto Iris
>Iris Override nel menu di
impostazione su On (vedere pagina 130).

2 Impostare ’interruttore MENU ON/
OFF su OFF.

3 Ruotarela manopola MENU per
modificare il valore di riferimento.

Far attenzione a confermare che la modalita
corrente dell’otturatore non sia ECS.

Un indicatore del valore di riferimento
corrente viene mostrato presso I’indicazione
della posizione del diaframma (vedere
pagina 33) sullo schermo del mirino.

Come aprire maggiormente il diaframma
Ruotare la manopola MENU in senso
antiorario come dal lato frontale del
camcorder.

Selezionare una opzione tra 0,25, 0,5, 0,75, o
1.

Come modificare il valore di riferimento per la regolazione automatica del diaframma



Come fermare il diaframma verso il basso
Ruotare la manopola MENU in senso orario
guardando il camcorder frontalmente.
Selezionare una opzione tra —0,25, -0,5, —
0,75, 0-1.

1l valore di riferimento modificato viene
mantenuto finché non viene spento il
camcorder.

Ogni volta che si accende 1’apparecchio, il
valore di riferimento, anche se modificato,
viene ripristinato sul valore standard.

Come impostare la finestra del
diaframma automatico

1 Impostare OPERATION >Auto Iris
>Iris Window Indication nel menu di
impostazione su On.

La finestra del diaframma automatico attuale
appare sullo schermo del mirino.

Se non ¢ necessario visualizzare la finestra
del diaframma automatico sullo schermo,
impostare su Off.

2 Girarela manopola MENU per
selezionare Iris Window, quindi
premere la manopola.

3 Ruotarela manopola MENU finché la
finestra del diaframma automatico
desiderata compare, poi premere la
manopola.

1 2 3 4 5 6
Le parti ombrate indicano I'area
in cui avviene il rilevamento

Se si seleziona “Var”, le voci seguenti
diventano effettive ed ¢ possibile impostare
la finestra alla dimensione desiderata.
Impostare le seguenti voci con
MAINTENANCE >Auto Iris2.

Elemento Impostazione
Iris Var Width  La larghezza della finestra
Iris Var Height L’altezza della finestra

Iris Var HPos  La posizione della finestra

in direzione orizzontale

Iris Var V Pos.  La posizione della finestra

in direzione verticale.

Quando si esce dal menu, appare la finestra del
diaframma automatico selezionata al punto 3.

A meno che non si abbia bisogno di mantenere
visualizzata la finestra, impostare OPERATION
>Auto Iris >Iris Window Indication nel menu di
impostazione su Off.

Come eliminare problemi con luminosita
molto elevata

Se I’oggetto ¢ troppo luminoso, il diaframma
potrebbe chiudersi troppo, lasciando I’intera
immagine scura o le luminosita potrebbero
diminuire del tutto. In questi casi, impostare la
funzione luminosita clip su “on” per ridurre la
luminosita, evitando problemi dalla correzione
automatica del diaframma.

Impostare OPERATION >Auto Iris >Clip High
Light nel menu di impostazione su On.

Come modificare il valore di riferimento per la regolazione automatica del diaframma
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Regolazione del livello
audio

Quando si imposta I’interruttore AUDIO
SELECT su AUTO, i livelli di input dei segnali
audio analogici registrati su ciascuno dei canali
vengono regolati automaticamente. E anche
possibile eseguire delle regolazioni manuali.

Anche se I'interruttore AUDIO SELECT viene
impostato su AUTO, i livelli di input dei segnali audio
digitali non sono regolati automaticamente.

Il'livello audio target per la regolazione manuale
del livello audio

Effettuare regolazioni utilizzando —20 dB come
livello target.

Se il misuratore del livello audio mostra un livello
massimo di 0 dB, poi esso indica che il livello
audio d’ingresso € eccessivo.

Livello di ingresso eccessivo

Livello d’ingresso target

Regolazione manuale dei livelli
degli ingressi audio dai connettori
AUDIO IN CH-1/CH-2

1 Per regolare ’ingresso del segnale al
connettore AUDIO IN CH-1 o CH-2,
impostare I’interruttore AUDIO IN
CH1 o CH2 su REAR.

Per regolare entrambi i segnali, impostare
entrambi gli interruttori su REAR.

Regolazione del livello audio

2 Impostare gli interruttori AUDIO
SELECT corrispondenti ai canali
selezionati al punto 1 su MANUAL.

3 Con le manopole LEVEL per i canali
selezionati alla fase 1, regolare in modo
che il misuratore del livello audio
mostri fino a
—20 dB per un normale volume
d’ingresso.

Corrispondenza tra le regolazioni del
livello di registrazione e i controlli del
livello audio

In MAINTENANCE >Audio nel menu di
impostazione, & possibile selezionare quale
comando del livello audio controlla il livello di
registrazione audio dell’ingresso ad ogni
connettore AUDIO IN CH-1/CH-2. Le
corrispondenze tra le impostazioni delle voci del
menu e i controlli sono come di seguito.

Rear1l/WRR Level: Livello di registrazione del

canale 1
Impostazione Manopola
Sidel Manopola LEVEL (CH1)
Front Controllo MIC LEVEL
Front+Sidel Manopola LEVEL (CH1) e
controllo MIC LEVEL

(funzionamento connesso)

Rear2/WRR Level: Livello di registrazione del

canale 2
Impostazione Manopola
Side2 Manopola LEVEL (CH2)
Front Controllo MIC LEVEL
Front+Side2 Manopola LEVEL (CH2) e

controllo MIC LEVEL
(funzionamento connesso)

Quando si eseguono operazioni delle manopole LEVEL
(CH1/CH2) e il controllo MIC LEVEL collegati, se il
controllo MIC LEVEL ¢ impostato su 0, i segnali audio
sui canali 1 e 2 non possono essere registrati. Controllare
la posizione del controllo MIC LEVEL prima di regolare
le manopole LEVEL (CH1/CH2).



Come regolare manualmente il
livello audio del connettore MIC
IN

1 Impostare uno o entrambi gli
interruttori AUDIO IN su FRONT.

2 Impostare gli interruttori AUDIO
SELECT corrispondenti ai canali audio
desiderati selezionati al punto 1 su
MANUAL.

3 Ruotare il controllo MIC LEVEL e
regolare in modo che il misuratore del
livello audio mostri fino a 20 dB per un
normale volume d’ingresso.

Quando si eseguono operazioni al controllo MIC
LEVEL e le manopole LEVEL (CH1/CH2) collegati
assieme, se le manopole LEVEL (CH1/CH2) sono
impostate su 0, i segnali audio sui canali 1 e 2 non
possono essere registrati. Controllare la posizione delle
manopole LEVEL (CH1/CH2) prima di regolare il
controllo MIC LEVEL.

Come registrare audio sui canali
3ed

Come selezionare audio registrato

E possibile selezionare 1’audio registrato sui
canali audio 3 e 4 con gli interruttori AUDIO IN
CH3/CH4.

Corrispondenza tra le regolazioni del
livello di registrazione e i controlli del
livello audio

In MAINTENANCE >Audio nel menu di
impostazione, ¢ possibile selezionare quale
comando del livello audio controlla il livello di
registrazione audio dell’ingresso del microfono
frontale. Le corrispondenze tra le impostazioni
delle voci del menu e i controlli sono come di
seguito.

MIC CH1 Level: Livello di registrazione del

canale 1
Impostazione Manopola
Sidel Manopola LEVEL (CH1)
Front Controllo MIC LEVEL
Front+Sidel Manopola LEVEL (CH1) e
controllo MIC LEVEL

(funzionamento connesso)

MIC CH2 Level: Livello di registrazione del

Interruttore Target di registrazione
CH3 Channel 3
FRONT Microfono audio frontale
REAR Ingresso segnale audio al
connettore AUDIO IN CH-1
WIRELESS Microfono audio wireless
Interruttore Target di registrazione
CH4 Channel 4
FRONT Microfono audio frontale
REAR Ingresso segnale audio al
connettore AUDIO IN CH-2
WIRELESS Microfono audio wireless

E possibile eseguire la selezione
automaticamente come di seguito.

Come selezionare automaticamente lo stesso
audio come sui canali1e 2

Impostare MAINTENANCE >Audio >Audio
CH3/4 Mode nel menu di impostazione su [Ch1/
2].

canale 2 P T . .
Come regolare i livelli di registrazione
Impostazione Manopola audio
Side2 Manopola LEVEL (CH2)
Front Controllo MIC LEVEL Come regolare automaticamente
FrontzSide2 Manopola LEVEL (CH2) ¢ Impostare gli interruttori AUDIO SELECT CH 3-
controllo MIC LEVEL 4 su AUTO.

(funzionamento connesso)

Come regolare manualmente

1 Impostare gli interruttori AUDIO
SELECT CH 3-4 su MANUAL.

Regolazione del livello audio
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2 Selezionare le manopole per la

regolazione dei livelli audio con le voci Im p ostaZi one d e i d ati

Audio CH3 Level e Audio CH4 Level in =
MAINTENANCE >Audio nel menu di te m p 0 ra I |
impostazione.

Audio CH3 Level: Livello di registrazione

del canale 3 m

Impostazione Manopola Quando la modalita Picture Cache ¢ attiva, non &
Side3 Manopola LEVEL (CH3) possibile impostare i dati temporali, anche se si imposta
F t Controllo MIC LEVEL Pinterruttore F-RUN/SET/R-RUN su SET. Se si

Ton ontrollo

- desidera impostare i dati temporali, per prima cosa uscire
Front+Side3 Manopola LEVEL (CH3) e dalla modalita Picture Cache.

controllo MIC LEVEL
(funzionamento connesso)

Impostazione del codice
Audio CH4 Level: Livello di registrazione
del canale 4 temporale

L’impostazione del codice temporale puo variare

Impostazione Manopola
da00:00:00:00a23:59:59:29 (ore : minuti

iuoizelsodwi ps juoizejofey ¢ ojonden

Side4 Manopola LEVEL (CH4) ) -
Front Controllo MIC LEVEL : secondi : fotogrammi).
Front+Sided M“‘EOIT;’I“DZ%VLEELV(EE“) e 1 Premere il pulsante DISP SEL/
controllo . .
. EXPAND per regolare il monitor LCD
(funzionamento connesso) I
sullo stato display.
Adesso & possibile regolare i livelli dei canali
audio 3 e 4 con le manopole selezionate qui. 2 Impostare ’interruttore DISPLAY su
TC.

3 Impostare ’interruttore PRESET/
REGEN/CLOCK su PRESET.

4 Impostare I’interruttore F-RUN/SET/
R-RUN su SET.
Lampeggia la prima cifra (all’estrema
sinistra) del codice temporale.

O Utilizzare i pulsanti freccia su e giu per
modificare i valori e utilizzare i pulsanti
freccia sinistra e destra per spostare la
cifra lampeggiante. Ripetere finché
tutte le cifre saranno impostate.

Come ripristinare il valore del codice
temporale su 00:00:00:00
Premere il pulsante RESET/RETURN.

6 Impostare I’interruttore F-RUN/SET/
R-RUN su F-RUN o R-RUN.
F-RUN: funzionamento libero. Il generatore
di codici temporali continua a
funzionare normalmente.

62 | Impostazione dei dati temporali



R-RUN: funzionamento durante la
registrazione. Il generatore del codice
temporale funziona solo durante la
registrazione.

Come impostare la modalita drop frame/non-
drop frame

E possibile selezionare la modalita drop frame
(DF) o non drop frame (NDF) in
MAINTENANCE >Timecode nel menu di
impostazione.

Continuita del codice temporale

Quando I'interruttore F-RUN/SET/R-RUN &
impostato su R-RUN, la registrazione su supporto
di un gran numero di scene produce codici
temporali continui. Tuttavia, se si estrae il
supporto e si registra su un altro supporto, la
continuita di tale codice non viene mantenuta
nemmeno quando si riutilizza, per la
registrazione, il supporto originale. In tal caso,
per rendere continuo il codice temporale,
impostare I’interruttore PRESET/REGEN/
CLOCK su REGEN.

Come memorizzare I’ora effettiva nel codice
temporale.

Per memorizzare 1’ora effettiva nel codice
temporale, impostare I’interruttore PRESET/
REGEN/CLOCK su CLOCK.

Quando & necessario impostare 1’ora, utilizzare
MAINTENANCE >Clock Set >Date/Time nel
menu di impostazione.

Per ulteriori informazioni, vedere “Impostazione di
data/ora dell’orologio interno” (pagina 39).

Impostazione dei bit dell’'utente

Impostando i bit utente (fino a 8 cifre
esadecimali), ¢ possibile registrare le
informazioni relative all’utente, quali data, ora o
numero di scena sulla traccia del codice
temporale.

1 Premere il pulsante DISP SEL/
EXPAND per regolare il monitor LCD
sullo stato display.

2 Impostare I’interruttore DISPLAY su
U-BIT.

3 Impostare I’interruttore F-RUN/SET/
R-RUN su SET.
La prima cifra (all’estrema sinistra)
lampeggia.

4  Utilizzare i pulsanti freccia su e giu per
modificare i valori e utilizzare i pulsanti
freccia sinistra e destra per spostare la
cifra lampeggiante. Ripetere finché
tutte le cifre saranno impostate.

Come ripristinare i dati bit dell’utente su
0000 00 00
Premere il pulsante RESET/RETURN.

) Impostare I’interruttore F-RUN/SET/
R-RUN su F-RUN o R-RUN, a seconda
della modalita operativa desiderata per
il generatore del codice temporale.

Come memorizzare I'impostazione dei bit
dell’utente

L’impostazione dei bit utente (oltre I’ orario reale)
viene automaticamente mantenuta in memoria
anche quando il dispositivo ¢ spento.

Come sincronizzare il codice
temporale

E possibile sincronizzare il generatore di codici
temporali interno del camcorder con un
generatore esterno per rigenerare il codice
temporale di un apparecchio esterno. E anche
possibile sincronizzare i generatori del codice
temporale di altri camcorder/VTR con il
generatore interno di questo camcorder.

Collegamenti per la sincronizzazione del
codice temporale

Collegare il segnale video di riferimento ed il
codice temporale esterno come illustrato di
seguito.

Impostazione dei dati temporali
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Esempio 1: sincronizzazione con un codice
temporale esterno

Codice temporale esterno

Segnale video di riferimento

© Connettore GENLOCK IN
@ Connettore TC IN

Esempio 2: come connettere diversi camcorder
(compreso un camcorder di riferimento)

Ad un altro camcorder esterno da sincronizzare

@ Connettore VIDEO OUT
@ Connettore TC OUT

© Connettore TC IN

@ Connettore GENLOCK IN

Come bloccare il codice temporale su
una sorgente esterna.

1 Accendere I’interruttore POWER.

Impostazione dei dati temporali

2 Impostare ’interruttore PRESET/
REGEN/CLOCK su PRESET.

3 Impostare Pinterruttore F-RUN/SET/
R-RUN su F-RUN.

4 Impostare Pinterruttore DISPLAY su
TC.

5 Fornire un segnale per codice
temporale e un segnale video di
riferimento che corrisponda agli
standard SMPTE e sia nel giusto
rapporto di fase, al connettore TC IN e
al connettore GENLOCK IN.

Tramite questa operazione, il generatore di
codici temporali interno viene sincronizzato
con il codice temporale esterno. Dopo circa
10 secondi, ¢ possibile scollegare il codice
temporale esterno mantenendo la
sincronizzazione.

» Terminata la procedura di sopra, il codice temporale
interno ¢ immediatamente sincronizzato con il codice
temporale esterno e il display del contatore mostrera il
valore del codice temporale esterno. Tuttavia, prima di
effettuare una registrazione & necessario attendere
alcuni secondi affinché il generatore di
sincronizzazione si stabilizzi.

Se la frequenza del segnale video di riferimento non
corrisponde alla frequenza di sistema del camcorder,
questo non pud essere sincronizzato mediante genlock
in modo corretto. In tal caso, il codice temporale
interno non ¢ correttamente sincronizzato con il codice
temporale esterno.

Impostazioni dei bit utente durante la
sincronizzazione del codice temporale
Durante la sincronizzazione del codice
temporale, vengono sincronizzati solo i dati
temporali con il valore del codice temporale
esterno.

Come disattivare la sincronizzazione dei codici
temporali

Scollegare dapprima il codice temporale esterno,
quindi impostare I’interruttore F-RUN/SET/R-
RUN su R-RUN.



Per sostituire I’alimentazione del pacco batteria
con una fonte di alimentazione esterna durante
la sincronizzazione dei codici temporali

Per mantenere ininterrotta 1’alimentazione, prima
di procedere alla rimozione del pacco batteria,
collegare I’alimentazione esterna al connettore
DC IN. Estraendo prima il pacco batteria, &
possibile che non venga mantenuta la
sincronizzazione dei codici temporali.

Sincronizzazione del camcorder durante la
sincronizzazione del codice temporale

Durante la sincronizzazione del codice
temporale, il camcorder viene sincronizzato
mediante genlock al segnale video di riferimento
immesso dal connettore GENLOCK IN.

Impostazione dei dati
delle riprese

Quando sono emesse le barre del colore &
possibile visualizzare i dati delle riprese.

PMW-500 #1
AUG/25/10 1
12345678901

Esempio di visualizzazione dei
dati delle riprese

E possibile selezionare quali dati delle riprese
sono sovrapposti alle barre di colore con
OPERATION >Shot Display nel menu di
impostazione.

Shot Date

Per sovrapporre la data della ripresa ruotare la
manopola MENU per impostare Shot Date su
[On], quindi premere la manopola.

Shot Time

Per sovrapporre 1’ora della ripresa ruotare la
manopola MENU per impostare Shot Time su
[On], quindi premere la manopola.

Shot Model Name

Per sovrapporre il nome del modello ruotare la
manopola MENU per impostare Shot Model
Name su [On], quindi premere la manopola.

Shot Serial Number

Per sovrapporre il numero di serie ruotare la
manopola MENU per impostare Shot Serial
Number su [On], quindi premere la manopola.

Shot ID Select

Per sovrapporre un’ID di ripresa creata in modo
arbitrario, ruotare la manopola MENU per
impostare Shot ID Select su uno di [ID-1] -
[ID-4], quindi premere la manopola.

Per creare un’ID di ripresa vedere la sezione
successiva, “Creazione di un’ID di ripresa”.

Impostazione dei dati delle riprese
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Creazione di un’ID di ripresa

E possibile creare fino a quattro ID di ripresa di
fino a 16 caratteri.

Per creare un’ID di ripresa

1 Con OPERATION >Shot ID nel menu
di impostazione, ruotare la manopola
MENU per selezionare un’ID di ripresa
da creare (ID-1 - ID-4), quindi premere
la manopola.

OPERATION

2
[CEMEME]234567890123456 SET

Viene visualizzata la schermata di
impostazione dell’ID di ripresa.

2 Seguire la procedura di “Come inserire
testo” (pagina 115) per creare un’ID di
ripresa.

Verifica delle
impostazioni del
camcorder e delle
informazioni di stato
(Schermate di stato)

Le schermate di stato permettono di verificare le
impostazioni del camcorder e vari tipi di
informazioni di stato.

Di seguito sono elencate le cinque schermate di
stato disponibili.

Schermata di Informazioni visualizzate

stato

Stato CAMERA  Impostazioni e informazioni di
stato relative alla ripresa

Stato AUDIO Impostazioni e informazioni di
stato relative all’ingresso e
all’uscita audio

Stato VIDEO Impostazioni e informazioni di
stato relative alla registrazione
e alla riproduzione

Stato ASSIGN Nomi delle funzioni assegnate

SWITCH a ciascun interruttore

programmabile

Stato BATTERY/ Stato della batteria inserita nel
MEDIA camcorder e stato del supporto

Come visualizzare le schermate di stato
Quando non ¢ visualizzato alcun menu, premere
Iinterruttore MENU CANCEL/PRST/ESCAPE
sul lato CANCEL/PRST. Ad ogni pressione viene
selezionata la schermata di stato successiva,
nell’ordine elencato nella tabella seguente.

Schermata di stato CAMERA STATUS

Questa schermata mostra le impostazioni e le
informazioni di stato relative alla ripresa.

CAMERA
White Bal  B: 12000K Gain L: 0dB
A: 4700K M: 9dB
PRST: 3200K H: 18dB
Zebra 1: On  70%

Zoom Speed 70
Skin Detail OFF 2: Off

White Bal: stato del bilanciamento del bianco

Gain: stato GAIN Switch

Zoom Speed: velocita di zoom impostata con il
pulsante ZOOM dell’ obiettivo

Verifica delle impostazioni del camcorder e delle informazioni di stato (Schermate di stato)



Zebra: stato Zebra
Skin Detail: stato dettagli Skin

Schermata di stato AUDIO

Questa schermata mostra le impostazioni e le
informazioni di stato relative all’ingesso e
all’uscita dell’audio.

AUDIO
Front MIC : Stereo

CH-1

CH-2
CH-3
CH-4

CH-1/CH-2/CH-3/CH-4: indicatori di livello
audio e fonte di ingresso
Wind Filter: impostazioni filtro Wind

Schermata di stato VIDEO

Questa schermata mostra le impostazioni e le
informazioni di stato relative alla registrazione e
alla riproduzione.
VIDEQ

Video Format

Rec Mode
Output&i.LINK

: HD 1080/59.94i
- HD 422 50
: HD/Disable

SDI Output : Off

Down Converter : Squeeze

Video Format: formato video

Rec Mode: velocita di trasmissione bit di
registrazione (solo modalita HD)

Output&i.LINK: impostazione Output&i. LINK
e stato d’uso i.LINK

SDI Output: impostazione di uscita del
connettore HD/SD SDI OUT

Down Converter: impostazione di conversione
in uscita SD (solo modalita HD)

Schermata di stato ASSIGN SWITCH

Questa schermata mostra i nomi delle funzioni
assegnate agli interruttori programmabili

ASSIGN SWITCH 4/5
0: Off RET : Return Video
: Freeze Mix C. Temp: Color Temp SW5600K
: Off

: Color Temp SW3200K
4: Rec Review
: Off

Schermata BATTERY/MEDIA STATUS

Questa schermata visualizza lo stato della batteria
inserita nel camcorder e lo stato del supporto.

BATTERY/MEDIA
Battery NN M EMEEOODO Charge Count 55
=}

HDD B W
0
MediaA MEEOOOOOOO 120min Life  100%
MediaB MEMMODOOOOODO 50min fLife  33%
0 50 100%

Battery: carica residua della batteria
Charge Count: il numero di volte in cui la
batteria non ¢ stata caricata
HDD A/HDD B: carica residua della batteria di
PHU-220R (in modalita FAT)
Media A/Media B:
* Capacita residua del supporto.
» Tempo di registrazione
* Vita approssimativa di scrittura (Life)
“Life 100%” viene mostrato in caso di
supporti non utilizzati.

Verifica delle impostazioni del camcorder e delle informazioni di stato (Schermate di stato)
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Capitolo4

Utilizzo delle schede di
memoria SxS

Questo camcorder registra video e audio su
schede di memoria SxS (non in dotazione)
caricate su uno o entrambi gli slot per schede di
memoria.

Il camcorder consente inoltre la registrazione sui

seguenti dispositivi:

« Disco rigido professionale PHU-220R

 Adattatore per supporti di memoria
MEAD-MS01/SDO01 (con modalita di
registrazione FAT) oppure adattatore
ExpressCard XQD QDA-EX1 (con modalita di
registrazione FAT/UDF)

Per ulteriori informazioni, consultare il

Supplemento fornito con il CD-ROM

(contrassegnato con “Manuals for Solid-State

Memory Camcorder”).

Informazioni sulle schede di
memoria SxS

Schede di memoria SxS che possono
essere utilizzate con questo camcorder

Utilizzare le seguenti schede di memoria SxS di
Sony (SxS PRO o SxS-1) con questo camcorder.

SxS PRO
« SBP-32 (32 GB)
* SBP-64A (64 GB)

$x8-1
* SBS-32G1A (32 GB)
* SBS-64G1A (64 GB)

11 funzionamento corretto non puo essere
garantito quando vengono utilizzate delle schede
di memoria diverse da SxS PRO e SxS-1.

Utilizzo delle schede di memoria SxS

Le schede di memoria elencate sopra sono
conformi allo standard per schede di memoria
ExpressCard.

¢ SxS, SxS PRO e SxS-1 sono marchi di fabbrica
di Sony Corporation.

* Il marchio e il logo ExpressCard sono di
proprieta della Personal Computer Memory
Card International Association (PCMCIA) e
sono concessi in licenza a Sony Corporation.
Gli altri marchi di fabbrica e nomi commerciali
sono da ritenersi proprieta dei rispettivi
proprietari.

Note sull’uso delle schede di memoria
SxS

* ] dati registrati potrebbero andare persi o
risultare corrotti nei casi seguenti.

- Quando il camcorder viene sottoposto a
scosse o vibrazioni durante la lettura, la
scrittura o la formattazione di una scheda di
memoria SxS, e quando il camcorder viene
spento o viene rimossa una scheda di memoria
SxS durante la lettura, la scrittura o la
formattazione.

- Quando il camcorder viene utilizzato in un
ambiente soggetto a elettricita statica o
disturbi elettrici.

* Non utilizzare o memorizzare le schede di
memoria SxS in luoghi che sono:

- Al di fuori delle gamme ambientali specificate

- Molto caldi, come in veicoli parcheggiati al
sole d’estate, o esposti alla luce diretta del
sole, o vicino a radiatori

- Soggetti a umidita elevata e ad agenti
corrosivi

¢ Quando si inserisce una scheda di memoria,
inserirla con il lato dell’etichetta rivolto verso la
direzione corretta.

* Trasportare e conservare le schede di memoria
SxS nelle apposite custodie, e chiudere le
custodie saldamente.



* Per usare una scheda di memoria SxS-1 “SBS-
32G1” in modalita UDF, & necessario
aggiornare il software. Per ulteriori
informazioni, accedere al sito web Sony pil
vicino alla propria zona. (Consultare la pagina
principale del manuale su CD-ROM in
dotazione.)

Premunirsi da incidenti o perdita imprevista di
dati effettuando un back up dei dati
memorizzati su schede di memoria SxS. Sony
non pud essere ritenuta responsabile per alcuna
conseguenza derivante da danni o perdita dei
dati memorizzati nelle schede di memoria SxS.
Non attaccare nulla che non sia una delle
etichette in dotazione nell’apposito spazio per
etichette. Quando si attacca un’etichetta,
assicurarsi che non fuoriesca dallo spazio per
etichette.

J

Label space

Utilizzare questo camcorder per formattare
schede di memoria SxS che verranno utilizzate
con questo camcorder. Quando le schede di
memoria vengono formattate su un’altra unita,
il formato viene considerato non valido,
rendendo necessaria un’ulteriore formattazione
delle schede di memoria.

Tuttavia, notare che le funzioni di cancellazione
e di formattazione di questo camcorder non
rimuovono completamente i dati dalle schede di
memoria. Prima di gettare o smaltire una scheda
di memoria, cancellare il suo contenuto
utilizzando un software commerciale di
cancellazione dati o distruggerla fisicamente.
Sony non pud essere considerata responsabile di
una completa cancellazione dei dati non
riuscita.

* Le operazioni con i clip potrebbero non essere
possibili quando la capacita rimanente del
supporto & bassa. In questo caso, utilizzare un
computer per cancellare i file che non sono
necessari e provare nuovamente.

* Aprire la custodia della scheda di memoria
completamente prima di conservare una scheda
nella custodia o di rimuovere una scheda dalla
custodia.

Prevenzione della cancellazione
accidentale

E possibile prevenire la registrazione, il
montaggio e la cancellazione accidentale dei dati
su una scheda di memoria SxS impostando
I’interruttore di protezione da scrittura sul lato
WP.

Interruttore di protezione da scrittura

Non toccare I’interruttore di protezione da scrittura
mentre una scheda di memoria SxS ¢ caricata su uno slot
per schede. Estrarre la scheda prima di impostare
I’interruttore di protezione da scrittura.

Caricamento ed espulsione delle
schede di memoria SxS

Come caricare le schede di memoria SxS

1 Fare scorrere il coperchio verso la
sinistra per aprire.

Utilizzo delle schede di memoria SxS
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2 Inserire una scheda di memoria SxS in
uno slot per schede.

Inserire con il lato dell’etichetta
rivolto verso destra.

La spia ACCESS diventa arancione, e quindi
diventa verde per indicare che la scheda di
memoria puo essere utilizzata.

3 Chiudere il coperchio.
Indicazioni di stato spia ACCESS

Gli slot per schede A e B sono dotati di una spia
ACCESS che indica lo stato dello slot.

Spia Stato dello slot
Diventa Accesso alla scheda di memoria
arancione SxS in corso (si illumina durante

la lettura e la scritture dei dati)

Diventa verde  Standby (la scheda di memoria
SxS caricata ¢ pronta per la
registrazione o la riproduzione)

Non accesa * Non ¢ caricata alcuna scheda di
memoria SxS.
« E stata caricata una scheda
inutilizzabile.
« E stata caricata una scheda di
memoria SxS, ma ¢ stato
selezionato 1’altro slot.

Utilizzo delle schede di memoria SxS

Come espellere le schede di memoria
Sx8

1 Aprire il coperchio, e quindi premere il
pulsante EJECT per rilasciare il blocco,
quindi far fuoriuscire il pulsante.

Premere il pulsante una volta
per rilasciare il blocco.

2 Premereil pulsante EJECT
nuovamente per espellere la scheda.

L’integrita dei dati non puo essere garantita se si spegne
il camcorder o si rimuove una scheda di memoria mentre
I’accesso alla scheda & in corso. L’operazione potrebbe
corrompere tutti i dati registrati sulla scheda. Assicurarsi
sempre che la spia ACCESS sia verde o spenta prima di
spegnere il camcorder o rimuovere una scheda di
memoria.



Selezione della scheda di
memoria SxS da utilizzare

Quando vengono caricate delle schede di
memoria SxS sia nello slot A che nel B, &
possibile premere il pulsante SLOT SELECT per
selezionare la scheda di memoria SxS da
utilizzare.

Il camcorder passa automaticamente all’altra
scheda se la scheda selezionata si esaurisce
durante la registrazione.

11 pulsante SLOT SELECT viene disabilitato durante la
riproduzione. Anche quando viene premuto, non cambia
lo slot selezionato. Le operazioni con i pulsanti vengono
abilitate quando viene visualizzata una schermata delle
miniature (vedere pagina 94).

Formattazione (Inizializzazione)
di schede di memoria SxS

Quando si carica una scheda di memoria non
formattata, una scheda di memoria formattata
secondo altre specifiche o una scheda di memoria
formattata in modalita UDF nel camcorder
impostato sulla modalita FAT, nel mirino appare
un messaggio per verificare se si deve eseguire la
formattazione (vedere pagina 72). In questo caso,
formattare la scheda di memoria nel seguente
modo.

Le schede di memoria SxS sono formattate in
modalitd FAT come impostazione predefinita.

Le schede di memoria SxS devono essere
formattate su un dispositivo XDCAM EX o su
questo camcorder. Non possono essere utilizzate
schede con altri formati.

Come formattare (inizializzare) una
scheda di memoria

Se viene visualizzato il messaggio relativo alla
formattazione, ruotare la manopola MENU per
selezionare “Execute”, quindi premere la
manopola.

La formattazione viene avviata.

Durante la formattazione, appare un’indicazione
sullo stato dell’operazione (%), e 1a spia ACCESS
diventa arancione.

Al termine della formattazione, il messaggio di
completamento viene visualizzato per tre
secondi.

Registrazione e riproduzione durante la
formattazione

Persino durante la formattazione sono possibili la
registrazione e la riproduzione utilizzando una
scheda di memoria SxS caricata nell’altro slot per
schede.

Se I'operazione di formattazione non & riuscita
L’operazione di formattazione potrebbe non
riuscire perché la scheda di memoria SxS ¢
protetta dalla scrittura, o perché non si tratta del
tipo di scheda specificato per 1’uso con questo
camcorder.

In questo caso, appare un messaggio di errore.
Seguire le istruzioni indicate nel messaggio di
errore e cambiare la scheda con una scheda di
memoria SxS che possa essere utilizzata con
questo camcorder.

Per eseguire la formattazione attraverso
operazioni del menu

Quando non viene visualizzato alcun messaggio
relativo alla formattazione, € possibile eseguirla
attraverso operazioni del menu.

1 Selezionare OPERATION >Format
Media nel menu di impostazione(vedere
pagina 119).

2 Selezionare [Media(A)] (slot A) o
[Media(B)] (slot B).

3 Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

Il messaggio di conferma della formattazione
viene visualizzato sullo schermo del mirino.

4 Ruotarela manopola MENU per
selezionare “Execute”, quindi premere
la manopola.

La formattazione viene avviata.

Durante la formattazione, appare un’indicazione
sullo stato dell’operazione (%), e 1a spia ACCESS
diventa arancione.

Al termine della formattazione, il messaggio di
completamento viene visualizzato per tre
secondi.

Utilizzo delle schede di memoria SxS
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¢ Quando si formatta una scheda di memoria vengono
cancellati tutti i dati, compresi i file di installazione.

« Utilizzare la funzione di formattazione di questo
camcorder per formattare le schede di memoria SxS
per I’uso su questo camcorder. Le formattazioni di
schede formattate su altri dispositivi non vengono
riconosciute come formattazioni valide, rendendo
necessario formattarle nuovamente su questo
camcorder.

Se si carica una scheda di
memoria formattata in una
modalita di registrazione diversa
da quella selezionata sul
camcorder

Appare un messaggio di errore 0 un messaggio

per verificare se si deve eseguire la formattazione.

Casi in cui appare un messaggio di errore

Il messaggio “Cannot Use Media(A)/

Unsupported File System” appare nel mirino nei

seguenti casi.

* Una scheda di memoria SxS utilizzata per la
registrazione in modalitda UDF ¢ stata caricata
nel camcorder impostato sulla modalita FAT.

* Una scheda di memoria SxS utilizzata per la
registrazione in modalitd FAT & stata caricata
nel camcorder impostato sulla modalita UDF.

¢ Una scheda di memoria SxS formattata in
modalita FAT ¢ stata caricata nel camcorder
impostato sulla modalita UDF.

Casi in cui appare un messaggio per verificare
se si deve eseguire la formattazione

Quando una scheda di memoria SxS formattata in
modalitd UDF ¢ stata caricata nel camcorder
impostato sulla modalita FAT, nel mirino appare
un messaggio per verificare se si deve eseguire la
formattazione in modalita FAT (vedere

pagina 71).

Controllo del Tempo di
registrazione residuo

E possibile controllare la capacita rimanente delle
schede di memoria SxS caricate nei due slot
controllando il riquadro della capacita residua del
supporto di registrazione nel mirino.

Utilizzo delle schede di memoria SxS

:00:00
t ND2 A:
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60min

120min 88F1.6

Il camcorder calcola il tempo di registrazione
residuo del supporto di ogni slot a seconda del
formato video attuale (bit rate di registrazione), e
lo visualizza indicando le unita dei minuti.

E inoltre possibile controllare il tempo residuo
nella schermata di stato BATTERY/MEDIA
(vedere pagina 67).

L’indicatore (@ appare quando una scheda di memoria
¢ protetta da scrittura.

Quando cambiare le schede di memoria
SxS

* Appare il messaggio di avvertenza “Media Near
Full”, gli indicatori WARNING e REC
lampeggiano sullo schermo del mirino, e suona
un segnale acustico quando il tempo totale di
registrazione residuo delle schede di
registrazione scende a cinque minuti durante la
registrazione.

Cambiare una delle schede con un supporto con
una capacita di registrazione disponibile.

Se si continua a registrare, appare il messaggio
“Media Full” e la registrazione si interrompe
quando il tempo totale di registrazione residuo
scende a 0.

Su una scheda di memoria SxS possono essere registrati
fino a 600 clip.

La visualizzazione del tempo di registrazione residuo
cambia a “0” e appare il messaggio “Media Full” quando
viene raggiunto il limite di clip.

Ripristino delle schede di
memoria SxS

Se per qualsiasi ragione si verifica un errore nelle
schede di memoria, la scheda deve essere
ripristinata prima dell’uso.

Quando si carica una scheda di memoria SxS che
deve essere ripristinata, appare un messaggio nel
mirino che chiede se si desidera ripristinarla.



Come ripristinare una scheda

Ruotare la manopola MENU per selezionare
[Execute], quindi premere la manopola.

Viene avviato il ripristino.

Durante il ripristino, appare un messaggio di
esecuzione, viene visualizzato lo stato
dell’operazione (%), e la spia ACCESS diventa
arancione.

Quando termina il ripristino, viene visualizzato
un messaggio di completamento per tre secondi.

Se il ripristino non riesce

¢ Le schede di memoria SxS protette da scrittura
e le schede in cui si sono verificati degli errori
di memoria non possono essere ripristinate. Per
le schede di questo tipo appare un messaggio di
avvertenza. Seguire le istruzioni del messaggio
ed eliminare la protezione da scrittura della
scheda o sostituirla con un’altra scheda.

Le schede di memoria SxS in cui si sono
verificati degli errori di memoria potrebbero
essere riutilizzabili se vengono formattate.

In alcuni casi, vi sono dei clip che possono
essere ripristinati, mentre altri che invece non
consentono tale operazione. I clip ripristinati
possono essere riprodotti normalmente.

Se continua ad apparire il messaggio “Could not
Restore Some Clips” in seguito a dei ripetuti
tentativi di ripristino, potrebbe essere possibile
ripristinare la scheda di memoria SxS con la
procedura seguente.

@ Utilizzare la funzione di copia del
camcorder (vedere pagina 107) o il
software di applicazione in dotazione
(vedere pagina 187) per copiare i clip
necessari su un’altra scheda di memoria
SxS.

® Formattare la scheda di memoria SxS
inutilizzabile sul camcorder.

(® Copiare i clip necessari di nuovo sulla
scheda di memoria SxS recentemente
formattata.

Registrazione e riproduzione durante il ripristino
Anche quando il ripristino ¢ in corso, ¢ possibile
registrare e riprodurre una scheda di memoria
SxS in un altro slot per schede.

Per il ripristino dei supporti registrati con questo
camcorder, assicurarsi di usare questo camcorder. I
supporti registrati con un dispositivo diverso da questo
camcorder o con una versione differente del stesso
camcorder (anche se si tratta dello stesso modello)
potrebbero non poter essere ripristinati con questo
camcorder.

Utilizzo delle schede di memoria SxS
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Utilizzo delle unita flash
USB

In modalita UDF. ¢ possibile connettere un'unita

flash USB connessa al dispositivo esterno per

registrare, salvare e caricare i seguenti dati.

* Registrare dati proxy (vedere pagina 88)

* Caricare i file metadata di pianificazione
(vedere pagina 90)

e Salvare e caricare dati di impostazione (vedere
pagina 176)

Se si desidera utilizzare unita di memoria flash
USB Sony con questo camcorder, si consiglia di
utilizzare memorie della serie Pocket Bit Hi-
Speed LX.

« Utilizzare unicamente unita di memoria flash USB con
una capacita di 4 GB o superiore.

* Le unita flash USB di tipo diverso da quelli consigliati
potrebbero non essere riconosciute una volta collegate
al connettore USB.

Formattazione (Inizializzazione)
delle unita flash USB

Le unita flash USB devono essere formattate con
il file system FAT32.

Prima di usare un’unita, formattarla sul camcorder o su
un PC. Se un'unita formattata su un PC non puo essere
usata, formattarla sul camcorder.

1 Collegare un’unita flash USB al
connettore di un dispositivo esterno.
Quando I’unita non & formattata o ¢ stata
formatta secondo altre specifiche, sullo
schermo del mirino appare un messaggio di
conferma della necessita di esecuzione della
formattazione.

Utilizzo delle unita flash USB

2 Ruotarela manopola MENU per
selezionare “Execute”, quindi premere
la manopola.

Una volta eseguita la formattazione, appare il
messaggio “Format USB Memory Done”.
La cartella AMSSONY\PRO\XDCAM\
MEMDISC e quella\General\Sony\Planning
sono create automaticamente nell’unita.

Se I'operazione di formattazione non @ riuscita
L’operazione di formattazione potrebbe non
riuscire perché I’unita flash USB ¢ protetta dalla
scrittura, o perché non si tratta del tipo di unita
specificato per I’uso con questo camcorder.

In questo caso, appare un messaggio di errore.
Seguire le istruzioni indicate nel messaggio di
errore e cambiare 1’unita con una che possa essere
utilizzata con questo camcorder.

Per eseguire la formattazione attraverso
operazioni del menu

Quando non viene visualizzato alcun messaggio
relativo alla formattazione, & possibile eseguirla
attraverso operazioni del menu.

1 Collegare un’unita flash USB al
connettore di un dispositivo esterno.

2 Selezionare OPERATION >USB >
Format USB Memory nel menu di
impostazione.

3 Ruotarela manopola MENU per
selezionare [Execute], quindi premere
la manopola.

Il messaggio di conferma della formattazione
viene visualizzato sullo schermo del mirino.

4 Ruotare la manopola MENU per
selezionare “Execute”, quindi premere
la manopola.

Appare un’indicazione sullo stato
dell’operazione (%) e la formattazione viene
avviata.

Una volta eseguita la formattazione, appare il
messaggio “Format USB Memory Done”.
La cartella \MSSONY\PRO\XDCAM\
MEMDISC e quella \General\Sony\Planning
sono create automaticamente nell’unita.



¢ Quando si formatta un’unita flash USB vengono

cancellati tutti i dati, compresi i file di installazione.

« Utilizzare la funzione di formattazione di questo

camcorder per formattare le unita flash USB per I'uso

su questo camcorder. Le formattazioni di unita
formattate su altri dispositivi non vengono
riconosciute come formattazioni valide, rendendo
necessario formattarle nuovamente su questo
camcorder.

Ripristino delle unita flash USB

Quando si carica un’unita flash USB che pud
essere montata normalmente in quanto file
system ¢ distrutto, sullo schermo del mirino &
visualizzato un messaggio di richiesta se si
desidera ripristinare 1’unita.

Premendo la manopola MENU dopo averla
ruotata per selezionare “Execute” si avvia la
formattazione ed ¢ visualizzata un’indicazione
sullo stato dell’operazione (%).

Una volta eseguita la formattazione, appare il
messaggio “Format USB Memory Done”.

Operazioni di base

Questa sezione spiega le procedure di base per
riprendere e per registrare.
Prima di cominciare a riprendere, esaminare il

sistema della telecamera per verificare che stia
funzionando correttamente.

1

Inserire un pacco batteria
completamente carico (vedere
pagina 34).

Selezionare la modalita di registrazione
(vedere pagina 52).

Caricare una o due schede di memoria
SxS (vedere pagina 69).

Se si caricano due schede di memoria, il
camcorder passa automaticamente alla
seconda scheda quando la prima scheda si
esaurisce.

Impostare ’interruttore POWER del
camcorder (vedere pagina 12) su ON.

Eseguire le seguenti impostazioni.

Visualizzazione degli indicatori: On
(vedere pagina 126)

Diaframma: Auto (vedere pagina 58)

Zoom: Auto

Immagine della telecamera: selezionare
I’immagine che si sta riprendendo
(immagine della telecamera), e attivare
la funzione DCC (vedere pagina 16).

Modalita di avanzamento del codice
temporale: F-RUN (Free Run) o R-
RUN (Rec Run) (vedere pagina 62)

Selezione del canale di ingresso audio:
Auto (vedere pagina 24)

Premere ’'interruttore AUTO W/B
BAL sul lato BLACK per regolare il
bilanciamento del nero (vedere
pagina 53).

Operazioni di base
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7 Selezionare un filtro a seconda delle
condizioni di illuminazione, e regolare il
bilanciamento del bianco (vedere
pagina 54).

8 Puntare il camcorder sul soggetto, e
regolare la messa a fuoco e lo zoom.

9  Sesi sta utilizzando un otturatore
elettronico, selezionare la modalita e la
velocita dell’otturatore adeguate
(vedere pagina 56).

10 Eseguire una delle procedure indicate

di seguito per avviare la registrazione.

- Premere il pulsante REC START (vedere
pagina 14).

- Premere il pulsante VTR sull’obiettivo.

- Accendere ’interruttore programmabile al
quale ¢ stata assegnata la funzione
Registrazione (vedere pagina 173).

Durante la registrazione, gli indicatori
TALLY, I'indicatore Tally sul pannello
anteriore del mirino, e I’indicatore REC nello
schermo del mirino si illuminano. Regolare
lo zoom e la messa a fuoco come richiesto.

* Non rimuovere il pacco batteria mentre il
camcorder ¢ in fase di registrazione (mentre la
spia ACCESS sul pannello a destra ¢ accesa in blu
e la spia ACCESS nello slot della scheda & accesa
in arancione). L’operazione comporta il rischio di
perdere vari secondi di dati prima di interrompere
la registrazione, perché I’elaborazione interna
non termina normalmente.

I pulsanti di controllo per la riproduzione
(EJECT, F REV, F FWD, NEXT, PREV, PLAY/
PAUSE, STOP) non funzionano durante la
registrazione.

11 Per interrompere la registrazione,
eseguire una delle operazioni elencate
nel punto 10.

Gli indicatori TALLY, I’indicatore Tally sul
pannello anteriore del mirino e I’indicatore
REC nello schermo del mirino si spengono, e
il camcorder entra in modalita standby di
registrazione (STBY).

E possibile creare dei clip a partire dai dati
video e audio e dai metadati registrati tra i
punti 10 e 11.

Operazioni di base

Quando la modalita di registrazione & UDF, se si
interrompe la registrazione entro 2 secondi
dall’avvio, viene registrato un clip di due secondi.

Come controllare la registrazione
(visualizzazione registrazione)

Quando il camcorder si trova in modalita
standby di registrazione (STBY), accendere
I’interruttore programmabile sulla funzione
Rec Review o la funzione Freeze Mix alla
quale ¢ stato assegnato (vedere pagina 171).
Il camcorder riproduce I’intero ultimo clip, o
gli ultimi secondi di quel clip (tre o dieci
secondi) e quindi ritorna alla modalita di
standby.

E possibile utilizzare MAINTENANCE
>Camera Config >Rec Review nel menu di
impostazione (vedere pagina 153) per
cambiare il tempo di riproduzione.

Quando la funzione Rec Review viene
assegnata al pulsante RET sull’obiettivo, si
puo anche effettuare una visualizzazione
utilizzando il pulsante RET.

12 Ripetere i punti 10 e 11 per continuare
la registrazione.
Con ogni ripetizione viene creato un nuovo
clip sulla scheda di memoria.

Clip 1 Clip 2 Clip 3
REC REC /REC REC /REC REC
START STOP/ START STOP/ START STOP

Non ¢ possibile riprendere la registrazione per circa un
secondo dopo aver fermato la registrazione.

Il numero massimo di clip che possono essere registrati
su una scheda di memoria & di 600. Anche se la scheda
di memoria dispone di sufficiente capacita per
registrare ulteriori clip, quando sono stati registrati 600
clip, non & possibile procedere con la registrazione.

Dimensioni dei clip

I formati dei clip variano in base ai formati del
file.



Format Dimensione del Dimensione del clip

o del file file

MP4 Meno di 4 GB Meno di trenta minuti

Meno di 9 minuti e
30 secondi

AVI Meno di 2 GB

MXF Meno di 43 GB  Meno di 6 ore

Se si continua a registrare durante un lungo
periodo di tempo, le registrazioni potrebbero
essere segmentate in vari file, a seconda delle
dimensioni del file (il numero massimo di
partizioni & di 99).

Il camcorder considera le registrazioni continue
come un unico clip anche se questo ¢ stato
segmentato in vari file.

Nomi dei clip

I'nomi di clip a otto caratteri (che consistono in un
prefisso di quattro caratteri e un numero di quattro
cifre) vengono generati automaticamente per i
clip registrati con questo camcorder.

Esempio: ABCD0001

E anche possibile usare OPERATION >Clip
>Title Prefix (vedere pagina 135) nel menu di
impostazione per impostare il prefisso del nome
del clip con una stringa di caratteri specificata
dall’utente (lunghezza massima da 4 a 46
caratteri). (Un prefisso specificato dall’utente non
puo essere modificato dopo la registrazione.)

Il numero da quattro cifre alla fine dei nomi di
clip viene generato automaticamente e aumenta in
ordine, man mano che i clip vengono registrati.

Riproduzione dei clip registrati

Quando il camcorder ¢ in modalita standby
(STBY), ¢ possibile riprodurre tutti o una parte
degli ultimi clip registrati (vedere pagina 76).

1 Inserire unascheda di memoria SxS per
la riproduzione (vedere pagina 69).

2 Premereil pulsante PREV (vedere
pagina 19) o il pulsante F REV (vedere
pagina 19) per caricare i clip da
riprodurre.

3 Premereil pulsante PLAY/PAUSE.
L’indicatore PLAY/PAUSE siillumina, e nel
mirino appare I’'immagine di riproduzione.

Come interrompere la riproduzione

Premere il pulsante PLAY/PAUSE.

Durante la pausa I’indicatore PLAY/PAUSE
lampeggia.

Premere il pulsante nuovamente per tornare alla
modalita di riproduzione.

Come riprodurre ad alta velocita

Premere il pulsante F FWD (vedere pagina 19) o
il pulsante F REV (vedere pagina 19).

Per tornare alla riproduzione normale premere il
pulsante PLAY/PAUSE.

Come passare da una scheda di memoria
all’altra

Quando sono caricate due schede di memoria,
premere il pulsante SLOT SELECT (vedere
pagina 23) per selezionare lo slot attivo.

Non ¢ possibile passare da una scheda di memoria
all’altra durante la riproduzione.

Come terminare la riproduzione

Premere il pulsante STOP: La riproduzione si
interrompe e il camcorder entra in modalita
E-E.

Premere il pulsante THUMBNAIL: La
riproduzione si interrompe e appare una
schermata delle miniature (vedere
pagina 94) nel mirino.

La riproduzione si interrompe e la schermata del

codice temporale appare nel mirino anche quando

si avvia laregistrazione durante lariproduzione, e

quando si espelle una scheda di memoria SxS.

Per visualizzare 'immagine del
camcorder durante la riproduzione
(funzione Live & Play)

La funzione Live & Play consente di visualizzare
I’immagine del camcorder (video in diretta) sullo
schermo del mirino durante la riproduzione.

Cio consente di inquadrare la prossima scena o
regolare la messa a fuoco e 1’esposizione mentre
si controlla I’immagine del camcorder (video in
diretta) sullo schermo del mirino. Per inquadrare
la scena successiva ¢ possibile usare questa
funzione insieme a quella Freeze Mix (vedere
pagina 87).

La funzione Live & Play ¢ abilitata quando il
camcorder € impostato come segue.

Operazioni di base
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HD/SD Numero di righe di Frequenza di
sistema sistema

HD 1080 1920/59.94i
1920/501

1440/59.94i

1440/50i

720 1280/59.94P
1280/50P

SD - 59.94i
50i
59.94i
50i

Per usare la funzione Live & Play impostare
OPERATION >Output >Live&Play nel menu di
impostazione su [On].

« Non ¢ possibile attivare e disattivare la funzione Live
& Play durante la riproduzione o visualizzazione delle
miniature.

* Lafunzione Live & Play non & disponibile in modalita
Frame Rec, Interval Rec, e Slow & Quick Motion e
quando la funzione Slow Shutter ¢ attivata.

 Per usare la funzione Live & Play insieme a quella
Freeze Mix, iniziare operando mentre si visualizza il
monitor LCD (con il pulsante DISP SEL/EXPAND
premuto per impostare la modalita di visualizzazione
differente da STATUS). Al termine dell’operazione e
quando la funzione Freeze Mix ¢ attivata, la stessa
immagine sara visualizzata sullo schermo del mirino.

* Non ¢ possibile passare dall'immagine di riproduzione
all'immagine del camcorder quando si sta
riproducendo un clip che sia stato registrato con un
numero di linee di sistema o una frequenza di sistema
differenti dalle impostazioni attuali del camcorder.

* L'uscita dal connettore HD/SD SDI OUT e dal
connettore VIDEO OUT potrebbe bloccarsi
momentaneamente quando 1'uscita passa da immagine
di riproduzione a immagine del camcorder.

Eliminazione dei clip registrati

E possibile utilizzare gli interruttori
programmabili per cancellare gli ultimi clip
registrati (funzione Last Clip DEL).

E inoltre possibile utilizzare il menu THUMBNAIL
per cancellare tutti i clip registrati (funzione All
Clips DEL) o per cancellare i clip selezionati. Per
ulteriori informazioni, vedere “Eliminazione di clip’
(pagina 108).

3

Operazioni di base

Accendere ’interruttore
programmabile al quale & stata
assegnata la funzione Last Clip DEL
(vedere pagina 172).

Appare un messaggio di conferma.

Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.
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Registrazione di indicatori di
ripresa

[vor ) Faro]

Su questo camcorder, nella modalita HD sono
disponibili due tipi di indicatori di ripresa. B
possibile registrarli su posizioni personalizzate
per facilitare gli editor nel caricamento di tali
posizioni.

Il numero massimo di indicatori di ripresa per clip
varia in base ai formati dei file.

Formato del file Numero massimo
MP4 127
MXF 999

Nella modalita SD non ¢ possibile registrare indicatori di
ripresa.

E possibile utilizzare il menu THUMBNAIL per
aggiungere e cancellare gli indicatori di ripresa
presenti nei clip. Per ulteriori informazioni, vedere
“Aggiunta ed eliminazione degli indicatori di
ripresa” (pagina 110).

Come registrare indicatori di ripresa

Eseguire una delle procedure indicate di seguito.
« Attivare un interruttore programmabile a cui &
stato assegnato I’indicatore Shot Mark 1 o Shot
Mark 2 (vedere pagina 171).
* Se Lens RET ¢ stata assegnata al pulsante RET
sull’obiettivo, agire come descritto di seguito.
Come registrare indicatore di ripresa 1:
premere il pulsante RET una volta.

Come registrare indicatore di ripresa 2:
premere il pulsante RET due volte in rapida
successione.

Quando viene registrato un indicatore di ripresa,
appare I’indicazione “Shot Mark 1” o “Shot Mark
2” sul mirino per circa tre secondi vicino
all’indicazione del codice temporale.

Impostazione degli indicatori OK

[vor ) Faro]

Per facilitare agli editor la selezione di buoni clip,
¢ possibile impostare degli indicatori OK sui clip
registrati in modalita HD.

Gli indicatori OK non possono essere impostati o
eliminati durante la registrazione o la riproduzione.

Come impostare/cancellare gli indicatori
0K

E possibile utilizzare il menu THUMBNAIL per
aggiungere e cancellare gli indicatori OK nei clip
registrati anteriormente. Per ulteriori
informazioni, vedere “Aggiunta ed eliminazione
di indicatori OK, NG o KP” (pagina 105).

Cominciare a registrare da video
memorizzati in precedenza
(funzione Picture Cache)

Il camcorder ¢ dotato di sufficiente memoria
interna da poter pre-salvare fino a 15 secondi di
dati video e audio in una picture cache. Cio
consente di cominciare un certo numero di
secondi in anticipo prima di premere il pulsante di
avvio della registrazione.

Selezione della modalita Picture Cache e
impostazione del tempo di Picture Cache

Prima di registrare in modalita Picture Cache, &
necessario selezionare la modalita Picture Cache
e impostare il tempo di Picture Cache (il numero
di secondi di dati video e audio memorizzati nella
memoria) nel menu OPERATION.

11 tempo di Picture Cache determina quanto in
anticipo € possibile cominciare la registrazione,
eseguendo il conto alla rovescia dei secondi
dall’ operazione che avvia la registrazione. Notare
che potrebbe non essere possibile cominciare
molto in anticipo nei casi speciali spiegati nelle
note seguenti.

» La memorizzazione dei dati immagine nella memoria
comincia quando si selezione la modalita Picture
Cache. Di conseguenza, se si comincia a registrare
immediatamente dopo aver selezionato la modalita

Operazioni avanzate
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Picture Cache, i dati immagine precedenti alla
selezione non vengono registrati.

* Non viene registrato alcun dato nella memoria Picture
Cache durante la revisione della riproduzione o della
registrazione e la visualizzazione di miniature. Non &
possibile registrare dati immagine dal punto in cui si
stava eseguendo la riproduzione o la revisione della
registrazione.

Come selezionare la modalita Picture Cache e
impostare il tempo di Picture Cache

La registrazione Picture Cache non & possibile nelle
modalita Frame Rec, Interval Rec, Slow & Quick
Motion e Clip Continuous Rec. Il camcorder esce dalle
modalita Frame Rec, Interval Rec, Slow & Quick
Motion o Clip Continuous Rec ogni volta che si
seleziona la modalita Picture Cache. Il camcorder esce
dalla modalita Picture Cache automaticamente ogni
volta che si selezionano le modalita Frame Rec,
Interval Rec, Slow & Quick Motion o Clip Continuous
Rec.

I dati memorizzati nella memoria Picture Cache
vengono cancellati quando si cambiano le
impostazioni di sistema, per esempio selezionando un
formato video diverso. I dati immagine presenti prima
del cambio non vengono registrati anche se si avvia la
registrazione immediatamente dopo il cambio. Il
camcorder esce dalla modalita Picture Cache
automaticamente.

Non ¢ possibile impostare il tempo di Picture Cache
durante la registrazione.

1 Nel menu di impostazione, selezionare
OPERATION >Rec Function >Picture
Cache Rec.

Per informazioni sulle operazioni del menu,
vedere “Operazioni di base del menu di
impostazione” (pagina 114).

2 Ruotarela manopola MENU per
selezionare [On], e quindi premere la
manopola.

3 Selezionare [P. Cache Rec Time],
ruotare la manopola MENU per
selezionare il tempo di Picture Cache
desiderato, e quindi premere la
manopola.

E possibile selezionare tra 0-2 secondi, 2-4
secondi, 4-6 secondi, 6-8 secondi, 8-10
secondi, 10-12 secondi, 12-14 secondi, e 13-
15 secondi.

Operazioni avanzate

Una volta terminato, le impostazioni sulla
modalita Picture Cache saranno effettive finché
non vengono cambiate.

Invece di eseguire i punti 1 € 2, & anche possibile
selezionare la modalita Picture Cache utilizzando
un interruttore programmabile al quale ¢ stata
assegnata la funzione Picture Cache (vedere
pagina 171).

Gestione dei dati del camcorder durante la
registrazione in modalita Picture Cache

Le procedure di registrazione nella modalita
Picture Cache sono praticamente equivalenti alle
normali procedure di registrazione. Tuttavia,
notare le seguenti differenze rispetto a come il
camcorder gestisce i dati video, del tempo, e di
uscita.

* Se si avvia la registrazione mentre si sta
eseguendo I’accesso al supporto, il punto di
avvio del video effettivamente registrato
potrebbe essere successivo rispetto al tempo di
Picture Cache specificato. Dato che il ritardo
aumenta man mano che aumenta il numero di
clip registrati, sarebbe necessario evitare rapidi
avvii e interruzioni delle operazioni di
registrazione nella modalita Picture Cache.
Indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN, la
modalita di avanzamento del generatore di
codici temporali interno ¢ sempre F-RUN.
Nella modalita Picture Cache, non ¢ possibile
impostare i dati temporali impostando
I’interruttore F-RUN/SET/R-RUN su SET.
Come inserire i dati temporali, uscire dalla
modalita Picture Cache.

Se la capacita residua del supporto nello slot
attualmente selezionato ¢ inferiore rispetto alla
durata di Picture Cache, e il supporto nell’altro
slot dispone di sufficiente capacita residua, i
dati vengono registrati nel supporto dell’altro
slot.

Tuttavia, non viene registrato alcun dato
quando nell’altro slot non vi & alcun supporto, e
quando il supporto nell’altro slot non dispone di
sufficiente capacita residua. (Appare un
messaggio nel mirino per informare I’ utente che
non vi & una capacita residua sufficiente).

Gli indicatori di ripresa non vengono registrati
se vengono impostati prima dell’operazione di
avvio della registrazione.

Se si seleziona un formato video che supporta il
segnale i.LINK HDV e si riproduce un clip
registrato in modalita picture cache, due o piu



fotogrammi con la stessa immagine e lo stesso
codice temporale potrebbero susseguirsi.

* Durante la registrazione Picture Cache &
possibile la trasmissione i. LINK. Tuttavia, il
tempo di Picture Cache ¢ limitato.

Se si verifica una perdita di alimentazione

durante la registrazione

* Se si imposta I’interruttore POWER del
camcorder su OFF, il camcorder si spegne
automaticamente dopo qualche secondo,
durante il quale viene effettuato I’accesso al
supporto per registrare i dati video e audio
memorizzati nella memoria del camcorder fino
a quel momento.

« Se si perde I’alimentazione perché & stata
rimossa la batteria, ¢ stato scollegato il cavo
CC, o ¢ stato spento I’apparecchio sul lato
dell’adattatore CA, vengono persi i dati video e
audio memorizzati nella memoria. I dati
memorizzati nella memoria non vengono
registrati. Prestare attenzione per evitare che cio
si verifichi quando si cambia la batteria.

Registrazione ripresa a
fotogrammi temporizzati
(funzione Interval Rec)

La funzione Interval Rec del camcorder consente
di eseguire la ripresa di fotogrammi temporizzati
tramite la memoria interna del camcorder. Questa
funzione costituisce un modo efficiente di
riprendere i soggetti che si muovono lentamente.
Quando si comincia a registrare, il camcorder
registra automaticamente un numero di
fotogrammi specificato con un tempo di
intervallo specificato.

Tempo di intervallo

I_l_l

//

Numero di fotogrammi in una ripresa

Quando Interval Rec viene abilitato & disponibile
un’opzione di preilluminazione. Questa funzione
accende automaticamente una luce video prima
che si avvii laregistrazione, in modo da registrare
le immagini in condizioni di temperatura del
colore e di illuminazione costanti.

Riprese e impostazioni Interval Rec

* La funzione Interval Rec non puo essere utilizzata
contemporaneamente alle funzioni Picture Cache,
Frame Rec, Slow & Quick Motion o Clip Continuous
Rec. Quando si seleziona la modalita Interval Rec, le
funzioni Picture Cache, Frame Rec, Slow & Quick
Motion e Clip Continuous Rec sono disabilitate.
Quando si selezionano le modalita Picture Cache,
Frame Rec, Slow & Quick Motion o Clip Continuous
Rec, la funzione Interval Rec viene disabilitata.

I dati memorizzati nella memoria Picture Cache
vengono cancellati quando si cambiano le
impostazioni di sistema, per esempio selezionando un
formato video diverso. I dati immagine presenti prima
del cambio non vengono registrati anche se si avvia la
registrazione immediatamente dopo il cambio. Il
camcorder esce dalla modalita Picture Cache
automaticamente.

Le impostazioni Interval Rec non possono essere
cambiate durante la registrazione.

Interval Rec viene disabilitato quando vengono

selezionati i formati seguenti.

- In modalita FAT, SP 1440/59.94i o SP 1440/50i,
quando I’'impostazione di uscita @ HD e
OPERATION >Input/Output >i.LINK I/O nel menu
di impostazione ¢ impostato su [Enable]

- In modalita FAT, SP 1440/23.98P (registrazione di

riduzione)

In modalita UDF, HD420 HQ 1280x720/23.98P

(registrazione di riduzione)

Diverso da HQ 1920/23.98P o HQ 1280/23.98P,

quando I’'impostazione di uscita ¢ SD e

OPERATION >Input/Output >i.LINK I/O nel menu

di impostazione & impostato su [Enable]

Come eseguire le impostazioni Interval Rec

1 Selezionare OPERATION >Rec
Function >Interval Rec nel menu di
impostazione.

Per informazioni sulle operazioni del menu,
vedere “Operazioni di base del menu di
impostazione” (pagina 114).

Operazioni avanzate
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2 Ruotare la manopola MENU per
selezionare [On], e quindi premere la
manopola.

Il camcorder entra nella modalita Interval
Rec, I’indicazione “Interval” sullo schermo
del mirino lampeggia.

(Anche I'indicatore tally verde del mirino
della serie HDVF lampeggia.)

3 Selezionare [Number of Frames],
ruotare la manopola MENU per
selezionare il numero di fotogrammi da
registrare in una ripresa, e quindi
premere la manopola.

E possibile selezionare tra 1, 3, 6, 9 (o tra 2,
6, 12 quando I’impostazione del formato
video & 720/59.94P o 720/50P).

4 Selezionare [Interval Time], ruotare la
manopola MENU per selezionare
P’intervallo desiderato, e quindi
premere la manopola.

E possibile selezionare 1 su 10/15/20/30/40/
50 secondi, 1 su 10/15/20/30/40/50 minuti, 1
su 4/6/12/24 ore.

5 Se necessario, selezionare [Pre-
Lighting], ruotare la manopola MENU
per selezionare la durata del tempo di
illuminazione prima che si avvii la
registrazione, e quindi premere la
manopola.

E possibile selezionare 1 su 10/15/20/30/40/
50 secondi, 1 su 10/15/20/30/40/50 minuti, 1
su 4/6/12/24 ore.

Se si desidera accendere la luce video prima dell’avvio
della registrazione, impostare I’interruttore LIGHT del
camcorder su [AUTO]. Anche I’interruttore della luce
video deve essere acceso. Una volta eseguita tale
operazione, la luce video si accende e si spegne
automaticamente. Tuttavia, la luce video rimane
accesa quando sono trascorsi cinque secondi 0 meno
da quando ¢ stata spenta.

Se siimposta I’interruttore LIGHT su [MANUAL] e si
accende I’interruttore della luce video, la luce video &
sempre accesa. (Non si accede e spegne
automaticamente.)

Operazioni avanzate

Il camcorder esce dalla modalita Interval Rec
quando viene spento, ma vengono mantenute le
impostazioni del numero di fotogrammi, del
tempo di intervallo, e di preilluminazione. Non
sara necessario impostarle nuovamente la
prossima volta che si riprende in modalita
Interval Rec.

Come riprendere in modalita Interval Rec
Eseguire le impostazioni e le operazioni
preliminari descritte in “Operazioni di base”
(pagina 75), fissare il camcorder saldamente in
maniera che non si muova e cominciare a
riprendere.

Quando si avvia la registrazione, 1’indicazione
“Interval” sul mirino cambia da lampeggiante ad
accesa, e “INT REC” e “INT STBY” appaiono
alternati nella posizione dell’indicatore REC. Gli
indicatori TALLY e I’indicatore Tally sul
pannello anteriore del mirino si accendono come
accade durante una registrazione normale.
(L’indicatore tally verde del mirino lampeggia a
frequenze elevate.)

Se si sta utilizzando la funzione di
preilluminazione, la luce video si accende prima
che la registrazione si avvii.

Come arrestare la ripresa
Arrestare la registrazione.

Quando la ripresa termina, i dati video
memorizzati nella memoria fino a quel punto
vengono trascritti sul supporto.

Come uscire dalla modalita Interval Rec

Eseguire una delle procedure indicate di seguito.

* Impostare I’interruttore POWER su OFF.

¢ Quando il camcorder si trova in modalita
standby di registrazione, impostare
OPERATION >Rec Function >Interval Rec nel
menu di impostazione su “Off”.

Limitazioni durante la registrazione

* Il connettore i. LINK (HDV/DV) non puo essere
utilizzato.

* Indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN, la
modalita di avanzamento del generatore di
codici temporali interno & sempre F-RUN.

* L’audio non puo essere registrato.

* La visualizzazione della registrazione non &
possibile.



« Se si preme il pulsante SLOT SELECT, il
camcorder completa la registrazione del
numero di fotogrammi specificato, crea un clip,
e passa all’altro supporto. (Quando la modalita
di registrazione & UDF.)

* Non ¢ possibile eseguire la funzione Genlock.

Se si verifica una perdita di alimentazione
durante la registrazione

« Se si imposta I’interruttore POWER del
camcorder su OFF, il camcorder si spegne
automaticamente dopo qualche secondo,
durante il quale viene effettuato 1’accesso al
supporto per registrare i dati video e audio
memorizzati nella memoria del camcorder fino
a quel momento.

Se si verifica una perdita di alimentazione
perché viene rimossa la batteria, perché ¢ stato
scollegato il cavo di alimentazione CC, o
I’apparecchio ¢ stato spento sul lato
dell’adattatore CA, potrebbero andare persi i
dati video e audio ripresi fino a quel punto
(massimo 10 secondi). Prestare attenzione per
evitare che cio si verifichi quando si cambia la
batteria.

Ripresa di Animation Stop Motion
(Funzione Frame Rec)

La funzione Frame Rec ¢ utile per riprendere
animazioni stop motion, come le animazioni con
marionette o statuette di argilla.

Ogni volta che viene premuto il pulsante di avvio
della registrazione, il camcorder riprende un
numero di fotogrammi specificato e quindi si
arresta.

Riprese e impostazioni Frame Rec

¢ La funzione Frame Rec non puo essere utilizzata
contemporaneamente alle funzioni Picture Cache,
Interval Rec, Slow & Quick Motion o Clip Continuous
Rec. Quando si seleziona la modalita Frame Rec, le
funzioni Picture Cache, Interval Rec, Slow & Quick
Motion e Clip Continuous Rec sono disabilitate.
Quando si selezionano le modalita Picture Cache,
Interval Rec, Slow & Quick Motion o Clip Continuous
Rec, la funzione Frame Rec viene disabilitata.

I dati memorizzati nella memoria vengono cancellati
quando si cambiano le impostazioni di sistema, per
esempio selezionando un formato video diverso. I dati
immagine presenti prima del cambio non vengono

registrati anche se si avvia la registrazione

immediatamente dopo il cambio. Il camcorder esce

dalla modalita Frame Rec automaticamente.

* Le impostazioni Frame Rec non possono essere
cambiate durante la registrazione.

 Frame Rec viene disabilitato quando vengono
selezionati i formati seguenti.

- In modalita FAT, SP 1440/59.94i o SP 1440/50i,
quando I’'impostazione di uscita @ HD e
OPERATION >Input/Output >i.LINK I/O nel menu
di impostazione & impostato su Enable

- In modalita FAT, SP 1440/23.98P (registrazione di

riduzione)

In modalita UDF, HD420 HQ 1280x720/23.98P
(registrazione di riduzione)

Diverso da HQ 1920/23.98P o HQ 1280/23.98P,
quando I’'impostazione di uscita ¢ SD e
OPERATION >Input/Output >i.LINK I/O nel menu
di impostazione & impostato su Enable

Come eseguire le impostazioni Frame Rec

1 Selezionare OPERATION >Rec
Function >Frame Rec nel menu di
impostazione.

Per informazioni sulle operazioni del menu,
vedere “Operazioni di base del menu di
impostazione” (pagina 114).

2 Ruotare la manopola MENU per
selezionare [On], e quindi premere la
manopola.

Il camcorder entra nella modalita Frame Rec,
I’indicazione “Frame Rec” sullo schermo del
mirino lampeggia.

(Anche ’indicatore tally verde del mirino
della serie HDVF lampeggia.)

3 Selezionare [Number of Frames],
ruotare la manopola MENU per
selezionare il numero di fotogrammi da
registrare in una ripresa, e quindi
premere la manopola.

E possibile selezionare tra 1, 3,6, 9 (o tra 2,
6, 12 quando I’'impostazione del formato
video & 720/59.94P o 720/50P).

Il camcorder esce dalla modalita Frame Rec
quando viene spento, ma viene mantenuta
I’impostazione del numero di fotogrammi. Non
sara necessario impostarla nuovamente la
prossima volta che si riprende in modalita Frame
Rec.

Operazioni avanzate
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Come riprendere in modalita Frame Rec
Eseguire le impostazioni e le operazioni
preliminari descritte in “Operazioni di base”
(pagina 75), fissare il camcorder saldamente in
maniera che non si muova e cominciare a
riprendere.

Quando si avvia la registrazione, I’indicazione
“Frame Rec” sul mirino cambia da lampeggiante
ad accesa, € “FRM REC” ¢ “FRM STBY”
appaiono alternati nella posizione dell’indicatore
REC. Gli indicatori TALLY e I’indicatore Tally
sul pannello anteriore del mirino si accendono
come accade durante una registrazione normale.

Come arrestare la ripresa
Arrestare la registrazione.

Quando la ripresa termina, i dati video
memorizzati nella memoria fino a quel punto
vengono trascritti sul supporto.

Come uscire dalla modalita Interval Rec

Eseguire una delle procedure indicate di seguito.

¢ Impostare ’interruttore POWER su OFF

¢ Quando il camcorder si trova in modalita
standby di registrazione, impostare
OPERATION >Rec Function >Interval Rec nel
menu di impostazione su “Off”.

Limitazioni durante la registrazione

* Il connettore i. LINK (HDV/DV) non puo essere
utilizzato.

« Indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN, la
modalita di avanzamento del generatore di
codici temporali interno & sempre R-RUN.

* L’audio non puo essere registrato.

* La visualizzazione della registrazione non &
possibile.

« Se si preme il pulsante SLOT SELECT, il
camcorder completa la registrazione del
numero di fotogrammi specificato, crea un clip,
e passa all’altro supporto.

* Non ¢ possibile eseguire la funzione Genlock.

Se si verifica una perdita di alimentazione

durante la registrazione

« Se si imposta I’interruttore POWER del
camcorder su OFF, il camcorder si spegne
automaticamente dopo qualche secondo,
durante il quale viene effettuato 1’accesso al
supporto per registrare i dati video e audio
memorizzati nella memoria del camcorder fino
a quel momento.
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* Se si verifica una perdita di alimentazione
perché viene rimossa la batteria, perché ¢ stato
scollegato il cavo di alimentazione CC, o
I’apparecchio & stato spento sul lato
dell’adattatore CA, potrebbero andare persi i
dati video e audio ripresi fino a quel punto
(massimo 10 secondi). Prestare attenzione per
evitare che cio si verifichi quando si cambia la
batteria.

Ripresa con Slow & Quick Motion

Quando il camcorder si trova in modalita HD e il
formato video (vedere pagina 50)¢ impostato su
uno dei formati elencati di seguito, ¢ possibile
specificare un frame rate di registrazione diverso
dal frame rate di riproduzione.

Impostazioni del menu Formato video

OPERATION >Format
Country File HD System
System Line
NTSC  UDF 1080 HD422 50/29.97P
Areao HD422 50/23.98P
NTSC{) 720 HD422 50/59.94P
Area HD422 50/29.97P
HD422 50/23.98P
FAT 1080 HQ 1920/29.97P
HQ 1920/23.98P
720 HQ 1280/59.94P
HQ 1280/29.97P
HQ 1280/23.98P
PAL UDF 1080 HD422 50/25P
Area 720 HD422 50/25P
HD422 50/50P
FAT 1080 HQ 1920/25P
720 HQ 1280/50P

HQ 1280/25P

Riprendendo con un frame rate che differisce dal
frame rate di riproduzione si possono ottenere
degli effetti di slow motion e quick motion che
sono piu fluidi rispetto alla riproduzione ad alta o
bassa velocita di immagini registrate a un frame
rate normale.

Esempio

Quando il formato video ¢ HQ 1280/23.98P, ¢
possibile ottenere effetti di quick motion
impostando il frame rate da 1 a 23, e ottenere
effetti slow motion impostando il frame rate da 25
a 60.



Riprese e impostazioni Slow & Quick
Motion

La funzione Slow & Quick Motion non puo essere
utilizzata allo stesso tempo delle funzioni Picture
Cache, Interval Rec, Frame Rec o Clip Continuous
Rec. Quando si seleziona la modalita Slow & Quick
Motion, le funzioni Picture Cache, Interval Rec, Frame
Rec e Clip Continuous Rec vengono disabilitate.
Quando si selezionano le modalita Picture Cache,
Frame Rec, Interval Rec o Clip Continuous Rec, la
funzione Slow & Quick Motion viene disabilitata.
Slow & Quick Motion viene disabilitato quando la
funzione Slow Shutter (nel mirino viene visualizzato
“SLS”) viene abilitata. La funzione Slow Shutter viene
disabilitata quando la funzione Slow & Quick Motion
viene abilitata.

Slow & Quick Motion viene disabilitato quando
OPERATION >Input/Output >i. LINK I/O nel menu di
impostazione ¢ impostato su [Enable]. Quando viene
abilitato Slow & Quick Motion, i.LINK I/O viene
fissato su [Disable].

La impostazioni della funzione Slow & Quick Motion
non possono essere cambiate durante la registrazione.

Como eseguire le impostazioni Slow & Quick
Motion

1 Selezionare OPERATION >Rec
Function > Slow & Quick nel menu di
impostazione.

Per informazioni sulle operazioni del menu,
vedere “Operazioni di base del menu di
impostazione” (pagina 114).

2 Ruotare la manopola MENU per
selezionare [On], e quindi premere la
manopola.

Il camcorder entra in modalita Slow & Quick
Motion, e I’indicazione “S&Q STBY” si
accende nel mirino.

3 Selezionare [Frame Rate], ruotare la
manopola MENU per selezionare il
frame rate di registrazione, e quindi
premere la manopola.

La gamma delle impostazioni per il frame
rate ¢ la seguente.

Lineedi Frequenza di fotogrammi
sistema

1080 Quando OPERATION >Format
>Country nel menu di impostazione
¢ impostato su [PAL Area] in
modalita UDF:

dala2s
In modalita FAT o quando
I’impostazione OPERATION
>Format >Country nel menu di
impostazione ¢ diversa da [PAL
Area] in modalita UDF:
dala30

720 Quando OPERATION >Format
>Country nel menu di impostazione
¢ impostato su [PAL Area] in
modalita UDF:

dala50
In modalita FAT o quando
I’'impostazione OPERATION
>Format >Country nel menu di
impostazione ¢ diversa da [PAL
Area] in modalita UDF:
dala60

Quando si termina di eseguire queste
impostazioni, la frequenza di sistema e il frame
rate appaiono sulla parte superiore dello schermo
del mirino. E possibile cambiare il frame rate
mentre si visualizza il riquadro nel mirino
ruotando la manopola MENU.

L’impostazione della modalita Slow & Quick
Motion e il frame rate vengono mantenuti anche
dopo lo spegnimento del camcorder.

Come riprendere in modalita Slow & Quick
Motion

Riprendere come descritto su “Operazioni di
base” (pagina 75).

Quando inizia la registrazione, 1’indicazione
“S&Q STBY” visualizzata nel mirino diventa
“@S&Q REC”. Gli indicatori TALLY e
I’indicatore Tally sul pannello anteriore del
mirino si accendono come accade durante una
registrazione normale.

Come arrestare la ripresa
Arrestare la registrazione.

La registrazione impiega pill tempo del solito per
arrestarsi quando Frame Rate & impostato su un valore
basso (per un frame rate lento).

Operazioni avanzate
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Come uscire dalla modalita Slow & Quick Motion
Quando il camcorder si trova in modalita standby
di registrazione, impostare OPERATION >Rec
Function >Slow & Quick nel menu di
impostazione su [Off].

Limitazioni durante la registrazione

* Il connettore i. LINK (HDV/DV) non puo essere
utilizzato.

« Indipendentemente dall’impostazione
dell’interruttore F-RUN/SET/R-RUN, la
modalita di avanzamento del generatore di
codici temporali interno & sempre R-RUN.

* L’audio non puo essere registrato quando i
frame rate di riproduzione e di registrazione
sono diversi.

* La visualizzazione della registrazione non &
possibile.

« Se si cambia il frame rate di registrazione a un
valore piu veloce della velocita dell’otturatore
attuale, la velocita dell’otturatore viene
cambiata al valore pil lento per cui € possibile
la ripresa.

Esempio: se il frame rate ¢ di 32 fps e la
velocita dell’ otturatore di 1/40, e si cambia il
frame rate a 55 fps, la velocita dell’ otturatore
viene cambiata a 1/60.

Se non ¢ possibile selezionare una velocita
dell’otturatore piu lenta del frame rate di
registrazione.

« Non ¢ possibile eseguire la funzione Genlock.

Registrazione con la funzione
registrazione clip senza
interruzioni

Generalmente, viene creata un clip indipendente
ogni volta che si avvia e interrompe la
registrazione. Tuttavia, questa funzione consente
di avviare e interrompere la registrazione durante
laregistrazione continua della stessa clip, fintanto
che la funzione resta attiva. E un’opzione comoda
quando non si desidera generare un numero
elevato di clip brevi, e si vuole registrare senza
timore di superare il limite massimo di clip. B
comunque facile individuare i punti iniziali di
registrazione, in quanto un indicatore di
identificazione Rec Start viene registrato nel
punto iniziale di registrazione ogni volta che si
avvia la registrazione.

Operazioni avanzate

Impostazioni di Clip Continuous Rec e
ripresa

La funzione Clip Continuous Rec non puo essere
utilizzata contemporaneamente alle funzioni Picture
Cache, Interval Rec, Frame Rec o Slow & Quick
Motion. Quando si seleziona la modalita Clip
Continuous Rec, le funzioni Picture Cache, Interval
Rec, Frame Rec e Slow & Quick Motion sono
disabilitate. Quando si selezionano le modalita Picture
Cache, Frame Rec, Interval Rec o Slow & Quick
Motion, la funzione Clip Continuous Rec viene
disabilitata.

La funzione Clip Continuous Rec viene disabilitata
quando la modalita di registrazione ¢ FAT.

Come eseguire le impostazioni Clip Continuous
Rec

1 Selezionare OPERATION >Rec
Function >Clip Continuous Rec nel
menu di impostazione.

Per ulteriori informazioni sulle operazioni
eseguibili nel menu, vedere “Operazioni di base
del menu di impostazione” (pagina 114).

2 Ruotarela manopola MENU per
selezionare [On], e quindi premere la
manopola.

Sul mirino sara visualizzato “CONT” e la
funzione sara abilitata.

E possibile assegnare la funzione Clip
Continuous Rec on/off a uno degli interruttori
ASSIGN 1/2/3, agli interruttori ASSIGNABLE
4/5 e al pulsante COLOR TEMP.

Per ulteriori informazioni, vedere “Assegnazione di
Sfunzioni agli interruttori programmabili”
(pagina 171).

Come riprendere in modalita Clip Continuous
Rec

Riprendere come descritto su “Operazioni di
base” (pagina 75).

Quando si avvia la registrazione, 1’indicazione
“Cont” sul mirino diventa “@REC”.

Gli indicatori TALLY e I’indicatore Tally sul
pannello anteriore del mirino si accendono come
accade durante una registrazione normale.



Durante la registrazione o in modalita di registrazione in
standby (quando I’indicazione “Cont” si illumina), se si
toglie il supporto, la batteria o 1’alimentazione occorrera
ripristinare il supporto. Non & possibile ripristinare il
supporto su un dispositivo diverso da questo camcorder.
Uscire dalla modalita Clip Continuous Rec, (vedere
pagina 87) quindi rimuovere il supporto.

Quando I’indicazione “Cont” lampeggia (1 flash/s), &
possibile rimuovere il supporto.

Come arrestare la ripresa
Arrestare la registrazione.

Arrestare la registrazione dopo che questa continua per
due o piu secondi.

Come uscire dalla modalita Clip Continuous Rec
Quando il camcorder si trova in modalita standby
di registrazione, impostare OPERATION >Rec
Function >Clip Continuous Rec nel menu di
impostazione su [Off].

Limitazioni durante la registrazione

Non ¢ possibile creare un’unica clip senza

interruzioni se si esegue una delle seguenti

operazioni quando il camcorder si trova in

modalita registrazione o standby di registrazione

(all’avvio della registrazione successiva sara

creata una nuova clip).

« Eseguire operazioni su un clip (bloccare,
eliminare o rinominare un clip)

* Modificare il formato di registrazione

« Spegnere 1’interruttore POWER

 Riproduzione

* Passato alla modalita delle miniature

Inquadratura di riprese con la
funzione Freeze Mix

La funzione Freeze Mix consente di sovrapporre
temporaneamente un’immagine fissa (immagine
bloccata) da un clip ripreso in modalita HD
sull’immagine attuale della telecamera.
Quest’operazione facilita I’inquadratura della
ripresa.

La funzione Freeze Mix non ¢ disponibile nei casi

seguenti.

* Quando il formato di registrazione ¢ SP 1080/23.98P
(modalita FAT) o HQ 1280/23.98P (modalita UDF)

¢ Quando i formati video dell’immagine registrata e
dell’immagine della telecamera sono diverse

* Quando si sta riprendendo in modalita Slow & Quick
Motion o in modalita Slow Shutter
* Quando vi € un ingresso i. LINK

Come visualizzare un’immagine Freeze
Mix

1 Riprodurre un clip o eseguire la
revisione della registrazione di un clip
con lo stesso formato dell’immagine del
camcorder.

2 Visualizzare I’immagine che si desidera
utilizzare come fotogramma, e quindi
accendere I’interruttore
programmabile al quale ¢ stata
assegnata la funzione Freeze Mix.
L’immagine di visualizzazione della
registrazione viene bloccata e sovrapposta
all’immagine della telecamera.

Le seguenti funzioni sono disabilitate nei momenti di
freeze mix.

* Operazioni del menu

* Durante la visualizzazione di Focus Mag

* Visualizzazione degli indicatori

* Visualizzazione zebra

* Visualizzazione della funzione peaking

* Visualizzazione dei dettagli della tonalita della pelle

Come cancellare la visualizzazione del
Freeze Mix

Eseguire una delle procedure indicate di seguito.

* Premere di nuovo I’interruttore programmabile
al quale ¢ stata assegnata la funzione Freeze
Mix.
La visualizzazione del Freeze Mix viene
cancellata e il riquadro ritorna all’immagine
normale della telecamera.

* Avviare la registrazione (vedere pagina 76).
Viene avviata la normale registrazione.

Operazioni avanzate
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Registrazione di dati
proxy

I dati proxy sono composti da dati video (MPEG-
4) e audio a bassa risoluzione (A-law) (video: 1,5
Mbps; audio: 64 Kbps a canale). Questi dati
proxy leggeri possono essere usati allo stesso
modo dei dati originali; tuttavia, possono essere
trasferiti pitl rapidamente, al fine di consentire la
visualizzazione ed editing piu efficienti.

In modalita UDF i dati proxy sono generati e
registrati automaticamente quando si registrano
video e audio con una unita flash USB collegata
al connettore di un dispositivo esterno. Caricando
i dati proxy dall’unita flash USB al computer &
possibile verificare rapidamente i contenuti
registrati o eseguire un rapido editing offline.

Non spegnere 1'unita o rimuovere I’unita flash USB
fintanto che si ha accesso alla suddetta. In caso contrario
si potrebbero perdere tutti i dati registrati nell’unita flash
USB.

Registrazione di dati proxy
durante la registrazione di clip

E possibile registrare dati proxy in un’unita flash
USB durante la registrazione di clip in una scheda
di memoria SxS.

1 Impostare MAINTENANCE >USB
>Memory Rec nel menu di
impostazione su [Enable].

2 Collegare un’unita flash USB
formattata con il file system FAT32 al
connettore di un dispositivo esterno
(vedere pagina 74).

3 Avvio della registrazione.
Mentre i dati originali sono registrati in una
scheda di memoria SxS, i dati proxy sono
salvati nella cartella \MSSONY\PRO\
XDCAM\MEMDISC\<Proav-ID> generata
automaticamente (Proav-ID ¢ un’ID

Registrazione di dati proxy

specificata per il file DISCMETA. XML
nella scheda di memoria SxS).

Dati proxy: salvati in <Proav-ID>\Sub\
Metadata: salvati in <Proav-ID>\Clip\

Per interrompere la registrazione dei dati proxy
Per interrompere la registrazione dei soli dati
proxy senza interrompere la registrazione dei dati
originali impostare MAINTENANCE >USB
>Memory Rec nel menu di impostazione su
[Disable].

In caso di mancata registrazione

Appare il messaggio “USB Memory Error”. In
caso di mancata registrazione poiché I’unita flash
USB ¢ piena, compare il messaggio “USB
Memory Full”.

I dati proxy sono salvati nella memoria interna di
questa unita. In caso di mancata registrazione
poiché I’unita flash USB ¢ difettosa o per qualche
altro motivo, ¢ possibile cambiare 1’unita flash
USB oricollegarla, e registrare nuovamente i dati
proxy salvati nella memoria interna.

Registrazione di dati proxy per i
clip esistenti

E possibile registrare dati proxy per clip su schede
di memoria SxS nelle unita flash USB.

Per registrare dati proxy per tutti i clip

1 Impostare MAINTENANCE >USB
>Memory Rec nel menu di
impostazione su [Enable].

2 Collegare un’unita flash USB
formattata con il file system FAT32 al
connettore di un dispositivo esterno
(vedere pagina 74).

3 Inserire una scheda di memoria SxS
contenente i clip registrati.

4 Selezionare MAINTENANCE >USB
>Copy All Clips nel menu di
impostazione e premere la manopola
MENU.



Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

La registrazione dei dati proxy ¢ avviata.
Al termine della registrazione appare il
messaggio “Copy All Clips Done”.

Per caricare un clip e registrarne i dati
proxy

1

Impostare MAINTENANCE >USB
>Memory Rec nel menu di
impostazione su [Enable].

Collegare un’unita flash USB
formattata con il file system FAT32 al
connettore di un dispositivo esterno
(vedere pagina 74).

Inserire una scheda di memoria SxS
contenente i clip registrati.

Caricare il clip di cui si desidera
registrare i dati proxy.

Selezionare MAINTENANCE >USB
>Copy Current Clip nel menu di
impostazione e premere la manopola
MENU.

Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

La registrazione dei dati proxy ¢ avviata.
Al termine della registrazione appare il
messaggio “Copy Current Clip Done”.

Eliminazione di tutti i dati proxy
da un’unita flash USB

E possibile eliminare tutti i dati proxy della
cartella \MSSONY\PRO\XDCAM\MEMDISC
eliminando la cartella.

1

Impostare MAINTENANCE >USB
>Memory Rec nel menu di
impostazione su [Enable].

Collegare un’unita flash USB

contenente i dati proxy al connettore di

un dispositivo esterno.

3 Selezionare MAINTENANCE >USB

>Del All Memory Clips nel menu di
impostazione e premere la manopola
MENU.

Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

L’eliminazione della cartella viene avviata.
Al termine dell’eliminazione appare il
messaggio “Delete All Clips Done”.

Registrazione di dati proxy
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Operazioni con
metadata di
pianificazione

I metadata di pianificazione sono informazioni su

piani di ripresa e registrazione registrati in un file
XML.

<?xmispversion="1.0"spencoding="UTF-8'?>

<PlanningMetadata

xmins="http://xmIns.sony.

assignld="P0001" creationDate="2011-08-20T17:00:00+09:00"
lastUpdate="2011-09-28710:30:00+09:00" load="false" version="1.00">

:00:00+09:00"

F yld="assi " update="2011-08
modifiedBy="Chris">

<TitlespusAscii="Typhoon" xml:lang="en">Typhoon_Strikes_Tokyo</Title>
</Properties>

</PlanningMetadata>

Esempio di file metadata di pianificazione

E possibile riprendere utilizzando nomi di clip e

di indicatori di ripresa definiti dapprima in un file

metadata di pianificazione.

Questo apparecchio ¢ in grado di visualizzare i

nomi dei clip e degli indicatori di ripresa definiti

nelle seguenti lingue.

* Inglese

* Cinese

¢ Tedesco

« Francese 1)

« Italiano

¢ Spagnolo

« Olandese "

 Portoghese

* Svedese

* Norvegese

* Danese

« Finlandese !

1) Alcuni caratteri sono visualizzati come differenti ma
simili.

Se si definisce il nome del clip e gli indicatori di ripresa
in lingue diverse dalla precedente, i suddetti potrebbero
non essere visualizzati nello schermo del mirino o nello
schermo del monitor LCD (con la modalita di
visualizzazione impostata su STATUS).

Nel monitor LCD (con la modalita di visualizzazione
impostata su STATUS) & possibile visualizzare solo
caratteri alfanumerici e simboli.

Operazioni con metadata di pianificazione

Caricamento di un file di
metadata di pianificazione nella
memoria interna del camcorder

Per registrare metadata di pianificazione insieme

ai clip di registrazione occorre caricare un file

metadata di pianificazione nella memoria del

camcorder prima di iniziare a riprendere.

Vi sono due modi per caricare i file.

* Caricare un file scritto nelle seguenti directory
in una scheda di memoria SxS o un’unita flash
USB.

Modalita di Supporto Directory in sui
registrazione sono scritti i file
FAT Scheda di BPAV/General/
memoria SxS Sony/Planning
SDHC PRIVATE/SONY/
BPAV/General/
Sony/Planning
UDF Scheda di General/Sony/
memoria SxS Planning
Unita flash
USB

¢ Quando si stabilisce una connessione Wi-Fi tra
il camcorder e un computer, utilizzare il menu
Web presente nel camcorder dal computer per
trasferire un file.

Per ulteriori informazioni su come usare il
menu Web per caricare un file metadata di
pianificazione, consultare il Supplemento
fornito con il CD-ROM (contrassegnato con
“Manuals for Solid-State Memory
Camcorder”).

Per caricare un file metadata di
pianificazione dal funzionamento del
menu

Attuare le seguenti procedure con OPERATION
>Planning Metadata nel menu di impostazione.

Caricare un file in una scheda di memoria SxS

1 Inserire una scheda di memoria SxS
nello slot per schede di memoria A o B,
quindi impostare Load/Slot(A) o Load/
Slot(B) su [Execute].

Viene visualizzato un elenco file.

L'elenco file visualizza fino a 64 file.



Anche se il numero totale dei file metadata di
pianificazione ¢ 64 o meno, i file metadata di
pianificazione potrebbero non essere visualizzati
tutti se la directory nella quale sono posizionati
sulla scheda di memoria SxS (General/Sony/
Planning) contiene 512 o piu file.

Ruotare la manopola MENU per
selezionare un file da caricare, quindi
premere la manopola.

Per caricare un file in un’unita flash USB (in
modalita UDF)

1

Collegare un’unita flash USB
formattata con il file system FAT32 al
connettore di un dispositivo esterno
(vedere pagina 74).

Viene visualizzato un elenco file.

L'elenco file visualizza fino a 64 file.

Anche se il numero totale dei file metadata di
pianificazione ¢ 64 o meno, i file metadata di
pianificazione potrebbero non essere visualizzati
tutti se la directory nella quale sono posizionati
sull'unita flash USB (General/Sony/Planning)
contiene 512 o piu file.

Ruotare la manopola MENU per
selezionare un file da caricare, quindi
premere la manopola.

Elemento Informazioni

File Name Nome del file

Assign ID ID assegnata

Created Data e ora di creazione

Modified Data e ora dell’ultima
modifica

Modified by =~ Nome della persona che ha
modificato il file

Title Titolo1 specificato in file
(nome clip in formato ASCII)

Title2 Titolo2 specificato in file
(nome clip in formato UTF-8)

Material Gp  Numero di clip del gruppo
materiale a)

Shot MarkO -  Nomi definiti nel file per Shot

Shot Mark9 Mark 0 - Shot Mark 9

a) Gruppo materiale: un gruppo di clip registrati
con gli stessa metadata di pianificazione.

E possibile ruotare la manopola MENU per
scorrere 1’elenco.

Una volta ruotata la manopola MENU per
selezionare un elemento, ¢ possibile premere
il pulsante SET per visualizzare solo
I’elemento selezionato.

Per cancellare i metadata di
pianificazione caricati

Per visualizzare informazioni dettagliate
nei metadata di pianificazione

Una volta caricati i metadata di pianificazione in
questa unita, & possibile verificare le informazioni
dettagliate in esso contenuti, come nomi di file,

data e ora di creazione e titoli.

1

In OPERATION >Plan.Metadata
>Properties nel menu di impostazione,
selezionare [Execute].

Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

Viene visualizzata la schermata PLANNING
METADATA PROPERTIES.

L’elenco contiene le seguenti informazioni.

1

In OPERATION >Plan.Metadata
>Clear nel menu di impostazione,
selezionare [Execute].

Ruotare la manopola MENU per
selezionare [Execute], quindi premere
la manopola.

L’eliminazione del file viene avviata.

Al termine dell’eliminazione appare il
messaggio “Clear Planning Metadata File
OK”.

Definizione dei nomi dei clip nei
metadata di pianificazione

Essi supportano la scrittura dei due seguenti tipi
di stringhe di nome file metadata di
pianificazione.

¢ Il nome in formato ASCII visualizzato nel

mirino

Operazioni con metadata di pianificazione
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« Il nome in formato UTF-8 effettivamente
registrato come nome della clip

E possibile selezionare il tipo di nome clip
visualizzato con OPERATION >Planning
Metadata >Clip Name Disp nel menu di
impostazione.

Quando un nome clip ¢ impostato con i metadata
di pianificazione, il nome ¢ visualizzato
all’interno dell’indicazione della profondita di
campo dello schermo del mirino.

Quando si definisce sia il nome in formato ASCII sia il
nome in formato UTF-8 con i metadata di pianificazione,
la stringa di formato UTF-8 viene usata come stringa del
nome della clip. Se si definisce il nome formato ASCII e
UTF-8 con i metadata di pianificazione, il nome formato
definito & visualizzato nonostante non sia selezionato
nell’impostazione del menu.

Esempio di stringa di nome clip

Usare un editor di testi per modificare i due campi
nella tag <Title> contenente le stringhe del nome
clip.

I campi ombreggiati nell’esempio sono stringhe
di nomi di clip. “Tifone” & descritto in formato
ASCII (fino a 44 caratteri).
“Tifone_Colpisce_Tokyo” & descritto in formato
UTEF-8 (fino a 44 byte).

“sp” indica uno spazio « un ritorno a capo.

<?xmlgpversion="1.0"g encoding="
UTF-8"7>¢=
<PlanningMetadatag,xmlIns="http://
xmlns.sony.net/pro/metadata/
planningmetadatapassignld="
P0001"g,creationDate="
2011-08-20T17:00:00+09:00" g,
lastUpdate="
2011-09-28T10:30:00+09:00"y,
version="1.00">«
<Propertiesg,propertyld="
assignment"g,update="
2011-09-28T10:30:00+09:00",
modifiedBy="Chris">«
<TitlespusAscii:”-”S
ol lang="it"> [ OTERCOIISCENTORSH]
</Title>«
</Properties>+
</PlanningMetadata>«

Operazioni con metadata di pianificazione

* Quando si crea un file, inserire ogni affermazione sotto
forma di riga singola con un CRLF solo dopo I’ultimo
carattere della riga e non inserire spazi se non dove
specificato.

E disponibile una stringa di fino a 44 byte (o caratteri)
per il nome del clip.

Se la stringa di formato UTF-8 supera i 44 byte, la
stringa da 44 byte sara usata per il nome del clip.

Se si specifica solo il nome in formato ASCII, la
stringa da 44 byte sara usata per il nome del clip.

Se non ¢ possibile usare se una stringa nome formato
ASCII né una di formato UTF-8 format, sara usato il
nome clip di formato standard.

E possibile usare il software applicativo Sony
Planning Metadata Add-in in dotazione con
I’adattatore Wi-Fi CBK-WAOI per definire i nomi
dei clip. Per ulteriori informazioni, consultare le
istruzioni per I'uso fornite con il CBK-WAOI.

Per impostare i nomi dei clip

1 Caricare un file metadata di
pianificazione contenente i nomi dei clip
nel camcorder.

2 Impostare OPERATION >Clip >Auto
Naming nel menu di impostazione su
[Plan].

Ogni volta che si registra un clip,
I’apparecchio genera automaticamente un
nome costituito dal nome del clip definito nel
file metadata di pianificazione,
accompagnato da una barra inferiore (_) e un
numero di serie a cinque cifre (da 00001 a
99999).
Esempi: Tifone_Colpisce_Tokyo_00001,
Tifone_Colpisce_Tokyo_00002, ...

Quando si carica un altro file metadata di pianificazione,
alla successiva operazione di registrazione il numero di
serie torna a 00001.

Per selezionare il formato di visualizzazione del
nome clip

Quando si definiscono i nomi in formato ASCII e
UTF-8, ¢ possibile usare OPERATION >Clip
>Clip Name Disp nel menu di impostazione per
selezionare quali dei nomi visualizzare sul
monitor LCD e sullo schermo del mirino.



Per visualizzare i nomi in formato ASCII:
Selezionare Titlel (ASCII).
11 clip diventa
“Tifone_Colpisce_Tokyo_NumeroSerie, ma
nelle schermate ¢ visualizzato
“Tifone_NumeroSerie”.

Per visualizzare i nomi in formato UTF-8:
Selezionare Title2 (UTF-8).
11 clip diventa
“Tifone_Colpisce_Tokyo_NumeroSerie”, e
lo stesso nome ¢ visualizzato nelle
schermate.

Definizione dei nomi degli
indicatori di ripresa nei metadata
di pianificazione

Quando si usano i metadata di pianificazione per
impostare gli indicatori di ripresa & possibile
definire i nomi per Shot Mark O - Shot Mark 9.
Quando si registrano indicatori di ripresa, &
possibile aggiungere le stringhe dei nomi degli
indicatori di ripresa definite nei metadata di
pianificazione.

E possibile registrare Shot Mark 1 e Shot Mark 2 sul
camcorder. Da Shot Mark 3 a Shot Mark 9 e Shot Mark
0 possono essere registrati tramite operazione da un
computer connesso con il camcorder mediante una
connessione Wi-Fi.

Esempio di stringa di nome di indicatore
di ripresa

Utilizzare un editor di testi per modificare i campi
nel tag <Meta name>.

I campi ombreggiati nell’esempio sono stringhe
di nome traccia di identificazione. I nomi possono
essere in formato ASCII (fino a 32 caratteri) o
UTF-8 (fino a 16 caratteri).

“sp” indica uno spazio « un ritorno a capo.

Se una stringa di nome contiene anche un solo carattere
non ASCII, la lunghezza massima di tale stringa sara di
16 caratteri.

<?xmlgpversion="1.0"gencoding="
UTF-8"7>¢=

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata”,assignld="

HO00123"g creationDate="
2011-04-15T08:00:00Z" g, lastUpdate="
2011-04-15T15:00:00Z"g,version=

"1.00" >4
<Propertiesg,propertyld=
"assignment"gpclass="original"s,

update="2011-04-15T15:00:00Z" g,
modifiedBy="Chris">«
<Titleg,usAscii="Football
Game"g xml:lang="it">
Football Game 15/04/2011</
Title>«
<Metag,name="_ShotMark1",
content="-"/>4—'
<Metagpname="_ShotMark2",
content:"-"/>4—'
<Metag,name="_ShotMark3",
content="_"/>4—'
<Metag,name="_ShotMark4",
content="_"/>4—'
<Metagyname="_ShotMark5",
content=" ">
<Metag,name="_ShotMark6",
content="-"/>4—'
<Metag,name="_ShotMark7",
content="_"/>4—'
<Metagyname="_ShotMark8",
content:"_"/>4—'
<Metag,name="_ShotMark9",
content="_"/>4—'
<Metag,name="_ShotMark0",
content=" ">
</Properties>«
</PlanningMetadata>«

Quando si crea un file di definizione, inserire ogni
affermazione sotto forma di riga singola con un CRLF
solo dopo I’ultimo carattere della riga e non inserire
spazi se non dove specificato, eccetto entro le stringhe di
nome traccia di identificazione.

E possibile usare il software applicativo Sony
Planning Metadata Add-in in dotazione con
l'adattatore Wi-Fi CBK-WAOI per definire i nomi
delle tracce di identificazione. Per ulteriori
informazioni, consultare le istruzioni per ’uso
fornite con il CBK-WAOI.

Operazioni con metadata di pianificazione
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s ¥ Operazioni con i clip

Riproduzione di clip

Appare una schermata di riproduzione delle miniature premendo il pulsante THUMBNAIL in modalita
E-E o di riproduzione. Le schermate delle miniature mostrano elenchi di clip memorizzate su schede di
memoria SxS sottoforma di immagini indice. (Appare un messaggio se si inserisce una scheda di memoria
che non contiene clip.)

E possibile selezionare clip (vedere pagina 97) in una schermata miniature e avviare la riproduzione del
clip (vedere pagina 97).

Schermata delle miniature

Nelle schermate delle miniature, il codice temporale delle immagini indice appare al di sotto di ciascun
clip. (Un indicatore OK, NG o KP appare anche quando un clip & stato indicato con un indicatore OK, NG
oKP.)

Le schermate di miniature normali visualizzano solo i clip SD o solo i clip HD, anche se la scheda di memoria SxS
contiene clip in entrambi i formati. E possibile selezionare il formato da visualizzare selezionando una modalita con
OPERATION >Format >HD/SD (vedere pagina 118) nel menu di impostazione.

Se si desidera visualizzare tutti i clip registrati, a prescindere della modalita HD/SD, passare alla schermata di miniature
d tutti i clip. Tuttavia, non ¢ possibile avviare la riproduzione da una schermata delle miniature di tutti i clip (vedere
pagina 103).

Riproduzione di clip



Schermata delle miniature in modalita UDF/FAT-HD

[vor) (Faro]

Viene evidenziata I'icona della scheda di memoria SxS attualmente
selezionata.
(Se la scheda & protetta da scrittura, compare un lucchetto sulla sinistra.)

Cursore (giallo)

Numero clip/Numero dei clip

N

" A\ ‘ \
A\

01:10:40:00 10:

01:11:00:00 01:11:10:00 & 01:11:20:00 01:11:30:00

EIrY

\
01:11:50:00

H_01:11:40:00

© Immagine indice

Quando si registra un clip, il primo fotogramma
viene impostato automaticamente come
immagine indice. E possibile modificare
I’immagine indice con qualsiasi fotogramma
(vedere pagina 111).

@ Indicatore di blocco

Indica che il clip selezionato viene indicato con
un indicatore OK o viene protetto.

©® Data e ora di inizio della registrazione
O Nome clip

© Icona del file indipendente AV

Appare solo quando un clip € un file AV
indipendente. Le schede di memoria SxS possono
contenere file indipendenti aggiunti direttamente
dal computer. Visto che i file indipendenti sono
privi dei file di gestione associati, alcune
visualizzazioni di operazioni e informazioni
potrebbero non essere disponibili.

O Formato video della registrazione

@ Informazioni sulla registrazione
speciale

Vengono visualizzate la modalita dei clip che

sono stati registrati in una modalita speciale

(Rallentatore e movimento rapido, Interval Rec,

Frame Rec).

Nei clip in Rallentatore e movimento rapido, la

frequenza di fotogrammi viene visualizzata sulla

destra come [Recording frame rate/Playback

frame rate] fps.

O Indicatore OK/NG/KP

Quando la modalita di registrazione ¢ UDF, un
indicatore OK, NG o KP appare se il clip & stato
indicato con un indicatore OK, NG o KP (vedere
pagina 105).

Quando la modalita di registrazione ¢ FAT, un
indicatore OK appare solo se il clip ¢ stato
indicato con un indicatore OK (vedere

pagina 105).

Riproduzione di clip
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© Formato del file

Indica il formato del file del clip selezionato
(MXF o MP4).

(Questa voce non ¢ indicata quando la modalita di
registrazione ¢ UDF-HD.)

@ durata del clip

@ Codice temporale
Questo ¢ il codice temporale delle immagini
indice.

Schermata delle miniature in modalita FAT-SD

selezionata.
Cursore (giallo)

01:11:00:00 701.11:10 0

21 01:11:20:00

Viene evidenziata I'icona della scheda di memoria SxS attualmente

(Se la scheda e protetta da scrittura, compare un lucchetto sulla sinistra.)

Numero clip/Numero dei componenti

0011/0300

01:11:30:00

© Indicatore Take

Indica che la dimensione del file & superiore a 2
GB, e che il clip ¢ stato diviso prima di essere
salvato.

E possibile verificare i file segmentati sulla
schermata di espansione delle miniature (vedere
pagina 108).

@ Immagine indice

Quando si registra un clip, il primo fotogramma
viene impostato automaticamente come
immagine indice.

© Data e ora di inizio della registrazione

Riproduzione di clip

O Nome clip/Numero di componenti

Il numero successivo al nome del clip (delimitato
da/) ¢ il numero dei componenti. Appare solo per
i clip di dimensioni maggiori a 2 GB che sono
stati divisi in file piu piccoli per la
memorizzazione.

© Formato video della registrazione

O Formato del file

Indica il formato del file del clip selezionato
(AVI).

@ durata del clip

@O Codice temporale
Questo ¢ il codice temporale delle immagini
indice.




Come passare tra schede di memoria
SxS

Quando due schede di memoria SxS vengono
caricate, & possibile passare dall’una all’altra
premendo il pulsante SLOT SELECT.

Quando viene visualizzata una schermata di espansione
delle miniature (vedere pagina 108) o una schermata
delle miniature degli indicatori di identificazione (vedere
pagina 110), non & possibile passare tra schede di
memoria SxS.

Come nascondere la schermata delle
miniature.

Premere il pulsante THUMBNAIL.

Riproduzione di clip

Come selezionare le miniature dei clip

Eseguire una delle seguenti opzioni per spostare il

cursore giallo sul clip che si desidera selezionare.

 Premere un pulsante freccia 1, b, <=, =),
* Ruotare la manopola MENU.
¢ Premere il pulsante PREV o NEXT.

Come selezionare la prima miniatura
Tenendo premuto il pulsante F REV, premere il
pulsante PREV.

Come selezionare I'ultima miniatura
Tenendo premuto il pulsante F FWD, premere il
pulsante NEXT.

Perriprodurre i clip in sequenza a partire
da un clip selezionato

1 Per prima cosa selezionare la miniatura
del clip che si desidera riprodurre.

2 Premereil pulsante PLAY/PAUSE.
La riproduzione inizia dal principio del clip
selezionato.

La riproduzione continua attraverso tutti i clip
successivi al clip selezionato.

Al termine della riproduzione dell’ultimo clip, il
camcorder entra in modalita di pausa (fermo
immagine) fermandosi sull’ultimo fotogramma
dell’ultimo clip.

Premere il pulsante THUMBNAIL per ritornare
alla schermata delle miniature.

Potrebbe verificarsi una temporanea dissociazione
dell’immagine o visualizzazione di fermi immagine
durante la transizione da un clip a un altro. In questo
momento, non & possibile utilizzare i comandi di
riproduzione e il pulsante THUMBNAIL.

Quando si seleziona un clip nella schermata delle
miniature e ha inizio la riproduzione, potrebbero
verificarsi temporanee dissociazioni dell’immagine
all’inizio del clip. Per visualizzare I’inizio del clip
senza dissociazioni, mettere il camcorder in modalita
di riproduzione, pausa, utilizzare il pulsante PREV per
tornare all’inizio del clip, e iniziare nuovamente la
riproduzione.

Nelle schede di memoria SxS che contengono sia clip
in modalita HD che clip in modalita SD, non &
possibile riprodurre tutti i clip in sequenza. Per
esempio, mentre si visualizza la schermata delle
miniature in modalita HD, vengono riprodotti in
sequenza solo i clip in modalita HD.

Per mettere in pausa la riproduzione

Premere il pulsante PLAY/PAUSE.

L’indicatore PLAY/PAUSE lampeggia mentre la
riproduzione ¢ in pausa.

Premere il pulsante nuovamente per tornare alla
modalita di riproduzione.

Come riprodurre ad alta velocita

Premere il pulsante F FWD (vedere pagina 19) o
il pulsante F REV (vedere pagina 19).

Per tornare alla riproduzione normale premere il
pulsante PLAY/PAUSE.

Per arrestare la riproduzione

Premere il pulsante STOP: la riproduzione si
ferma e il camcorder entra in modalita E-E.

Premere il pulsante THUMBNAIL: la
riproduzione si ferma e la schermata delle
miniature (vedere pagina 94) appare nel
mirino.

La riproduzione si ferma anche se si espelle la
scheda di memoria. In questo caso, nel mirino
appare I'immagine della telecamera.

Come cercare un clip

Come tornare all’inizio del clip corrente

Premere il pulsante PREV.

* Durante la riproduzione o F FWD, salta
all’inizio del clip attuale e inizia la
riproduzione.

Riproduzione di clip
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¢ Durante il FREV o la pausa, salta all’inizio del
clip attuale e vene visualizzato un fermo
immagine.

« A ciascuna pressione del pulsante si sposta al
clip precedente.

Come avviare la riproduzione dall’inizio del
primo clip

Premere simultaneamente i pulsanti PREV e F
REV. Si salta all’inizio del primo clip sulla
scheda di memoria SxS.

Come passare direttamente all’inizio del clip

successivo

Premere il pulsante NEXT.

 Durante la riproduzione o F FWD, salta
all’inizio del clip successivo e inizia la
riproduzione.

¢ Durante il FREV o la pausa, salta all’inizio del
clip successivo e viene visualizzato un fermo
immagine.

« A ciascuna pressione del pulsante si sposta al
clip successivo.

Come avviare la riproduzione dall’inizio
dell’ultimo clip

Premere simultaneamente i pulsanti NEXT e F
FWD. Si salta all’inizio dell’ultimo clip sulla
scheda di memoria SxS.

Come aggiungere un indicatore di
ripresa durante la riproduzione

E possibile aggiungere indicatori di ripresa ai clip
durante la riproduzione utilizzando lo stesso
metodo usato durante la riproduzione (vedere
pagina 79).

« Gli indicatori di ripresa non possono essere registrati
se la scheda di memoria SxS ¢ protetta da scrittura.

« Gli indicatori di ripresa non possono essere aggiunti al
primo fotogramma di ciascun clip o all’ultimo
fotogramma dell’ultimo clip.

Riproduzione di clip

Uso delle miniature nella ricerca
all’interno di un clip

E possibile passare da una schermata delle

miniature alle seguenti schermate di ricerca delle

miniature, che permettono di trovare velocemente

i clip desiderati.

* Schermata di espansione delle miniature

* Schermata delle miniature degli indicatori di
identificazione (solo in modalita HD)

Come la normale schermata delle miniature e la
schermata delle miniature dei clip OK, queste
schermate permettono di selezionare le miniature
dei clip (vedere pagina 97) e avviare la
riproduzione dei clip (vedere pagina 97).

Come cercare le scene in un clip con la
schermata di espansione delle miniature

La schermata di espansione delle miniature &
conveniente quando si desidera trovare e caricare
una scena specifica di un clip lungo.

Per visualizzare la schermata di espansione delle

miniature, selezionare un clip nella schermata

delle miniature e premere il pulsante DISP SEL/

EXPAND (vedere pagina 19) o selezionare

THUMBNAIL >Thumbnail View >Forward

Expansion nel menu di impostazione. II clip

selezionato viene visualizzato come di seguito.

Modalita HD: Il clip viene diviso in 12 blocchi
della stessa dimensione, e viene visualizzata
una miniatura del primo fotogramma di
ciascun blocco.

Modalita SD: solo nel caso in cui i clip che sono
stati divisi in parti perche la dimensione del
file era superiore a 2 GB, viene visualizzata
una miniatura del primo fotogramma di
ciascun file parziale.

Cio permette di caricare una scena desiderata in
un clip di lunga durata.

Vedere “Visualizzazione della schermata di
espansione delle miniature” (pagina 108) per
ulteriori informazioni sulla schermata di espansione
delle miniature.



Come cercare nei clip con la schermata
delle miniature degli indicatori di
identificazione

[vor ) Faro]

Quando un clip contiene uno o pill indicatori di
identificazione, ¢ semplice trovarlo con la
schermata delle miniature degli indicatori di
identificazione. La schermata delle miniature
degli indicatori di identificazione mostra una
miniatura di ciascun fotogramma indicatore di
identificazione nel clip.

Per visualizzare la schermata delle miniature
degli indicatori di identificazione, premere il
pulsante ESSENCE MARK (vedere pagina 21) o
selezionare THUMBNAIL >Thumbnail View >
Essence Mark Thumbnail nel menu di
impostazione.

Vedere “Visualizzazione della schermata delle
miniature degli indicatori di identificazione”
(pagina 110) per ulteriori informazioni sulla
schermata delle miniature degli indicatori di
identificazione.

Riproduzione di clip
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Operazioni miniature

E possibile utilizzare il menu THUMBNAIL per eseguire diverse operazioni sui clip, per verificare le
proprieta dei clip, e per cambiare i metadati dei clip.

Configurazione menu THUMBNAIL

Voci dei menu Voci secondarie

Descrizione

Clip Properties —

Visualizza proprieta dettagliate.(vedere pagina 104)

Set Index Picture —

[UDF]/[FaTHD]

Modifica delle immagini indice delle clip nella schermata
di espansione delle miniature o nella schermata delle
miniature degli indicatori di identificazione (vedere
pagina 111).

Thumbnail View Forward Expansion

* Visualizza la schermata di espansione delle miniature
(vedere pagina 108).

 Nella schermata di espansione delle miniature, aumenta
il numero di divisioni (vedere pagina 109).

Back Expansion

Nella schermata di espansione delle miniature, diminuisce
il numero di divisioni.

/ Essence Mark Thumbnail

Visualizza la schermata delle miniature degli indicatori di
identificazione (vedere pagina 110).

Clip Thumbnail

Visualizza la schermata delle miniature normale.

All Clip Thumbnail

Visualizza la schermata delle miniature di tutti i clip
(vedere pagina 103).

Set Shot Mark Add Shot Mark1

[vor ) [FaT)

Nella schermata di espansione delle miniature o nella
schermata delle miniature degli indicatori di
identificazione, aggiunge un indicatore Shot Mark1
(vedere pagina 110).

Delete Shot Mark1

Nella schermata di espansione delle miniature o nella
schermata delle miniature degli indicatori di
identificazione, elimina un indicatore Shot Mark1 (vedere
pagina 111).

Add Shot Mark2

Nella schermata di espansione delle miniature o nella
schermata delle miniature degli indicatori di
identificazione, aggiunge un indicatore Shot Mark2
(vedere pagina 110).

Delete Shot Mark2

Nella schermata di espansione delle miniature o nella
schermata delle miniature degli indicatori di
identificazione, elimina un indicatore Shot Mark2 (vedere
pagina 111).

Set Clip Flag OK Aggiunge un indicatore OK.

NG Aggiunge un indicatore NG.
KP(Keep) Aggiunge un indicatore KP.
None Elimina un indicatore OK, NG o KP.

Operazioni miniature



Voci dei menu

Voci secondarie

Descrizione

Add OK Mark
FAT-HD

Aggiunge un indicatore OK e protegge il clip (vedere
pagina 105).

Delete OK Mark
FAT-HD

Cancella un indicatore OK e toglie la protezione al clip
(vedere pagina 106).

Lock Clip

Protegge un clip.

Unlock Clip

Annulla la protezione di un clip.

OE
o
]
<
a
Sh

Copia un clip (vedere pagina 107).

Delete Clip

Cancella un clip (vedere pagina 108).

Divide Clip
FAT-HD

Divide un clip (vedere pagina 111).

Filter Clips

o
i
X
o

Visualizza il clip OK nella schermata delle miniature
(vedere pagina 102).

Filter Clips OK Visualizza il clip OK nella schermata delle miniature.

NG Visualizza il clip NG nella schermata delle miniature.
KP(Keep) Visualizza il clip KP nella schermata delle miniature.
None Visualizza il clip None (clip indicato da un indicatore OK,

NG o KP) nella schermata delle miniature.

Lock All Clips — Protegge tutti i clip visualizzati.

Unlock All Clips — Annulla la protezione di tutti i clip visualizzati.

Copy All All Clips Copia gruppi di clip/file in un’unica operazione (vedere
General Files pagina 107).
All Clips & General Files

Delete all clips Execute/Cancel Cancella tutti i clip non protetti (vedere pagina 108).

Operazioni miniature
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Funzioni hase del Menu
THUMBNAIL

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

Come visualizzare il menu THUMBNAIL

1 Premereil pulsante THUMBNAIL per
visualizzare la schermata delle
miniature.

2 Impostare I’interruttore MENU ON/
OFF su ON, o premere il pulsante
MENU.

3 Girare la manopola MENU per
selezionare “TH”, quindi premere la
manopola. In alternativa premere il
pulsante Todb per selezionare “TH”,
quindi premere il pulsante SET.
Appare il menu THUMBNAIL.

FAT

THUMBNAIL

Clip Properties
Set Index Picture

2 ll Thumbnail View
Set Shot Mark

afl Add OK Mark
Delete OK Mark

in modalita FAT

THUMBNAIL
=]

Clip Properties
pj| Set Index Picture

a [l Thumbnail View »
Set Shot Mark

2l Set Clip Flag
Lock Clip

in modalita UDF

Per nascondere il menu THUMBNAIL, premere
nuovamente il pulsante MENU.

Come selezionare le voci e le voci
secondarie del menu

Eseguire una delle procedure indicate di seguito.

Operazioni miniature

* Girare la manopola MENU per selezionare una
voce o una voce secondaria, quindi premere la
manopola.

* Premere i pulsanti frecce (ﬂ}, {}, <=, =>) per
selezionare una voce o una voce secondaria,
quindi premere il pulsante SET.

A seconda della voce selezionata o della voce

secondaria, appare un elenco di selezione o una

schermata di proprieta dei clip (vedere

pagina 104).

Per tornare allo stato precedente, spostare

I’interruttore MENU CANCEL/PRST/ESCAPE

su ESCAPE.

¢ Quando una scheda di memoria SxS ¢ protetta da
scrittura, non € possibile copiare, cancellare, o dividere
i clip, cambiare le immagini indice, o aggiungere e
cancellare indicatori OK/NG/KP e indicatori di
ripresa.

* Alcune voci non possono essere selezionare, a seconda
dello stato del camcorder quando viene visualizzato il
menu.

Come nascondere una schermata di
proprieta del clip

Eseguire una delle procedure indicate di seguito.

Premere il pulsante RESET/RETURN: Torna
al menu THUMBNAIL.

Premere il pulsante THUMBNAIL: 11
camcorder entra in modalita E-E, e appare
I’immagine del camcorder.

Premere il pulsante PLAY/PAUSE: La
riproduzione dei clip selezionati ha inizio.

Modifica il tipo della schermata
delle miniature

Come visualizzare le miniature di clip
OK/NG/KP/None

Quando la modalita di registrazione ¢ UDF, tra
tutti i clip memorizzati nella scheda di memoria
SxS selezionata, possono essere visualizzati solo
i clip indicati da un indicatore OK, NG o KP o
solo i clip privi di indicatori (clip None).
Quando la modalita di registrazione ¢ FAT, tra
tutti i clip memorizzati nella scheda di memoria
SxS selezionata, possono essere visualizzati solo
i clip indicati da un indicatore OK.




Quando la schermata delle miniature normale
viene visualizzata, ¢ possibile selezionare
THUMBNAIL >Filter Clips per passare alla
schermata.

In modalita FAT-HD: passaggio al clip OK nella
schermata delle miniature.

In modalita UDF: selezionando OK, NG, KP
(Keep) e None nell’area di impostazione, ¢
possibile visualizzare la schermata delle
miniature contenente solo i clip indicati con
I’indicatore selezionato o solo i clip
contrassegnati senza indicatori (clip None).

Vedere “Aggiunta ed eliminazione di indicatori OK,

NG o KP” (pagina 105) per informazioni su come

aggiungere indicatori OK.

Come visualizzare la schermata delle
miniature di tutti i clip

La schermata delle miniature di tutti i clip mostra
miniature di tutti i clip nella scheda di memoria
selezionata, inclusi i clip in modalita HD e SD. E
utile quando si desidera verificare se la scheda di
memoria contiene clip in un’altra modalita.

E possibile passare alla schermata delle miniature
di tutti i clip selezionando THUMBNAIL >All
Clip Thumbnail nel menu di impostazione nella
schermata delle miniature normale.

Premendo il pulsante RESET/RETURN si torna
alla schermata delle miniature normale, in cui &
possibile eseguire la riproduzione e altre
operazioni di clip.

Non ¢ possibile iniziare la riproduzione dalla schermata
delle miniature di tutti i clip.

Operazioni miniature
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Visualizzazione delle proprieta dei clip

La schermata delle proprieta dei clip appare quando si seleziona Clip Properties nel menu THUMBNAIL.

[vor ) Faro]

{ I 120min PROPERTIES

PREV CLIP

{ HHEN120min PROPERTIES

©

al Az 0011/0300

Q 1920/23. 9 ):[
S&O Motlon 29/24fs |

al Az 0011/0300

JPANOO11(1 /03
01/JAN/2009 10:

TCR 00:00:00:00 STR)-

TOR 00:25:05:00 END
=1

CH1/CH2

@ Immagine del clip corrente

@ Immagine del clip precedente
Premere il pulsante PREV per visualizzare le
proprieta del clip precedente.

©® Immagine del clip successivo
Premere il pulsante NEXT per visualizzare le
proprieta del clip successivo.

Operazioni miniature

O Nome clip

In modalita SD, solo i clip che sono stati divisi
perche la dimensione del file era superiore a 2
GB, il numero dei clip componenti appare dopo il
nome del clip.

Quando i nomi di clip sono di 12 caratteri o piu,
vengono visualizzati solo i primi cinque caratteri
e gli ultimi cinque caratteri. Se si desidera
verificare i caratteri abbreviati, premere la
manopola MENU per passare alla modalita di
visualizzazione completa. In modalita di




visualizzazione completa, vengono visualizzati
fino a 53 caratteri dei nomi di clip.

Premere nuovamente la manopola MENU per
uscire dalla modalita di visualizzazione completa.
Premendo il pulsante PREV o NEXT per
visualizzare il clip precedente o successivo siesce
anche dalla modalita di visualizzazione completa.

© Indicatore di blocco

Appare quando il clip viene indicato con un
indicatore OK o viene protetto.

O Indicatore OK/NG/KP

Appare solo quando ¢ stato aggiunto un
indicatore OK/NG/KP.

@ Data e ora di inizio della registrazione

© Formato del file
1l formato del file del clip (MXF, MP4 o AVI)
appare.

© Informazioni sulla registrazione
speciale

Vengono visualizzate la modalita dei clip che

sono stati registrati in una modalita speciale

(Rallentatore e movimento rapido, Interval Rec,

Frame Rec).

Nei clip in Rallentatore e movimento rapido, la

frequenza di fotogrammi viene visualizzata sulla

destra come [Recording frame rate/Playback

frame rate].

@ Codice temporale del’immagine
visualizzata

Codice temporale dell’inizio della
registrazione

Codice temporale della fine della
registrazione

Durata

Canali audio registrati

® 66 6

Formato video della registrazione

Aggiunta ed eliminazione di
indicatori OK, NG o KP

[UDF]/[FaT-HD]

E possibile aggiungere indicatori OK, NG o KP ai
clip. Cio permette di visualizzare le miniature di
solo i clip di cui si ha bisogno premendo il
pulsante THUMBNAIL.

Come aggiungere un indicatore 0K

1 Nella schermata delle miniature,
selezionare THUMBNAIL >Add OK
Mark.

La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I’immagine
indice.

2 Selezionare [Execute], quindi premere
la manopola MENU.
L’indicatore OK viene aggiunto al clip
selezionato.

E possibile utilizzare un interruttore
programmabile cui & assegnato Clip Flag OK per
aggiungere indicatori OK.

Come aggiungere un indicatore OK, NG o
KP

1 Nella schermata delle miniature,
selezionare THUMBNAIL >Set Clip
Flag.

2 Selezionare OK, NG o KP nell’area di
impostazione.

3 Selezionare [Execute], quindi premere
la manopola MENU.
L’indicatore selezionato al punto 2 viene
aggiunto al clip selezionato.

E possibile utilizzare interruttori assegnabili cui
sono assegnati Clip Flag OK, Clip Flag NG e Clip

Operazioni miniature
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Flag Keep per aggiungere indicatori OK, NG e

KP.

clip. I clip protetti non possono essere eliminati
né divisi.

Come aggiungere I'indicatore 0K

Come proteggere un clip

Appare la voce Delete OK Mark nel menu
THUMBNAIL quando si seleziona un clip con un
indicatore OK.

1

Nella schermata delle miniature,
selezionare THUMBNAIL >Delete OK
Mark.

La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I’immagine
indice.

Selezionare [Execute], quindi premere
la manopola MENU.

L’indicatore OK viene eliminato dal clip
selezionato.

Come eliminare un indicatore OK, NG o

KP

1

Nella schermata delle miniature,
selezionare la miniatura del clip da cui
si desidera eliminare un indicatore OK,
NG o KP, quindi selezionare
THUMBNALIL >Set Clip Flag >None.
La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I'immagine
indice.

Selezionare [Execute], quindi premere
la manopola MENU.

L’indicatore selezionato al punto 2 viene
aggiunto al clip selezionato.

Protezione di clip

Quando la modalita di registrazione ¢ UDF, ¢
possibile proteggere un clip selezionato o tutti i

Operazioni miniature

1

Nella schermata delle miniature,
selezionare la miniatura del clip che si
desidera proteggere e selezionare
THUMBNAIL >Lock Clip.

La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I’immagine
indice.

Selezionare [Execute], quindi premere
la manopola MENU.
11 clip selezionato viene protetto.

Come proteggere tutti i clip

1

Nella schermata delle miniature,
selezionare THUMBNAIL >Lock All
Clips.

Un messaggio di conferma appare sotto
I’immagine indice.

Selezionare [Execute], quindi premere
la manopola MENU.
Tutti i clip vengono protetti.

Come annullare la protezione di un clip

1

Nella schermata delle miniature,
selezionare la miniatura del clip di cui si
desidera eliminare la protezione e
selezionare THUMBNAIL >Unlock
Clip.

La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I’immagine
indice.

Selezionare [Execute], quindi premere
la manopola MENU.

Viene eliminata la protezione del clip
selezionato.



Come annullare la protezione di tutti i
clip

1 Nella schermata delle miniature,
selezionare THUMBNAIL >Unlock All
Clips.

Un messaggio di conferma appare sotto
I’immagine indice.

2 Selezionare [Execute], quindi premere
la manopola MENU.
Viene eliminata la protezione di tutti i clip.

Come copiare i clip

E possibile copiare i clip in un’altra scheda di
memoria SxS.
I Clip vengono copiati alle schede di memoria
SxS di destinazione usando gli stessi nomi dei
clip originali.

Se esiste gia un clip con lo stesso nome nella scheda di
memoria SxS di destinazione della copia, viene
aggiunto un numero di un solo carattere tra parentesi
viene aggiunto al nome originale.

1l numero tra parentesi ¢ il numero piu piccolo che non
esiste alla destinazione della copia.

Esempi:

ABCD0002—ABCDO0002(1)
ABCDO0002(1)—ABCD0002(2)
ABCDO0005(3)—ABCD0005(4)

Se i numeri da (1) a (9) sono gia presenti alla
destinazione della copia, non ¢ possibile copiare altri
clip con lo stesso nome. (Non & possibile copiare una
decima copia.)

* Appare un messaggio se non c’¢ abbastanza spazio
residuo nella scheda di memoria SxS destinazione
della copia. Cambiare la scheda con un’altra con
maggiore capacita.

Quando si registrano diversi clip in una scheda di
memoria SxS, potrebbe non essere possibile copiare
tutte i clip fino alla fine. A seconda delle caratteristiche
della memoria e dell’uso delle schede di memoria, cid
puo avvenire anche quando le schede di memoria fonte
e di destinazione hanno la stessa capacita.

1 Nella schermata delle miniature,
selezionare la miniatura del clip da
copiare, quindi selezionare
THUMBNAIL >Copy Clip.

La schermata passa alla schermata di
proprieta del clip, quindi appare un

messaggio di conferma sotto I’immagine
indice.

2 Selezionare [Execute], quindi premere
la manopola MENU.
La copia ha inizio.

Durante la copia, vengono visualizzati un

messaggio di esecuzione e una barra progressiva.

Quando termina la copia, la visualizzazione torna
alla schermata delle miniature.

Come cancellare un’operazione di copia
Premere il pulsante RESET/RETURN.

La copia viene cancellata, e la visualizzazione
torna alla schermata delle miniature.

Come copiare gruppi di clip/file in
un’unica operazione

E possibile copiare gruppi di clip da una scheda di

memoria SxS su un’altra scheda di memoria SxS.

Quando sono presenti clip sia nella modalita HD
che nella modalita SD nella scheda di memoria
SxS, vengono copiati solo i clip nella modalita
selezionata. B un modo comodo per estrarre i clip
in una delle modalita.

E anche possibile copiare i file nella directory
General, sia assieme ai clip sia separatamente.

1 Nella schermata delle miniature,
selezionare le miniature dei clip da
copiare, quindi selezionare
THUMBNAIL >Copy All >All Clips.
Appare il messaggio di conferma “Copy All
Clip?”.

2 Selezionare [Execute], quindi premere
la manopola MENU.
La copia ha inizio.
Durante la copia, viene visualizzato il
progresso della copia.
Se si esegue la copia in modalita HD,
vengono copiati solo i clip in modalita HD.
Se si esegue la copia in modalita SD,
vengono copiati solo i clip in modalita SD.

Come annullare I'operazione di copia
Premere il pulsante RESET/RETURN.

Quando termina la copia
Appare un messaggio di completamento e la
schermata del menu THUMBNALIL riappare.

Operazioni miniature
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Per copiare tutti i file nella directory General
Per copiare solo tutti i file, senza copiare le clip,
selezionare THUMBNAIL >Copy All >General
Files al punto 1.

Per copiare tutti i file assieme a tutte le clip,
selezionare THUMBNAIL >Copy All >All Clips
& General Files al punto 1.

Eliminazione di clip

E possibile eliminare i clip dalle schede di
memoria SxS.

1 Nella schermata delle miniature,
selezionare la miniatura del clip da
eliminare, quindi selezionare
THUMBNALIL >Delete Clip.

La schermata passa alla schermata di
proprieta del clip, quindi appare un
messaggio di conferma sotto I’immagine
indice.

2 Selezionare [Execute], quindi premere
la manopola MENU.
1l clip viene eliminato.

Nella schermata delle miniature, i clip che
seguono il clip eliminato salgono di una
posizione.

Come eliminare gruppi di clip in un’unica
operazione

E possibile eliminare gruppi di clip in un’unica
operazione da una scheda di memoria SxS.

Quando sono presenti clip sia nella modalita HD che
nella modalita SD nella scheda di memoria SxS,
vengono eliminati solo i clip nella modalita selezionata.

1 Nella schermata delle miniature,
selezionare le miniature dei clip da
eliminare, quindi selezionare
THUMBNAIL >Delete All Clips.
Appare il messaggio di conferma “Delete All
Clips?”.

2 Selezionare [Execute], quindi premere
la manopola MENU.
L’eliminazione ha inizio.
Durante 1’eliminazione, viene visualizzato il
progresso dell’eliminazione.

Operazioni miniature

Se si esegue I’eliminazione in modalita HD,
vengono eliminati solo i clip in modalita HD.
Se si esegue I’eliminazione in modalita SD,

vengono eliminati solo i clip in modalita SD.

Come annullare I’eliminazione
Premere il pulsante RESET/RETURN.

Quando termina I’eliminazione.
Appare un messaggio di completamento e la
schermata del menu THUMBNALIL riappare.

Visualizzazione della schermata
di espansione delle miniature

La schermata di espansione delle miniature
permette di ricercare all’interno dei clip
utilizzando le miniature (vedere pagina 98), per
cambiare le immagini indice (vedere

pagina 111), e per aggiungere e eliminare
indicatori di ripresa (vedere pagina 110).

Come visualizzare la schermata

Nella schermata delle miniature, selezionare una
miniatura e premere il pulsante DISP SEL/
EXPAND (vedere pagina 19) o selezionare
THUMBNAIL >Thumbnail View >Forward
Expansion.

Appare la schermata di espansione delle
miniature del clip selezionato.

Schermata di espansione delle
miniature in modalita UDF/FAT-HD

[Gor ) Farso)

In modalita UDF o FAT-HD, il clip selezionato
viene diviso in 12 blocchi della stessa
dimensione, e viene visualizzata una miniatura
del primo fotogramma di ciascun blocco.



Numero del fotogramma selezionato

alCAT

L
~ 01:10:40:00
..,

e

7 01:11:20:00

11:40:00  01:11:50:00
01/JAN/2009 10:53 S&Q Motion 29
JPAN0011(1) @@ HQ 1920/24p

Le proprieta dei clip vengono mostrate in fondo
allo schermo.

Fatta eccezione per la voce elencata sotto, le
informazioni visualizzate qui sono le stesse delle
informazioni visualizzate nella normale
schermata delle miniature.

© Informazioni sul fotogramma
Questo visualizza le informazioni del
fotogramma usando le icone.

&0

Immagine indice

Fotogramma con indicatore Shot
Mark1

Fotogramma con indicatore Shot
m Mark 2

Le stesse icone sono visualizzate anche sotto le
miniature. Tuttavia, quando diverse icone
dovrebbero essere visualizzate per lo stesso
fotogramma, viene selezionata un’icona da
visualizzare, nell’ordine di priorita Index picture
> Shot Mark1 > Shot Mark2.

@ Codice temporale

Visualizza il codice temporale del fotogramma
selezionato nella schermata di espansione delle
miniature.

Schermata di espansione delle
miniature in modalita FAT-SD

In modalita FAT-SD, solo nel caso dei clip divisi
in file parziali perché la dimensione del file
superava i 2 GB, viene visualizzata una miniatura
del primo fotogramma di ciascun file parziale.

Numero del fotogramma selezionato

EXPAND

-

00:09:30:00 00:19:00:00

JPAN0O011_01 DVCAM30P SQ

01/JAN/2009 10:53 l

(ICR 00:00:00:00)
OUR 00:09:30:00)

Le proprieta dei clip vengono mostrate in fondo
allo schermo.

Fatta eccezione per la voce elencata sotto, le
informazioni visualizzate qui sono le stesse delle
informazioni visualizzate nella normale
schermata delle miniature.

© Codice temporale

Questo ¢ il codice temporale di un file parziale
selezionato.

® Durata
Questa ¢ la durata di un file parziale selezionato.

Come aumentare il numero di divisioni

Quando si preme il pulsante DISP SEL/
EXPAND, o si seleziona THUMBNAIL
>Thumbnail View >Forward Expansion, il clip o
il file diviso viene ulteriormente diviso in 12
blocchi di dimensioni uguali (un clip o un file
diviso in 12 viene ulteriormente divisoin 12, 12 x
12 = 144 divisioni). E possibile ripetere la stessa
operazione per aumentare il numero di divisioni.

Come tornare al livello di divisione precedente
Premere il pulsante DISP SEL/EXPAND tenendo
premuto il pulsante SHIFT, o selezionare
THUMBNAIL >Thumbnail View >Back
Expansion. La schermata di espansione delle
miniature torna al livello precedente di divisione.

Operazioni miniature
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Visualizzazione della schermata
delle miniature degli indicatori di
identificazione

[Gor ) Faro]

Nella schermata delle miniature degli indicatori
di identificazione (mostrata solo in modalita HD),
¢ possibile cercare gli indicatori di ripresa nei clip
(vedere pagina 98), cambiare le immagini indice
(vedere pagina 111), e aggiungere ed eliminare
¢li indicatori di ripresa (vedere pagina 110).

1 Nella schermata delle miniature,
selezionare la miniatura di un clip e
premere il pulsante ESSENCE MARK
(vedere pagina 21) o selezionare
THUMBNAIL >Thumbnail View
>Essence Mark Thumbnail.

Appare la schermata delle miniature degli
indicatori di identificazione, e viene
visualizzato un elenco di selezione.

2 Selezionare il tipo di schermata delle
miniature degli indicatori di
identificazione
All: visualizzazione di tutti i fotogrammi

indicati con tracce di identificazione.
Rec Start: visualizzazione dei fotogrammi
indicati con le tracce Rec Start e dei
primi fotogrammi dei clip quando i primi
fotogrammi non sono indicati con le

tracce Rec Start (solo in modalita UDF).

Shot Mark1: visualizza solo i fotogrammi

contrassegnati da indicatori Shot Mark1.

Shot Mark2: visualizza solo i fotogrammi

contrassegnati da indicatori Shot Mark2.

E anche possibile selezionare Shot Mark 0 e
Shot Mark 3 - Shot Mark 9.

Se sono stati registrati dei clip usando
metadata di pianificazione che definivano i
nomi per Shot Mark O - Shot Mark 9, i nomi
definiti sono visualizzati nell'elenco al posto
dei suddetti nomi voce.

Operazioni miniature

Esempio di schermata delle miniature
degli indicatori di ripresa (con Shot
Mark1 selezionato)

T SHOT MARK1 (o] {5 I

Le proprieta del clip appaiono in fondo allo
schermo.

Fatta eccezione per la voce seguente, le
informazioni visualizzate qui sono le stesse delle
informazioni visualizzate nella schermata di
espansione delle miniature.

© Codice temporale

Si tratta del codice temporale del fotogramma
selezionato nella schermata delle miniature degli
indici di ripresa.

Aggiunta ed eliminazione degli
indicatori di ripresa

[Gor ) Fao)

Nella schermata delle miniature degli indicatori
di identificazione (vedere pagina 110) o nella
schermata di espansione delle miniature (vedere
pagina 108), ¢ possibile aggiungere delle
miniature a qualsiasi fotogramma di clip
registrato in modalitd HD, ed eliminare gli
indicatori di ripresa registrati.

Come aggiungere gli indicatori di ripresa

1 Selezionare il fotogramma in cui si
desidera aggiungere un indicatore di
ripresa, quindi selezionare
THUMBNAIL > Set Shot Mark > Add
Shot Mark1 (o Add Shot Mark?2).



Appare la schermata delle proprieta del
fotogramma selezionato, e un messaggio di
conferma appare sotto I’immagine.

2 Selezionare [Execute], quindi premere
la manopola MENU.

Come eliminare gli indicatori di ripresa

1 Selezionare il fotogramma in cui si
desidera eliminare un indicatore di
ripresa, quindi selezionare
THUMBNAIL > Delete Shot Markl1 (o
Delete Shot Mark?2).

Appare la schermata delle proprieta del
fotogramma selezionato, e un messaggio di
conferma appare sotto I’immagine.

2 Selezionare [Execute], quindi premere
la manopola MENU.

Modifica delle immagini indice
dei clip

[Gor ) Faro]

Nella schermata delle miniature delle tracce
identificazione (vedere pagina 110) o nella
schermata di espansione delle miniature(vedere
pagina 108), & possibile impostare il fotogramma
selezionato del clip registrato in modalita UDF/
FAT-HD come immagine indice.

1 Selezionare la miniatura del
fotogramma che si desidera utilizzare
come immagine indice, quindi
selezionare THUMBNAIL >Set Index
Picture.

Appare la schermata delle proprieta del
fotogramma selezionato, e un messaggio di
conferma appare sotto I’immagine.

2 Selezionare [Execute], quindi premere
la manopola MENU.

Anche se si imposta I’'immagine indice su un
fotogramma che non ¢ il primo fotogramma di un clip, la
riproduzione di quel clip da una schermata delle
miniature inizia sempre con il primo fotogramma.

Divisione dei clip

Nella schermata di espansione delle miniature
(vedere pagina 108) e nella schermata delle
miniature degli tracce di identificazione (vedere
pagina 110), 1 clip registrati in modalita FAT-HD
possono essere divisi in due clip nel fotogramma
selezionato.

1 Selezionare la miniatura del
fotogramma in cui si desidera dividere
il clip, quindi selezionare
THUMBNAIL >Divide Clip.
Appare la schermata delle proprieta del
fotogramma selezionato, e un messaggio di
conferma appare sotto I’immagine.

2 Selezionare [Execute], quindi premere
la manopola MENU.
1l clip viene diviso al clip selezionato, e
vengono creati due clip con nomi differenti.

I primi quattro caratteri del nome del clip
vengono presi dal nome dei clip originali, e gli
ultimi quattro caratteri sono nuovi numeri di
serie.

Esempio: Se il nome di un clip di nuova
registrazione € EFGHO0100, e un clip
denominato ABCDO0002 viene diviso, i nomi
dei clip di nuova creazione sono ABCD0100
and ABCDO0101.

Quando non c¢’¢ sufficiente spazio residuo sulla scheda di
memoria SxS per memorizzare i clip divisi, appare un
messaggio per informare che non c’¢ sufficiente spazio
disponibile.

Operazioni miniature
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Organizzazione e livelli
del menu di
impostazione

Su questo camcorder, le impostazioni per la
ripresa e la riproduzione vengono eseguiti nel
menu di impostazione che appare nel mirino.

Il menu di impostazione puo anche essere
visualizzato su un monitor video esterno (vedere
pagina 184).

Organizzazione del menu di
impostazione

Il menu di impostazione & costituito dai seguenti
menu.

Us: menu USER
Voci di menu aggiunte in qualsiasi ordine da altri
menu (vedere pagina 117)

Op: menu OPERATION

Impostazioni relative alla ripresa, eccetto
impostazioni relative alla qualita dell’immagine
(vedere pagina 118)

Pa: menu PAINT
Impostazioni relative alla qualita dell’'immagine
(vedere pagina 138)

Th: menu THUMBNAIL
Impostazioni relative alle miniature dei clip
(vedere pagina 100)

Il menu THUMBNAIL si utilizza solo quando viene
visualizzata una schermata delle miniature (vedere
pagina 94) . Viene disabilitato quando non viene
visualizzata alcuna schermata delle miniature.

Ma: menu MAINTENANCE
Impostazioni relative all’audio e al codice
temporale (vedere pagina 145)

Fi: menu FILE
Impostazioni relative alle operazioni sui file
(vedere pagina 164)

Organizzazione e livelli del menu di impostazione

sl Menu e impostazioni dettagliate

Livelli del menu di impostazione

Vedere “Configurazione menu THUMBNAIL”
(pagina 100) per I’organizzazione del menu
THUMBNAIL.

Menu USER (vedere pagina 117)

USER
Format Media
Rec Function
——— Input/Output
——— Clip
——— Assignable SW
Camera Config

Menu OPERATION (vedere pagina 118)

OPERATION

Format

Format Media
——— Input/Output

Super Impose
———-LCD

Rec Function
——— Assignable SW
——— VF Setting

Marker

Gain Switch
———TLCS
————— Zebra
—— Display On/Off

“1” LED

Auto Iris
———— Shot ID
——— Shot Display

White setting
— Offset White

Shutter

Time Zone
—— Clip

Plan.Metadata
———USB




Menu PAINT (vedere pagina 138)
PAINT

——— Switch Status
—— White

——— Black

|— Flare

—— Gamma

| — Black Gamma
I— Knee

——— White Clip
| Detail(HD Mode)
|— Detail(SD Mode)
|— Aperture

— Skin Detail
| Matrix

——— Multi Matrix
——— V Modulation

Low Key Saturation

L Noise Suppress

Menu MAINTENANCE (vedere pagina 145)

MAINTENANCE

‘White Shading
Black Shading
Battery

Audio

WRR Setting
Timecode
Essence Mark
Camera Config
Preset White
White Filter
DCC Adjust
Auto Iris2
Genlock

ND Comp
Lens

Auto Shading
APR

Trigger Mode

Wi-Fi Setting
Clock set
Language

Hours Meter

Version

Network Setting

Menu FILE (vedere pagina 164)
FILE

User

All

Scene

Reference

Lens

Organizzazione e livelli del menu di impostazione
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Operazioni di base del
menu di impostazione

Come visualizzare il menu di
impostazione

Impostare I’interruttore MENU ON/OFF su ON,
o premere il pulsante MENU.

Il camcorder entra nella modalita menu e appare
I’elenco dei menu sullo schermo.

Appare un cursore sui primi due caratteri del menu
usato piu di recente, quindi appare sulla destra
I’area di selezione della voce del menu
corrispondente.

Esempio: Quando il cursore si posiziona sul
menu OPERATION

Elenco dei menu

OPERATION

Format
Format Media
a2 lf Input/Output

Area di selezione delle voci del

I menu di impostazione non pud essere utilizzato
quando il camcorder si trova in modalita di
ingrandimento della messa a fuoco. Uscire dalla
modalita di ingrandimento della messa a fuoco
premendo I’interruttore programmabile a cui & stata
assegnata la funzione Focus Mag.

Come impostare il menu

1 Ruotarela manopola MENU, o
premere il pulsante 1} o &, per spostare
il cursore sulla voce che si desidera
impostare.
Un elenco di voci di menu selezionabili
appaiono nell’apposita area di selezione a
destra dell’icona.

Operazioni di base del menu di impostazione

2 Premerela manopola MENU o il
pulsante SET.

11 cursore si sposta sull’area di selezione

delle voci di menu.

E anche possibile spostare il cursore sull’area

di selezione delle voci di menu premendo il

pulsante =>.

* Nell’area di selezione delle voci del menu
vengono visualizzate massimo sette righe.
E possibile scorrere i menu con piil di 7
righe muovendo il cursore verso I’alto o il
basso.

Dei triangoli appaiono nella parte in alto a
destra dell’area di selezione delle voci del
menu per indicare che ¢ possibile far
scorrere il menu.

OPERATION
Format

Format Media
Input/Output

Super impose

Appare quando piu voci del menu
sono disponibili sotto I'ultima linea.
(A appare quando piu voci del menu
sono disponibili oltre la prima linea.)

Area di selezione delle voci del menu

* P appare sulla destra quando sono
disponibili delle voci secondarie piu
dettagliate.

* Le impostazioni appaiono sulla destra
quando una voce del menu non ha voci
secondarie.

* E possibile selezionare &) per tornare al
livello precedente.

3 Ruotarela manopola MENU, o
premere il pulsante 1} o {, per spostare
il cursore sulla voce che si desidera
impostare, quindi confermare
premendo la manopola MENU o il
pulsante SET.
L’area delle voci secondarie viene
visualizzata a destra dell’area di selezione
delle voci di menu e il cursore si sposta sulla
prima delle relative voci secondarie.



OPERATION
2
Format File System
()l Format Media HD/SD : HD

Input/Output HD System Line  : 1080
Super impose System Frequency : 59.94i
LCD Rec Format : HQ 1920
Rec Function
Area voci secondarie
 Visualizza le voci secondarie e le loro
impostazioni attuali.
¢ Per tornare al livello precedente,
selezionare =), premere il pulsante <=, o
spostare l'interruttore MENU CANCEL/
PRST/ESCAPE su ESCAPE.

Ruotare la manopola MENU, o
premere il pulsante 1} o &, per spostare
il cursore sulla voce secondaria che si
desidera impostare, quindi confermare
la selezione premendo la manopola
MENU o il pulsante SET.

Appaiono le impostazioni della voce
secondaria selezionata quindi il cursore si
sposta sul valore attualmente selezionato.

OPERATION

Format File System

(3 Format Media HD/SD
Input/Output HD System Line
Super impose

Rec Function

Area di impostazione

¢ Nell’area delle impostazioni viene
visualizzato un massimo di sette righe. E
possibile scorrere i menu con pil di 7 voci
secondarie spostando il cursore verso 1’alto
o il basso. Nell’area delle impostazioni
appaiono dei triangoli in alto a destra e in
basso a destra per indicare che & possibile
far scorrere il menu delle voci secondarie.
Per le voci secondarie con un’ampia
gamma di impostazione (per esempio, da —
99 a +99), non viene visualizzata I’area di
impostazione. Invece, il nome della voce
secondaria viene evidenziato per indicare
che € possibile impostare la voce
secondaria.

9 Ruotarela manopola MENU, o
premere il pulsante fod, per
selezionare il valore da impostare,
quindi confermare premendo la
manopola MENU o il pulsante SET.
L’impostazione viene cambiata, € la
schermata viene aggiornata per mostrare la
nuova impostazione.

Se si seleziona [Execute] per una voce che
prevede I’esecuzione di un’azione, la
funzione corrispondente viene eseguita.

Voci che richiedono una conferma prima
dell’esecuzione

Al punto 3, il menu scompare e appare un
messaggio di conferma se si seleziona una voce
che richiede una conferma prima dell’esecuzione.
Seguire le istruzioni visualizzate nel messaggio
per eseguire o annullare 1’operazione.

Come inserire testo

Alcune voci, come dati temporali o nomi di file,
devono essere impostati inserendo testo. Quando
si seleziona una di queste voci, I’area di
inserimento del testo viene evidenziata, con
“SET” visualizzato sulla destra.

1 Ruotarela manopola MENU, o
premere il pulsante 1} o {, per
selezionare un carattere, quindi
confermare premendo la manopola
MENU o il pulsante SET.

11 cursore si sposta nella posizione
successiva.

Per tornare alla posizione precedente,
spostare I’interruttore MENU CANCEL/
PRST/ESCAPE su ESCAPE.

2 Selezionare dei caratteri per tutte le
posizioni fino all’ultima.
11 cursore si sposta su “SET”.

Premere la manopola MENU o il
pulsante SET.
Cosi facendo si conferma I’impostazione.

Annullare le modifiche all’impostazione

Spostare I'interruttore MENU CANCEL/PRST/
ESCAPE su ESCAPE.

Operazioni di base del menu di impostazione
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Ripristinare il valore iniziale di
un’impostazione

1 Prima di modificare un’impostazione, o
dopo aver annullato una modifica,
spostare I’interruttore MENU
CANCEL/PRST/ESCAPE su
CANCEL/PRST.

2 Quando si visualizza il messaggio per
confermare il ripristino ai valori
iniziali, spostare di nuovo I’interruttore
MENU CANCEL/PRST/ESCAPE su
CANCEL/PRST.

Le impostazioni attuali vengono ripristinate
ai valori iniziali.

Come uscire dal menu

Impostare I’interruttore MENU ON/OFF su OFF
o premere il pulsante MENU.
Riappare I'immagine normale della telecamera.
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Menu USER (configurazione predefinita)

Il menu USER ¢ costituito dalle seguenti voci quando si trova nello stato predefinito.
« Format Media (vedere pagina 119)

« Input/Output (vedere pagina 120)

* Rec Function (vedere pagina 123)

« Assignable Swl) (vedere pagina 125)

* Clip (vedere pagina 134)

» Camera Config?) (vedere pagina 153)

1) Esclusa la voce secondaria <0>
2) Contiene solo il Menu User come voce secondaria

E possibile modificare la configurazione del menu USER aggiungendo le voci di menu desiderate e
disponendole in una cartella desiderata.

Per ulteriori informazioni, consultare il Supplemento fornito con il CD-ROM (contrassegnato con
“Manuals for Solid-State Memory Camcorder”).

Elenco dei menu
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Menu OPERATION

Le impostazioni in grassetto corrispondono ai valori predefiniti.

OPERATION

Voci dei menu Voce secondaria  Impostazioni

Descrizione

Format File System UDF/FAT
Specifica la modalita
di registrazione, la

Passa tra UDF e FAT in base alla
modalita di registrazione (eseguire
selezionando [Execute]).

modalita operativa e HD/SD HD/SD
il formato di

registrazione del
camcorder.

Passa tra HD o SD in base alla modalita
operativa (eseguire selezionando
[Execute]).

Se il CBK-MDO1 opzionale non &
installato, [SD] non puo essere selezionato.
(La registrazione SD non & consentita.)

HD System Line ~ 1080/720

Quando la modalita operativa ¢ HD,
imposta il numero di linea del sistema
su 1080 o 720 (eseguire selezionando
[Execute]).

System Frequency Le impostazioni
disponibili cambiano in
base alle impostazioni di
HD/SD, HD System Line
e Country.

Seleziona la frequenza di sistema
(eseguire selezionando [Execute]).

59.94i/29.97P/23.98P

Quando I"impostazione HD/SD ¢ su
[HD], I'impostazione HD System Line
si trova su [1080], e I'impostazione
Country ¢ diversa da [PAL Area].

50i/25P

¢ Quando I"'impostazione HD/SD ¢ su
[HD], I'impostazione HD System
Line si trova su [1080], e
I’impostazione Country ¢ [PAL Area].

* Quando I’impostazione HD/SD si
trova su [SD], e I'impostazione
Country ¢ su [PAL Area].

59.94P/29.97P/23.98P

Quando I’impostazione HD/SD ¢ su
[HD], I'impostazione HD System Line
si trova su [720], e I'impostazione
Country ¢ diversa da [PAL Area].

50P/25P

Quando I’impostazione HD/SD ¢ su
[HD], I'impostazione HD System Line
si trova su [720], e I'impostazione
Country ¢ [PAL Area].

59.94i/29.97P
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Quando I"impostazione HD/SD si trova
su [SD], e I’'impostazione Country &
diversa da [PAL Area].
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Format

Specifica la modalita
operativa del
camcorder e il
formato di
registrazione.

Rec Format

Le impostazioni

disponibili cambiano in
base alle impostazioni di
UDF/FAT, HD/SD, HD
System Line e System

Frequency.

Seleziona il formato di registrazione
(eseguire selezionando [Execute]).

HD422 50/HD420 HQ

¢ Quando I’impostazione UDF/FAT ¢
[UDF], I'impostazione HD/SD ¢
[HD], I'impostazione HD System
Line & [1080].

* Quando I"'impostazione UDF/FAT ¢
[UDF], 'impostazione HD/SD ¢
[HD], I'impostazione HD System
Line ¢ [720] e I'impostazione System
Frequency ¢ [23.98P]. (Quando
I’'impostazione System Frequency &
[25P], [29.97P] o [SOP], questa
impostazione ¢ fissa su [HD422 50].)

HQ 1920/HQ 1440

Quando I’impostazione UDF/FAT ¢
FAT, I'impostazione HD/SD ¢ [HD],
I’impostazione HD System Line &
[1080] e I'impostazione System
Frequency ¢ [29.97P] o [25P].

HQ 1920/HQ 1440/
SP 1440

Quando I’impostazione UDF/FAT ¢
FAT, I'impostazione HD/SD ¢ [HD],
I’impostazione HD System Line &
[1080] e I'impostazione System
Frequency ¢ diversa da [29.97P] e
[25P].

HQ 1280 Quando I"'impostazione UDF/FAT &
FAT, I’'impostazione HD/SD ¢ [HD],
I’'impostazione HD System Line &
[720].
IMX50/DVCAM Quando I’impostazione UDF/FAT ¢
[UDF] e I'impostazione HD/SD ¢ [SD].
DVCAM Quando I’impostazione UDF/FAT &
[FAT] e I'impostazione HD/SD & [HD].
Aspect Ratio (SD) 16:9/4:3 Seleziona il rapporto larghezza/altezza
quando viene selezionata la modalita
SD (eseguire selezionando [Execute]).
Audio 24bit/16bit Seleziona la velocita di trasmissione
Length(IMX) audio per la registrazione in formato
IMX.
Country NTSC Area/NTSC(J) Selezionare I’area d’uso (eseguire
Area/PAL Area selezionando [Execute]).
Format Media Media(A) Execute/Cancel Inizializza la scheda di memoria SxS
Esegue la nello slot A (eseguire selezionando
formattazione di un [Execute]).
supporto. Media(B) Execute/Cancel Inizializza la scheda di memoria SxS

nello slot B (eseguire selezionando
[Execute]).

Elenco dei menu
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Input/Output In modalita FAT HD&HDV/SD&HDV/  Seleziona i segnali da inviare dai
Effettua le Output& i.LINK ~ SD&DV connettori video e dal connettore
impostazioni relative 'Tn modalita UDF ~ HD/SD i.LINK (HDV/DV).
ai segnali /0. Output Quando I’impostazione HD/SD & SD,
viene selezionato “SD&DV” o “SD”.
23.98P Output PsF/Pull Down Quando il formato video ¢ HQ 1920/

23.98P o HQ 1440/23.98P, seleziona se
utilizzare I’invio progressivo (PsF) o
I’invio ridotto (Pull Down).

Source Select )

Camera/i. LINK
/External

Seleziona se utilizzare I’'immagine del
camcorder (Camera), I’ingresso i. LINK
(solo in modalita FAT) o I’ingresso SDI/
COMPOSITE (External) come fonte di
ingresso video.

¢ Quando Rec Source ¢ assegnato
all’interruttore ASSIGN. 2 questa
impostazione ¢ disattivata.

¢ Cambiare l'impostazione File System
>UDF/FAT ripristina questa voce su
[Camera] (impostazione predefinita).

Ext Video Source @)

HD SDI/SD SDI/
Composite

Seleziona il segnale di ingresso esterno.

HD-SDI: segnali HDSDI (solo in
modalita HD)

SD-SDI: segnali SDSDI

Composite: segnali compositi

i.LINK I/O

Enable/Disable

Seleziona se abilitare o disabilitare
I’immissione o I’emissione dei segnali
attraverso il connettore i. LINK (HDV/
DV).

Quando si seleziona Enable, ¢ possibile
eseguire la regolazione automatica del
bilanciamento del bianco durante
I’uscita i.LINK.

SDI Output

On/Off

Attiva o disattiva I’emissione di segnali
dal connettore HD/SD SDI OUT.

SDI Out Super

On/Off

Attiva o disattiva la sovrapposizione di
informazioni di testo sull’uscita del
connettore HD/SD SDI OUT

Video Out Super

On/Off

Attiva o disattiva la sovrapposizione di
informazioni di testo sull’uscita del
connettore VIDEO OUT.

Live & Play

On/Off

Attiva o disattiva la funzione Live &
Play.
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Input/Output Down Converter ~ Crop/Letter/Squeeze Seleziona la modalita di conversione del
Effettua le segnale per I’emissione di segnali SD.

impostazioni relative
ai segnali I/O.

Crop: taglia i bordi dell’immagine in
16:9 e I’invia come immagine in
4:3.

Letterbox: maschera la parte superiore
e la parte inferiore dell’immagine
in 4:3 e la visualizza al centro dello
schermo come un’immagine in
16:9.

Squeeze: schiaccia I'immagine in 16:9
orizzontalmente e la emette come
immagine in 4:3.

Wide ID Through/Auto

Seleziona se aggiungere un segnale

Wide ID al segnale di uscita SD.

Through: uscita senza aggiunta di un
segnale Wide ID.

Auto: aggiunge ed emette un segnale
Wide ID quando I’impostazione
Down Converter ¢ Squeeze.

Wide Auto/16:9
Mode(EXT) &

Quando il segnale di ingresso ¢ SD,
selezionare il metodo che determina se
il segnale viene trattato come un segnale
ampio.

Auto: quando si rileva un segnale Wide
ID nel segnale di ingresso, trattare
il segnale come ampio e impostare
la modalita di funzionamento
dell’up-converter su squeeze.
Quando non si rileva un segnale
Wide ID, impostare la modalita di
funzionamento dell’up-converter
su edge crop e non registrare un
segnale Wide ID.

16:9: Trattare sempre il segnale come
segnale ampio e impostare la
modalita di funzionamento dell’up-
converter su squeeze.

Setup 7.5%/0.0%
Remove(EXT) 2

Quando I’impostazione Country ¢
diversa da [PAL Area], seleziona se
rimuovere il livello di impostazione dei
segnali video di ingresso analogici.
7.5%: elimina I’impostazione.

0.0%: non eliminare I’'impostazione.

Elenco dei menu
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Voci dei menu Voce secondaria  Impostazioni Descrizione

Super Impose Super(VF Display) On/Off Quando I"impostazione di Input/Output
Esegue le Super(Menu) On/Off >SDI Out Super o Video Out Super ¢ su
impostazioni relative Super(Timecode)  On/Off On, le informazioni di testo

al testo sovrascritto e

P . sovraimpresso nell’emissione dal
agli indicatori.

connettore HD/SD SDI OUT e dal
connettore VIDEO OUT, come
specificato (On o Off) per ciascuna
voce.

Super(Marker) On/Off Quando I’impostazione Input/Output
>Video Out Super ¢ su On, specifica se
sovrapporre gli indicatori nell uscita dal
connettore VIDEO OUT.

Super(Rec Status  On/Off Attiva (On) o disattiva (Off) la

Indicator) sovraimpressione dell’indicatore dello
stato di registrazione sulle due uscite
seguenti:

« Uscita dal connettore VIDEO OUT
con Input/Output >Video Out Super
impostato su [On]

« Uscita dal connettore SDI con Input/
Output >SDI Out Super impostato su

[On]
LCD LCD Color Da-99 a 0 a +99 Regola il colore dell’LCD.
LCD On/Off Porta la visualizzazione dell’indicatore
Marker&Zebra e del motivo zebrato sul monitor LCD

sulla posizione ON o OFF.
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Voci dei menu Voce secondaria

Impostazioni

Descrizione

Rec Function
Esegue le
impostazioni relative
alle modalita di
registrazione speciali.

Slow & Quick

On/Off

Attiva o disattiva la funzione Slow &
Quick Motion. (Quando ¢ impostata su
On, le voci secondarie Picture Cache
Rec, Interval Rec, e Frame Rec sono
impostate su Off.)

Quando si assegna un
Picture Cache a un
interruttore
programmabile,
questa voce &
disattivata
(visualizzata in
grigio).

Frame Rate

Le impostazioni
disponibili variano a
seconda
dell’impostazione Format
>HD System Line.

Quando I’'impostazione Slow & Quick ¢
su On, imposta la frequenza di
fotogrammi per la ripresa Slow & Quick
Motion.

Quando Format >Country
non ¢ impostato su [PAL
Area] in modalita UDF o
in modalita FAT: da 1 a 30
Quando Format >Country
¢ impostato su [PAL
Area] in modalita UDF:
dala25

Quando I"'impostazione HD System
Line ¢ 1080.

Quando Format >Country
non ¢ impostato su [PAL
Area] in modalita UDF o
in modalita FAT: da 1 a 30
a 60

Quando Format >Country
¢ impostato su [PAL
Area] in modalita UDF:

Quando I’impostazione HD System
Line & 720.

dala25a50
Clip Continuous  On/Off Attiva o disattiva la funzione Clip
Rec Continuous Rec. (Quando ¢ impostata
su On, le voci secondarie Slow &
Quick, Picture Cache Rec, Interval Rec
e Frame Rec sono impostate su Off.)
Picture Cache Rec  On/Off Attiva o disattiva la funzione picture

cache. (Quando ¢ impostata su On, le
voci secondarie Slow & Quick, Interval
Rec, e Frame Rec sono impostate su
Off.)

Elenco dei menu
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Rec Function
Esegue le
impostazioni relative

P. Cache Rec Time

0-2sec/2-4sec/4-6sec/6-
8sec/8-10sec/10-12sec/
12-14sec/13-15sec

Quando I"impostazione Picture Cache
Rec ¢ su On, impostare picture cache
time.

alle modalita di

f . . .. Interval Rec On/Off Attiva o disattiva la funzione Interval

registrazione speciali. .. .
Rec. (Quando ¢ impostata su On, le voci

m secondarie Slow & Quick, Picture

Quando si assegna un Cache Rec, e Frame Rec sono impostate

Picture Cache a un su Off.)

interruttore Frame Rec On/Off Attiva o disattiva la funzione Frame

prog{ammab\lle, Rec. (Quando & impostata su On, le voci

questa voce & secondarie Slow & Quick, Picture

disattivata

(visualizzata in Cache Rec, e Interval Rec sono

grigio). impostate su Off.)

Number of Frames

Le impostazioni
disponibili cambiano in
base alle impostazioni di
Format >HD System Line
e Format >System
Frequency.

Quando Interval Rec o Frame Rec sono
impostati su On, specifica il numero di
fotogrammi da riprendere in una ripresa
Interval Rec o Frame Rec.

2frame/6frame/12frame

Quando I"impostazione HD System
Line setting & su 720, e System
Frequency ¢ 59.94P o 50P.

1frame/3frame/6frame/
9frame

Quando I"'impostazione HD System
Line ¢ diversa da 720, o I’impostazione
System Frequency ¢ diversa da 59.94P o
50P.

Interval Time

1/2/3/4/5/6/7/8/9/10/15/
20/30/40/50 (sec)

1/2/3/4/5/6/7/8/9/10/15/
20/30/40/50 (min) 1/2/3/

Quando I"'impostazione Interval Rec ¢
su On, imposta I’intervallo per Interval
Rec shooting.

4/6/12/24 (hour)

Pre-Lighting Off/2sec/5sec/10sec Se si desidera accendere la luce del
video prima della ripresa Interval Rec,
selezionare un numero dell’avvio della
ripresa. Se non si desidera accenderla,
selezionare Off.

Live Logging Live/View In modalita UDF: selezionare la

modalita di funzionamento Live
Logging.

In modalita FAT: fisso su [Live]
(modalita Live).

Quando ¢ selezionata una modalita fra
Frame Rec, Interval Rec e Clip
Continuous Rec, non ¢ possibile
selezionare [View].

Per ulteriori informazioni sulle funzioni
Live Logging, consultare il Supplemento
fornito con il CD-ROM (contrassegnato
con “Manuals for Solid-State Memory
Camcorder”).
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Assignable SW <0> Vedere pagina 171. Assegna la funzione all’interruttore
Assegna delle ASSIGN. 0.
funzioni agli <I> Assegna la funzione all’interruttore
interruttori B ASSIGN. 1.
programmabili. <2> Assegna la funzione all’interruttore
Vedere ASSIGN. 2.
“Assegnazione di 33 Assegna la funzione all’interruttore
Sfunzioni agli ASSIGN. 3.
interruttori <4> Assegna la funzione all’interruttore
programmabili” ASSIGNABLE 4.
(pag i'na i 171) per "33 Assegna la funzione all’interruttore
ulteriori ASSIGNABLE 5.
informazioni RET Assegna la funzione al pulsante RET
sull’assegnazione di sull’ obiettivo.
Junzioni. C. Temp Assegna la funzione al pulsante
COLOR TEMP.
Zoom Speed Da0a20a99 Quando Zoom ¢ stato assegnato
all’interruttore ASSIGNABLE 4 0 5,
specifica la velocita dello zoom.
VF Setting Color b) Da-99 a 0 a +99 Regola la densita dei colori visualizzati
Esegue le nella schermata del mirino.
impostazioni relative Mode b) Color/B&W Seleziona la modalita di visualizzazione
all'a' schermata del del mirino.
mirino. .
Color: a colori
B&W: monocromatica
Peaking Type b) Normal/Color/Both Seleziona il tipo di peaking.
Normal: peaking normale
Color: peaking a colori
Both: entrambi
Peaking Normal/High Seleziona Normal (Normale) o High
Frequency b) (Alto) come la frequenza del peaking.
Peaking Colorb) ~ White/Red/Yellow/Blue  Quando I’impostazione di Peaking Type

¢ Color, seleziona il colore del peaking
tra White (Bianco), Red (Rosso),
Yellow (Giallo), e Blue (Blu).

VF Detail Level ¢)

Da-99 a+0a +99

Regola il livello del dettaglio (impostato
sul camcorder) del mirino

Color Peaking
Level b)

Low/Mid/High

Quando I’impostazione Peaking Type &
su Both, seleziona il livello peaking a
colori tra Low (basso), Mid (medio), e
High (alto).

Elenco dei menu
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Marker Setting On/Off Attiva o disattiva tutti gli indicatori.
Esegue le

impostazioni relative
alla visualizzazione
degli indicatori nella
schermata del mirino.

Quando Marker ¢ assegnato all’interruttore
ASSIGN. 2 questa impostazione &
disattivata.

Center Maker 1/2/3/410ff

Quando viene visualizzato I’indicatore
del centro, seleziona il tipo. Selezionare
Off se non si desidera visualizzare
I’indicatore.

Quando tre di Safety Zone, User Box,
Guide Frame e 100% Marker sono
impostati su [On], questa impostazione
non & disponibile.

Center H Position Da-40a 0 a40

Specifica la posizione orizzontale
dell’indicatore del centro.

Center V Position Da-40a0a40

Specifica la posizione verticale
dell’indicatore del centro.

Safety Zone On/Off

Attiva o disattiva la visualizzazione
dell’area di sicurezza.

Quando tre di Center Marker, User Box,
Guide Frame e 100% Marker sono
impostati su [On], questa impostazione
non ¢ disponibile.

Safety Area 80%/90%/92.5%/95%

Seleziona le dimensioni dell’area di
sicurezza.

Aspect Marker Line/Mask/Off

Quando viene visualizzato un indicatore

di formato, seleziona il metodo di

visualizzazione. Selezionare Off se non

si desidera visualizzare 1’indicatore.

Line: mostra delle linee bianche.

Mask: visualizzazione attraverso
I’abbassamento del livello del
segnale video delle aree esterne al
range dell’indicatore.

Aspect Select 15:9/14:9/13:9/4:3/ Seleziona il rapporto larghezza/altezza
1.66:1/1.85:1/2.35:1/2.4:1 dell’indicatore.
100% Marker On/Off Attiva o disattiva la visualizzazione

dell’area di sicurezza 100%.

Quando tre di Center Marker, Safety Zone,
User Box e Guide Frame sono impostati su
[On], questa impostazione non ¢
disponibile.
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Marker

Esegue le
impostazioni relative
alla visualizzazione
degli indicatori nella
schermata del mirino.

Aspect Mask

Da 0% a 30% a 90%
(incrementi del 10%)

Quando I’impostazione di Aspect
Marker & su Mask, specifica il livello di
segnale video delle aree esterne al range
dell’indicatore sottoforma di valore
percentuale relativo al livello del
segnale video delle aree interne al range
dell’indicatore.

User Box

On/Off

Attiva o disattiva il cursore della casella.

Quando tre di Center Marker, Safety Zone,
Guide Frame e 100% Marker sono
impostati su [On], questa impostazione
non & disponibile.

User Box Width

Da 40 a 500 a 999

Specifica la larghezza del cursore della
casella (distanza dal centro ai bordi
destro e sinistro).

User Box Height

Da 70 a 500 a 999

Specifica I’altezza del cursore della
casella (distanza dal centro al bordo
superiore e inferiore).

User Box H Da-479 a 0 a 479 Specifica la posizione orizzontale del
Position centro del cursore della casella.

User Box V Da -464 a 0 a 464 Specifica la posizione verticale del
Position centro del cursore della casella.

Guide Frame

On/Off

Attiva o disattiva la visualizzazione del
fotogramma guida.

Quando tre di Center Marker, Safety Zone,
User Box e 100% Marker sono impostati
su [On], questa impostazione non &
disponibile.

Gain Switch
Esegue le
impostazioni relative

all’interruttore
GAIN.

Gain Low —6 dB/-3 dB/0 dB/3 dB/6 Specifica il valore del guadagno per la
dB/9 dB/12 dB/18 dB/24  posizione L dell’interruttore GAIN.
dB/30 dB/36 dB/42 dB

Gain Mid —6 dB/-3 dB/0 dB/3 dB/6 Specifica il valore del guadagno per la
dB/9 dB/12 dB/18 dB/24 posizione M dell’interruttore GAIN.
dB/30 dB/36 dB/42 dB

Gain High —6 dB/-3 dB/0 dB/3 dB/6 Specifica il valore del guadagno per la
dB/9 dB/12 dB/18 dB/24 posizione H dell’interruttore GAIN.
dB/30 dB/36 dB/42 dB

Gain Turbo —6 dB/-3 dB/0 dB/3 dB/6 Specifica il valore del guadagno della
dB/9 dB/12 dB/18 dB/24  funzione Turbo Gain, che puo essere
dB/30 dB/36 dB/42dB  assegnata a un interruttore

programmabile.

Shockless Gain On/Off Attiva o disattiva lo shockless gain (una

funzione che permette di cambiare

facilmente quando il guadagno ¢ attivo).
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Voci dei menu Voce secondaria

Impostazioni

Descrizione

TLCS

Esegue le
impostazioni relative
al livello di controllo
totale.

Mode

Backlight/Standard/
Spotlight

Seleziona la modalita del diaframma
automatico utilizzata quando il sistema
TLCS ¢ attivo.

Backlight: modalita Backlight
(diminuisce il blackout del
soggetto principale che si verifica
in condizioni di retroilluminazione)

Standard: modalita standard

Spotlight: modalita Spotlight
(diminuisce il whiteout of del
soggetto principale che si verifica
in uno spotlight)

Speed

Da-99 a+0 a +99

Specifica la velocita di comando
(velocita di reazione alle modifiche nel
video) utilizzate quando il sistema
TLCS ¢ attivo. (Valori maggiori
specificano tempi di reazione pil
rapidi.)

AGC

On/Off

Attiva o disattiva la funzione AGC
(controllo del guadagno automatico).

AGC Limit

3dB/6dB/9dB/12dB/
18dB

Specifica il massimo guadagno in uso
quando AGC ¢ in funzione.

AGC Point

F5.6/F4/F2.8

Specifica il valore F dove il controllo
con gli interruttori del diaframma
automatico per il controllo con AGC,
utilizzato quando AGC ¢ attivo.

Auto Shutter

On/Off

Attiva o disattiva la funzione otturatore
automatico.

Auto Shutter Limit

1/100/ 1/150 / 1/200 /
1/250

Seleziona la velocita massima
dell’otturatore utilizzata quando & attivo
I’otturatore automatico.

Auto Shutter Point

F5.6/F8/F11/F16

Specifica il valore F in cui il controllo
attraverso il diaframma automatico
passa a comando attraverso 1’otturatore
automatico, utilizzato quando
I’otturatore automatico & attivo.

Zebra
Esegue le

Zebra Select

1/2/BOTH

Seleziona il tipo di motivo zebrato
(Zebral, Zebra2, Both).

impostazioni relative
alla visualizzazione

Zebral Level

Da50% a70% a 107%

Specifica il livello di visualizzazione
Zebral.

del motivo zebrato. - -
Livello di apertura

Zebral

Dalal1l0% a20%

Specifica il livello di apertura Zebral.

Zebra2 Level

Da 52% a 100% a 109%

Specifica il livello di visualizzazione
Zebra2.
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Voci dei menu Voce secondaria  Impostazioni Descrizione

Display On/Off Video Level On/Off Attiva o disattiva le avvertenze che

Selezionare le vocida  Warnings appaiono quando il livello video &

visualizzare nella troppo brillante o troppo scuro.

schermata del mirino. Brightness Display On/Off Attiva o disattiva le indicazioni
numeriche della luminosita video.

Histogram Display On/Off Attiva o disattiva la visualizzazione a

(solo in modalita istogramma dei livelli del segnale video.

HD)

Lens Info Meter/Feet/Off Seleziona se visualizzare o meno
I’indicazione della profondita di campo
e I'unita per la visualizzazione della
profondita di campo.

Meter: visualizzazione in metri
Feet: visualizzazione in piedi
Off: non visualizzare

Focus Position On/Off Attiva o disattiva I’indicazione della
messa a fuoco dell’obiettivo.

Zoom Position On/Off Attiva o disattiva I’indicazione dello
zoom dell’obiettivo.

Audio Level Meter On/Off Attiva o disattiva la visualizzazione
degli indicatori dei livelli audio.

Timecode On/Off Attiva o disattiva la visualizzazione dei
dati temporali (codice temporale, bit
utente, contatore, durata).

Battery Remain On/Off Attiva o disattiva le indicazioni del
tempo residuo della batteria e della
tensione in ingresso.

Media Remain On/Off Attiva o disattiva I’indicazione dello
spazio residuo sui supporti.

TLCS Mode On/Off Attiva o disattiva I’indicazione della
modalita operativa TLCS.

Focus Mode On/Off Attiva o disattiva I’indicazione della
modalita operativa di messa a fuoco.

White Balance On/Off Attiva o disattiva I’indicazione della

Mode modalita di bilanciamento del bianco.

Filter Position On/Off Attiva o disattiva I’indicazione delle
impostazioni dei filtri ND.

Iris Position On/Off Attiva o disattiva I’indicazione della
posizione del diaframma.

Gain Setting On/Off Attiva o disattiva I’indicazione delle
impostazioni del guadagno.

Shutter Setting On/Off Attiva o disattiva le indicazioni della
modalita e della velocita di otturazione.

Color Temp On/Off Attiva o disattiva I’indicazione della
temperatura del colore.

Video Format On/Off Attiva o disattiva I’indicazione del
formato video.

System Line On/Off Attiva o disattiva I’indicazione delle
righe di sistema.

Rec Mode On/Off Attiva o disattiva le indicazioni di

modalita speciali di registrazione (S&Q,
Interval, Frame Rec, Picture Cache
Rec).
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Display On/Off
Selezionare le voci da
visualizzare nella
schermata del mirino.

Extender

On/Off

Attiva o disattiva I’indicazione di
estensione obiettivo.

WRR RF Level

On/Off

Attiva o disattiva I’indicazione de livello
di ricezione del ricevitore wireless
digitale.

Clip Number(PB)

On/Off

Attiva o disattiva I’indicazione di
informazione clip.

“""LED©

Gain<!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! quando il
guadagno € impostato su un valore
diverso da 0 dB.

Shutter <!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! quando il
selettore SHUTTER ¢ impostato su ON.

White Preset <!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! quando
I’interruttore WHITE BAL ¢ impostato
su PRST.

ATW Run <!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! quando White
Setting >White Switch<B> & impostato
su [ATW].

Extender <!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! quando si
utilizza I’estensore dell’ obiettivo.

Iris Override <!>

On/Off

Attiva o disattiva la funzione per
illuminare I’indicatore ! il valore di
riferimento della regolazione
automatica del colore non ¢ un valore
standard.

Auto Iris

Esegue le
impostazione relativa
al diaframma
automatico.

Iris Override

On/Off

Attiva o disattiva la funzione di
esclusione del diaframma
(un’impostazione che apre o chiude il
diaframma piu del normale).

Iris Speed

Da-99 a +0 a +99

Specifica la velocita di controllo del
diaframma (velocita di reazione a
cambiamenti nel video). (Valori
maggiori specificano tempi di reazione
piu rapidi.)

Clip High Light

On/Off

Attiva o disattiva la funzione che ignora
le luminosita e spinge a una reazione
piu piatta alle alte luminosita.

Iris Window

1/2/3/4/5/6/Var

Seleziona il tipo di finestra di
rilevamento del diaframma automatico.
Var: variabile

Iris Window
Indication

On/Off

Attiva o disattiva I’indicazione della
finestra principale di rilevamento
automatico del diaframma.
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Voci dei menu

Voce secondaria  Impostazioni

Descrizione

Shot ID ID-1 Crea stringhe ID-1 (fino a 16 caratteri)
Crea ID di ripresa sovraimposte.
sovraimposte sulle  ID-2 Crea stringhe ID-2 (fino a 16 caratteri)
barre dei colori. sovraimposte.
1D-3 Crea stringhe ID-3 (fino a 16 caratteri)
sovraimposte.
ID-4 Crea stringhe ID-4 (fino a 16 caratteri)
sovraimposte.
Shot Display Shot Date On/Off Seleziona se sovrimporre (On) o meno
Seleziona quali dati (Off) la data di ripresa.
delle riprese Shot Time On/Off Seleziona se sovrimporre (On) o meno

sovrimporre sulle
barre a colori
registrate.

(Off) I’ora di ripresa.

Shot Model Name  On/Off

Seleziona se sovrimporre (On) o meno
(Off) il nome modello.

Shot Serial On/Off
Number

Seleziona se sovrimporre (On) o meno
(Off) il numero di serie.

Shot ID Select ID-1/ID-2/ID-3/ID-4/Off

Seleziona se sovrimporre 0 meno 1’ID
di ripresa impostato con la voce ID di
ripresa e quale ID di ripresa
sovrimporre.
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Voci dei menu

Voce secondaria  Impostazioni

Descrizione

White setting
Esegue le
impostazioni relative
alle regolazioni
automatiche del
bilanciamento del
bianco.

White Switch<B> Memory/ATW

Specifica le modalita operative

selezionare dalla posizione B

dell’interruttore WHITE BAL.

Memory: bilanciamento automatico del
bianco

ATW: bilanciamento automatico del
bianco

Shockless White — Oft/1/2/3

Specifica la velocita di reazione quando
si cambia I’impostazione
dell’interruttore WHITE BAL. Off ¢
una reazione istantanea e 1 ¢ piu rapido
di2o3.

ATW Speed 1/2/3/4/5 Specifica la velocita di reazione quando
I’impostazione White Switch<B> ¢
[ATW]. 1 ¢ la reazione piu rapida.

ATW Mode Natural/Pure Natural: in base alla luminosita della

scena, consente di regolare
automaticamente il bilanciamento
del bianco rispetto
all’ambientazione naturale.

Pure: non mettendo da parte il colore
blu o rosso, consente di regolare
automaticamente il bilanciamento
del bianco avvicinandosi ai colori
originali.

AWB Fixed Area  On/Off

Specifica se il bilanciamento del bianco
automatico viene eseguito al centro
dello schermo.

On: esegue un’area corrisponde al 25%
dell’altezza e della larghezza dello
schermo.

Off: esegue un’area corrisponde al 70%
dell’altezza e della larghezza dello
schermo.

Filter White On/Off
Memory

Specifica se assegnare un’area di

memoria del bilanciamento del bianco a

ogni posizione della manopola FILTER.

On: assegnazione dell’area di memoria
del bilanciamento del bianco a
ciascuna posizione della manopola
FILTER.

Off: uso della memoria A/B a
prescindere dalla posizione del
filtro.
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Offset White Offset White <A> On/Off Specifica se aggiungere (On) o non
Esegue le aggiungere (Off) un valore di offset al

impostazioni relative
ai valori di offset del

valore di bilanciamento del bianco della
memoria A.

bilanciamento del

bianco. ‘Warm Cool <A>

Temperatura del colore
approssimativa

Quando I’impostazione Offset
White<A> ¢ su [On], specifica (come
una temperatura del colore) 1’offset da
aggiungere al valore di bilanciamento
del bianco della memoria A. (Notare
che la gamma di errori aumenta nelle
temperature del colore di offset piu alte.
Regolare quando si vede il video
effettivo.)

‘Warm Cool
Balance<A>

Da-99 a+0a +99

Specifica una temperatura del colore piu
precisa, da utilizzare quando non &
possibile ottenere un video
soddisfacente con I’impostazione Warm
Cool <A>.

Offset White <B>

On/Off

Quando ¢ impostato su [On], I’offset
regolato con questa voce viene aggiunto
al bilanciamento del bianco del canale
B.

‘Warm Cool <B>

Temperatura del colore
approssimativa

Quando I"impostazione Offset
White<B> ¢ su [On], specifica (come
una temperatura del colore) 1’ offset da
aggiungere al valore di bilanciamento
del bianco della memoria B. (Notare che
la gamma di errori aumenta nelle
temperature del colore di offset piu alte.
Regolare quando si vede il video
effettivo.)

‘Warm Cool
Balance<B>

Da-99 a +0 a +99

Specifica una temperatura del colore piu
precisa, da utilizzare quando non &
possibile ottenere un video
soddisfacente con I’impostazione Warm
Cool <B>.

Shutter

Esegue le
impostazioni relative
all’otturatore.

Shutter Select

Second/Degree

Specifica I’unita utilizzata per
selezionare le velocita dell’ otturatore.

Second: selezionare in unita di secondo.

Degree: selezionare in gradi.

Slow Shutter

On/Off

Attiva o disattiva la modalita SLS.

SLS Frames

2Frames/3Frames/
4Frames/Frames/

6Frames/7Frames/
8Frames/16Frames

Seleziona il numero di fotogrammi
accumulati in modalita SLS.

Time Zone Zone
Specifica il fuso

orario.

Da-12:00 a +0:00 a
+14:00 (incrementi di
30 minuti)

Specifica una differenza dall’UTC
(Greenwich Mean Time) in unita di
30 minuti.
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Voci dei menu Voce secondaria  Impostazioni Descrizione

Clip Auto Naming In modalita FAT: Title/ Seleziona il formato del nome del clip.
Esegue le Plan C#*##%: nome standard XDCAM (solo
impostazioni relative In modalith UDE: C###/ in modalita UDF)

al nome di clip e alla Title/Plan Title: nome specificato da Title Prefix

gestione di clip.

Non assegnare nomi
di clip che iniziano
con il simbolo *.”
(punto).

Non & possibile
visualizzare sul
software di
applicazione per
computer i clip con
nomi il cui primo

N o

carattere €

Plan: nome specificato nei metadata di
pianificazione (se non & specificato
alcun nome, viene selezionato il
nome specificato da Title Prefix).
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Descrizione

Voci dei menu Voce secondaria  Impostazioni
Clip Title Prefix Inserimento testo
Esegue le

impostazioni relative
al nome di clip e alla
gestione di clip.

Non assegnare nomi
di clip che iniziano
con il simbolo *.”
(punto).

Non & possibile
visualizzare sul
software di
applicazione per
computer i clip con
nomi il cui primo

N o

carattere € *.

Specifica la parte del titolo (Da 4 a 46
caratteri alfanumerici) dei titoli di clip.
Quando la lunghezza massima del titolo
specificato attualmente ¢ di otto
caratteri 0 meno, appare il titolo per
intero. Quando la lunghezza del titolo
supera gli otto caratteri, appaiono i
primi sette caratteri e un simbolo “--” in
sostituzione all’ottavo carattere.
Visualizza la schermata Character Set.

Configurazione della schermata

Character Set

* Area di selezione del carattere (tre

linee)

Selezionare il carattere da inserire nella

posizione del cursore del prefisso del

titolo.

#$%()+.-.;=@[]"_~0123456789

abcdefghijklmnopgrstuvwxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ

* Area operativa del cursore (una linea)

Space: cambia il carattere nella
posizione del cursore in uno spazio

INS: inserisce uno spazio nella
posizione del cursore

DEL: elimina il carattere presente nella
posizione del cursore

<«—: sposta il cursore a sinistra

—: sposta il cursore a destra

ESC: cancella la modifica e torna al
menu normale

END: esegue la modifica e torna al
menu normale

* Area del prefisso del titolo (una linea)

Area in cui inserire il titolo

Come inserire titoli

1 Girare la manopola MENU o
premere i pulsanti freccia per
selezionare un carattere, evidenziarlo
nell’area di selezione del carattere
quindi premere la manopola MENU
o il pulsante SET per inserirlo nella
posizione del cursore nell’area del
prefisso del titolo. (Il cursore si
sposta a destra.)

2 Ripetere il punto 1 per aggiungere
piu caratteri al titolo (usando Space,
INS, e DEL come richiesto).

3 Quando si & terminato di inserire il
titolo, selezionare END per chiudere
la schermata Character Set.
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Clip Number Set Da 00001 a 99999 Specifica il valore iniziale della parte
Esegue le numerica (cinque cifre) dei nomi dei
impostazioni relative clip (la parte numerica dei nomi dei clip
al nome di. clip calla ¢ limitata ad un numero di quattro cifre
gestione di clip. .
se I'Auto Naming & impostato su una
m voce diversa da [Plan] o se i metadata di
Non assegnare nomi pianificazione non sono validi
di clip che iniziano nonostante I'Auto Naming sia impostato
con il simbolo *.” su [Plan].)
(punto). Name Display Off/Viewfinder/LCD Seleziona se visualizzare il nome dei
Non ¢ possibile . s . . R
visualizare sul Status/Both clip successivi da rAeglstra‘Ie (in modalita
software di E-E) e dove visualizzare il nome.
applicazione per Off: non visualizzare
computer i clip con Viewfinder: visualizzazione sullo
nomi il Cl}i‘P’fimo schermo del mirino
carattere ¢ .. LCD Status: visualizzazione sul
monitor LCD (con la modalita di
visualizzazione impostata su
STATUS)
Both: visualizzazione sullo schermo del
mirino e sul monitor LCD
[ Nota |
Se un clip con lo stesso nome di quello
successivo da registrare ¢ gia presente nei
supporti di registrazione, subito dopo
I’inizio della registrazione il nome del clip
sara visualizzato con un numero di serie
differente (quando la selezione ¢ diversa da
Off).
Update Media<A>/Media<B> Aggiorna i file di gestione del supporto

nello slot selezionato (eseguire
selezionando [Execute]).
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Voci dei menu Voce secondaria  Impostazioni Descrizione
Plan.Metadata Load/Slot(A) Execute/Cancel Esegue il caricamento dei metadata di
Esegue le pianificazione dalla scheda di memoria

impostazioni per
I'utilizzo dei
metadata di
pianificazione.

SxS nello slot A.

Selezionare [Execute] per mostrare
I’elenco dei file metadata di pianificazione
memorizzati nella scheda di memoria SxS
dello slot A e selezionare un file per
eseguire il caricamento.

Load/Slot(B) Execute/Cancel

Esegue il caricamento dei metadata di
pianificazione dalla scheda di memoria
SxS nello slot B.

Selezionare [Execute] per mostrare
I’elenco dei file metadata di
pianificazione memorizzati nella scheda
di memoria SxS dello slot B e
selezionare un file per eseguire il
caricamento.

Load/USB Execute/Cancel
(solo in modalita
UDF)

Esegue il caricamento dei metadata di
pianificazione dall’unita flash USB
collegata al connettore di un dispositivo
esterno.

Selezionare [Execute] per mostrare
I’elenco dei file metadata di
pianificazione memorizzati nell’unita
flash USB e selezionare un file per
eseguire il caricamento.

Properties Execute/Cancel

Visualizza le informazioni dettagliate
nel metadata di pianificazione caricato
nel camcorder (eseguire selezionando
[Execute]).

Clear Execute/Cancel

Cancella i metadata di pianificazione
caricati nel camcorder (eseguire
selezionando [Execute]).

Clip Name Disp Title1(ASCII)/
Title2(UTF-8)

Seleziona la modalita di visualizzazione
del nome clip specificato nel metadata
di pianificazione (vedere pagina 92).

USB Memory Rec Enable/Disable
Esegue le
impostazioni

Selezionare se attivare o disattivare la
registrazione dei dati proxy in un’unita
flash USB.

sull’utilizzo di Copy Current Clip Execute/Cancel
un’unita flash USB
(solo in modalita

Esegue la copia dei dati proxy sul clip
corrente in un’unita flash USB (eseguire
selezionando [Execute]).

UDF). Copy All Clips Execute/Cancel

Esegue la copia dei dati proxy su tutti i
clip memorizzati nella scheda di
memoria SXS selezionata in un’unita
flash USB (eseguire selezionando
[Execute]).

Quando USB >With General Files ¢
impostato su [Enable], verranno copiati
anche tutti i dati della cartella General.
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Voci dei menu Voce secondaria  Impostazioni Descrizione

USB Del All Memory  Execute/Cancel Cancella i dati proxy su tutti i clip
Esegue le Clips copiati in un’unita flash USB (eseguire
impostazioni selezionando [Execute]).

sull’utilizzo di Format USB Execute/Cancel Esegue la formattazione FAT32 di
un’unita flash USB Memory un’unita flash USB (eseguire

(solo in modalita selezionando [Execute]).

UDF). With General Files Enable/Disable Quando USB >Copy All Clips &

impostato su [Execute], verranno
copiati allo stesso tempo tutti i dati della
cartella General (se [Enable] &
selezionato).

a) Quando il CBK-HDO02 opzionale ¢ installato

b) Quando si usa il CBK-VF01.

Menu PAINT

Le impostazioni in grassetto corrispondono ai valori predefiniti.

¢) Quando si usa un mirino serie HDVF.

PAINT

Voci dei menu Voce secondaria Impostazioni Descrizione

Switch Status Gamma On/Off Attiva o disattiva la correzione della
Attiva o disattiva gamma.

diverse funzioni di Black Gamma On/Off Attiva o disattiva la correzione della
correzione del segnale e

un segnale di prova. gamma del nero.

Matrix On/Off Attiva o disattiva le funzioni di
correzione matrice lineare e matrice
impostata dall’utente.

Knee On/Off Attiva o disattiva la correzione della
curvatura.

White Clip On/Off Attiva o disattiva la correzione di
ridimensionamento del bianco.

Detail On/Off Attiva o disattiva la correzione dei
dettagli.

Aperture On/Off Attiva o disattiva la correzione
dell’apertura.

Flare On/Off Attiva o disattiva la correzione della
luminanza.

Test Saw On/Off Attiva o disattiva il segnale di prova

a dente di sega.
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PAINT

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

White

Imposta la temperatura
del colore, ed esegue
regolazioni manuali del
bilanciamento del
bianco.

Color Temp <A>

Da 1500K a 3200K a
50000K

Visualizza la temperatura del colore
del bilanciamento del bianco salvata
nella memoria A.

Color Temp BAL
<A>

Da-99 a+0 a +99

Specifica i valori del guadagno del
bilanciamento del bianco salvati
nella memoria A (collegato al
guadagno R e al guadagno B).

R Gain <A> Da-99 a 0 a +99 Specifica il valore del guadagno R
del bilanciamento del bianco salvato
nella memoria A.

B Gain <A> Da-99 a 0 a +99 Specifica il valore del guadagno B

del bilanciamento del bianco salvato
nella memoria A.

Color Temp <B>

Da 1500K a 3200K a
50000K

Visualizza la temperatura del colore
del bilanciamento del bianco salvata
nella memoria B.

Color Temp BAL
<B>

Da-99 a+0 a +99

Specifica i valori del guadagno del
bilanciamento del bianco salvati
nella memoria B (guadagnoR e
guadagno B collegati).

R Gain <B> Da-99 a 0 a +99 Specifica il valore del guadagno R
del bilanciamento del bianco salvato
nella memoria B.
B Gain <B> Da -99 a +0 a +99 Specifica il valore del guadagno B
del bilanciamento del bianco salvato
nella memoria B.
Black Master Black Da-99 a 0 a +99 Specifica il livello di nero del
Specifica il livello del master.
nero (livello delle parti "RpJ,ck Da —99 a +0 a +99 Specifica il livello R del nero.
non illuminate del —
video). B Black Da-99 a 0 a +99 Specifica il livello B del nero.
E possibile archiviare
I’aspetto desiderato
regolando il livello del
nero su dei neri pitt
profondi o tenui.
Flare Flare On/Off Attiva o disattiva la correzione della

Esegue le impostazioni
relativa alla luce
parassita.

La luce parassita & la
luce generata da una
regione luminosa
dell’immagine che si
espande nel resto
dell’immagine,
aggiungendo luce alle
regioni scure e
riducendo il contrasto.
Viene causata da un
riflesso nel sistema
dell’ obiettivo.

luminanza.

Master Flare

Da-99 a+0 a +99

Imposta il livello master di
correzione della luce parassita.

R Flare Da-99 a+0 a +99 Imposta il livello R di correzione
della luminanza.

G Flare Da-99 a 0 a +99 Imposta il livello G di correzione
della luminanza.

B Flare Da-99 a+0 a +99 Imposta il livello B di correzione

della luminanza.
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PAINT

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Gamma Gamma

Esegue le impostazioni

On/Off

Attiva o disattiva la correzione della
gamma.

relativa alla gamma.

. Step Gamma
La correzione della

Da 0.35 2 0.45 2 0.90
(incrementi di 0,05)

Specifica il valore di correzione
della gamma a intervalli da 0,05.

gamma permette di
alterare
significativamente

Master Gamma

Da-99 a +0 a +99

Specifica il livello di gamma del
master.

Da-99 a+0 a +99

Specifica il livello di gamma R.

Da-99 a +0 a +99

Specifica il livello di gamma G.

I'impressione data dal  "R"Gamma

video regolando il

contrasto. G Gamma
B Gamma

Da-99 a +0 a +99

Specifica il livello di gamma B.

Gamma Select

Le impostazioni
disponibili variamo in
base all’impostazione in
Gamma Category (vedere
“Descrizione”).

Seleziona la tabella della gamma da
utilizzare nella correzione gamma.
Quando Gamma Category ¢ su
STD:

1 DVW: equivalente ad un
camcorder DVW

2 x4.5: guadagno x4.5

3 x3.5: guadagno x3.5

4 240M: equivalente a SMPTE-
240M

5 R709: equivalente a ITU-R709
(impostazione predefinita)

6 x5.0: guadagno x5.0

Quando Gamma Category & su
HG:

1 3250: comprimere un ingresso
video dal 325% a un’uscita
video al 100%.

2 4600: comprimere un ingresso
video dal 460% a un’uscita
video al 100%.

3 3259: comprimere un ingresso
video dal 325% a un’uscita
video al 109%.

4 4609: comprimere un ingresso
video dal 460% a un’uscita
video al 109% (impostazione
predefinita).

Gamma Category STD/HG Seleziona I’uso della gamma
standard (STD) o della
HyperGamma (HG).
Black Gamma Black Gamma On/Off Attiva o disattiva la correzione della

Esegue le impostazioni

gamma del nero.

relative alla correzione “Gama Level
gamma del nero.
La correzione gamma

Da-99 a+0 a +99

Specifica il livello di gamma di nero
del master.

del nero permette di Range
riprodurre le gradazioni

e le sfumare di colore

nelle parti nere o delle

tonalita del nero (scure)
dell’immagine.

Low/L.Mid/H.Mid/High

Seleziona il range reale della
correzione di gamma del nero.
LOW:da0a3,6%
LMID:da0a7,2%

H.MID: da 0 a 14,4%
HIGH: da 0 a28,8%
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PAINT

Voci dei menu Voce secondaria Impostazioni Descrizione
Knee Knee On/Off Attiva o disattiva la correzione della
Esegue le impostazioni curvatura.
relative alla correzione oo point Da 50.0% a 95.0% a Specifica il punto di curvatura.
della curvatura.
. 109.0%
La correzione della
curvatura & il processo  Knee Slope Da-99 a +0 a +99 Specifica la pendenza della

che previene la

curvatura.

cancellazione causata
dalla compressione
delle parti luminose del

Knee Saturation

On/Off

Attiva o disattiva la funzione di
saturazione della curvatura.

video secondo un limite
maggiore della gamma
dinamica delle
immagini registrate e
inviate. Il livello del
segnale in cui inizia il
processo di curvatura si
chiama “knee point”, e
la pendenza della
compressione della
curvatura si chiama

Knee Saturation
Level

Da-99 a +0 a +99

Specifica il livello di saturazione
della curvatura.

“knee slope”.
White Clip White Clip On/Off Attiva o disattiva la regolazione del
Esegue le impostazioni ridimensionamento del bianco.
ffllal%‘é? alle regolazioni oy [NTSC Area] o [NTSC _ Specifica il livello di
el ridimensionamento Area(J)] viene ridimensionamento del bianco.
del bianco. )
11 ridimensionamento selezionato per Country
del bianco & un Da 90.0% a 108.0% a
processo che limita il 109.0%
livello massimo dei [PAL Area] viene
segnali di uscita V]d.e 0 selezionato per Country
11 valore massimo di
uscita del segnale video Da 90.0% a 105.0% a
si chiama “white clip 109.0%
level”.
Detail(HD Mode)/ Detail On/Off Attiva o disattiva la regolazione del
Detail(SD Mode) dettaglio.
Esegue le impostazioni L evel Da-99 a =0 a +99 Specifica il livello del dettaglio.
relative alle regolazioni pve 00 . - YR -
dei dettagli in modalita H/V Ratio Da-99 a 0 a +99 Spemflcd ‘11 rdppor.to ‘d1 ‘
HDe SD. combinazione tra il livello di
La regolazione del dettaglio H e il livello di dettaglio V.
dettaglio & un processo  Crispening Da-99 a =0 a +99 Specifica il livello di nitidezza.

che migliora la
chiarezza del video
aggiungendo segnali di
dettaglio ai bordi del

Level Depend

On/Off

Attiva o disattiva la funzione di
regolamento di dipendenza del
livello.

soggetto.

Level Depend Level

Da-99 a+0 a +99

Specifica il livello di dipendenza del
livello.

Frequency

Da-99 a+0 a +99

Specifica la frequenza centrale per i
segnali di dettaglio H. Valori piu
grandi danno dettagli piu precisi.

Knee Aperture

On/Off

Attiva o disattiva la funzione di
apertura della curvatura.

Knee Aperture Level Da —99 a #0 a +99

Specifica il livello di apertura della
curvatura.
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PAINT

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Detail(HD Mode)/
Detail(SD Mode)
Esegue le impostazioni
relative alle regolazioni

Limit

Da-99 a+0 a +99

Specifica i valori del limitatore di
dettagli sia per la direzione della

parte bianca che per la direzione

della parte nera.

dei dettagli in modalita
HD e SD.
La regolazione del

White Limit

Da-99 a +0 a +99

Specifica il valore del limitatore del
dettaglio della parte bianca.

dettaglio & un processo
che migliora la

Black Limit

Da-99 a+0 a +99

Specifica il valore del limitatore del
dettaglio della parte nera.

chiarezza del video
aggiungendo segnali di
dettaglio ai bordi del

V-BLK Limit

Da-99 a+0 a +99

Specifica il valore del limitatore del
dettaglio V della parte nera.

soggetto.

V Detail Creation

NAM/G/R+G/Y

Seleziona il segnale sorgente
utilizzato per generare il segnale del
dettaglio V.

NAM: Un segnale di dettaglio V
creato da un segnale R, o un
segnale di dettaglio V creato da
un segnale G, o un segnale di
dettaglio V creato da un
segnale B, qualunque sia il
segnale con il livello piu alto.

G: segnale G

G+R: segnale composito che
comprende il segnale G e il
segnale R in un rapporto 1:1

Y: segnale Y

Cross Color
(solo in modalita
SD)

Da-99 a +0 a +99

Imposta il livello di riduzione
dell’interferenza a colori
sovrapposti per dettagli.

Quando Detail & impostato su [Off] o
OPERATION >Format >Country &
impostato su [PAL Area], questa
impostazione ¢ disattivata.

Aperture
Esegue le impostazioni

relative alla correzione
dell’apertura.

La correzione
dell’apertura & un
processo che permette
di migliorare la
risoluzione
aggiungendo segnali di
apertura ad alte
frequenze su un segnale
video, il quale corregge
la degenerazione
dovuta alle
caratteristiche delle alte
frequenze.

Aperture On/Off Attiva o disattiva la correzione
dell’apertura.
Level Da-99 a 0 a +99 Imposta il livello di apertura.
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PAINT

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Skin Detail
Esegue le impostazioni

Skin Detail

On/Off

Attiva o disattiva la correzione del
dettaglio pelle.

relative alla correzione
dei dettagli pelle.
LA correzione dei

Area Detection

Schermo di rilevamento
del colore

Rileva il colore su cui applicare la
correzione del dettaglio pelle.

dettagli pelle & un
processo che permette
di aumentare e
diminuire il livello del
dettaglio di una gamma

Area Indication

On/Off

Attiva o disattiva la funzione che
visualizza un motivo zebra nellarea
su cui applicare la correzione del
dettaglio pelle.

specifica del colore Level Da 99 a +0 a +99 Specifica il livello del dettaglio

(gamma delle tonalita pelle.

d§11a pelle), allo scopo  Saturation Da-99 a 0 a +99 Specifica la saturazione del colore

d“ ottenere una su cui applicare la correzione del

npmd_u zione dettaglio pelle.

accattivante delle

tonalita della pelle. Hue Da 0 a 359 Specifica la tonalita del colore su
cui applicare la correzione del
dettaglio pelle.

Width Da0a40a90 Specifica una gamma per la tonalita
del colore su cui applicare la
correzione del dettaglio pelle.

Matrix Matrix On/Off Attiva o disattiva la funzione di
Esegue le impostazioni correzione della matrice.

relative alla correzione  “preget Matrix On/Off Attiva o disattiva la funzione della
della matrice. . .

La correzione della matrice preimpostata.

matrice permette di Preset Select 1/2/3/4/5/6 Seleziona una matrice preimpostata.
regolare il colore e la 1: equivalente a SMPTE-240M
vivacita del video. A 2: equivalente a ITU-709

seconda dell’effetto 3: equivalente a SMPTE WIDE
des1d§rato, ¢ possibile 4: equivalente a NTSC

selezionare una tra un *

numero di matrici 5: equivalente a EBU
preimpostate, che 6: equivalente a PAL

definiscono diversi User Matrix On/Off Attiva o disattiva la funzione di

parametri di
impostazione. In

matrice dell’utente.

alternativa & possibile
selezionare una matrice

User Matrix R-G

Da-99 a +0 a +99

Specifica una matrice dell’utente R-
G liberamente impostata.

dell’utente con i propri
parametri.

User Matrix R-B

Da-99 a+0 a +99

Specifica una matrice dell’utente R-
B liberamente impostata.

User Matrix G-R

Da-99 a+0 a +99

Specifica una matrice dell’utente G-
R liberamente impostata.

User Matrix G-B

Da-99 a +0 a +99

Specifica una matrice dell’utente G-
B liberamente impostata.

User Matrix B-R

Da-99 a+0a+99

Specifica una matrice dell’utente B-
R liberamente impostata.

User Matrix B-G

Da-99 a+0 a +99

Specifica una matrice dell’utente B-
G liberamente impostata.
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PAINT

Voci dei menu Voce secondaria Impostazioni Descrizione

Multi Matrix Multi Matrix On/Off Attiva o disattiva la correzione
Esegue le impostazioni matrice multipla.

relative alla correzione  “Ave; Tndication On/Off Attiva o disattiva la funzione che

della matrice multipla.
La correzione della
matrice multipla
permette a colori
specifici di essere
selezionati per la
correzione della
saturazione in uno
spazio di tonalita a 16
assi.

visualizza un motivo zebra nell’area
di colore su cui applicare la
correzione della matrice multipla.

Color Detection

Schermo di rilevamento
del colore

Rileva i colori su cui applicare la
correzione della matrice multipla.

Preset Execute/Cancel Riporta Hue e Saturation ai valori
predefiniti (eseguire selezionando
Execute).

Axis B/B+/MG-/MG/MG+/ Specifica un colore su cui applicare

R/R+/YL-/YL/YL+/G-/ la correzione della matrice multipla
G/G+/CY/CY+/B— (modalita 16 assi).

Hue Da-99 a+0 a +99 Specifica la tonalita del colore su
cui applicare la correzione della
matrice multipla per ciascuna
modalita a 16 assi.

Saturation Da -99 a 0 a +99 Specifica la saturazione del colore

su cui applicare la correzione della
matrice multipla per ciascuna
modalita a 16 assi.

'V Modulation
Esegue le impostazioni
relative
all’ombreggiatura di
modulazione V.
L’ombreggiatura di
modulazione V
corregge gli
sbilanciamenti verticali
nella sensibilita
provocati dalla
relazione tra un
obiettivo e un prisma.

V Modulation

On/Off

Attiva o disattiva I’ombreggiatura
della modulazione V.

Master V Da-99 a 0 a +99 Specifica il livello di modulazione

Modulation del master V.

R V Modulation Da-99 a 0 a +99 Specifica i segnali R del livello di
modulazione V.

G V Modulation Da -99 a+0 a +99 Specifica i segnali G del livello di

modulazione V.

B V Modulation

Da-99 a+0 a +99

Specifica i segnali B del livello di
modulazione V.

Low Key Sat.
Esegue le impostazioni
relative alla correzione

Low Key Saturation

On/Off

Attiva o disattiva la correzione della
saturazione low key.

; Level Da-99 a 0 a +99 Specifica la saturazione dei colori
della saturazione low A
key. nelle aree con scarsa luminanza.
E possibile correggere  Range Low/L.Mid/H.Mid/High Specifica il livello di luminanza su
la saturazione dei colori cui ¢ abilitata la saturazione low key.
solo nelle parti scure
del video.
Noise Suppress Noise Suppress On/Off Attiva o disattiva la soppressione del

Esegue le impostazioni
relative alla
soppressione del
rumore (compressione
del rumore).

E possibile sopprimere
efficacemente le
componenti rumorose
mentre si preservano i
componenti fine edge
nel soggetto.

rumore.
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Menu MAINTENANCE

Le impostazioni in grassetto corrispondono ai valori predefiniti.

MAINTENANCE

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

White Shading
Esegue le impostazioni
relative

Channel Select

Red/Green/Blue

Seleziona dove applicare la
correzione delle sfumature del
bianco.

all’ombreggiatura del
bianco.
L’ombreggiatura del
bianco & richiesta da
ciascun obiettivo

differente per
correggere le
irregolarita derivanti
dalle caratteristiche
degli obiettivi.

R/G/B White H Saw Da -99 a +0 a +99 Specifica un valore di correzione
dell’ombreggiatura del bianco a
dente di sega per la direzione
orizzontale.

R/G/B White H Para Da —99 a 0 a +99 Specifica un valore di correzione

dell’ombreggiatura del bianco a
parabola per la direzione
orizzontale.

Corregge la luminanza
e le irregolarita del
colore nelle aree
luminose.

R/G/B White V Saw

Da-99 a +0 a +99

Specifica un valore di correzione
dell’ombreggiatura del bianco a
dente di sega per la direzione
verticale.

R/G/B White V Para

Da-99 a+0 a +99

Specifica un valore di correzione
dell’ombreggiatura del bianco a
parabola per la direzione verticale.

White Saw/Para

On/Off

Attiva o disattiva le funzioni di
correzione dell’ombreggiatura del
bianco a dente di sega e Parabola.

Black Shading
Esegue le impostazioni

Channel Select

Red/Green/Blue

Seleziona dove applicare la

correzione delle sfumature del nero.

relative alla correzione
dell’ombreggiatura del
nero.

R/G/B Black H Saw

Da-99 a +0 a +99

Specifica un valore di correzione
dell’ombreggiatura del nero a dente
di sega per la direzione orizzontale.

R/G/B Black H Para

Da-99 a +0 a +99

Specifica un valore di correzione
dell’ombreggiatura del nero a
parabola per la direzione
orizzontale.

R/G/B Black V Saw

Da-99 a+0 a +99

Specifica un valore di correzione
dell’ombreggiatura del nero a dente
di sega per la direzione verticale.

R/G/B Black V Para

Da-99 a+0 a +99

Specifica un valore di correzione
dell’ombreggiatura del nero a
parabola per la direzione verticale.

Black Saw/Para

On/Off

Attiva o disattiva le funzioni di
correzione dell’ombreggiatura del
nero a dente di sega e Parabola.

Master Black

Da-99 a+0 a +99

Specifica il livello di nero del
master.

Master Gain (TMP)

-6 dB/-3 dB/0 dB/3 dB/6
dB/9 dB/12 dB/18 dB/24

dB/30 dB/36 dB/42 dB

Specifica un valore del guadagno
del master temporaneo.
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MAINTENANCE

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Battery
Esegue le impostazioni
relative alle batterie.

Info Before End

5%/10%/15%...95%/
100%

Specifica un valore di soglia che
aziona I’avvertenza “Battery Near
End” quando si utilizza il pacco
batteria BP-GL65/GL95.

Info End

0%11%12%13 %/4%/5%

Specifica un valore di soglia che
aziona I’avvertenza “Battery End”
quando si utilizza il pacco batteria
BP-GL65/GL95.

Sony Before End

Dall5Val7V
(incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery Near
End” quando si utilizza il pacco
batteria BP-L60S/L80S.

Sony End

Dall0Valls5V
(incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery End”
quando si utilizza il pacco batteria
BP-L60S/L80S.

Other Before End

Dall5Vall8Val7,0
V (incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery Near
End” quando si utilizza un pacco
batteria che non ¢ di Sony.

Other End

Dal1l.0Val4.0V
(incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery End”
quando si utilizza un pacco batteria
che non ¢ di Sony.

DC In Before End

Dall5Vall8Val7,0
V (incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery Near
End” quando si connette una fonte
di alimentazione esterna al
connettore DC IN.

DC In End

Dal1l.0Val4.0V
(incrementi di 0,1 V)

Specifica un valore di soglia che
aziona I’avvertenza “Battery End”
quando si connette una fonte di
alimentazione esterna al connettore
DC IN.

Detected Battery

Info/Sony/Other/DC IN

Visualizza i risultati del rilevamento
automatico del tipo di pacco
batteria.

Type Detection

Auto/Other

Auto: rilevare automaticamente il
tipo di batteria.

Other: indicare il rilevamento del
tipo di batteria come “Other”.
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Battery
Esegue le impostazioni

Segment No.10

Dall0OVal7.0V
(incrementi di 0,1 V)

relative alle batterie.

Segment No.9

Dall.0Val1l6.0Val7.0
V (incrementi di 0,1 V)

Segment No.8

Dall.0Val5.0Val70
V (incrementi 0,1 V)

Segment No.7

DallOVal40Val7.0
V (incrementi di 0,1 V)

Segment No.6

Dall.0Val35Val70
V (incrementi di 0,1 V)

Segment No.5

Dall.0Val3.0Val70
V (incrementi di 0,1 V)

Segment No.4

DallOVal25Val7.0
V (incrementi di 0,1 V)

Segment No.3

Dall.0Val2.0Val70
V (incrementi di 0,1 V)

Segment No.2

Dall.0Vall5Val70
V (incrementi di 0,1 V)

Segment No.1

Dal1l.0Val7.0V
(incrementi di 0,1 V)

Specificare il valore di soglia della
tensione che causa lo spegnimento
dei segmenti di carica residua nel
display di carica residua della
batteria (vedere pagina 31). (1
segmenti si spengono in base al
valore specificato.)

Questi valori vengono utilizzati
quando il tipo di batteria & stato
riconosciuto in “Other”.

Audio
Esegue le impostazioni

Front MIC Select

Mono/Stereo

Seleziona se il microfono ¢ mono
(Mono) o stereo (Stereo).

relative all’audio.

Audio CH3/4 Mode

Ch1/2 / Switch

Seleziona i segnali di ingresso dei

connettori AUDIO IN CH-3/CH-4.

Ch1/2: gli stessi segnali dei
connettori AUDIO IN CH-1/
CH-2.

Switch: segnali selezionati con gli
interruttori AUDIO IN CH3/
CH4.

Rear XLR Auto

On/Off

Attiva o disattiva il rilevamento
automatico della connessione XLR
(per i connettori AUDIO IN CH-1/
CH-2 sul pannello posteriore).

Front MIC CH1 Ref

—70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Seleziona il livello di riferimento del
canale 1 del microfono frontale.

Front MIC CH2 Ref

—-70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Seleziona il livello di riferimento del
canale 2 del microfono frontale.

Rear MIC CH1 Ref

—~70dB/-60dB/-50dB/
—40dB/-30dB/-20dB

Seleziona il livello di ingresso di
riferimento quando I’'impostazione
dell’interruttore AUDIO IN CH1 &
impostato su MIC.

Rear MIC CH2 Ref —70dB/-60dB/-50dB/ Seleziona il livello di ingresso di
—40dB/-30dB/-20dB riferimento quando I’impostazione
dell’interruttore AUDIO IN CH2 &
impostato su MIC.
Line Input Ref +4dB/0dB/-3dB/EBUL  Seleziona il livello di ingresso di

riferimento quando gli interruttori
AUDIO IN CHI e AUDIO IN CH2
sono impostati su LINE.
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Voci dei menu Voce secondaria

Impostazioni

Descrizione

Audio Min Alarm Volume
Esegue le impostazioni
relative all’audio.

Off/Set

Seleziona il volume quando la
manopola ALARM ¢
completamente girata verso il basso.
Off: quasi inudibile.

Set: appena percettibile.

Speaker Attenuate

Off/3dB/6dB/9dB/12dB

Seleziona il volume dal monitor
dagli altoparlanti (non influenza il
volume degli auricolari).

Headphone Out

Mono/Stereo

Seleziona se gli auricolari sono
mono (Mono) o stereo (Stereo).

Reference Level

—20dB/-18dB/
—16dB/-12dB/EBUL

Seleziona il livello di uscita del
segnale di prova a 1 kHz.

Reference Out

0dB/+4dB/-3dB/EBUL

Specifica il livello di uscita rispetto
al livello di ingresso di riferimento.

CH1&2 AGC Mode

Mono/Stereo

Per la regolazione automatica dei
livelli di ingresso dei segnali audio
analogici registrati nei canali 1 e 2,
specifica se eseguire le regolazioni
separatamente per ciascun canale
(Mono) o in modalita stereo
(Stereo).

CH3&4 AGC Mode

Mono/Stereo

Per la regolazione automatica dei
livelli di ingresso dei segnali audio
analogici registrati nei canali 3 e 4,
specifica se eseguire le regolazioni
separatamente per ciascun canale
(Mono) o in modalita stereo
(Stereo).

o AGC Spec —6dB/-9dB/-12dB/ Seleziona il livello di saturazione
£ —15dB/-17dB AGC.
3 Limiter Mode Off/-6 dB/ Per le regolazioni manuali dei livelli
g -9 dB/-12 dB/ audio, seleziona il livello di
= -15dB/-17 dB saturazione per il limitatore
] applicato ai segnali elevati di
g ingresso.
5 Selezionare Off se non si desidera
3 utilizzare il limitatore.
% Output Limiter On/Off Attiva o disattiva il limitatore di
'g- uscita audio.
‘:—;_- CH1 Wind Filter On/Off Attiva o disattiva il filtro del vento
° del canale 1.
tg CH2 Wind Filter On/Off Attiva o disattiva il filtro del vento
) del canale 2.
® CH3 Wind Filter On/Off Attiva o disattiva il filtro del vento
del canale 3.
CH4 Wind Filter On/Off Attiva o disattiva il filtro del vento

del canale 4.
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Voci dei menu Voce secondaria

Impostazioni

Descrizione

Audio Audio SG (1KHz)
Esegue le impostazioni
relative all’audio.

On/Off/Auto

Seleziona se emettere (On) o non
emettere (Off) un segnale di prova
da 1 kHz in modalita color bar.
Auto: emettere il segnale di prova
solo quando I’interruttore
AUDIO SELECTCH 1 ¢
impostato su AUTO.

MIC CHI Level

Sidel/Front/Front+Sidel

Per la registrazione audio di
ingresso dal microfono frontale del
canale 1, seleziona la manopola per
la regolazione del livello audio.
Sidel: manopola LEVEL (sinistra)
sul pannello laterale
Front: controllo MIC LEVEL del
pannello anteriore
Front+Sidel: regolare sia la
manopola LEVEL (sinistra)
che il controllo MIC LEVEL.

MIC CH2 Level

Side2/Front/Front+Side2

Per la registrazione audio di
ingresso dal microfono frontale del
canale 2, seleziona la manopola per
la regolazione del livello audio.
Side2: manopola LEVEL (destra)
sul pannello laterale
Front: controllo MIC LEVEL del
pannello anteriore
Front+Side2: regolare sia con la
manopola LEVEL (destra) che
il controllo MIC LEVEL.

Rearl/WRR Level

Sidel/Front/Front+Sidel

Seleziona la manopola che regola i
livelli audio di un microfono
wireless e di un dispositivo
connesso al connettore AUDIO IN
CH-1 sul pannello posteriore.
Sidel: manopola LEVEL (sinistra)
sul pannello laterale
Front: controllo MIC LEVEL del
pannello anteriore
Front+Sidel: regolare sia la
manopola LEVEL (sinistra)
che il controllo MIC LEVEL.
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Audio
Esegue le impostazioni
relative all’audio.

Rear2/WRR Level

Side2/Front/Front+Side2

Seleziona la manopola che regola i
livelli audio di un microfono
wireless e di un dispositivo
connesso al connettore AUDIO IN
CH-2 sul pannello posteriore.
Side2: manopola LEVEL (destra)
sul pannello laterale
Front: controllo MIC LEVEL del
pannello anteriore
Front+Side2: regolare sia con la
manopola LEVEL (destra) che
il controllo MIC LEVEL.

Audio CH3 Level

Side3/Front/Front+Side3

Seleziona la manopola che regola il

livello audio registrato sul canale 3.

Side3: manopola LEVEL sul
pannello laterale

Front: controllo MIC LEVEL del
pannello anteriore

Front+Side3: regolare sia con la
manopola LEVEL che il
controllo MIC LEVEL.

Audio CH4 Level

Sided/Front/Front+Side4

Seleziona la manopola che regola il

livello audio registrato sul canale 4.

Side4: manopola LEVEL sul
pannello laterale

Front: controllo MIC LEVEL del
pannello anteriore

Front+Side4: regolare sia con la
manopola LEVEL che il
controllo MIC LEVEL.
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

WRR Setting
Esegue impostazioni
relative al

WRR Valid CH Sel

All/CHI

Seleziona se abilitare i canali 1 e 2
del ricevitore (All) oppure solo il
canale 1 (CH1).

sintonizzatore wireless.

WRR CH Select

TX1/TX2

Specifica il canale target per altre
voci secondarie.

TX1: canale 1

TX2: canale 2

WRR Delay Comp

On/Off

Abilita (On) o disabilita (Off) la
compensazione del ritardo per
I’ingresso audio wireless. (Quando
si seleziona On, 1’audio di uscita in
all E-E viene ritardato di circa 8
ms.)

X

Visualizza il nome del trasmettitore
i cui segnali vengono ricevuti dal
canale selezionato con WRR CH
SELECT.

TX Audio Peak

---/Peak

Mostra se il livello AF del
trasmettitore i cui segnali vengono
ricevuti sul canale selezionato con

WRR CH SELECT ¢ sopra al picco.

TX Input Level

---/Mic/Line

Mostra se il livello di ingresso del
trasmettitore i cui segnali vengono
ricevuti sul canale selezionato con
WRR CH SELECT ¢ impostato su
microfono (Mic) o su line (Line).

TX ATT Level

Imposta il livello ATT del
trasmettitore i cui segnali vengono
ricevuti dal canale selezionato con
WRR CH SELECT. (La gamma di
impostazione varia a seconda del
trasmettitore.)

TX LCF Frequency

Imposta la frequenza del filtro low
cut i cui segnali vengono ricevuti dal
canale selezionato con WRR CH
SELECT. (La gamma di
impostazione varia a seconda del
trasmettitore.)

TX System Delay

Auto/0.0ms to 8.0ms

Specifica I’ammontare del ritardo

audio.

Auto: regola automaticamente il
valore del ritardo, in modo che
il ritardo nell’audio ricevuto dal
trasmettitore wireless sia zero.

0.0ms to 8.0ms: imposta il valore
del ritardo del sistema wireless
anticipato, per casi in cui
vengono usati diversi sistemi
wireless sullo stesso
dispositivo, come per esempio
un mixer audio.
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Voci dei menu Voce secondaria Impostazioni

Descrizione

Timecode TC Out Auto/Generator
Esegue le impostazioni

relative al codice

temporale.

Seleziona la fonte per 1’uscita del

codice temporale.

Auto: durante la registrazione, i
valori d’uscita generati dal
generatore del codice
temporale, e durante i valori di
uscita ottenuti durante la
registrazione dal lettore del
codice temporale.

Generator: valori di uscita generati
dal generatore del codice
temporale sia durante la
registrazione che la
riproduzione.

DF/NDF DF/NDF

Quando I"impostazione Country &
diversa da [PAL Area], seleziona la
modalita drop-frame (DF) o la
modalita non-drop-frame (NDF).

LTC UBIT Fix/Time

Specifica i dati registrati in bit

utente LTC.

Fix: registrare dati specificati
dall’utente.

Time: registrare 1’ora attuale.

Counter Display Counter/Duration

Seleziona il metodo utilizzato per
ripristinare il valore di contatore
visualizzato sullo schermo del
mirino.

Counter: continua ad incrementare
fino a che non viene premuto il
pulsante RESET.

Duration: ripristinare ogni volta
che inizia la registrazione.
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Voci dei menu Voce secondaria Impostazioni Descrizione

Essence Mark Ret Shot Mark 1 On/Off Specificare se inviare gli indicatori

Esegue le impostazioni di ripresa Shot Mark1 utilizzando il

relative agli indicatori pulsante RET sull’obiettivo.

di ripresa e alle — P — -
Ret Shot Mark 2 On/Off Specificare se inviare gli indicatori

miniature dell’indice
dei clip.

di ripresa Shot Mark? utilizzando il
pulsante RET sull’obiettivo.

Index Pic Pos

Da Osec a 10sec (a
intervalli da 1 sec)

Specifica quale fotogramma usare
come miniatura del clip

Find Mode

Clip/Rec Start

Specificare il fotogramma da
mettere in corda quando si preme il
pulsante PREV o NEXT.

Rec Start: il fotogramma
successivo o precedente in cui ¢
impostato un indicatore di
identificazione Rec Start.

Clip: premendo il pulsante NEXT si
passa al fotogramma iniziale
del clip successivo. Premendo
il pulsante PREV si passa al
fotogramma iniziale del clip
attuale. (Premendo il pulsante
PREV sul fotogramma iniziale
del clip attuale si passa al
fotogramma iniziale del clip
precedente.)

Camera Config Rec Tally Blink
Esegue le impostazioni

relative a varie

operazioni del

camcorder.

On/Off

Attiva o disattiva le avvertenze
luminose dell’indicatore TALLY. Le
avvertenze avvisano su un pacco
batteria quasi esaurito o spazio
residuo ridotto sui supporti.

Rec Review

3sec/10sec/Clip

Seleziona il tempo di

visualizzazione della registrazione.

Clip: visualizza tutto il clip
registrato pil di recente.
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Voci dei menu Voce secondaria Impostazioni Descrizione
Camera Config HD SDI Remote I/F  Off/Chara/G-Tally/R- Seleziona se usare la funzione che
Esegue le impostazioni Tally abilita il controllo della

relative a varie
operazioni del
camcorder.

registrazione da questo camcorder

di un dispositivo esterno collegato al

connettore HD/SD SDI OUT (uscita

HDSDI). Quando si utilizza la

funzione, selezionare anche

I’indicazione che mostra se il

dispositivo esterno sta registrando.

Off: non usare la funzione di
comando remoto della
registrazione.

Chara: indica mediante
I’indicazione di controllo di
dispositivi esterni sullo
schermo del mirino.

G-Tally: indica mediante
I’indicatore tally verde nel
mirino della serie HDVF o
I’indicatore tally verde nello
schermo del mirino CBK-
VFOI1.

R-Tally: indica mediante indicatori
di registrazione/tally rosso nel
mirino della serie HDVF o
l'indicazione modalita di
registrazione speciale/stato
operativo nello schermo del
mirino CBK-VFO1.

Color Bars Select ARIB/100%/75%/
SMPTE

Seleziona il tipo di barra del colore.

User Menu Only On/Off

Seleziona se visualizzare solo il
menu USER (On) o I’elenco del
menu (Off) quando il camcorder
accede alla modalita menu.

RM Common On/Off
Memory

ajel|benap uoizejsodwi 8 nusy 9 ojouden

Seleziona se condividere (On) o non
condividere (Off) le impostazioni
quando un’unita di controllo remoto
viene connessa e quando il
camcorder viene usato localmente.

Quando & collegato un’unita di
controllo remoto questa impostazione
¢ disattivata.

RM Rec Start RM/CAM/PARA

Quando un’unita di controllo
remoto viene connessa, seleziona se
i pulsanti di registrazione start/stop
sono abilitati sul camcorder o
sull’unita di controllo remoto.

RM: unita di controllo remoto
CAM: camcorder

PARA: entrambi
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Voce secondaria

Impostazioni

Descrizione

Camera Config
Esegue le impostazioni
relative a varie
operazioni del
camcorder.

Rec Start/Stop Beep  On/Off

Specifica se generare (On) o non
generare (Off) un segnale acustico
all’avvio e al termine della
registrazione.

Quando I’opzione ¢ impostata su
[On], un bip verra emesso all’avvio
della registrazione e due bip
verranno emessi al termine della
registrazione.

Rec Status Indicator

Viewfinder/LCD/Both/
Off

Specifica la posizione

dell’indicatore di stato della

registrazione.

Viewfinder: Solo nel mirino.

LCD: Solo sul monitor LCD.

Both: Sia nel mirino che sul
monitor LCD

Off: Non visualizzata.

Preset White
Esegue le impostazioni

Color Temp<P>

Da 1500K a 3200K a
50000K

Specifica il valore predefinito del
bilanciamento del bianco.

relative ai valori di

Da-99 a +0 a +99

Specifica le impostazioni di
temperatura del colore piu precise,
per 1'uso quando non & possibile
ottenere video soddisfacenti con
Color Temp<P>.

Da-99 a +0 a +99

Specifica il valore predefinito del
guadagno R.

. ! Color Temp
preimpostazione del Balance<P>
bilanciamento del alance
bianco.

R Gain <P>
B Gain <P>

Da-99 a+0 a +99

Specifica il valore predefinito del
guadagno B.

AWB Enable <P>

On/Off

Attiva o disattiva ’esecuzione della
funzione AWB (auto white balance)
quando I’interruttore WHITE BAL

viene impostato su PRST.
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Voci dei menu Voce secondaria Impostazioni Descrizione
White Filter ND Filter On/Off Attiva o disattiva la funzione che
Esegue le impostazioni C.Temp assegna filtri elettrici CC ai filtri
relative ai filtri. ND.
ND FLT 3200K/4300K/5600K/ Seleziona la temperatura del colore
C.Temp<1> 6300K per quando il filtri CC vengono
assegnati ai filtri ND.
ND FLT 3200K/4300K/5600K/ Seleziona la temperatura del colore
C.Temp<2-4> 6300K per quando il filtri CC vengono
assegnati ai filtri ND.
Electrical 3200K/4300K/5600K/ Seleziona la temperatura del colore
CC<A> 6300K per quando la funzione di passaggio
del filtro CC elettrico viene
assegnata a un interruttore
programmabile.
Electrical 3200K/4300K/5600K/ Seleziona la temperatura del colore
CC<B> 6300K per quando la funzione di passaggio
del filtro CC elettrico viene
assegnata a un interruttore
programmabile.
Electrical 3200K/4300K/5600K/ Seleziona la temperatura del colore
CC<C> 6300K/----- per quando la funzione di passaggio
del filtro CC elettrico viene
assegnata a un interruttore
programmabile.
Selezionare “----” se non si desidera
utilizzare C.
Electrical 3200K/4300K/5600K/ Seleziona la temperatura del colore
CC<D> 6300K/----- per quando la funzione di passaggio

del filtro CC elettrico viene
assegnata a un interruttore
programmabile.

Selezionare “----” se non si desidera
utilizzare D.
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Impostazioni

Descrizione

DCC Adjust DCC Function Select DCC/Fix

Esegue le impostazioni
relative a DCC
(dynamic contrast
control).

Attiva o disattiva la regolazione
automatica del punto di curvatura
quando I’interruttore OUTPUT/
DCC ¢ impostato su CAM, DCC:
ON.

DCC: regola automaticamente il
punto di curvatura a seconda
della luminosita dell’oggetto.

Fix: imposta il punto di curvatura ad
un valore fisso.

DCC D Range

400%/450%/500%/
550%/600 %

Specifica la gamma dinamica
quando I’interruttore OUTPUT/
DCC ¢ impostato su CAM, DCC:
ON.

DCC Point

Da-99 a +0 a +99

Regola il punto minimo di curvatura
del DCC.

DCC Gain

Da-99 a+0 a +99

Specifica il guadagno secondo il
valore rilevato di DCC.

DCC Delay Time

Da-99 a+0 a +99

Specifica la velocita di controllo del
DCC (velocita di reazione a
cambiamenti nel video).

DCC Peak Filter

Da-99 a+0 a +99

Regola la sensibilita di risposta ai
picchi dei valori rilevati del DCC.
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Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Auto Iris2

Esegue le impostazione

relativa al diaframma
automatico.

Iris Window

1/2/3/4/5/6/Var

Seleziona il tipo di finestra di
rilevamento del diaframma.
Var: variabile

Iris Window Ind

On/Off

Attiva o disattiva la funzione che
mostra un indicatore di frame per la
finestra di rilevamento del
diaframma automatico.

Iris Level

Da-99 a +0 a +99

Regola il livello del valore target del
diaframma automatico.

Iris APL Ratio

Da-99 a +0 a +99

Regola il rapporto di combinazione
del valore di picco e del valore
medio del rilevamento diaframma
(disponibile quando OPERATION
>TLCS >Mode ¢ impostato su
[Standard]).

Iris Var Width

Da 40 a 500 a 999

Regola la larghezza della finestra di
rilevamento quando I’impostazione
di Iris Window & su VAR.

Iris Var Height

Da 70 a 500 a 999

Regola I’altezza della finestra di
rilevamento quando I’impostazione
di Iris Window & su VAR.

Iris Var H Position

Da-479 a 0 a +479

Specifica la posizione orizzontale
della finestra di rilevamento quando
I’'impostazione di Iris Window ¢ su
VAR.

Iris Var V Position

Da 464 a 0 a +464

Specifica la posizione verticale della
finestra di rilevamento quando
I’impostazione di Iris Window ¢ su
VAR.

Iris Speed

Da-99 a +0 a +99

Specifica la velocita di controllo
(velocita di reazione a cambiamenti
nel video). (Valori maggiori
specificano tempi di reazione pitl
rapidi.)

Clip High Light

On/Off

Attiva o disattiva la funzione che
ignora le luminosita e spinge a una
reazione piu piatta alle alte
luminosita.

Genlock

Esegue le impostazioni

relative al genlock.

Genlock

On/Off

Attiva o disattiva la funzione
genlock.

H Phase(HD)

Da -999 a +0 a +999

Specifica la fase H dell’uscita HD
quando genlock ¢ abilitato.

H Phase(SD)

Da-99 a +0 a +99

Specifica la fase H dell’uscita SD
quando genlock ¢ abilitato.

Reference

Internal/Genlock

Visualizza il tipo di segnale di
riferimento usato dal camcorder.
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Impostazioni

Descrizione

ND Comp
Esegue impostazioni

ND Offset Adjust

On/Off

Funzione di compensazione del
colore del filtroND.

relative alla
compensazione del
colore del filtro ND.
Nonostante le
differenze siano molto
sottili, ciascuno dei
filtri ND in dotazione
ha differenti
caratteristiche di
colore. Quando si passa
tra filtri ND, & possibile
che il bilanciamento del
bianco venga
disturbato. E possibile
correggere queste
leggerissime differenze
di colore
automaticamente
registrando i valori di
compensazione di
ciascun filtro.

Clear ND Offset

Execute/Cancel

Cancella i valori di compensazione
del colore del filtro ND (eseguire
selezionando [Execute]).

Lens

Esegue la regolazione
automatica della
flangia.

Auto FB Adjust

Execute/Cancel

Esegue la regolazione auto flange
back, solo per gli obiettivi supportati
(eseguire selezionando [Execute]).

Auto Shading
Esegue la
compensazione

Auto Black Shading

Execute/Cancel

Esegue la compensazione
dell’ombreggiatura automatica
(eseguire selezionando [Execute]).

dell’ombreggiatura
automatica del nero.

Reset Black Shading

Execute/Cancel

Cancella i valori di compensazione
dell’ombreggiatura del nero
(eseguire selezionando [Execute]).

Master Gain (TMP)

—6 dB/-3 dB/0 dB/3 dB/6
dB/9 dB/12 dB/18 dB/24
dB/30 dB/36 dB/42 dB

Specifica un valore del guadagno
del master temporaneo. (Il valore &
lo stesso di quello selezionato con
I’interruttore GAIN.)

APR

APR(SLS)

Execute/Cancel

Elimina i granellini bianchi in
modalita SLS eseguendo la funzione
di riduzione automatica della
rumorosita dei pixel (eseguire
selezionando [Execute]).

APR Preset

Execute/Cancel

Elimina i granellini bianchi aggiunti
con I’esecuzione delle funzioni della
regolazione automatica del
bilanciamento del nero e APR
(eseguire selezionando [Execute]).
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Voce secondaria

Impostazioni

Descrizione

Trigger Mode
Esegue le impostazioni Mode
relative all’impulso di

avvio e blocco della

i.LINK Trigger

Internal/Both/External

Selezionare Internal quando le
operazioni di avvio e blocco della
registrazione si applicano solo alle
schede di memoria SxS. Selezionare

registrazione. External quando si applicano solo ai
dispositivi collegati attraverso
connettori i. LINK (HDV/DV) o HD/
SD SDI OUT. Selezionare Both
quando si applicano solo sia su
schede di memoria SxS che su
dispositivi esterni.

Network Setting DHCP Enable/Disable Seleziona se acquisire ’indirizzo IP

Esegue le automaticamente da un server

impostazioni sulla DHCP (Enable) o meno (Disable).

connessione direte. [P Address Da 0.0.0.0 a Quando DHCP & impostato su

m 255.255.255.255 [Disable], imposta I’indirizzo IP.

(192.168.1.10)
) O(fcolrre V"adattatore gy o Mask Da 0.0.0.0 a Quando DHCP & impostato su
Wi-Fi CBK-WAOI. 255.255.255.255 [Disable], imposta la subnet mask.

¢ Questa voce &

disatti Default Gateway Da 0.0.0.0 a Quando DHCP ¢ impostato su
isattivata 255.255.255.255 [Disable], imposta il gateway
(visualizzata in ..
igio) d el predefinito.
rigio) durante la
g g . User Name admin Imposta un nome utente desiderato
registrazione e . .
. . inserendo da 1 a 31 caratteri
riproduzione. ..
alfanumerici.
f) er ulter{ort- Password pmw-500 (nome Imposta una password (nome
inf ormaziont Sf‘ll“ modello) modello) inserendo da 0 a 31
connesszonej di rete, caratteri alfanumerici.
consultare il . Set Execute/Cancel Conferma le impostazioni in
Supplemento fornito Lo .
) Impostazioni di rete (eseguire
con il CD-ROM .
(cont . selezionando [Execute]).
OMTASSESAe SO0 MAC Address Visualizza Uindirizzo MAC.
‘Manuals for Solid- E— - —
Net Config Reset Execute/Cancel Ripristina i valori predefiniti delle

State Memory
Camcorder”).

Impostazioni di rete (eseguire
selezionando [Execute]).
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Voce secondaria

Impostazioni

Descrizione

Wi-Fi Setting
Esegue le
impostazioni sulla
connessione Wi-Fi.

Scan Networks

Execute/Cancel

Quando Wi-Fi ¢ impostato su
[Enable], eseguire la scansione della
connessione di rete disponibile.

SSID

Nome connessione di rete

Imposta il nome della connessione
di rete utilizzando fino a 32
caratteri.

* Occorre 1’adattatore Network Type

Wi-Fi CBK-WAOL1.
¢ Questa voce &
disattivata
(visualizzata in
grigio) durante la
registrazione e
riproduzione.

Per ulteriori
informazioni sulla
connessione Wi-Fi,
consultare il
Supplemento fornito
con il CD-ROM
(contrassegnato con
“Manuals for Solid-
State Memory
Camcorder”).

Infra/Adhoc

Seleziona la modalita di
connessione.

Infra: modalita infrastruttura
Adhoc: modalita ad hoc

Ch

Dalall

Quando Network Type ¢ impostato
su [Adhoc], impostare il canale
wireless.

Authentication

Open/Shared/WPA/
WPA2

Seleziona 1’autenticazione di rete.

OPEN: autenticazione del sistema
aperto

SHARED: autenticazione del
codice condiviso

WPA: autenticazione WPA (Wi-Fi
Protected Access)

WPAZ2: autenticazione WPA2 (Wi-
Fi Protected Access 2)

Encryption

Disable/WEP/TKIP/AES

Seleziona se applicare la crittografia

dati e il tipo di crittografia.

Disable: non applicare la
crittografia dati.

WEP: applica WEP (Wired
Equivalent Privacy) quando
Authentication ¢ impostato su
[Open] o [Shared]

TKIP: applica TKIP (Temporal Key
Integrity Protocol) quando
Authentication ¢ impostato su
[WPA] o [WPA2]

AES: applica AES (Advanced
Encryption Standard) quando
Authentication ¢ impostato su
[WPA] o [WPA2]

WEP Key Index

1/2/3/4

Quando Encryption ¢ [WEP],
seleziona I’indice del codice.
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MAINTENANCE

Voci dei menu Voce secondaria Impostazioni Descrizione

Wi-Fi Setting Input Select Quando Encryption ¢ Seleziona il formato di ingresso a

Esegue le impostato su [WEP]: seconda della chiave di rete (o

impostazioni sulla ASCII5, ASCII13, chiave di sicurezza).

connessione Wi-Fi. HEX10, HEX26 ASCIIS: formato ASCII cinque
Quando Encryption ¢ caratteri

m impog[ato su [TKIP] ASCII13: formato ASCII 13

¢ Occorre I’ adattatore o [AES]: ASCII8-63, caratteri

Wi-Fi CBK-WAOI.
¢ Questa voce &
disattivata
(visualizzata in
grigio) durante la
registrazione e

HEX64

HEX10: 10 cifre esadecimali

HEX26: 26 cifre esadecimali

ASCII8-63: da 8 a 63 caratteri in
formato ASCII a 8 bit

HEX64: 64 cifre esadecimali
(caratteri)

riproduzione.

Per ulteriori

Key

Imposta la chiave di rete (o chiave di
sicurezza).

informazioni sulla
connessione Wi-Fi,
consultare il
Supplemento fornito

Abilita la impostazioni di Wi-Fi
Setting quando Wi-Fi ¢ impostato su
[Enable] (eseguire selezionando
[Execute]).

con il CD-ROM
(contrassegnato con
“Manuals for Solid-
State Memory
Camcorder”).

Wi-Fi Status

L 1 1] ]]
Connecting

Visualizza “Connecting” quando si
tenta la connessione. Visualizza dei
quadratini neri a indicare lo stato di
connessione in base al numero di
quadratini quando il camcorder &
connesso a un computer o LAN.

Wireless Mode

802.11b/802.11g/802.11n

Visualizza uno standard
IEEE802.11.

Wi-Fi

Enable/Disable

Seleziona se attivare o disattivare la
connessione Wi-Fi.

Wi-Fi Remote

On/Off

Selezionare “On” quando si utilizza
il telecomando Wi-Fi.

Non selezionabile quando “Wi-Fi” &
impostato su “Disable”.

Clock Set

Date/Time

Imposta la data e 1’ora attuali.

Imposta I’orologio
interno.

12H/24H

12H/24H

Seleziona il formato 12 ore (12H) o
il formato 24 ore (24H) per la
visualizzazione dell’ora.

Date Mode

YYMMDD/MMDDYY/
DDMMYY

Seleziona il formato di
visualizzazione della data.
YYMMDD: anno, mese, giorno
MMDDYY: mese, giorno, anno
DDMMYY: giorno, mese, anno

Language
Seleziona la lingua per i
messaggi.

Language

English/Chinese

Seleziona la lingua per i messaggi
tra Inglese e Cinese.
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MAINTENANCE

Voci dei menu Voce secondaria Impostazioni Descrizione
Hours Meter Hours(Sys) Visualizza le ore d’uso cumulative
Esegue le impostazioni (non puo essere ripristinato).
rglglive al contatore Hours(Reset) Visualizza le ore d’uso (puo essere
digitale. ripristinato).

Reset Execute/Cancel Ripristina le ore(Reset) a 0 (eseguire

selezionando [Execute]).

Version Version Visualizza la versione del software
Visualizza la versione del camcorder (VxX.xx).
del Famcqrder, € CBK-HDO02 @ Visualizza la versione del software
aggiorna il camcorder. del CBK-HDO2 (Vx.xx).

Version Up Execute/Cancel Aggiorna il camcorder (eseguire

selezionando [Execute]).

Non ¢ possibile selezionarlo a meno
che non venga inserita una scheda di
memoria SxS.

a) Quando il CBK-HDO02 opzionale ¢ installato

Elenco dei menu
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Menu FILE

Le impostazioni in grassetto corrispondono ai valori predefiniti.

FILE

Voci dei menu Voce secondaria Impostazioni Descrizione

User User Load SxS Execute/Cancel Carica un file utente da una scheda

Esegue le di memoria SxS (eseguire

impostazioni selezionando [Execute]).

sull’utilizzo dei file Quando Load Customize Data ¢

utente. impostato su [Off]: sostituire
le impostazioni del menu
USER correnti con quelle
memorizzate nel file di utilizzo
caricato (con la configurazione
del menu originale non
modificata).

Quando Load Customize Data ¢
impostato su [On]: sostituire
la configurazione e le
impostazioni del menu USER
correnti con quelle
memorizzate nel file di utilizzo
caricato.

Quando User Load White &
impostato su [Off]: caricare un
file utente escludendo i dati di
bilanciamento del bianco.

Quando User Load White ¢
impostato su [On]: caricare un
file utente includendo i dati di
bilanciamento del bianco.

User Save SxS Execute/Cancel Memorizza la configurazione e le

impostazioni del menu USER
correnti, compresi i dati di
bilanciamento del bianco, in una
scheda di memoria SxS come file
utente (eseguire selezionando
[Execute]).

User Load USB (solo in modalita UDF)

Carica un file utente da un’unita
flash USB (eseguire selezionando
[Execute]).

User Save USB (solo in modalita UDF)

ajel|benap uoizejsodwi 8 nusy 9 ojouden

Memorizza la configurazione e le
impostazioni del menu USER
correnti, compresi i dati di
bilanciamento del bianco, in
un’unita flash USB come file utente
(eseguire selezionando [Execute]).

File ID

Assegna un nome a un file. I nomi
possono essere composti da un
massimo di 16 caratteri.
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FILE

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

User

Esegue le
impostazioni
sull’utilizzo dei file

Recall User Preset

Execute/Cancel

Ripristina i valori predefiniti delle
impostazioni del menu USER
correnti (eseguire selezionando
[Execute]).

utente.

Store User Preset

Execute/Cancel

Memorizza il menu USER come file
utente in cui tutte le impostazioni
sono ripristinate secondo i valori
predefiniti (eseguire selezionando
[Execute]).

Clear User Preset

Execute/Cancel

Ripristina i valori di fabbrica delle
impostazioni del menu USER
correnti (eseguire selezionando
[Execute]).

Load Customize
Data

Off/On

Seleziona se caricare i dati di
bilanciamento del bianco della
configurazione e delle impostazioni
di menu (On) o solo delle
impostazioni di menu (Off) quando
si carica un file utente.

Load White Data

Off/On

Seleziona se caricare (On) o meno
(Off) i dati di bilanciamento del
bianco quando si carica un file
utente.

Elenco dei menu
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FILE

Voci dei menu Voce secondaria Impostazioni Descrizione
All Display Mode Date&Time/Model Seleziona le voci da visualizzare
Esegue le impostazioni Name nella casella elenco che appare
relative alle operazioni quando un file viene salvato o
sui file ALL. caricato.

All Load SxS Execute/Cancel Carica un file ALL da una scheda di

memoria SxS (eseguire
selezionando [Execute]).

All Save SxS Execute/Cancel Memorizza un file ALL in una
scheda di memoria SxS (eseguire
selezionando [Execute]).

All Load USB Execute/Cancel Carica un file ALL da un’unita flash
(solo in modalita USB (eseguire selezionando

UDF) [Execute]).

All Save USB Execute/Cancel Memorizza un file ALL in un’unita
(solo in modalita flash USB (eseguire selezionando
UDF) [Execute]).

File ID Assegna un nome a un file. I nomi

possono essere composti da un
massimo di 16 caratteri.

All Preset Execute/Cancel Riporta tutte le voci ai valori
predefiniti (eseguire selezionando
[Execute]).

Store All Preset Execute/Cancel Memorizza le impostazioni attuali

di tutte le voci come valori
predefiniti (eseguire selezionando

[Execute]).

Clear All Preset Execute/Cancel Cancella i valori predefiniti di tutte
le voci (eseguire selezionando
[Execute]).

3Sec Clr Preset On/Off Attiva o disattiva la funzione che

cancella ciascun valore predefinito
quando si mantiene premuto
I’interruttore MENU CANCEL/
PRST/ESCAPE per tre secondi sul
lato CANCEL/PRST.

Network Data Off/On Seleziona se caricare (On) o meno
(Off) le impostazioni di rete mentre
si carica un file ALL.
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FILE

Voci dei menu Voce secondaria Impostazioni Descrizione
Scene 01 Standard Numero e ID file
Esegue le impostazioni  [12 Standard Numero e ID file
relfi tive a'lle operaziont "Mz Standard Numero e ID file
dei file di scena.

04 Standard Numero e ID file

0s Standard Numero e ID file

[OStandard Standard settings

Display Mode Date&Time/Model Seleziona le voci da visualizzare

Name nella casella elenco che appare
quando un file viene salvato o
caricato.

Scene Recall Mem  Execute/Cancel Carica un file dalla memoria interna
(eseguire selezionando [Execute]).

Scene Store Mem Execute/Cancel Memorizza un file nella memoria
interna (eseguire selezionando
[Execute]).

Scene Recall SxS Execute/Cancel Carica un file da una scheda di
memoria SxS (eseguire
selezionando [Execute]).

Scene Store SxS Execute/Cancel Memorizza un file in una scheda di
memoria SxS (eseguire
selezionando [Execute]).

Scene Recall US Execute/Cancel Carica un file da un’unita flash USB

(solo in modalita (eseguire selezionando [Execute]).

UDF)

Scene Store USB Execute/Cancel Memorizza un file in un’unita flash

(solo in modalita
UDF)

USB (eseguire selezionando
[Execute]).

File ID

Assegna un nome a un file. I nomi
possono essere composti da un
massimo di 16 caratteri.

Elenco dei menu
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FILE

Voci dei menu Voce secondaria Impostazioni Descrizione

Reference Reference Store Execute/Cancel Memorizza le impostazioni attuali

Esegue le impostazioni delle voci dei file di riferimento che

relative alle operazioni vengono mantenuti nella memoria

sui file di riferimento. interna (eseguire selezionando
[Execute]).

Reference Clear Execute/Cancel Cancella il file di riferimento
(eseguire selezionando [Execute]).

Refer. Load SxS Execute/Cancel Carica un file di riferimento da una
scheda di memoria SxS (eseguire
selezionando [Execute]).

Refer. Save SxS Execute/Cancel Memorizzare un file di riferimento
in una scheda di memoria SxS
(eseguire selezionando [Execute]).

Refer. Load USB Execute/Cancel Carica un file da un’unita flash USB

(solo in modalita (eseguire selezionando [Execute]).

UDF)

Refer. Store USB Execute/Cancel Memorizza un file in un’unita flash

(solo in modalita USB (eseguire selezionando

UDF) [Execute]).

File ID Assegna un nome a un file. I nomi
possono essere composti da un
massimo di 16 caratteri.

Scene White Data On/Off Selezionare se caricare (On) o non
caricare (Off) i dati del
bilanciamento del bianco quando si
esegue Scene >Scene Recall o
Scene >Standard.

Lens Display Mode Date&Time/Model Seleziona le voci da visualizzare
Esegue le impostazioni Name nella casella elenco che appare
rel'al‘%ve alle’ opfara'zioni quando un file viene salvato o
dei file dell’obiettivo. caricato.

Lens Recall Mem Execute/Cancel Carica un file dalla memoria interna
(eseguire selezionando [Execute]).

Lens Store Mem Execute/Cancel Memorizza un file nella memoria
interna (eseguire selezionando
[Execute]).

Lens Recall SxS Execute/Cancel Carica un file da una scheda di
memoria SxS (eseguire
selezionando [Execute]).

Lens Store SxS Execute/Cancel Memorizza un file in una scheda di
memoria SxS (eseguire
selezionando [Execute]).

Lens Recall USB Execute/Cancel Carica un file da un’unita flash USB

(solo in modalita (eseguire selezionando [Execute]).

UDF)

Lens Store USB Execute/Cancel Memorizza un file in un’unita flash

(solo in modalita
UDF)

USB (eseguire selezionando
[Execute]).
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FILE

Voci dei menu Voce secondaria Impostazioni Descrizione
Lens File ID Assegna un nome al file caricato piu
Esegue le impostazioni di recente. I nomi possono essere
relative alle operazioni composti da un massimo di 16
dei file dell’obiettivo. caratteri.

Source Visualizza il numero di file

selezionati.
Lens No Offset Execute/Cancel Cancella un file (eseguire

selezionando [Execute]).

Lens Auto Recall

Off/On/Serial Number

Quando I’ obiettivo installato
supporta la comunicazione seriale,
specifica se caricare
automaticamente il file di
riferimento.

Off: non utilizzare la funzione.

On: caricare il riferimento per il
nome del modello e riflettere i
contenuti del file.

Serial Number: per gli obiettivi che
supportano la comunicazione
con il numero seriale, caricare
il file dell’ obiettivo
corrispondente al nome del
modello dell’obiettivo e al
numero seriale e riflettere i
contenuti del file. Per gli
obiettivi che non supportano la
comunicazione con il numero
seriale, caricare il riferimento
per il nome del modello (come
quando viene selezionato On).

Serial Number

Visualizza il numero di serie

dell’ obiettivo installato (solo per gli
obiettivi che supportano la
comunicazione seriale).

Lens ID

Visualizza il nome del modello
dell’ obiettivo installato (solo gli
obiettivi che supportano la
comunicazione seriale).

L Manufacturer

Visualizza il nome del produttore
dell’ obiettivo installato (solo per gli
obiettivi che supportano la
comunicazione seriale).

M V Modulation

Da-99 a +0 a +99

Imposta il valore della
compensazione dell’ombreggiatura
verticale a dente di sega nel file
obiettivo.

Lens Center H Da-40a0a40 Imposta la posizione orizzontale
dell’indicatore del centro nel file
obiettivo.

Lens Center V Da-40a0a40 Imposta la posizione verticale

dell’indicatore del centro nel file
obiettivo.
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FILE

Voci dei menu

Voce secondaria

Impostazioni

Descrizione

Lens

Esegue le impostazioni
relative alle operazioni

dei file dell’obiettivo.

Lens R Flare

Da-99 a+0 a +99

Imposta il livello di luce parassita R
nel file obiettivo.

Lens G Flare

Da-99 a +0 a +99

Imposta il livello di luce parassita G
nel file obiettivo.

Lens B Flare

Da-99 a +0 a +99

Imposta il livello di luce parassita B
nel file obiettivo.

Lens W-R Offset

Da-99 a+0 a +99

Imposta un valore di compensazione
del bilanciamento del bianco R nel
file obiettivo.

Lens W-B Offset

Da-99 a+0 a +99

Imposta un valore di compensazione
del bilanciamento del bianco B nel
file obiettivo.

Shading Ch Sel

Red/Green/Blue

Seleziona dove applicare la
compensazione dell’ombreggiatura
del bianco.

L R/G/B H Saw

Da-99 a+0 a +99

Imposta il valore della
compensazione dell’ombreggiatura
orizzontale a dente di sega nel file
obiettivo.

L R/G/B H Para

Da-99 a+0 a +99

Imposta il valore della
compensazione dell’ombreggiatura
orizzontale Parabola nel file
obiettivo.

L R/G/B V Saw

Da-99 a +0 a +99

Imposta il valore della
compensazione dell’ombreggiatura
del bianco verticale a dente di sega
nel file obiettivo.

L R/G/B V Para

Da-99 a+0 a +99

Imposta il valore della
compensazione dell’ombreggiatura
verticale a parabola nel file
obiettivo.
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Assegnazione di funzioni agli interruttori
programmabili

Utilizzando la voce Assignable SW del menu OPERATION, ¢ possibile assegnare le funzioni specifiche
per I'utente agli interruttori ASSIGN. da 0 a 3, gli interruttori ASSIGNABLE 4 e 5, il pulsante COLOR
TEMP., e il pulsante RET sull’obiettivo .
Le seguenti tabelle elencano le funzioni assegnate quando il camcorder viene spedito dalla fabbrica.

Interruttore o pulsante

Funzione

Impostazione Assignable SW

Interruttore ASSIGN. 0

Nessuna assegnazione

disattivato

Interruttore ASSIGN. 1  Nessuna assegnazione disattivato
Interruttore ASSIGN. 2 Nessuna assegnazione disattivato
Interruttore ASSIGN. 3 Nessuna assegnazione disattivato
Interruttore Nessuna assegnazione disattivato
ASSIGNABLE 4
Interruttore Nessuna assegnazione disattivato
ASSIGNABLE 5
Pulsante RET Durante la registrazione o la riproduzione: Lens RET
scrivere un indicatore di ripresa.
Negli altri stati: condurre una visualizzazione della
registrazione (se si permette la riproduzione).
Pulsante COLOR TEMP. Regolare il bilanciamento del bianco con il valore ~ Color Temp SW 5600K

predefinito di bilanciamento del bianco di 5600K.

Le funzioni che possono essere assegnate all’interruttore ASSIGN. 0

Impostazione  Funzione

Stato in cui il

interruttore camcorder viene acceso
programmabile successivamente.

Off Nessuna assegnazione —

Marker Attiva o disattiva la visualizzazione di tutti gli indicatori. Impostazioni mantenute
ATW Hold Mantiene I’impostazione di bilanciamento del bianco in modalita —

ATW (bilanciamento automatico del bianco).

Picture Cache Attivare o disattivare la funzione picture cache.

Impostazioni mantenute

FREEZE MIX  Eseguire la funzione freeze mix.

Focus Mag Attiva o disattiva la funzione di ingrandimento della messa a Impostazione non
fuoco. mantenuta
Zebra Attivare o disattivare la visualizzazione zebra. Impostazione non
mantenuta
Shot Mark1 Scrivere Shot Mark1. —
Shot Mark2 Scrivere Shot Mark2. —
OK Mark Aggiungere o eliminare un indicatore OK. —
Clip Flag OK Aggiungere/eliminare un indicatore OK al/dal clip registrato o Impostazione non
riprodotto. mantenuta
Clip Flag NG Aggiungere/eliminare un indicatore NG al/dal clip registrato o Impostazione non
riprodotto. mantenuta

Assegnazione di funzioni agli interruttori programmabili

aje|benep luoizeysodwi 8 nua|y 9 ojoyden

171



ajelBenep uoizejsodwi & nusyy 9 ojoude)

172

Impostazione
interruttore
programmabile

Funzione

Stato in cui il
camcorder viene acceso
successivamente.

Clip Flag Keep  Aggiungere/eliminare un indicatore KP al/dal clip registrato o
riprodotto.

Impostazione non
mantenuta

Le funzioni che possono essere assegnate all’interruttore ASSIGN. 2

Subito dopo aver assegnato una funzione all’interruttore ASSIGN. 2 o aver cambiato il formato di registrazione, le
impostazioni dell’interruttore in quel punto potrebbero non corrispondere allo stato interno del camcorder. Dopo aver
assegnato una funzione, passare all’interruttore ASSIGN. 2 o spegnere e riaccendere il camcorder.

Impostazione Funzione

interruttore

programmabile

Off Nessuna assegnazione

Front Mic Passare tra stereo e mono quando un microfono stereo viene connesso.
Marker Attiva o disattiva la visualizzazione di tutti gli indicatori.

Picture Cache

Attivare o disattivare la funzione picture cache.

Zebra

Attivare o disattivare la visualizzazione zebra.

Clip Continuous Rec

Attivare o disattivare la modalita Clip Continuous Rec.

Digital Extender

Attivare o disattivare la funzione di ingrandimento dello schermo quando ¢ installato
I’ingresso CBK-HDO02 SDI/COMPOSITE opzionale e I’interfaccia a 50 pin.

Rec Source

Commutare i segnali da registrare tra 'immagine del camcorder e I’ingresso esterno
quando ¢ installato I’ingresso CBK-HD02 SDI/COMPOSITE opzionale e I’interfaccia
a 50 pin. (Se I'unita sta registrando o riproducendo, la commutazione ha luogo al
termine della registrazione o riproduzione.)

a) Quando Picture Cache ¢ assegnato, OPERATION
>Rec Function nel menu di impostazione ¢ disattivato
(visualizzato in grigio) per mantenere 1’impostazione

senza modifiche.

Le funzioni che possono essere assegnate agli interruttori ASSIGN. 1 e 3,
gli interruttori ASSIGNABLE 4 e 5 e il pulsante COLOR TEMP.

Impostazione  Funzione Stato in cui il

interruttore camcorder viene acceso

programmabile successivamente.

Off Nessuna assegnazione —

Front Mic Passare tra stereo (On) e mono (Off) quando viene connesso un  Impostazioni mantenute
microfono stereo.

Marker Attiva o disattiva la visualizzazione di tutti gli indicatori. Impostazioni mantenute

Last Clip Delete Eliminare il clip registrato piu di recente. —

ATW Attivare o disattivare la modalita ATW (bilanciamento automatico Impostazione non

del bianco).

mantenuta

Assegnazione di funzioni agli interruttori programmabili



Impostazione

Funzione

Stato in cui il

interruttore camcorder viene acceso

programmabile successivamente.

ATW Hold Mantenere 1’'impostazione di bilanciamento del bianco nella —
modalita ATW.

EZ Mode Eseguire la modalita EZ, secondo I’'impostazione di OPERATION Impostazioni mantenute
>TLCS.

Turbo Gain Eseguire Turbo Gain secondo I’'impostazione di OPERATION Impostazione non
>Gain Switch >Gain Turbo. mantenuta

Rec Review Condurre una visualizzazione della registrazione. —

Rec Avviare o bloccare la registrazione. —

Picture Cache Attivare o disattivare la funzione picture cache. Impostazioni mantenute

FREEZE MIX  Eseguire la funzione freeze mix. Impostazione non

mantenuta

Spotlight Attiva o disattiva la funzione spotlight della modalita auto iris. Impostazioni mantenute

Backlight Attiva o disattiva la funzione retroilluminazione della modalita ~ Impostazioni mantenute
auto iris.

EVF Mode Passa lo schermo del mirino tra B/N (On) e a colori (Off). Impostazioni mantenute

BRT Disp Attiva o disattiva la visualizzazione del livello di luminosita. Impostazioni mantenute

Histogram Attiva o disattiva la visualizzazione dell’istogramma. Impostazioni mantenute

Lens Info Passare I’indicazione della profondita di campo tra off, Impostazioni mantenute

visualizzazione in metri, visualizzazione in piedi.

Zoom Tele/Wide

Quando ¢ installato un obiettivo che supporta la comunicazione
seriale, assegnare la funzione Zoom Tele a ASSIGNABLE 4, e
assegnare la funzione Zoom Wide a ASSIGNABLE 5
(visualizzata solo se sono impostati <4> e <5>).

Zoom Wide/Tele

Quando ¢ installato un obiettivo che supporta la comunicazione
seriale, assegnare la funzione Zoom Wide a ASSIGNABLE 4, e
assegnare la funzione Zoom Tele a ASSIGNABLE 5 (visualizzata
solo se sono impostati <4> e <5>).

Manual Focus
Assist

Attiva o disattiva la funzione di messa a fuoco manuale.

Impostazioni mantenute

Focus Mag Attiva o disattiva la funzione di ingrandimento della messa a Impostazione non
fuoco. mantenuta
Zebra Attivare o disattivare la visualizzazione zebra. Impostazione non
mantenuta
Lens RET Visualizza i segnali di ritorno del video quando ¢ installato il —

CBK-HDO02 opzionale ed ¢ collegata un’unita di estensione per

telecamera).

Quando un'unita di estensione per telecamera non ¢ connessa,

funziona come segue.

Durante la registrazione o la riproduzione: scrivere un
indicatore di ripresa.

Negli altri stati: condurre una visualizzazione della registrazione
(se si permette la riproduzione).

Return Video

Visualizza i segnali di ritorno del video quando ¢ installato il
CBK-HDO02 opzionale ed ¢ collegata un’unita di estensione per
telecamera).

Return Video2

Per futura estensione del sistema. Non correntemente attiva.

Assegnazione di funzioni agli interruttori programmabili
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Impostazione  Funzione Stato in cui il

interruttore camcorder viene acceso

programmabile successivamente.

Return Video3  Per futura estensione del sistema. Non correntemente attiva. —

Return Video4  Per futura estensione del sistema. Non correntemente attiva. —

Shot Mark1 Scrivere Shot Mark1. —

Shot Mark2 Scrivere Shot Mark?2. —

OK Mark Aggiungere o eliminare un indicatore OK. —

Clip Flag OK Aggiungere/eliminare un indicatore OK al/dal clip registrato o Impostazione non
riprodotto. mantenuta

Clip Flag NG Aggiungere/eliminare un indicatore NG al/dal clip registrato o Impostazione non

riprodotto.

mantenuta

Clip Flag Keep

Aggiungere/eliminare un indicatore KP al/dal clip registrato o
riprodotto.

Impostazione non
mantenuta

Color Temp SW  Regolare il bilanciamento del bianco con un valore preimpostato  Impostazioni mantenute
3200K 3200K.
Color Temp SW  Regolare il bilanciamento del bianco con un valore predefinito di Impostazioni mantenute
4300K 4300K.
Color Temp SW  Regolare il bilanciamento del bianco con un valore predefinito di Impostazioni mantenute
5600K 5600K.
Color Temp SW  Regolare il bilanciamento del bianco con un valore predefinito di Impostazioni mantenute
6300K 6300K.
Electrical CC Funzione che passa tra il filtro elettrico CC (3200K/4300K/ Impostazioni mantenute
5600K/6300K) applicato ai valori di regolazione del
bilanciamento del bianco.
A ciascuna pressione dell’interruttore o del pulsante passa
nell’ordine 3200K—4300K—5600K—6300K.
Possono anche essere applicate da un menu (applicare con
Electrical CC<A><B><C><D>).
Questa funzione non ¢ disponibile quando Maintenance >White
Filter >ND Filter C.Temp nel menu di impostazione ¢ impostato
su On.
Se si imposta ND Filter C.Temp su On dopo I’assegnazione della
funzione, Iinterruttore programmabile termina con la funzione.
CC5600K Applicare un filtro elettrico CC da 5600K ai valori di regolazione Impostazioni mantenute

del bilanciamento del bianco.

Clip Continuous
Rec

Attivare o disattivare la modalita Clip Continuous Rec. Impostazione non

mantenuta

Slot Select Se supporti di registrazione sono inseriti in entrambi gli slot Ae —

B, questa voce consente di selezionare il supporto da utilizzare.

Digital Extender Attivare o disattivare la funzione di ingrandimento dello schermo
quando ¢ installato I’ingresso CBK-HD02 SDI/COMPOSITE

opzionale e I'interfaccia a 50 pin.

Impostazione non
mantenuta
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Funzioni che possono essere assegnate al pulsante RET sull’obiettivo

Impostazione  Funzione Stato in cui il
interruttore camcorder viene acceso
programmabile successivamente.

Off Nessuna assegnazione —

Lens RET Visualizza i segnali di ritorno del video quando ¢ installato il —

CBK-HDO02 opzionale ed ¢ collegata un’unita di estensione per

telecamera).

Quando un'unita di estensione per telecamera non ¢ connessa,

funziona come segue.

Durante la registrazione o la riproduzione: scrivere un
indicatore di ripresa.

Negli altri stati: condurre una visualizzazione della registrazione

(se si permette la riproduzione).

Return Video

Visualizza i segnali di ritorno del video quando ¢ installato il
CBK-HDO02 opzionale ed ¢ collegata un’unita di estensione per
telecamera).

Rec Review Eseguire una visualizzazione della registrazione. —

Shot Mark1 Scrivere Shot Mark1. —

Shot Mark2 Scrivere Shot Mark2. —

Clip Flag OK Aggiungere/eliminare un indicatore OK al/dal clip registrato o Impostazione non
riprodotto. mantenuta

Clip Flag NG Aggiungere/eliminare un indicatore NG al/dal clip registrato o Impostazione non
riprodotto. mantenuta

Clip Flag Keep  Aggiungere/eliminare un indicatore KP al/dal clip registrato o Impostazione non
riprodotto. mantenuta

OK Mark Aggiungere o eliminare un indicatore OK. —

Focus Mag Attiva o disattiva la funzione di ingrandimento della messa a Impostazione non

fuoco.

mantenuta

Assegnazione di funzioni agli interruttori programmabili
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Impostazioni di
salvataggio e
caricamento

E possibile salvare le impostazioni del menu di
impostazione nella memoria interna del
camcorder e nelle schede di memoria SxS o unita
flash USB flash (in modalita UDF). Permette di
richiamare velocemente impostazioni appropriate
per I’attuale situazione delle impostazioni del
menu.

I dati di impostazione sono salvati nelle seguenti

categorie.

File utente: i file utente salvano le voci e i dati di
impostazione del menu USER. E possibile
salvare fino a 64 file utente nelle schede di
memoria SxS e nelle unita flash USB (in
modalita UDF). E possibile impostare il
menu USER in modo da personalizzare lo
stato leggendo uno di questi file nelle
memoria dell’unita.

File ALL: i file ALL salvano i dati
d’impostazione di tutti i menu. E possibile
salvare fino a 64 file ALL in una scheda di
memoria SxS o unita flash USB (in modalita
UDF).

I dati specifici del dispositivo (sfumature, livelli di
uscita e altri dati che richiedono regolazioni per il
dispositivo specifico) non vengono salvati.

File di scena: il file di scena salva le regolazioni
nelle voci del menu PAINT per girare una
scena in particolare. E possibile salvare fino
a cinque file di scena nella memoria interna
del camcorder e fino a 64 file di scena in una
scheda di memoria SxS o unita flash USB (in
modalita UDF).

File di riferimento: i file di riferimento salvano i
valori di riferimento impostati quando si
esegue FILE >Scene >Standard nel menu di
impostazione. E possibile salvare un file di
riferimento nella memoria interna del
camcorder e uno in una scheda di memoria
SxS o unita flash USB (in modalita UDF).

Impostazioni di salvataggio e caricamento

oyl 3lvataggio e caricamento di datidi impostazione utente

File dell’obiettivo: i file dell’obiettivo salvano i
dati di impostazione utilizzati per
compensare le caratteristiche dell’obiettivo,
come la luce parassita, I’ombreggiatura del
bianco, il bilanciamento del bianco e gli
indicatori del centro. E possibile salvare fino
a 32 file dell’ obiettivo nella memoria interna
del camcorder e fino a 64 file dell’obiettivo
in una scheda di memoria SxS o unita flash
USB (in modalita UDF).

Le prime impostazioni memorizzate in un file
vengono chiamate valori “predefiniti”.

Persino dopo aver caricato i file per la
configurazione del camcorder, e aver sovrascritto
i file originari con le nuove impostazioni, &
ancora possibile ripristinare i valori preimpostati
e reimpostare i file al loro stato iniziale (vedere
pagina 178).

Salvataggio dei dati di
impostazione

Questa sezione spiega come salvare dei dati di
impostazione su un file ALL.

Prima di cominciare, inserire una scheda di
memoria SxS senza protezione da scrittura nello
slot per schede di memoria.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >All nel menu di
impostazione.

Come assegnare un nome ai dati prima di
salvarli

Assegnare un nome prima di procedere al
punto 2.

Per ulteriori informazioni, vedere “Come
assegnare nomi ai file” (pagina 177).

2 Selezionare All Save SxS >Execute.
Appare una casella elenco di file ALL.



I numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti. I numeri dei file con un nome o una
data e 1’ora sono numeri di file che
contengono gia dei dati.

3 Ruotarela manopola MENU per
selezionare il numero di file desiderato.

4 Premerela manopola MENU.
Appare un messaggio di conferma.

9 Per eseguire il salvataggio, selezionare
[Execute], e quindi premere la
manopola MENU.

Per cancellare il salvataggio,
selezionare [Cancel], e quindi premere
la manopola MENU.

Se si sceglie di eseguire il salvataggio, la spia
ACCESS si illumina (in blu sul pannello a
destra e in arancione nello slot della scheda).
Appare un messaggio di completamento e la
spia ACCESS si spegne quando i dati sono
stati salvati.

Se appare un messaggio di errore

Durante I’esecuzione del salvataggio o quando si
seleziona [Execute] potrebbe apparire uno dei
seguenti messaggi di errore. In questo caso, non
viene salvato il file sulla scheda di memoria SxS.

Messaggio di Problema Cosa fare

errore

NG:Cannot Save Nessun Inserire un

supporto supporto
registrabile registrabile.
inserito.

NG:Media Full Utilizzare un
supporto con
spazio libero a

disposizione.

11 supporto &
pieno.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare All Save USB >Execute al punto 2.

Come assegnare nomi ai file

Assegnare un nome prime di salvare i dati su un
file ALL facilitare la distinzione dei file.

Nei nomi dei file possono essere utilizzati i
seguenti caratteri.

Caratteri alfanumerici (a~z, A-Z, 0-9) e caratteri
speciai (!#$ % &' ()*+,-./:;<=>2@[\]~)

1 Selezionare FILE >All >File ID nel
menu di impostazione.

2 Ruotare la manopola MENU per
selezionare un carattere, e quindi
premere la manopola MENU.

3 Ripetere il punto 3.

4 Una volta terminato di inserire i
caratteri, premere la manopola MENU
per muovere il cursore su “SET”, e
quindi premere la manopola MENU.
Viene visualizzato il nome specificato.
Quando si salva il file (vedere pagina 176), i
dati verranno salvati con questo nome.

Caricamento dati impostazione

Quando si carica un file da una scheda di memoria SxS o
un’unita flash USB (in modalita UDF), i dati salvati nella
memoria interna del camcorder saranno sovrascritti.
Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >All nel menu di
impostazione.

2 Selezionare All Load SxS >Execute.
Appare una casella elenco di file ALL.
I numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti. I numeri dei file con un nome o una
data e 1’ora sono numeri di file che
contengono gia dei dati.

3 Ruotare la manopola MENU per
selezionare il numero di file desiderato.

4 Premerela manopola MENU.
Appare un messaggio di conferma.

5 Per eseguire il caricamento, selezionare
[Execute], e quindi premere la
manopola MENU.

Per annullare il caricamento,

Impostazioni di salvataggio e caricamento
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selezionare [Cancel], e quindi premere
la manopola MENU.

Se si sceglie di eseguire il caricamento, la
spia ACCESS si illumina (in blu sul pannello
a destra e in arancione nello slot della
scheda). La spia ACCESS si spegne e appare
un messaggio di completamento quando i
dati sono stati caricati.

Se appare un messaggio di errore

Durante I’esecuzione del caricamento, o quando
si seleziona [Execute] potrebbe apparire uno dei
seguenti messaggi di errore. In questo caso, il file
non viene caricato dalla scheda di memoria SxS.

Messaggio  Problema Cosa fare

di errore

NG:No Data * Non c’¢ nessun Inserire il
supporto leggibile supporto che

« Il file specificato  contiene il file
non esiste nel desiderato.

supporto

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare All Load USB >Execute al punto 2.

Ripristino di un file dopo aver
cambiato il suo contenuto

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >All nel menu di
impostazione.

2 Selezionare [All Preset], quindi
premere la manopola MENU.

3 Per eseguire il ripristino, selezionare
[Execute], e quindi premere la
manopola MENU.

Per annullare il ripristino, selezionare
[Cancel], e quindi premere la manopola
MENU.

Se si sceglie di eseguire il ripristino, tutte le
impostazioni nel file ALL vengono
ripristinate sui valori predefiniti.

Salvataggio e caricamento di file di scena

Salvataggio e
caricamento di file di
scena

Ifile di scena consentono di salvare i seguenti tipi

di dati.

* Valori impostati nel menu PAINT

* Velocita dell’otturatore impostate nella
modalita standard o nella modalita ECS

* Dati di bilanciamento del bianco
I dati che vengono salvati e caricati dipendono
dalle impostazioni di FILE >Reference >Scene
White Data nel menu di impostazione.

Salvataggio file di scena

Per salvare un file di scena su una scheda di
memoria SxS, inserire la scheda in uno slot per
schede di memoria e quindi procedere come
segue.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >Scene nel menu di
impostazione.

Come assegnare un nome ai dati prima di
salvarli

Assegnare un nome prima di procedere al
punto 2.

Per ulteriori informazioni, vedere “Come
assegnare nomi ai file” (pagina 177).

2 Selezionare Scene Store Mem >Execute
(se si desidera salvare i dati nella
memoria interna del camcorder), o
Scene Store SxS >Execute (se si
desidera salvare i dati su una scheda di
memoria SxS).

3 Premerela manopola MENU.
Appare una casella elenco di file di scena.
I numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti.



4 Selezionare il numero del file con il
quale si desidera salvare i dati, e quindi
premere la manopola MENU.

Appare un messaggio di conferma.

5 Per eseguire il salvataggio, selezionare
[Execute], e quindi premere la
manopola MENU.

Per cancellare il salvataggio,
selezionare [Cancel], e quindi premere
la manopola MENU.

Se ¢ stato selezionato Scene Store SxS
>Execute nel punto 2, la spia ACCESS si
illumina (in blu sul pannello a destra e in
arancione nello slot della scheda) quando si
esegue il salvataggio.

Una volta salvati i dati, sara visualizzato un
messaggio di completamento e la spia
ACCESS si spegne.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare Scene Store USB >Execute al punto

2.

Caricamento dei file di scena

Per caricare un file di scena da una scheda di
memoria SxS, inserire la scheda di memoria SxS
in uno slot per schede di memoria, e quindi
procedere come segue.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >Scene nel menu di
impostazione.

2 Selezionare Scene Recall Mem
>Execute se si desidera caricare il file
dalla memoria interna del camcorder, e
selezionare Scene Recall SxS >Execute
se si desidera caricare il file da una
scheda di memoria SxS.

3 Premerela manopola MENU.
Appare una casella elenco di file di scena. I
numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti.

4 Selezionare il numero di file desiderato,
e quindi premere la manopola MENU.
Appare un messaggio di conferma.

5 Per eseguire il caricamento, selezionare
[Execute], e quindi premere la
manopola MENU.

Per annullare il caricamento,
selezionare [Cancel], e quindi premere
la manopola MENU.

Se ¢ stato selezionato Scene Recall SxS
>Execute nel punto 2, la spia ACCESS si
illumina (in blu sul pannello a destra e in
arancione nello slot della scheda) quando si
esegue il caricamento.

Una volta caricati i dati, sara visualizzato un
messaggio di completamento e la spia
ACCESS si spegne.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare Scene Recall USB >Execute al
punto 2.

Salvataggio e caricamento di file di scena

ajualn suoizejsodwi Ip P Ip OlusWEDLIED 8 olbbeleaesg 7 ojonden

179



sjua)n suoizejsodwi Ip 1ep Ip ojusweoled o oibbeleaes 7 ojonde)

180

Salvataggio e
caricamento di file
dell’obiettivo

Impostazione dati file
dell’obiettivo

Utilizzare FILE >Lens (vedere pagina 168) nel
menu di impostazione per impostare i dati nei file
dell’obiettivo.

E possibile impostare i dati seguenti e salvarli
come file dell’obiettivo.

Dati di impostazione Voci secondarie

Valori di compensazione M V Modulation
ombreggiatura di

modulazione V

Posizione dell’indicatore ~ Lens Center H

del centro Lens Center V

Livello di luce parassita Lens R Flare
Lens G Flare
Lens B Flare

Valore di compensazione  Lens W-R Offset

del bilanciamento del Lens W-B Offset

bianco

Valore di compensazione L R/G/B H Saw

delle sfumature del bianco L R/G/B H Para
L R/G/B V Saw

L R/G/B V Para

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

Salvataggio file dell’obiettivo

Per salvare un file dell’obiettivo su una scheda di
memoria SxS, inserire la scheda in uno slot per
schede di memoria e quindi procedere come
segue.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >Lens nel menu di
impostazione.

Salvataggio e caricamento di file dell’obiettivo

Come assegnare un nome ai dati prima di
salvarli

Assegnare un nome prima di procedere al
punto 2.

Per ulteriori informazioni, vedere “Come
assegnare nomi ai file” (pagina 177).

2 Selezionare Lens Store Mem >Execute
(se si desidera salvare i dati nella
memoria interna del camcorder), e
Lens Store SxS >Execute (se si desidera
salvare i dati su una scheda di memoria
SxS).

3 Premerela manopola MENU.
Se si seleziona [Execute], appare una casella
elenco del numero di file dell’ obiettivo. I
numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti.

4 Selezionare il numero del file con il
quale si desidera salvare i dati, e quindi
premere la manopola MENU.

Appare un messaggio di conferma.

5 Per eseguire il salvataggio, selezionare
[Execute], e quindi premere la
manopola MENU.

Per cancellare il salvataggio,
selezionare [Cancel], e quindi premere
la manopola MENU.

Se ¢& stato selezionato Lens Store SxS
>Execute nel punto 2, la spia ACCESS si
illumina (in blu sul pannello a destra e in
arancione nello slot della scheda) quando si
esegue il salvataggio.

Una volta salvati i dati, sara visualizzato un
messaggio di completamento e la spia
ACCESS si spegne.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare Lens Store USB >Execute al punto 2.

Quando si salva un file di un obiettivo che era installato
su un altro camcorder PMW-500 per un obiettivo seriale
su un’unita flash USB, salvarlo con il suddetto obiettivo
seriale montato su questo camcorder per permettere il



caricamento automatico dello stesso file dell’obiettivo
(Lens Auto Recall).

Caricamento dei file dell’obiettivo

Per caricare un file dell’obiettivo da una scheda di
memoria SxS, inserire la scheda di memoria SxS
in uno slot per schede di memoria, e quindi
procedere come segue.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >Lens nel menu di
impostazione.

2 Selezionare Lens Recall Mem >Execute
se si desidera caricare il file dalla
memoria interna del camcorder, e
selezionare Lens Recall SxS >Execute se
si desidera caricare il file da una scheda
di memoria SxS.

3 Premerela manopola MENU.
Se si seleziona [Execute], appare una casella
elenco dei file dell’ obiettivo. I numeri dei file
presenti dove viene visualizzato “No File”
sono numeri di file vuoti.

4 Selezionare il numero di file desiderato,
e quindi premere la manopola MENU.
Appare un messaggio di conferma.

9 Per eseguire il caricamento, selezionare
[Execute], e quindi premere la
manopola MENU.

Per annullare il caricamento,
selezionare [Cancel], e quindi premere
la manopola MENU.

Se ¢ stato selezionato Lens Recall SxS
>Execute nel punto 2, la spia ACCESS si
illumina (in blu sul pannello a destra e in
arancione nello slot della scheda) quando si
esegue il caricamento.

Una volta caricato il file dell’ obiettivo
specificato, sara visualizzato un messaggio
di completamento e la spia ACCESS si
spegne.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare Lens Recall USB >Execute al

punto 2.

Caricamento automatico dei file
dell’ohiettivo

Quando si utilizza un obiettivo che supporta la
comunicazione seriale, & possibile impostare il
camcorder caricando automaticamente il file
dell’obiettivo che corrisponde alle impostazioni
dell’obiettivo (funzione Lens Auto Recall).
Per utilizzare la funzione Lens Auto Recall,
impostare FILE >Lens >Lens Auto Recall nel
menu di impostazione su una delle seguenti
posizioni.
On: carica il file dell’ obiettivo che corrisponde al
nome del modello.

Off: non utilizzare la funzione Lens Auto Recall.

Serial Number: carica il file dell’ obiettivo che
corrisponde al nome del modello e al numero
di serie (quando I’obiettivo supporta la
comunicazione del numero di serie).

Se I’obiettivo non supporta la comunicazione del

numero di serie, entrambe le impostazioni

caricano il file dell’obiettivo che corrisponde al

nome del modello.

Salvataggio e caricamento di file dell’obiettivo
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Salvataggio e
caricamento di file
utente

E possibile salvare le impostazioni e
configurazione del menu USER oltre che i dati sul
bilanciamento del bianco come file utente.

Salvataggio di file utente

Per salvare un file utente su una scheda di
memoria SxS, inserire la scheda in uno slot per
schede di memoria e quindi procedere come
segue.

Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1 Selezionare FILE >User nel menu di
impostazione.

Come assegnare un nome ai dati prima di
salvarli

Assegnare un nome prima di procedere al
punto 2.

Per ulteriori informazioni, vedere “Come
assegnare nomi ai file” (pagina 177).

2  Selezionare User Save SxS >Execute.
Viene visualizzata casella elenco dei file
utente.

I numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti. I numeri dei file con un nome o una
data e 1’ora sono numeri di file che
contengono gia dei dati.

3 Ruotarela manopola MENU per

selezionare il numero di file desiderato.

4 Premerela manopola MENU.
Appare un messaggio di conferma.

Salvataggio e caricamento di file utente

5 Per eseguire il salvataggio, selezionare
[Execute], e quindi premere la
manopola MENU. Per cancellare il
salvataggio, selezionare [Cancel], e
quindi premere la manopola MENU.
Se si sceglie di eseguire il salvataggio, la spia
ACCESS si illumina (in blu sul pannello a
destra e in arancione nello slot della scheda).
Appare un messaggio di completamento e la
spia ACCESS si spegne quando i dati sono
stati salvati.

Salvataggio del menu USER come file
utente in cui tutte le impostazioni del
menu sono ripristinate secondo i valori
predefiniti

Selezionare Store User Preset >Execute al
punto 2.

Quando si usa un’unita flash USB (in
modalita UDF)

Collegare un’unita flash USB formattata
(vedere pagina 74) al connettore di un
dispositivo esterno.

Selezionare User Save USB >Execute al
punto 2.

La spia ACCESS non si accende durante il
salvataggio al punto 5.

Caricamento dati impostazione

Quando si carica un file da una scheda di memoria SxS o
un’unita flash USB (in modalita UDF), i dati salvati nella
memoria interna del camcorder saranno sovrascritti.

A seconda delle impostazioni di Load Customize
Data e User Load White in FILE >User nel menu
di impostazione

Quando Load Customize Data ¢ impostato su
[Off]: sono caricate solo le impostazioni del
menu USER.

Quando Load Customize Data ¢ impostato su
[On]: sono caricate le impostazioni e la
configurazione del menu USER.

Quando User Load White ¢ impostato su [Off]:
i dati sul bilanciamento del bianco non sono
caricati.

Quando User Load White ¢ impostato su [On]:
i dati sul bilanciamento del bianco sono
caricati.



Per informazioni sulle operazioni di menu, vedere
“Operazioni di base del menu di impostazione”
(pagina 114).

1

Selezionare FILE >User nel menu di
impostazione.

Selezionare User Load SxS >Execute.
Appare una casella elenco di file utente.

I numeri dei file presenti dove viene
visualizzato “No File” sono numeri di file
vuoti. I numeri dei file con un nome o una
data e 1’ora sono numeri di file che
contengono gia dei dati.

Ruotare la manopola MENU per

selezionare il numero di file desiderato.

Premere la manopola MENU.
Appare un messaggio di conferma.

Per eseguire il caricamento, selezionare
[Execute], e quindi premere la
manopola MENU. Per annullare il
caricamento, selezionare [Cancel], e
quindi premere la manopola MENU.
Se si sceglie di eseguire il caricamento, la
spia ACCESS si illumina (in blu sul pannello
a destra e in arancione nello slot della
scheda). La spia ACCESS si spegne e appare
un messaggio di completamento quando i
dati sono stati caricati.

Quando si usa un’unita flash USB (in modalita
UDF)

Collegare un’unita flash USB formattata (vedere
pagina 74) al connettore di un dispositivo
esterno.

Selezionare User Load USB >Execute al punto 2.

La spia ACCESS non si accende durante il
salvataggio al punto 5.

Salvataggio e caricamento di file utente
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Capitol08

E possibile azionare il camcorder anche mediante un dispositivo di comando a distanza, ad esempio
un’unita di controllo remoto RM-B150/B170/B750 o un pannello di controllo remoto RCP-1001/1501.
Per informazioni dettagliate sulla connessione e 1’utilizzo del dispositivo di comando, consultare il
supplemento fornito con il CD-ROM (contrassegnato con “Manuals for Solid-State Memory
Camcorder”).

Connessione di monitor esterni

Selezionare il segnale in uscita e utilizzare un cavo adeguato per la connessione con il monitor.

HD/SD SDI
ouT

Cavo BNC (non fornito)

SDIIN

&5

4+
VIDEO IN

VIDEO OUT

Cavo BNC (non fornito)

A prescindere dal tipo di segnale HD o SD, ¢ m
possibile visualizzare sul monitor esterno le
stesse informazioni di stato e menu visualizzate
nella schermata del mirino.

I'segnali SD convertiti per 1’uscita hanno le seguenti
limitazioni:

Le immagini di 50P/50i/25P vengono emesse come
segnali PAL, quelle di 59.94P/59.94i/29.97P come
segnali NTSC e quelle di 23.98P come segnali NTSC di
riduzione 2-3.

Connessione di monitor esterni



Connettore HD/SD SDI OUT (BNC)

1l connettore HD/SD SDI OUT puo essere
utilizzato per collegare un dispositivo che
supporta I’SDI. 1l tipo di dispositivo puo essere
un monitor, un interruttore, un VIR o altri
dispositivi di registrazione.

L’uscita dal connettore puo essere abilitata e
disabilitata tramite OPERATION >Input/Output
>SDI Output nel menu di impostazione (vedere
pagina 120).

Per la connessione, utilizzare un cavo BNC (non
in dotazione).

Connettore VIDEO OUT

1l connettore VIDEO OUT puo essere utilizzato
per collegare un dispositivo che supporta il
segnale composito analogico. Il tipo di
dispositivo puo essere un monitor, un VIR o altri
dispositivi di registrazione.

11 segnale di uscita varia come illustrato nella
tabella di seguito a seconda dell’impostazione di
OPERATION >Output&i.LINK nel menu di
impostazione.

Impostazione Segnale di uscita

HD&HDV (in Segnale analogico HD-Y con
modalita FAT) lo stesso formato video

HD (in modalita  dell'uscita di segnale dal
UDF) connettore HD/SD SDI OUT.
SD&HDV o Segnale composito con lo
SD&DV (in stesso formato video
modalita FAT) dell'uscita di segnale dal

SD (in modalita connettore HD/SD SDI OUT.
UDF) Quando OPERATION

>Format >HD/SD nel menu di
impostazione ¢ impostato su
[SD], il segnale composito di
uscita ¢ lo stesso segnale
codificato NTSC o PAL
emesso dal connettore HD/SD
SDI OUT ¥

a) Usare OPERATION >Format >Country (vedere
pagina 119) nel menu di impostazione per passare da
NTSC a PAL e viceversa.

Per inviare il segnale in uscita dal connettore
VIDEO OUT al dispositivo composito esterno di
tipo analogico, potrebbe essere necessario
cambiare 1’impostazione del segnale in ingresso
del dispositivo esterno affinché corrisponda
all’impostazione del segnale composito
analogico per il connettore VIDEO OUT.

Per inviare 1’audio in ingresso del camcorder a un
dispositivo esterno come un monitor o un VIR o
altri dispositivi di registrazione, connettere
I’uscita audio del connettore AUDIO OUT
all’ingresso audio del dispositivo esterno.

Per la connessione, utilizzare un cavo BNC (non
in dotazione).

Connettore i.LINK (HDV/DV)

In modalita FAT, il connettore i.LINK (HDV/
DV) supporta I’'HDV e I’ingresso/uscita DV.
Tuttavia, lo stream DV non puo essere registrato
su questo camcorder.

Questo connettore puo essere utilizzato per
collegare un dispositivo che supporta i.LINK
(HDV). Il tipo di dispositivo puo essere un
monitor, un dispositivo read/write come VIR o
HDD, o un computer.

Come inviare/ricevere segnali HDV
L’ingresso/uscita HDV & supportato se il formato
video & compatibile con HDV (SP 1440/59.94i,
SP 1440/50i o SP 1440/23.98P), Input/Output
>Output&i.LINK nel menu OPERATION &
impostato su [HD&HDV] o [SD&HDV], e Input/
Output >i.LINK I/O & impostato su [Enable].

Se il formato video & SP 1440/23.98P, viene
emesso un segnale 59.94i HDV soggetto a
elaborazione con riduzione 2-3.

Come inviare/ricevere segnali DV
L’ingresso/uscita DV & supportato in ognuna
delle seguenti condizioni.

* Input/Output >i.LINK I/O nel menu
OPERATION ¢ impostato su [Enable] nella
modalita SD.

¢ In modalita HD, il formato video ¢ diverso dai
formati incompatibili con DV (HQ 1920/
23.98P, HQ 1440/23.98P, e HQ 1280/23.98P),
Input/Output >Output&i.LINK & impostato su
[SD&DV] e Input/Output >i. LINK I/O &
impostato su [Enable].

Connessione di monitor esterni
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Esecuzione di clip con
un computer

I clip registrati su schede di memoria SxS con
questo camcorder possono essere gestiti mediante
computer e modificati tramite il software di
montaggio non lineare opzionale.

Per tali scopi, i clip su una scheda di memoria SxS
possono essere utilizzati caricando direttamente
la scheda in un computer oppure collegando il
camcorder o il dispositivo USB SBAC-US10 di
lettura/scrittura di schede di memoria SxS
opzionale al computer tramite cavo USB, come
illustrato di seguito.

Utilizzo di uno slot ExpressCard di
un computer

Se il computer & dotato di slot ExpressCard/34 o
ExpressCard/54, ¢ possibile inserire direttamente
la scheda di memoria SxS contenente clip
registrati con questo camcorder ed accedere ai
file.

« Scaricare e installare nel computer il SxS Device
Driver Software e I"UDF Driver Software. Per i
dettagli, fare riferimento a “Download del software”
(pagina 11).

« Il funzionamento non & garantito con tutti i computer.

Per ulteriori informazioni software del driver,
visitare il sito Web all’indirizzo riportato di seguito:
http://www.sony.net/SxS-Support/

Allo slot ExpressCard
[ @ =
Scheda di memoria
SxS

Computer con SxS
Device Driver
Software installato

Su un computer con sistema operativo Windows
Controllare che appaia Disco rimovibile su
Risorse del computer. Cid indica uno stato
normale.

Esecuzione di clip con un computer

Su un computer con sistema operativo
Macintosh
Nella barra dei menu viene visualizzata un’icona.

Connessione USB con un
computer

Preparazioni

Collegando il camcorder ad un computer tramite
il cavo USB (non in dotazione), la scheda di
memoria nello slot viene riconosciuta dal
computer come estensione del drive.

Quando si inseriscono due schede di memoria in
questo camcorder, vengono riconosciute dal
computer come due estensioni indipendenti dei
drive.

Cavo USB
(non fornito)

=&

Nel collegare il cavo USB al computer, prestare
attenzione al modello e alla direzione del connettore
USB.

Il camcorder non funziona sull’alimentazione bus
proveniente dal computer.

Per avviare la connessione USB

Quando un computer viene connesso a un connettore PC
di un camcorder e allo stesso tempo un disco rigido
professionale PHU-220R (alimentato a batteria) viene
connesso al computer, la batteria scarica nel PHU-220R
(indicato dall’avvertenza Battery End) disattiva i
seguenti.
¢ Come salvaguardare il PHU-220R dagli accessi dal
computer



¢ Ladisconnessione del cavo PHU-220R dallo slot della
scheda di memoria o la riconnessione del cavo nello
slot.

¢ Per accendere 1’indicatore tally sullo schermo del
mirino per avvisare 1’operatore

Collegando un computer al connettore PC tramite
un cavo USB (non in dotazione), viene
visualizzato il messaggio “Connect USB Now?”
nel quale si richiede la conferma di abilitazione
della connessione USB.

Se si seleziona “Cancel” o si sposta MENU
CANCEL/PRST/ESCAPE su ESCAPE o se si
disconnette il cavo USB, il messaggio “Connect
USB Now?” scompare.

Cancel

Se si seleziona “Execute” e si preme la manopola
MENU, la connessione USB viene abilitata e il
camcorder viene riconosciuto come drive di
estensione. E possibile svolgere le stesse
operazione grazie ai pulsanti freccia (ﬂ}, {}, <=,
=>) (vedere pagina 20).

USB Connecting

Se la connessione USB viene abilitata durante
I’operazione di registrazione/riproduzione,
I’operazione viene bloccata e il messaggio “USB
Connecting” appare nella schermata del mirino.
A questo punto, il segnale di uscita dal connettore
VIDEO OUT e dal connettore HD/SD SDI OUT
si trasforma in un segnale nero.

* Quando viene visualizzato il messaggio “USB
Connecting”, il camcorder non puo essere utilizzato
per la registrazione, riproduzione, ecc.

¢ Quando un computer ha accesso al supporto caricato
nel camcorder, non svolgere le seguenti operazioni.

- Mettere in funzione il camcorder (accendere/
spegnere, cambiare la modalita operativa, ecc.)

- Larimozione o il caricamento di un supporto da uno
slot attivo (a cui si accede da un computer)

- La rimozione o connessione del cavo USB

Disabilitazione della connessione USB

Per disabilitare la connessione USB, seguire la
stessa procedura della rimozione di un dispositivo
da un computer.

Per abilitare nuovamente la connessione USB,
per prima cosa disconnettere il cavo USB e
riconnetterlo. Appare nuovamente il messaggio
“Connect USB Now?”.

Se si connette un cavo i.LINK, non & possibile utilizzare
il computer per utilizzare i file archiviati in un supporto
di registrazione caricato nello slot della scheda di
memoria presente nel camcorder.

Come rimuovere una scheda di memoria
SxS

Windows

1. Fare clic sull’icona “Rimozione sicura
dell’hardware” nella barra degli strumenti
del computer.

2. Selezionare “I’opzione relativa alla
rimozione sicura della scheda di memoria
SxS, unita (X:)”, dal menu visualizzato.

3. Attendere il messaggio di conferma della
rimozione sicura dell’hardware, quindi
rimuovere la scheda.

Macintosh

Trascinare I’icona della scheda di memoria SxS
sul desktop nel Cestino.

Se la scheda di memoria SxS ¢ posizionata in
Finder, fare clic sull’icona eject posta sul lato.

Come usare il software di applicazione

Per copiare i clip nel disco locale di un computer,
& necessario scaricare e installare il software
dedicato nel computer. Per i dettagli, fare
riferimento a “Download del software”

(pagina 11).

Anche se i dati dei materiali registrati vengono
memorizzati in piu file e cartelle, i clip possono
essere facilmente gestiti senza tener conto della
struttura di tali dati e directory utilizzando il
software dedicato.

Se i clip vengono copiati, ad esempio, sulla scheda di
memoria SxS utilizzando Explorer (Windows) o Finder
(Macintosh), i dati ausiliari contenuti dei clip potrebbero
andare perduti.

Esecuzione di clip con un computer

1UI81S8 IAISOdSIp Ip ojuawebs|jon g ojouden

187



Come usare un sistema di montaggio non connessione dl un

lineare

Per un sistema di montaggio non lineare, & d ISPOSItIVO ESte o
necessario utilizzare il software di montaggio (con nessi one i LI N K)

opzionale corrispondente ai formati di
registrazione utilizzati con questo camcorder.
Archiviare preventivamente i clip da montare

sull’unita disco rigido del computer tramite il FAT

software di applicazione in dotazione. E possibile registrare le stesse immagini di quelle
Alcuni software di montaggio potrebbero non registrate sulla scheda di memoria su questo
funzionare correttamente. Prima dell’uso, camcorder o su un dispositivo esterno connesso al
assicurarsi che il formato di registrazione sia connettore i. LINK (HDV/DV), o registrare
conforme a quello utilizzato con questo I’immagine di riproduzione del dispositivo
camcorder.

esterno nella scheda di memoria del camcorder.
Quando si connette il camcorder a un sistema di
montaggio non lineare che supporta il formato
HDV, ¢ possibile modificare le immagini
registrate sulla scheda di memoria del camcorder.

* La connessione i.LINK ¢ disponibile solo in modalita
FAT.

Utilizzare il connettore i. LINK (HDV/DV) solo per la
connessione i.LINK uno a uno.
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Quando si modifica un’impostazione che influenza i
segnali in uscita dal connettore i. LINK (HDV/DV),
come HD/SD, HD System Line, System Frequency, e
Rec Format alla voce OPERATION >Format nel menu
di impostazione o i.LINK I/O e Down Converter alla
voce OPERATION >Input/Output nel menu di
impostazione, disconnettere il cavo i.LINK e cambiare
I’impostazione. La modifica di tali impostazioni con il
cavo i.LINK connesso pud causare un funzionamento
scorretto del dispositivo connesso con i.LINK.

Il segnale di ingresso esterno attraverso la connessione
i.LINK che si puo registrare sul camcorder ¢ solo
HDV. Non ¢ possibile registrare stream DV con la
connessione i.LINK.

Registrazione delle immagini del
camcorder su un dispositivo
esterno

L’immagine registrata con questo camcorder
viene inviata con uno stream HDV o DV
attraverso il connettore i.LINK (HDV/DV). Puo
essere registrata su un registratore HDV o
DVCAM in sincronizzazione con le operazioni di
registrazione di avvio/stop di questo camcorder.

188 | Connessione di un dispositivo esterno (connessione i.LINK)



1 Svolgere le impostazioni preparatorie
del camcorder.
¢ Impostare OPERATION >Input/Output

>Output & i.LINK nel menu di

impostazione (vedere pagina 120) su “HD

& HDV” 0 “SD & HDV”.

HD & HDV 0 SD & HDV: per inviare uno
stream HDV in modalita HD quando
il formato video ¢ impostato su un
formato compatibile HDV (SP 1440/
59.94i, SP 1440/50i, o SP 1440/
23.94P)

SD & DV: consente di emettere stream
DV

Impostare OPERATION >Input/Output

>i.LINK

1/0O nel menu di impostazione su [Enable].

Impostare MAINTENANCE >Trigger
Mode >i.LINK Trigger Mode nel menu di
impostazione (vedere pagina 160) su
[Both] o [External].

Both: per svolgere una registrazione sulla
scheda di memoria nel camcorder e
sul dispositivo esterno

External: per eseguire delle registrazioni
solo sul dispositivo esterno

2 Impostare lo stato di standby di
registrazione del dispositivo esterno.

Per le operazioni con un dispositivo esterno,
consultare il manuale operativo di quel
dispositivo.

3 Avvio della registrazione.
Il dispositivo esterno avvia la registrazione in
sincronizzazione.

Lo stato di un dispositivo esterno viene
visualizzato nell’area relativa allo stato di i. LINK
(vedere pagina 32) sullo schermo del mirino.

Indicazione Stato di un dispositivo
esterno

STBY [ Registrazione HDV in standby

OREC j[Ih11] Registrazione HDV

STBY D1 Registrazione DV in standby

OREC ;1 Registrazione DV

« 1l funzionamento potrebbe essere differente a seconda
del tipo di dispositivo esterno.

* Quando si esegue la registrazione sul supporto di
registrazione caricato nel camcorder mentre i segnali
HDV vengono emessi dal connettore i. LINK (HDV/
DV), I’emissione del segnale HDV si arresta per circa
un secondo prima di iniziare la registrazione, quindi
riprende.

* Mentre & possibile registrare indicatori di ripresa sulla
scheda di memoria durante la registrazione, non
vengono aggiunti alle immagini registrate nel
dispositivo esterno.

Montaggio non lineare

E possibile trasferire uno stream HDV a un
sistema di montaggio non lineare connesso
attraverso il connettore i.LINK (HDV/DV).

11 connettore i.LINK (HDV/DV) del camcorder & un
connettore a 6 pin. Verificare il numero di pin sul
connettore i.LINK sul computer e utilizzare il cavo
i.LINK appropriato.

Cercando immagini di questo camcorder sul computer,
potrebbe essere necessario del tempo fino a che il
display venga visualizzato sul computer.

Se il clip di riproduzione ¢ breve o se il punto di inizio
della riproduzione ¢ vicino alla fine del clip, il segnale
i.LINK puo interrompersi tra il clip e quello
successivo. Quando viene eseguito il tentativo di
acquisizione di tale segnale mediante il sistema di
montaggio non lineare, pud verificarsi un errore a
seconda del software di montaggio non lineare in uso.

Se viene specificata una velocita di ricerca diversa da
una4, 15 o 24 volte maggiore rispetto a quella normale
mediante un sistema di editing non lineare, non verra
emesso alcun segnale i.LINK. In tal caso, I'immagine
sul monitor LCC puo bloccarsi.

E possibile che I'immagine riprodotta ad elevata
velocita non venga visualizzata, a seconda del software
di montaggio non lineare in uso.

Impostazione su questo camcorder

Impostare OPERATION >Input/Output >i.LINK
1/O nel menu di impostazione su [Enable].

Per l'utilizzo del software di montaggio non lineare,
consultare il manuale operativo del software.

Registrazione di segnali di
ingresso esterni

L’ingresso stream HDV da un dispositivo
connesso attraverso il connettore i. LINK (HDV/
DV) puo essere registrato su una scheda di
memoria SxS nel camcorder.

Connessione di un dispositivo esterno (connessione i.LINK)
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I codici temporali sovrapposti sull’ingresso
i.LINK vengono registrati a prescindere dalle
impostazioni del camcorder.

Lo stream DV non puo essere registrato.

1 Impostare il segnale esterno a un
formato che puo essere registrato sul
camcorder.

Selezionare un formato compatibile a HDV
(SP 1440/59.94i, SP 1440/501, o SP 1440/
23.94P) per il formato video.

2 Eseguire le seguenti impostazioni con
OPERATION >Input/Output nel menu
di impostazione (vedere pagina 120).

* Impostare Output&i.LINK su
[HD&HDV] o [SD&HDV].

¢ Impostare i.LINK 1I/O su [Enable].

* Impostare Source Select su [i. LINK].

11 video in ingresso viene visualizzato nello

schermo del mirino o nel monitor connesso al

connettore VIDEO OUT.

I segnali audio vengono emessi attraverso gli

altoparlanti integrati, le cuffie collegate al

connettore EARPHONE, e gli altoparlanti di

un monitor connesso al connettore VIDEO

OUT.

3 Avviarela registrazione.

 Un errore viene generato nei seguenti casi. In tal caso,
cancellare la modalita di registrazione.

- 1l formato video del segnale in ingresso non
corrisponde a quello specificato nel camcorder.
- Viene immesso uno stream con copia protetta.

* Se si verifica una perdita del segnale in ingresso del
camcorder durante la registrazione, gli indicatori
TALLY, I’indicatore tally sulla parte anteriore del
mirino, e I'indicatore REC (@REC) nello schermo del
mirino lampeggiano per indicare che nessun segnale &

in corso di registrazione sulla scheda di memoria SxS.

Quando il segnale in ingresso viene ripristinato, la
registrazione viene avviata nuovamente, aumentando
il numero di clip sulla scheda di memoria.

Configurazione di un
sistema di ripresa e
registrazione

L’installazione del CBK-HDO2 opzionale su
questo camcorder consente il collegamento
dell’adattatore per videocamera HD CA-FB70
per telecamera e dell’unita di controllo HD CA-
TX70.

Cio consente la configurazione di un sistema di
ripresa e registrazione costituito da vari
camcorder con unita di estensione per telecamera
collegate ad una unita di controllo remoto.

Per ulteriori informazioni su CA-FB70 e CA-TX70,
consultare i relativi manuali operativi.

Quando si usa il camcorder in questo sistema, non
connettere una luce video al camcorder.

Configurazione di un sistema di ripresa e registrazione



Capitnlng

Verificare le funzioni del camcorder prima di
eseguire le impostazioni per una sessione di
riprese, preferibilmente registrando e
riproducendo segnali audio e video.

Pulizia del mirino

Utilizzare un compressore per pulire lo schermo
CRT ed il vetro interno del cilindro del mirino.
Pulire I’obiettivo ed il filtro protettivo con un
prodotto adeguato disponibile in commercio.

Non utilizzare solventi organici, quali diluenti.

Smontaggio dell’oculare per la pulizia
(esempio: HDVF-20A)

© Cilindro del mirino
@ Supporto oculare

© Filtro di protezione
O Rotellina di fissaggio
@ Oculare

1 Scollegare I’oculare dal cilindro del
mirino.
Per la procedura di distacco, vedere
“Rimozione dell’oculare” a pagina 37.

2 Estrarre ’oculare dal supporto.

3 Estrarre il filtro di protezione e la
rotellina di fissaggio dal supporto.

Test del camcorder / Manutenzione
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4 Scollegare il filtro di protezione dalla
rotellina di fissaggio.

Filtro antinebbia

A seconda della temperatura e dell’umidita, il
filtro di protezione potrebbe offuscarsi, specie se
si respira vicino ad esso. Per essere certi che il
mirino sia sempre nitido, sostituire il filtro di
protezione con un filtro antinebbia (numero
articolo: 1-547-341-11).

Montaggio del filtro antinebbia

Sostituire il filtro di protezione situato sulla
rotellina di fissaggio con il filtro antinebbia.
Accertarsi di montare correttamente il filtro
antinebbia, la rotellina di fissaggio e 1’oculare, in
modo che I’oculare riassemblato sia
impermeabile.

Pulire il filtro antinebbia delicatamente con un panno
umido per evitare danni al rivestimento antinebbia.

Nota sul morsetto della batteria

Il morsetto della batteria dell’apparecchio (il
connettore per pacchi batteria e adattatori CA) &
un prodotto di consumo.

Se i piedini del morsetto sono piegati e deformati
a causa di urti o vibrazioni o se vengono corrosi a
causa di un uso prolungato all’aria aperta, &
probabile che I’apparecchio non sia alimentato in
modo corretto.

Si consiglia di eseguire dei controlli periodici per
assicurare il funzionamento corretto
dell’apparecchio e prolungarne la durata.

Per ulteriori informazioni sui controlli, contattare il
rivenditore o un rappresentante Sony.

Manutenzione



Avvisi relativi al funzionamento

Se si verifica un problema durante 1’accensione o 1’utilizzo del camcorder, verra emesso un avviso da

parte di diversi indicatori sia visivi che audio. Gli indicatori visivi e audio sono i seguenti:

* Messaggio di errore/di avvertenza (“A” nella “Descrizione della tabella dei messaggi di avviso” qui di
seguito)

* Indicatore WARNING (“B”), suono di avviso dagli altoparlanti e dagli auricolari (“C”), indicatore tally/
REC (“D”), e indicatore batteria residua (“E”).

Un messaggio di avviso e un indicatore REC appaiono sullo schermo del mirino.

Il volume dei segnali acustici puo essere regolato con la manopola ALARM. Impostare la manopola

ALARM sul minimo per eliminare 1’audio.

Descrizione della tabella dei messaggi di avviso

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
B C D E
<
Problema Operazione sul modulo di | Azione correttiva
registrazione

« Il funzionamento dell’indicatore WARNING, I’indicatore tally/REC, e I’indicatore della batteria ¢
rappresentato dai simboli grafici seguenti.
K‘L‘é: continuo
8¢ 1 lampeggio/s
o) 4 lampeggi/s
« I segnali acustici sono rappresentati dai seguenti simboli grafici.
)M : segnale acustico continuo
)M : 1 segnale acustico/s

Indicazione di errore

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

— DM ot —

Problema Operazione sul modulo di | Azione correttiva

registrazione
Errore (Il camcorder  |La registrazione si Disattivare 1'alimentazione e controllare se si
presenta anomalie.) interrompe. verificano errori sui dispositivi collegati, i cavie i

supporti. (Se non ¢ possibile disattivare
I'alimentazione impostando l'interruttore POWER
su OFF, rimuovere il pacco batteria o
I'alimentatore CA.)

Se il problema persiste dopo aver riavviato il
camcorder, rivolgersi al proprio rappresentante
Sony.

Auvvisi relativi al funzionamento
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Indicazione di avviso

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

—jo::— )N o —

Problema Operazione sul modulo di | Azione correttiva

Lo spazio disponibile
sulla scheda di
memoria SxS &
insufficiente.

Media Near Full

La registrazione continua.

Sostituire la scheda prima possibile.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

2(}2 )M —o:)))— —

Problema Operazione sul modulo di | Azione correttiva

registrazione

Lo spazio disponibile
sulla scheda di
memoria SxS &
terminato. Impossibile
eseguire registrazioni,
copie e divisioni di
clip.

Media Full

La registrazione si
interrompe.

Sostituirla con una nuova.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

g.:g )N ;:.g g.:g

Problema Operazione sul modulo di | Azione correttiva

Battery Near End

La batteria ¢ quasi
esaurita.

La registrazione continua.

Ricaricarla al piu presto.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

2(}2 )M —jo:))):— 5.::—

Problema Operazione sul modulo di | Azione correttiva

registrazione

Battery End

Pacco batteria scarico.
Impossibile eseguire
una registrazione.

La registrazione si
interrompe.

Collegare la fonte di alimentazione attraverso il
connettore DC IN o fermare I’operazione per
caricare il pacco batteria.

Auvvisi relativi al funzionamento



Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
b NV
_En P 3 )N > 3 —
= Problema Operazione sul modulo di | Azione correttiva
; registrazione
§ La temperatura interna | La registrazione continua. | Sospendere 1’operazione, spegnere e attendere
E- ha superato il limite che la temperatura si abbassi.
E massimo di
funzionamento in
condizioni di
sicurezza.
Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Je- )N g:.g g.:g
Problema Operazione sul modulo di | Azione correttiva

Voltage Low

registrazione

La tensione CC IN ¢
ridotta (fase 1).

La registrazione continua.

Verificare 1’alimentazione.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
D
5 %\% )M 5.:)))3 30:3
S
z Problema Operazione sul modulo di | Azione correttiva
; registrazione
9
%" Latensione CCIN ¢ |La registrazione si Collegare un altro alimentatore.
& troppo basso (fase 2). |interrompe.
L
Impossibile eseguire
una registrazione.
3| Indicatore Segnale acustico di Tally/REC Batteria residua
E’ WARNING avvertimento
5 &
il - - -
ﬁi ;'73 Problema Operazione sul modulo di | Azione correttiva
R registrazione
= O
5 “¥ E stato rilevato un La registrazione si Sostituire il pacco batteria con uno normale.
§ errore nel pacco interrompe.
A .
batteria.
Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

Please Change.

La batteria di riserva
residua non &
sufficiente.

Backup Battery End

La registrazione continua.

Contattare un rappresentante Sony per la
sostituzione della batteria.

Auvvisi relativi al funzionamento
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registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
—'2 ) Problema Operazione sul modulo di | Azione correttiva
= registrazione
<zl
g 5 E stata inserita una La registrazione continua. |Impossibile utilizzare la scheda con questo
!; P scheda di memoria di camcorder. Rimuoverla e caricare una scheda
] § partizione o una compatibile.
= 2] contenente un numero
SR di clip registrati
superiore a quello
consentito per questo
g)) camcorder.
% Indicatore Segnale acustico di Tally/REC Batteria residua
) . WARNING avvertimento
© = -
g < — _ —
5 BN
:3, E 4| Problema Operazione sul modulo di | Azione correttiva
@ g E registrazione
§' Zn. E Il numero massimo di |La registrazione si Sostituire la scheda.
@ 5 § clip per una singola interrompe.
2 E scheda di memoria ¢
E E statoi rzflgglun.to. Non ¢
& 6 pos.s1b1.le registrare
altri clip su questa
scheda.
Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

Media Error

E stato rilevato un
errore nella scheda di
memoria. E necessario
ripristinare la scheda.

La registrazione si
interrompe.

Rimuovere la scheda, caricarla nuovamente,

quindi ripristinarla.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

Media Error
Cannot Record to Med'a(A)l) Media(A)D Needs to be Restored

difettosa.

Impossibile eseguire la
registrazione poiché la
scheda di memoria &

La registrazione si
interrompe.

Se ¢ possibile eseguire la riproduzione, &
consigliabile sostituire la scheda dopo aver

copiato i clip.

196 | Avvisi relativi al funzionamento



Media Error
Cannot Use Media(A)l)

=
2
]
g
£
=
=
]
g
St
=]
=~
(=]
D
=
=

Copy Protected Input

Cannot Use Media(A)1J

Indicatore
WARNING

Segnale acustico di
avvertimento

Tally/REC Batteria residua

Problema

Operazione sul modulo di
registrazione

Azione correttiva

Impossibile eseguire la
registrazione o la
riproduzione poiché la
scheda di memoria &
difettosa.

La registrazione si
interrompe.

Non ¢ compatibile con questo camcorder.
Sostituire la scheda.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

registrazione

Cannot Record

E stata inserita una

La registrazione si

Non & compatibile con questo camcorder.

scheda di un diverso | interrompe. Sostituirla con un’altra scheda oppure formattarla
sistema di file. con questo camcorder.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

Problema Operazione sul modulo di | Azione correttiva

registrazione

Impossibile registrare
I’ingresso del segnale
esterno tramite la
connessione i.LINK
poiché il formato
video ¢ diverso dal
formato del segnale
dell’ingresso esterno.

La registrazione si
interrompe.

Modificare le impostazioni di OPERATION
>Format nel menu di impostazione affinché
combacino con il segnale esterno.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

registrazione

Impossibile registrare
il segnale di ingresso
esterno tramite
connessione i. LINK
poiché lo stream ¢
protetto da copia.

La registrazione si
interrompe.

Verificare il segnale di ingresso.

Auvvisi relativi al funzionamento
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registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
r‘:‘: — _ _ —
o0 B " 5 A A
7 § Problema Operazione sul modulo di | Azione correttiva
a :“2 registrazione
= é Impossibile registrare |La registrazione si —
E =) il segnale di ingresso | interrompe.
g b esterno tramite
=] connessione i. LINK
poiché si tratta di uno
stream DV.
Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

E stato rilevato un
errore nella lettura di
dati dalla scheda di
memoria ed ¢
necessario sospendere
la riproduzione.

=
5=
= &
=N
m.&
£8
=
g‘;
[
3
(-9

La registrazione si
interrompe.

Se tale situazione si verifica frequentemente,
modificare la scheda di memoria dopo aver

copiato i clip.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

Non ¢ possibile

Media(A)” Error

La registrazione si

Se tale situazione si verifica frequentemente,

registrazione

eseguire la interrompe. sostituire la scheda di memoria.
registrazione a causa

di un errore nella

scheda di memoria.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

—jo::— )N ;:.g —

Problema Operazione sul modulo di | Azione correttiva

La batteria del’HDD
connesso ¢ quasi
esaurita.

HDD A2 Battery Near End

La registrazione continua.

Cambiarla al piu presto.

Auvvisi relativi al funzionamento



HDD A2 Battery End

Not Enough Capacity

53
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=
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=
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Not Enough Capacity
Cannot Divide

Will Switch Slots Soon

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
&‘?2 )M —jo:))):— —

Problema

Operazione sul modulo di
registrazione

Azione correttiva

La batteria del’HDD

La registrazione si

Interrompere il funzionamento per cambiare la

connesso ¢ scarica. interrompe. batteria.

Impossibile eseguire

una registrazione.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

Problema

Operazione sul modulo di
registrazione

Azione correttiva

La capacita non ¢
sufficiente per la

La registrazione continua
(copia non consentita).

Sostituire la scheda presente nello slot A con
un’altra.

copia.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

Problema Operazione sul modulo di | Azione correttiva

registrazione

=1 La scheda contiene gia

dieci clip con lo stesso
nome di quello che si &
provato a copiare.

La registrazione continua
(copia non consentita).

Sostituire la scheda presente nello slot A con
un’altra.

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva
registrazione
Non ’¢ abbastanza La registrazione continua | —

spazio per dividere un
clip.

(divisione non consentita).

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

registrazione

Passera presto all’altro
slot.

La registrazione continua.

Assicurarsi che la scheda di memoria ¢ stata
caricata nell’altro slot.

Auvvisi relativi al funzionamento
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Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

& | — — —

% Problema Operazione sul modulo di | Azione correttiva

z registrazione
Non c’¢ nessun clip da |La registrazione continua. |—
visualizzare.
Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento

=

5 _ _ _ _

% Problema Operazione sul modulo di | Azione correttiva

2 registrazione

Non c’¢ alcun clip con
I’indicatore OK.

La registrazione continua.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

=1 La scheda contiene gia
dei clip con lo stesso
nome di quello che si &
provato a copiare.

]
Rz
=
=
>
=
<
@
=
=
=
=
L
g
<
wn

La registrazione continua
(copia non consentita).

Sostituire la scheda presente nello slot A con
un’altra.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

La scheda di memoria
& ha raggiunto la fine del
periodo di

=
s
= .
1®] funzionamento.

Media Reached Rewriting Limit

La registrazione si
interrompe.

Effettuare una copia di backup e sostituire la
scheda il prima possibile. La registrazione e la
riproduzione potrebbero non essere eseguite
correttamente se si continua ad utilizzare la
scheda.

Per ulteriori informazioni, consultare le istruzioni
per I'uso della scheda di memoria.

registrazione

Indicatore Segnale acustico di Tally/REC Batteria residua
WARNING avvertimento
Problema Operazione sul modulo di | Azione correttiva

La scheda di memoria
contiene clip registrati
in un formato non
supportato da questo
camcorder.

=
S
B =
=5 &

&
g F
2 3
5 =
= 2
ED
g 3
2 =
2 =
gs:
2 O
=

La scheda nello slot A non puo essere utilizzata
con questo camcorder.
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Indicatore Segnale acustico di Tally/REC Batteria residua
_ WARNING avvertimento
El — — -
&
53 Problema Operazione sul modulo di | Azione correttiva
c: registrazione
<
B [ a ventola non gira — Evitare I’'uso ad alte temperature. Spegnere il
quando viene avviata. camcorder e contattare un rappresentante Sony.
Segnale acustico di Tally/REC Batteria residua
avvertimento

Problema

Operazione sul modulo di
registrazione

Azione correttiva

E necessario il
ripristino in quanto un
supporto & stato
rimosso mentre il
camcorder era in
modalita standby di
registrazione di Clip
Continuous Rec
(vedere pagina 87).

Media was Ejected Just Now
It Needs to be Restored

La registrazione continua.

Inserire nuovamente il supporto che & stato
rimosso e ripristinarlo (vedere pagina 72).

Indicatore
WARNING

Segnale acustico di
avvertimento

Tally/REC Batteria residua

Problema

Operazione sul modulo di
registrazione

Azione correttiva

E stata rimossa
I'alimentazione al
connettore di
dispositivi esterni in
quanto ¢ stata rilevata
sovracorrente sul
connettore. (Non sono

USB(Host)Over Current
Remove USB Device

interessate altre
operazioni.)

La registrazione continua.

Spegnere il camcorder e rimuovere 1'adattatore
Wi-Fi o I'unita flash USB che ¢ connessa al
connettore di dispositivi esterni.

1) (B) per la scheda nello slot B

2) B per un HDD connesso allo slot B

Auvvisi relativi al funzionamento
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I Appendice

Note importanti sul
funzionamento

Uso e conservazione

Non sottoporre il camcorder a duri colpi

« Il meccanismo interno pud danneggiarsi o la
struttura deformarsi.

 Se I’accessorio montato sull’attacco accessori
viene sottoposto a urti, I’attacco accessori
potrebbe danneggiarsi. In questo caso non
utilizzarlo e contattare il proprio rivenditore o
un rappresentante Sony.

Non coprire il camcorder durante il
funzionamento

Ad esempio, un panno collocato sul camcorder
potrebbe causare un accumulo eccessivo di calore
interno.

Dopo I'uso
Spegnere sempre I’interruttore POWER.

Prima di riporre il camcorder per periodi
prolungati
Rimuovere il pacco batteria.

Spedizione

* Rimuovere il supporto prima di trasportare il
camcorder.

« Se si invia I’apparecchio tramite camion, nave,
per via aerea o con altro servizio di trasporto,
chiuderlo nella confezione.

Cura del camcorder

Rimuovere polvere e sporcizia dalle superfici
degli obiettivi o dai filtri ottici servendosi di un
compressore.

Se la struttura del camcorder & sporca, pulirla con
un panno morbido e asciutto. In casi estremi,
usare un panno bagnato con alcune gocce di
detergente neutro, quindi asciugare. Non usare
solventi organici, come alcool o diluenti, in
quanto potrebbero scolorire o danneggiare la
finitura del camcorder.

Note importanti sul funzionamento

In caso di problemi di funzionamento
In caso di problemi con il camcorder, contattare
un rappresentante Sony.

Luoghi d’uso e conservazione

Conservare in un punto piano e ventilato. Evitare
di usare o conservare il camcorder nei seguenti
luoghi.

* Eccessivamente caldi o eccessivamente freddi
(gamma della temperatura di funzionamento: da
-5°C a +40°C

* Ricordare che in estate o in climi caldi, la
temperatura all’interno di un’auto, con i
finestrini chiusi, puo facilmente superare i
50°C.

* In luoghi umidi o polverosi

* Luoghi in cui il camcorder potrebbe essere
esposto alla pioggia

* In luoghi soggetti a vibrazioni violente

* In prossimita di forti campi magnetici

* Vicino ad un trasmettitore radio o televisivo che
produce forti campi elettromagnetici.

« Sotto la diretta luce del sole o vicino a
riscaldamenti, per un periodo di tempo
prolungato

Per evitare interferenze elettromagnetiche da
periferiche di comunicazione portatili

L’uso di telefoni portatili e di altre periferiche di
comunicazione, situati vicino a questo
camcorder, potrebbe causare malfunzionamenti
ed interferenze con i segnali audio e video.

Si consiglia di spegnere le periferiche di
comunicazione portatili situate vicino a questo
camcorder.

Installazione dell’obiettivo di zoom

E importante installare I’obiettivo in modo
corretto in modo da evitare danni. Consultare la
sezione “Montaggio e regolazione
dell’obiettivo” (pagina 40).



Mirino

Non lasciare il camcorder con I’oculare puntato
direttamente in direzione del sole.

L’obiettivo oculare potrebbe concentrare i raggi
solari e fondere la parte interna del mirino.

Informazioni sui pannelli LCD

11 pannello LCD presente in questo camcorder &
fabbricato con una tecnologia di alta precisione in
grado di offrire un rapporto di pixel di almeno il
99,99%. Cio nonostante una piccolissima
percentuale dei pixel potrebbe essere “bloccata”,
sempre spenta (nera), sempre accesa (rossa, verde
o blu) o lampeggiante. Inoltre, per un lungo
periodo di utilizzo, a causa delle caratteristiche
fisiche del display a cristalli liquidi, questo tipo di
pixel “bloccati” potrebbero apparire
spontaneamente. Non si tratta di un
malfunzionamento. Tali problemi non hanno
alcun effetto sui dati registrati.

1l problema puo essere attenuato eseguendo la
funzione APR (riduzione automatica del rumore
pixel) con MAINTENANCE >APR nel menu di
impostazione (vedere pagina 159). 1l ramore
pixel viene ridotto di un certo tanto dalla
regolazione automatica del bilanciamento del
nero (vedere pagina 53); tuttavia, le capacita di
rilevazione di quella funzione sono limitate. Per
ottenere la correzione piu efficace eseguire la
funzione APR.

Distorsione a striscia verticale

Quando si riprende un oggetto eccessivamente
luminoso, quale un riflettore o una pila tascabile,
sullo schermo si producono strisce verticali
oppure I’immagine ¢ distorta.

Fenomeni specifici per i sensori di
immagine CCD

I seguenti fenomeni che potrebbero apparire nelle
immagini sono specifici dei sensori di immagine
CCD (dispositivo di collegamento di carica). Essi
non indicano malfunzionamenti.

Chiazze hianche

Nonostante i sensori di immagine CCD siano
prodotti con tecnologie ad alta precisione, in
alcuni casi rari potrebbero crearsi dei granellini
bianchi sullo schermo causati da raggi cosmici,
ecc.

Ci0 & dovuto ai principi dei sensori di immagine
CCD e non si tratta di malfunzionamento.

In particolare le macchie bianche tendono a

comparire nei seguenti casi:

 Durante il funzionamento a temperature
ambientali elevate

 Una volta raggiunto il guadagno master
(sensibilita)

In modalita SLS, i granellini bianchi risultano pil
evidenti quando si imposta la velocita
dell’otturatore (numero di fotogrammi) su valori
piu alti.

? ¢
]

\
i

© Schermo del monitor

@ Strisce verticali sullimmagine

@ Oggetto luminoso (ad es. riflettore o luce
forte riflessa, pila tascabile, il sole)

Gradinatura

Se vengono ripresi motivi a strisce o a righe,
questi potrebbero risultare ondulati o si verifica
uno sfarfallio.

Frammentazione

Se non ¢ possibile registrare o riprodurre
correttamente le immagini, provare a formattare il
supporto di registrazione.

Se si ripete la registrazione o la riproduzione di
immagini su un certo supporto di registrazione in
un periodo prolungato, i file nel supporto possono
essere frammentati, impedendo la corretta
registrazione e memorizzazione. In tal caso,
effettuare il backup dei clip nel supporto quindi
formattare il supporto tramite OPERATION
>Format Media (vedere pagina 119) nel menu di
impostazione.

Note importanti sul funzionamento
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Sostituzione della
batteria dell’orologio
interno

L’orologio interno del camcorder viene
alimentato da una batteria al litio. Se il messaggio
“BackUp Battery End” appare nel mirino, la
batteria deve essere cambiata. Contattare un
rappresentante Sony.

Specifiche tecniche

Generale

Alimentazione
12VCC(dallVal70Vv)

Consumo energetico
Circa 27 W (solo unita principale, durante la
registrazione con il monitor LCD acceso)

* Non utilizzare una luce video con un
consumo di corrente superiore a 50 W.

* Quando si connette un dispositivo al
connettore DC OUT, utilizzarne uno con
consumo di corrente di almeno 0,5 A o
meno.

Temperatura di esercizio
Da -5°C a +40°C

Temperatura di conservazione
Da —20°C a +60°C

Formati di registrazione/riproduzione

Modalita UDF

* HD422
Codec video: MPEG-2 422P@HL
Velocita video: 50 Mbps/CBR
Campionamenti video: 1920 x 1080, 1280 x
720
Proxy video: MPEG-4
Audio: LPCM 4CH, 24 bit, 48 kHz
Proxy audio: A-law

.

HD420

Codec video: MPEG-2 MP@HL(1440)
Velocita video: 35 Mbps/VBR
Campionamenti video: 1440 x 1080
Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bit, 48 kHz
Proxy audio: A-law

Sostituzione della batteria dell’orologio interno / Specifiche tecniche



Codec video: MPEG-2 MP@HL
Velocita video: 35 Mbps/VBR
Campionamenti video: 1280 x 720
Proxy video: MPEG-4
Audio: LPCM 4CH, 16 bit, 48 kHz
Proxy audio: A-law

* IMX
Codec video: MPEG-2 422P@ML Intra
Velocita video: 50 Mbps
Campionamenti video: 720 x 486 (NTSC)/576
(PAL)
Proxy video: MPEG-4
Audio: LPCM 4CH, 24/16 bit, 48 kHz
Proxy audio: A-law

DVCAM

Velocita video: 25 Mbps

Campionamenti video: 720 x 480 (NTSC)/576
(PAL)

Proxy video: MPEG-4

Audio: LPCM 4CH, 16 bit, 48 kHz

Proxy audio: A-law

Modalita FAT

* HD420
Codec video: MPEG-2 MP@HL
Velocita video: 35 Mbps/VBR
Campionamenti video: 1920 x 1080, 1280 x
720
Audio: LPCM 4CH, 16 bit, 48 kHz

Codec video: MPEG-2 MP@HL(1440)
Velocita video: 35 Mbps/VBR
Campionamenti video: 1440 x 1080
Audio: LPCM 4CH, 16 bit, 48 kHz

Codec video: MPEG-2 MP@H14
Velocita video: 25 Mbps/CBR
Campionamenti video: 1440 x 1080
Audio: LPCM 4CH, 16 bit, 48 kHz

DVCAM

Velocita video: 25 Mbps

Campionamenti video: 720 x 480 (NTSC)/576
(PAL)

Audio: LPCM 2CH, 16 bit, 48 kHz

Tempo di registrazione/riproduzione
Con un SBP-32/SBS-32G1A
Modalita FATHQ: circa 100 minuti
SP: circa 140 minuti
DVCAM: circa 130 minuti
Modalita UDFHD422 50/IMX50: circa 60
minuti
HDA420 HQ: circa 90 minuti
DVCAM: circa 110 minuti
Con un SBP-64A/SBS-64G1A
Modalita FATHQ: circa 200 minuti
SP: circa 280 minuti
DVCAM: circa 260 minuti
Modalita UDFHD422 50/IMX50: circa
120 minuti
HD420 HQ: circa 180 minuti
DVCAM: circa 220 minuti

11 tempo effettivo di registrazione/riproduzione
puo differire leggermente dai valori indicati, in
base alle condizioni di utilizzo, caratteristiche

della memoria, ecc.

Tempo di esecuzione continuo
Con il BP-L80S
Circa 145 min.

Peso

Solo corpo principale: 3,4 kg

Dimensioni

Vedere pagina 208.

Accessori in dotazione

Vedere pagina 207.

Blocco della telecamera

Sensore
Sensore di immagine CCD di tipo 2/3
Elementi effettivi delle immagini:
1920 (H) x 1080 (V)

Format
3-chip RGB

Sistema ottico

F1.4 prisma

Filtri ND
1: nitido
2:1,ND
3:1/,4ND
4:'/,ND

Specifiche tecniche

90Ipuaddy

205



aolpuaddy

206

Sensibilita
F11 (frequenza di sistema: 59.94i)
F12 (Frequenza di sistema: 50i)
(2000 1x, 89,9% riflesso, 3200K)

Altoparlante incorporato
Mono
Uscita: 300 mW

Illuminazione minima
0,016 1x (F1.4, +42 dB, con accumulo 16
fotogrammi)

S/N video
54 dB (soppressione di rumore spento)
59 dB (soppressione di rumore acceso)

Visualizzazione

Monitor LCD

Dimensione dello schermo
8,8 cm di diagonale (3,5")

Risoluzione orizzontale
1000TV linee o piu

Rapporto larghezza/altezza
16:9

Modulazione
45% o piu (27,5 MHz, al centro dello schermo)

Elementi dell’immagine
640 (H) x 3 x 480 (V) Sequenza delta

Livello di nero
3+1% (quando Black nel menu di impostazione
€ impostato su +0)

Sistema di trasmissione

Tipo ibrido (semi-trasmissivo)

Gain
-6,-3,0,3,6,9, 12, 18, 24, 30, 36, 42 dB, AGC

Velocita dell’otturatore
59.94i/P, 50i/P: da l/60 a 1/2000 sec.
29.97P: da 4 a p00 sec.
25P: da /33 a pgq sec.
23.94P: da /35 a 0 sec.

Blocco supporto

Alloggiamenti schede
Tipo: Express Card34
Numero di alloggiamenti: 2
Connettore: Conforme a PCMCIA Express Card

Freq di scrittura

Otturatore lento

Da?2 a8, 16 fotogrammi

Gamma dinamica
600%
460% (1080/29.97P, 1080/25P, 1080/23.98P)

Smear
-135dB

Blocco audio

Frequenza di campionamento
48 kHz

Quantizzazione
16 bit/24 bit

Headroom
20 dB (impostazione predefinita di fabbrica)
(20, 18, 16, 12 dB), EBU

Risposta in frequenza
Da 20 Hz a 20 kHz (entro +3 dB)

Gamma dinamica
90 dB (tipico)

Distorsione
Max 0,08% (con livello di ingresso 40dBu)

Specifiche tecniche

50 Mbps o pil

Frequenza di lettura
50 Mbps o pit

Ingressi/Uscite

Connettori di ingresso/uscita

Ingressi del segnale

GENLOCK IN: tipo BNC
1,0 Vp-p, 75 Q, non bilanciato

TC IN: tipo BNC
Da 0,5V a 18 Vp-p, 10 kQ

AUDIO IN CH-1/CH-2: tipo XLR, 3 pin,
femmina
(Con funzione di rilevamento automatico e
commutazione)

MIC: da—70 a —20 dBu

LINE: +4, 0, -3 dBu

MIC IN: tipo XLR, 5 pin, femmina
Da-70 a-20 dBu

WRR CHI1/CH2
D-sub 15-pin
WRR analogico: —-40 dBu
WRR digitale: 40 dbFS




HD/SD SDI
Quando ¢ installata un’opzione

Audio a 4 canali

Uscite del segnale

VIDEO OUT: tipo BNC, commutazione tra
composito analogico SD e HD-Y

HD/SD SDI OUT 1/2: tipo BNC
0,8 Vp-p, non bilanciato (commutazione
tra HD e SD)

Conforme a SMPTE292M/259M

Audio a 4 canali (da CH1 a CH4)

AUDIO OUT: tipo XLR, 5 pin, maschio
+4, 0, -3 dBu (bilanciato)

TC OUT: tipo BNC
1,0 Vp-p, 75 Q

EARPHONE (mini jack stereo)
8Q, 5mW

Altri

DC IN: tipo XLR, 4 pin, maschio
Dallal7VCC

DC OUT: 4-pin
Da 11 a 17 V CC, corrente massima:
0,5A

LENS: 12-pin
Alimentazione dell’obiettivo
Da 11 a 17 V CC, corrente massima:
1,0A

REMOTE: 8 pin

LIGHT: 2 pin

USB: 4 pin (tipo A), 4 pin (tipo B)

i.LINK (HDV/DV): 6 pin, conforme a
IEEE 1394

VF: 26 pin, rettangolare, 20 pin rotondo

Per i ricevitori wireless: D-sub 15 pin

Accessori in dotazione

Tracolla (1)

Kit per attacco a piede fisso (1 set)

Tappo obiettivo (1)

Diagramma di regolazione posteriore della flangia

OPERATION MANUAL (manuale di istruzioni)
Versione giapponese (1)
Versione inglese (1)

CD-ROM
Manuals for Solid-State Memory Camcorder
(PDF OPERATION MANUAL (manuale di
instruzioni) e Supplemento) (1)

Apparecchiature aggiuntive
consigliate

Tasto opzione

Chiave di registrazione e riproduzione SD
CBK-MDO1

Alimentazione ed apparecchiatura correlata

Adattatore CA
AC-DN10/DN2B

Pacco batteria
BP-L80S

Caricabatterie
BC-L160/L500/L70

Obiettivo, mirino e apparecchiatura correlata

Obiettivo
Attacco di tipo 2/3 a baionetta

Mirino
Mirino serie HDVF: HDVF-200/20A/C35W/
C950W/C730W
CBK-VFO01

Braccetto di rotazione del mirino
BKW-401

Apparecchiatura per il telecomando

Unita di controllo remoto
RM-B170/B750
RCP-1000/1001/1500/1501/1530

Ingresso SDI/COMPOSITE e interfaccia a 50 pin
CBK-HD02

Adattatore per videocamera HD
CA-FB70 (quando il CBK-HDO2 opzionale &
installato)

Unita di controllo HD
CA-TX70

Adattatore MPEG TS
HDCA-702 (quando il CBK-HDO2 opzionale &
installato)

Adattatore Wi-Fi
CBK-WAO01

Adattatore per supporti di memoria

MEAD-MSO01 (per “Memory Stick”)
MEAD-SDO1 (per scheda SDHC)

Adattatore ExpressCard XQD

QDA-EX1 (per schede di memoria XQD)

Specifiche tecniche
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Supporto

Scheda di memoria SxS
SxS PRO SBP-32 (32 GB)
SxS PRO SBP-64A (64 GB)
SxS-1 SBS-32G1A (32 GB)
SxS-1 SBS-64G1A(64 GB)

Disco rigido professionale
PHU-220R (in modalita FAT)

Apparecchiatura audio

Microfono
ECM-678/674/673/680S

Sostegno per microfono
CAC-12

Microfono wireless
DWR-S01D
WRR-855S/860C/861/862

Altre periferiche

Adattatore per treppiede
VCT-14/U14

Dimensioni

124

[

11 design e le specifiche tecniche sono soggette a
cambiamenti senza preavviso.

Luce video
UC-D200A (PROTECH)
Ultralight (Anton Bauer)

Protezione
Protezione per le riprese a spalla tipo morbido
CBK-SP01

Attrezzature per la manutenzione e una cura pill
facile

Custodia rigida
LC-H300

Custodia morbida
LC-DS300SFT

M le per la €]

Specifiche tecniche

¢ Eseguire sempre una registrazione di prova, e
verificare che il contenuto sia stato registrato
correttamente.
LA SONY NON SARA RESPONSABILE DI
DANNI DI QUALSIASI TIPO, COMPRESI, MA
SENZA LIMITAZIONE A, RISARCIMENTI O
RIMBORSI A CAUSA DI GUASTI DI QUESTO
APPARECCHIO O DEI SUOI SUPPORTI DI
REGISTRAZIONE, SISTEMI DI
MEMORIZZAZIONE ESTERNA O QUALSIASI
ALTRO SUPPORTO O SISTEMA DI
MEMORIZZAZIONE PER REGISTRARE
CONTENUTI DI QUALSIASI TIPO.

 Verificare sempre che I’apparecchio stia
funzionando correttamente prima di usarlo. LA
SONY NON SARA RESPONSABILE DI DANNI
DI QUALSIASI TIPO, COMPRESI, MA SENZA
LIMITAZIONE A, RISARCIMENTI O
RIMBORSI A CAUSA DELLA PERDITA DI
PROFITTI ATTUALI O PREVISTI DOVUTA A
GUASTI DI QUESTO APPARECCHIO, SIA
DURANTE IL PERIODO DI VALIDITA DELLA
GARANZIA SIA DOPO LA SCADENZA DELLA
GARANZIA, O PER QUALUNQUE ALTRA
RAGIONE.




Tabella dei componenti opzionali e degli accessori

Monitor HD/Monitor SD

Microfono ECM-
[ 680S/678/674/673

Sezione di applicazione
del microfono CAC-12

O

Q

%((%ﬁ\\w Mirino CBK-VFO1

« Mirino HDVF-200/
20A/C35W/C950W/
C730W

SBP-32/64A

Unita di controllo

29| remoto

3% RM-B170/B750

50| RCP-730/750/751/920/
921/1001/1501
MSU-900/950/700

Il

Adattatore per
=0
treppiede VCT-14/
U4

Treppiede

5 Custodia morbida
§ LC-DS300SFT @

| LC-H300
Il Custodia rigida

{ PHU-220R

MPEG TS

2] Registratore serie XDCAM HD
PDW-F1600/HD1500, PDW-F75

Registratore serie HDCAM
Registratore serie HDW-2000, HDW-S280

Sintonizzatore a sintesi di frequenza UHF WRR-855S
e Ricevitore wireless digitale DWR-S01D

= SBS-32G1A/64G1A
EEI Scheda di memoria SxS

Adattatore per supporti di memoria MEAD-MSO01, MEAD-SDO01
Adattatore ExpressCard XQD QDA-EX1

Chiave di registrazione e riproduzione SD CBK-MDO1
s |ngresso CBK-HDO02 SDI/COMPOSITE e interfaccia a 50 pin

‘ Disco rigido professionale

Alngresso CBK-HD02 SDI/COMPOSITE e
interfaccia a 50 pin + dattatore HDCA-702

Ingresso CBK-HD02 SDI/COMPOSITE e
interfaccia a 50 pin + adattatore per
videocamera HD CA-FB70

BP-L80S
Pacco batteria

Adattatore CA
AC-DN10/DN2B

T

Caricabatterie
BC-L160

Caricabatterie
BC-L70

Caricabatterie
BC-L500

a) La custodia & abbastanza grande da poter contenere il camcorder con il mirino e il microfono montati.
Tuttavia, rimuoverli se fuoriescono per piu di 25 cm.

Tabella dei componenti opzionali e degli accessori
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Informazioni su i.LINK

La presente sezione contiene le specifiche e le
caratteristiche di i. LINK.

Cosa e i.LINK?

i.LINK ¢ un’interfaccia seriale digitale progettata
per integrare dispositivi dotati di connettori
i.LINK. Tale interfaccia consente al dispositivo
di eseguire le operazioni riportate di seguito:
* Eseguire trasmissioni bidirezionali e ricevere
dati come segnali digitali audio e video.
¢ Controllare altri dispositivi i. LINK.
¢ Collegare facilmente piu dispositivi tramite un
unico cavo i.LINK.
1l dispositivo i.LINK consente di collegare una
vasta gamma di dispositivi digitali AV per il
trasferimento di dati e altre operazioni.
Inoltre offre i vantaggi riportati di seguito. Se pilt
dispositivi i.LINK vengono collegati tra loro, ¢
possibile eseguire il trasferimento di dati e altre
operazioni non solo
collegando direttamente i dispositivi tra loro, ma
anche collegandoli ad altri dispositivi intermedi.
Pertanto, non € necessario prestare attenzione
all’ordine di connessione dei dispositivi.
Tuttavia, in base alle caratteristiche e alle
specifiche dei dispositivi collegati, potrebbe
essere necessario utilizzare alcune funzioni in
modo diverso e il trasferimento dei dati ed altre
operazioni potrebbero non essere eseguibili.

i.LINK, denominazione relativa a IEEE 1394
proposta da Sony, ¢ un marchio di fabbrica
supportato da gran parte delle aziende in tutto il
mondo.

IEEE 1394 ¢ uno standard internazionale definito
dall’ente IEEE, Institute of Electrical and
Electronics Engineers, Inc.

E possibile collegare il camcorder a un dispositivo
tramite il cavo i.LINK (cavo DV). Quando si esegue il
collegamento a un dispositivo HDV o DV con due o pit
connettori i.LINK, consultare

le istruzioni per I’uso fornite con il dispositivo collegato.

Informazioni su i.LINK

Informazioni sulla velocita di
trasferimento di dati di i.LINK

i.LINK stabilisce una velocita di trasferimento

dei dati massima di circa 100, 200 e 400 Mbps !

definita rispettivamente S100, S200 e S400.

Per i dispositivi i.LINK, la massima velocita di

trasferimento dati supportata dal dispositivo

viene definita nella pagina delle “Specifiche”
delle istruzioni per 1’uso fornite in dotazione
oppure accanto al connettore i.LINK.

1) Collegando un dispositivo che supporta diverse
velocita di trasferimento dati, la velocita effettiva
potrebbe essere diversa da quella descritta sui
connettori i.LINK.

Definizione di Mbps?

Mega bit al secondo, ovvero la quantita di dati
trasmessi in un secondo. Nel caso di 100 Mbps, &
possibile trasmettere 100 Megabit di dati al
secondo.

Funzionamento di i.LINK con il
camcorder

Per ulteriori informazioni sul funzionamento
durante il collegamento di altri dispositivi tramite
il connettore i.LINK (HDV o DV), consultare
pagina 188.

Per ulteriori informazioni sul collegamento con il
cavo I.LINK e il software necessario, consultare le
istruzioni per I'uso fornite con il dispositivo
collegato.

Informazioni sul cavo i.LINK necessario

Utilizzare un cavo i.LINK Sony da 6 a 4 pin o da
6 a 6 pin per collegare dispositivi i. LINK.

i.LINK e gsono marchi di fabbrica.



Licenza MPEG-4 Visual
Patent Portfolio

QUESTO PRODOTTO VIENE CONCESSO IN
LICENZA AI SENSI DELLA LICENZA DI
RACCOLTA DIBREVETTI VISUALIMPEG-4
PER L’USO PERSONALE E NON
COMMERCIALE DA PARTE DEL
CONSUMATORE PER

(i) LA CODIFICA DI VIDEO IN
CONFORMITA ALLO STANDARD VISUALE
MPEG-4 (“MPEG-4 VIDEO”)

E/O

(ii) LA DECODIFICA DI VIDEO MPEG-4
CODIFICATI DAL CONSUMATORE NEL
CORSO DI ATTIVITA PERSONALI E NON
COMMERCILI E/O OTTENUTI DA UN
FORNITORE DI VIDEO AUTORIZZATO DA
MPEG LA ALLA FORNITURA DI VIDEO
MPEG-4.

NESSUNA LICENZA VIENE CONCESSA O
PUO ESSERE USATA PER QUALSIASI
ALTRA FINALITA. ULTERIORI
INFORMAZIONI, COMPRESE QUELLE CHE
SI RIFERISCONO A PROMOZIONI, USI
INTERNI E COMMERCIALL E LICENZE,
POSSONO ESSERE OTTENUTE DA MPEG
LA, LLC. CONSULTARE IL SITO HTTP://
WWW.MPEGLA.COM

MPEG LA rilascia licenze per (i) la produzione/
vendita di supporti per 1’archiviazione di
informazioni video in formato visuale MPEG-4
(ii) la distribuzione/trasmissione di informazioni
video in formato visuale MPEG-4 sotto qualsiasi
forma (Come servizi di distribuzione di video
online, trasmissione via Internet, trasmissione
TV). Per altri usi del prodotto, potrebbe essere
necessario ottenere una licenza da MPEGLA.
Contattare la MPEG LA per ulteriori
informazioni. MPEG LA, L.L.C., 250 STEELE
STREET, SUITE 300, DENVER, COLORADO
80206,

http://www.mpegla.com

Licenza MPEG-2 Video
Patent Porifolio

EVENTUALI USI DEL PRODOTTO DIVERSI
DALL’USO PERSONALE DEL
CONSUMATORE CHE RISPETTINO LO
STANDARD MPEG-2 PER LA CODIFICA DI
INFORMAZIONI VIDEO PER I MEDIA
IMPACCHETTATISONO ESPLICITAMENTE
VIETATI SENZA UNA LICENZA AI SENSI
DEI BREVETTI APPLICABILI NELLA
RACCOLTA DI BREVETTI MPEG-2, TALE
LICENZA E DISPONIBILE DA MPEG LA,
L.L.C., 250 STEELE STREET, SUITE 300,
DENVER, COLORADO 80206.

“MEDIA IMPACCHETTATI” significa
qualsiasi dispositivo di archiviazione che
contenga informazioni video MPEG-2 come film
in DVD che siano venduti/distribuiti ai
consumatori generici. I duplicatori di dischi o i
rivenditori di MEDIA IMPACCHETTATI
devono ottenere una licenza per le loro attivita da
MPEG LA. Contattare la MPEG LA per ulteriori
informazioni. MPEG LA. L.L.C., 250 STEELE
STREET, SUITE 300, DENVER, COLORADO
80206

http://www.mpegla.com

Informazioni sui
caratteri Bitmap

Questo prodotto usa caratteri Bitmap RICOH
prodotti e venduti da Ricoh Company, Ltd.

Licenza MPEG-4 Visual Patent Portfolio / Licenza MPEG-2 Video Patent Portfolio / Informazioni sui caratteri Bitmap

90Ipuaddy

211



Informazioni su OpenSSL

Poiché usa OpenSSL Toolkit, questo prodotto usa software sviluppato da OpenSSL Project
(http://www.openssl.org/).

OpenSSL License

/*
* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.
%

* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:

3

* 1. Redistributions of source code must retain the above copyright

* notice, this list of conditions and the following disclaimer.
ES

aolpuaddy

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in

*  the documentation and/or other materials provided with the

*  distribution.

E3

* 3. All advertising materials mentioning features or use of this

* software must display the following acknowledgment:

*  "This product includes software developed by the OpenSSL Project

* for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

3

* 4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to

* endorse or promote products derived from this software without

*  prior written permission. For written permission, please contact

* openssl-core @openssl.org.

F

* 5. Products derived from this software may not be called "OpenSSL"

* nor may "OpenSSL" appear in their names without prior written

* permission of the OpenSSL Project.

3

* 6. Redistributions of any form whatsoever must retain the following

* acknowledgment:

* "This product includes software developed by the OpenSSL Project

*  for use in the OpenSSL Toolkit (http://www.openssl.org/)"

3

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ““AS IS" AND ANY

* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
* TS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
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* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

*

%
* This product includes cryptographic software written by Eric Young
* (eay @cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).

*

%

Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay @cryptsoft.com)
* All rights reserved.

E3

* This package is an SSL implementation written

* by Eric Young (eay @cryptsoft.com).

* The implementation was written so as to conform with Netscapes SSL.
ES

* This library is free for commercial and non-commercial use as long as

* the following conditions are aheared to. The following conditions

* apply to all code found in this distribution, be it the RC4, RSA,

* Thash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms

* except that the holder is Tim Hudson (tjh@cryptsoft.com).

E3

* Copyright remains Eric Young's, and as such any Copyright notices in

* the code are not to be removed.

* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.

* This can be in the form of a textual message at program startup or

* in documentation (online or textual) provided with the package.

E3

* Redistribution and use in source and binary forms, with or without

* modification, are permitted provided that the following conditions

* are met:

* 1. Redistributions of source code must retain the copyright

* notice, this list of conditions and the following disclaimer.

* 2. Redistributions in binary form must reproduce the above copyright

* notice, this list of conditions and the following disclaimer in the

* documentation and/or other materials provided with the distribution.

* 3. All advertising materials mentioning features or use of this software

* must display the following acknowledgement:

*  "This product includes cryptographic software written by

*  Eric Young (eay @cryptsoft.com)"

* The word 'cryptographic' can be left out if the rouines from the library
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*  being used are not cryptographic related :-).

* 4. 1If you include any Windows specific code (or a derivative thereof) from

* the apps directory (application code) you must include an acknowledgement:

* "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

E3

* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “"AS IS" AND

* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OQUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

* SUCH DAMAGE.

E3

* The licence and distribution terms for any publically available version or

* derivative of this code cannot be changed. i.e. this code cannot simply be

* copied and put under another distribution licence

* [including the GNU Public Licence.]

*/
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